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3 1. Présentation

Configuration du système

Système de 
microphone 

sans fil 
(récepteur : 
URX-P40) 
UWP-D21 
UWP-D22 
UWP-D26

Adaptateur de 
griffe à interfaces 

multiples 
SMAD-P5

Récepteur de 
microphone  

sans fil 
URX-P03D

Adaptateur de 
griffe à interfaces 

multiples  
SMAD-P3D

Kit adaptateur XLR 
XLR-K3M

Lampe vidéo 
HVL-LBPC

Objectif PL S35
Poignée équipée d’une griffe MI 
(A-5012-165-) Poignée

Module du viseur

Pack de batteries 
BP-GL95B

Adaptateur CA 
AC-DN10A

Unité de 
télécommande 
RM-30BP/1BP

MPC-2610

Cartes mémoire 
CFexpress Type B

Adaptateur d’épaule 
VCT-FSA5

Télécommande de poignée 
GP-VR100

Carte SD

Adaptateur de la 
monture PL

Objectif anamorphique 
(monture PL)

Objectif plein format 
(monture PL)

Objectif à monture E

Adaptateur de monture de type A 
LA-EA4 
LA-EA5

Microphone ECM-680S*, 
ECM-678, ECM-674, 
ECM-MS2
*	 EC-0.5X5F3M requis

Lecteur de cartes  
CFexpress Type B/ 

Lecteur de cartes SD

Attache de tige (A-2182-621-) 
Ensemble de support de 
microphone (X-2596-733-) 
Vis P2.6×8 (2)  
(7-627-556-98)
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Localisation et fonctions des pièces

Côté des commutateurs de l’opérateur

LOCK

MFAF

ND STEP ND VARIABLE

FULL MENU

ND ON

1 2

3

CLEAR

DISP

AUTO

A

B

CLIPS

CH-1

CH-2AUTO

SLOT
SEL

MENU

BACK

REC

SD

4 7 92 10

14151718
16

1920
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27

24

22
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Section du logement de carte 
CFexpress Type B (page 5)

1.	 Commutateur FOCUS (page 89)

2.	 Commutateur LOCK
Verrouille les opérations des touches.
Lorsqu’il est verrouillé, la LED d’arrière-plan du 
commutateur s’allume en orange.

3.	 Molette ND VARIABLE (page 96)

4.	 Haut-parleur intégré (page 72)

5.	 Entrée d’air

[Remarque]
Ne couvrez pas l’entrée d’air.

6.	 Touche MENU (page 28, 33)
Appuyez sur la touche MENU pour afficher 
l’écran d’état. Maintenez la touche MENU 
enfoncée pour afficher l’écran de menu 
complet.

Appuyez sur la touche durant l’affichage de 
l’écran d’état ou de l’écran de menu complet 
pour revenir à l’affichage d’écran précédent.

7.	 Commutateurs CH1/CH2 (AUTO/MAN) 
(page 99)

8.	 Antenne Wi-Fi

[Remarque]
La communication Wi-Fi peut être interrompue si 
vous couvrez cette partie avec votre main ou un objet 
métallique.

9.	 Molettes AUDIO LEVEL (CH1/CH2) 
(page 99)

10.	 Touche CLIPS (page 69)
Appuyez pour afficher les plans sur le support 
de lecture actif de l’écran des plans et activer 
l’opération de lecture. Appuyez lorsque l’écran 

des plans s’affiche pour revenir à l’écran de 
prise de vue.

11.	 Indicateurs d’accès A/B (page 18)

12.	 Touche SLOT SELECT (sélection de carte 
mémoire CFexpress type B) (page 72)

13.	 Connecteur de casque (mini-prise stéréo)
Raccordez les écouteurs pour la surveillance 
audio. Vous pouvez contrôler l’audio d’entrée 
pendant la prise de vue/l’enregistrement et le 
son de lecture pendant la lecture (page 72).

14.	 Logement de carte SD Utility/Indicteur 
d’accès (page 20)

15.	 Microphone interne (page 99)
Microphone de narration pour 
l’enregistrement du son d’ambiance.

16.	 Touche BACK
Annule le réglage de menu et remonte d’un 
niveau dans la hiérarchie du menu pendant 
l’affichage du menu. Annule le processus 
d’exécution ou le processus en attente 
pendant l’affichage de l’exécution/de la mise 
en attente du processus.

17.	 Interrupteur d’alimentation
Placez en position  (ON) pour mettre 
l’alimentation sous tension. Placez en position 
 (veille) pour mettre l’alimentation hors 
tension.

[Remarques]
•• Cet appareil utilise une petite alimentation de veille 

lorsque l’alimentation est coupée. Retirez le pack 
de batteries en cas de non-utilisation prolongée de 
l’appareil.

•• Pour retirer le pack de batteries ou couper 
l’alimentation DC IN, veillez à régler l’interrupteur 
d’alimentation sur la position STANDBY et vérifiez que 
le témoin d’alimentation n’est pas allumé. En cas de 
déconnexion alors que l’interrupteur d’alimentation 
est en position ON, un dysfonctionnement de 
l’appareil ou des cartes mémoire pourrait survenir.

18.	 Témoin d’alimentation (page 83)

19.	 Témoin REC ACTIVE
Le témoin s’allume en vert lorsque la touche 
REC est activé.

20.	Touche/Témoin REC (démarrer/arrêter 
l’enregistrement)

Appuyez pour démarrer l’enregistrement, 
allumant ainsi le témoin REC. Appuyez à 
nouveau pour arrêter l’enregistrement, 
éteignant ainsi le témoin REC (page 83).

21.	 Témoin ASSIGN (personnalisable) 3 
(page 101)

Le témoin s’allume en orange lorsque la 
fonction assignée est on (activée) et ne 
s’allume pas lorsque la fonction est off 
(désactivée).

22.	 Molette multifonction (page 101)
Lorsque vous visualisez l’image sur le viseur, 
appuyez pour afficher et actionner le menu 
direct .
Lorsqu’un menu est affiché sur le viseur, 
tournez la molette pour déplacer le curseur 
vers le haut/bas et sélectionner des éléments 
ou des réglages de menu. Appuyez pour 
appliquer l’élément sélectionné.
Lorsque le menu n’est pas affiché, vous 
pouvez aussi utiliser la molette comme 
molette personnalisable.

[Conseil]
Par défaut, vous pouvez utiliser la molette pour régler le 
diaphragme lorsqu’un objectif à monture E est installé.

23.	 Sélecteur multiple (touches 8 voies D-pad 
et de mise en application)

À utiliser pour sélectionner un cadre de 
reconnaissance du sujet lors de la mise 
au point automatique, déplacer la zone 
de mise au point et déplacer la position 
d’agrandissement pendant l’utilisation de la 
loupe de mise au point. Vous pouvez aussi 
l’utiliser pour les opérations du menu lorsque 
le moniteur LCD est en mode de surveillance 
vidéo (page 21).

[Conseil]
Le sélecteur multiple de la télécommande de poignée 
(en option) et de la télécommande LANC (en option) 
fonctionne de la même manière que ce sélecteur 
multiple.
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24.	 Touche DISPLAY (affichage de l’écran) 
(page 22)

25.	 Touches/Témoins ASSIGN 
(personnalisables) 1/2 (page 101)

Le témoin s’allume en orange lorsque la 
fonction assignée est on (activée) et ne 
s’allume pas lorsque la fonction est off 
(désactivée).

26.	 Touches haut/bas ND FILTER POSITION/
Témoin ND CLEAR (page 96)

Lorsque ND filter est réglé sur CLEAR, le 
témoin ND CLEAR s’allume.

27.	 Commutateur ND STEP/VARIABLE 
(page 96)

28.	 Adaptateur de la monture PL (page 15)

Section du logement de carte CFexpress 
Type B(page 18)

Les logements de carte CFexpress Type B se 
trouvent derrière le couvercle.

1

1.	 Logements A/B de carte CFexpress Type B

Côté des connecteurs

SDI OUT  1

SDI OUT  2
INPUT LINE

MIC
MIC + 48V

TC

OUT
IN

REF

12V

REMOTE GRIP

VF

7

1

INPUT
2

LINE
MIC

MIC + 48V

3 4

13 12 11 10

14

15

1 2

6
5

7

9
8

1.	 Témoin d’enregistrement/de signalisation 
(page 83)

Allumé pendant l’enregistrement et clignote 
lorsque la capacité restante de la batterie ou 
du support d’enregistrement est faible.

2.	 Connecteur USB-C (page 76, 80, 109)

3.	 Touche/Témoin ASSIGN (personnalisable) 
7 (page 101)

Le témoin s’allume en orange lorsque la 
fonction assignée est on (activée) et ne 
s’allume pas lorsque la fonction est off 
(désactivée).

4.	 Crochet pour mètre à ruban
Le crochet pour mètre à ruban se trouve au 
même niveau que le capteur d’image. Pour 
mesurer la distance entre l’appareil et le 
sujet de manière précise, utilisez ce crochet 
comme point de référence. Vous pouvez fixer 
l’extrémité d’un mètre à ruban au crochet pour 
mesurer la distance à partir du sujet.

5.	 Antenne Wi-Fi

[Remarque]
La communication Wi-Fi peut être interrompue si 
vous couvrez cette partie avec votre main ou un objet 
métallique.

6.	 Commutateur INPUT 1 (LINE/MIC/
MIC+48V) (page 99)

7.	 Connecteur INPUT 1 (entrée audio 1) 
(page 99)

8.	 Commutateur INPUT 2 (LINE/MIC/
MIC+48V) (page 99)

9.	 Connecteur INPUT 2 (entrée audio 2) 
(page 99)

10.	 Fixation de télécommande de poignée
Point de fixation de la télécommande de 
poignée (en option).

11.	 Sortie d’air

[Remarque]
Ne couvrez pas la sortie d’air.

12.	 Connecteur de la télécommande de 
poignée

Connectez à la télécommande de poignée (en 
option).

13.	 Connecteur REMOTE
Permet la connexion à l’accessoire à prise 
LANC à usage général.

14.	 Commutateur de sélection TC/REF IN/OUT 
(page 108)

Commutez les fonctions de deux connecteurs 
situés à l’arrière, entre TC IN/REF IN et TC OUT/
REF OUT.

15.	 Fiche du viseur (page 10)
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Avant

3

1

3

2

1.	 Contact électrique d’objectif PL (haut)

2.	 Contact électrique d’objectif PL (côté)

3.	 Touche ASSIGN (personnalisable) 3 
(page 101)

La fonction assignée bascule entre on/off 
(activé/désactivé) ou est activée à chaque 
pression.

Arrière

12
11

10

1
2

3

4

5

6

7

9 88

1.	 Connecteur HDMI OUT (page 107)

2.	 Connecteur SDI OUT 1 (page 107)
Prend en charge la sortie 12G-SDI.

3.	 Connecteur SDI OUT 2 (page 107)
Prend en charge la sortie 3G-SDI.

4.	 Connecteur TC IN/TC OUT (entrée/sortie 
de code temporel) (page 108)

5.	 Connecteur REF IN/REF OUT (entrée/
sortie du signal de synchronisation)

À utiliser pour l’une des applications 
suivantes, selon le commutateur de sélection 
TC/REF IN/OUT.
IN : entrez un signal de référence externe 

pour effectuer un verrouillage de 
synchronisation de l’appareil sur une 
source externe ou pour verrouiller le code 
temporel de l’appareil sur une source 
externe.

OUT : émettez un signal de synchronisation 
pour synchroniser des dispositifs externes. 

Le connecteur REF OUT émet toujours un 
signal de synchronisation HD.

6.	 Connecteur réseau (RJ-45)
Connectez-vous à un réseau LAN filaire à l’aide 
d’un câble LAN (non fourni) pour assurer un 
réseau stable (page 76).

[Remarque]
Ne peut être utilisé en même temps que le Wi-Fi.

7.	 Connecteur DC-IN (XLR 4 broches) 
(page 13)

Connecteur DC IN (entrée d’alimentation CC) 
(XLR 4 broches, mâle) pour l’alimentation 
externe de l’appareil. Prend en charge une 
tension d’entrée de 12 V (11 V à 17 V).
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N° Signal

1 GND

2 NC

3 NC

4 12 V (11 V à 17 V)

8.	 Entrée d’air

[Remarque]
Ne couvrez pas l’entrée d’air.

9.	 Témoin d’enregistrement/de signalisation
Allumé pendant l’enregistrement et clignote 
lorsque la capacité restante de la batterie ou 
du support d’enregistrement est faible.

10.	 Prise de fixation de la batterie 
(page 13)

11.	 Monture du pack de batteries 
(page 13)

12.	 Levier de déverrouillage de la batterie 
(page 13)

Haut

22

1

1.	 Connecteur de poignée
À raccorder à une poignée (en option) équipée 
d’une griffe MI.

2.	 Trous des vis de fixation d’accessoire
Type de vis : 1/4-20UNC (8)
Type de vis : 3/8-16UNC (6)
Longueur d’engagement : 10 mm (13/32 po) ou 
moins
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Fond

1

2

1.	 Orifices de fixation de la plaque de 
trépied

Type de vis : 1/4-20UNC (4)
Type de vis : 3/8-16UNC (4)
Longueur d’engagement : 9 mm (3/8 po) ou 
moins

2.	 Entrée d’air

[Remarque]
Ne couvrez pas l’entrée d’air.

Écran LCD

H&V FLIP

8

9

10

HOME

11

1 32

245

10

6

7

9
8

1.	 Touche ASSIGN (personnalisable) 11 
(page 101)

2.	 Touches ITEM 1 à 6 (page 25)
À utiliser pour actionner l’écran d’accueil et 
l’écran de lecture.

3.	 Languette de verrouillage de la loupe 
(page 11)

4.	 Panneau tactile
Les opérations tactiles peuvent être 
désactivées à l’aide d’une touche 
personnalisable ou à l’aide du menu 
(page 9).

5.	 Commutateur H&V FLIP (ON/OFF)
Permet d’alterner l’affichage de l’écran entre 
normal (OFF) et basculé vers le haut/le bas/la 
gauche/la droite (ON).

6.	 Touche ASSIGN (personnalisable) 8 
(page 101)

7.	 Touche ASSIGN (personnalisable) 9 
(page 101)

8.	 Sélecteur multiple (touches 8 voies D-pad 
et de mise en application)

À utiliser pour contrôler le contenu affiché sur 
le moniteur LCD.

9.	 Touche ASSIGN (personnalisable) 10 
(page 101)

10.	 Touche HOME (page 21)
Appuyez pour afficher l’écran d’accueil.

[Conseil]
Vous pouvez commuter entre le mode de surveillance 
vidéo pour contrôler diverses opérations depuis l’écran 
de prise de vue et le mode d’affichage d’informations 
pour vérifier et modifier les réglages de l’écran d’accueil.
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Utilisation du panneau tactile

Précautions d’utilisation du 
panneau tactile

Le moniteur LCD de l’appareil est un écran 
tactile, que vous actionnez directement en le 
touchant avec le doigt.
•• Le panneau tactile est conçu pour être 

touché légèrement avec votre doigt. 
N’appuyez pas sur le panneau avec force et 
ne le touchez pas avec des objets pointus 
ou tranchants (clou, stylo à bille, épingle, 
etc.).

•• Le panneau tactile risque de ne pas 
répondre s’il est touché dans les 
circonstances suivantes. Notez également 
que cela risque de provoquer un 
dysfonctionnement.

•• 	Fonctionnement en utilisant le bout des 
ongles

•• 	Fonctionnement alors que d’autres 
objets touchent la surface

•• 	Fonctionnement avec une feuille ou un 
autocollant de protection

•• 	Fonctionnement avec des gouttelettes 
d’eau ou de la condensation sur l’écran

•• 	Fonctionnement en utilisant des doigts 
mouillés ou moites

Gestes propres au panneau tactile

Toucher
Touchez légèrement un élément, tel qu’une 
icône ou un élément de menu, avec votre 
doigt, puis retirez immédiatement votre doigt.

Faire glisser
Touchez l’écran et faites glisser votre doigt 
jusqu’à la position souhaitée de l’écran, puis 
retirez votre doigt.

Saisir en glissant/Balayer
Touchez l’écran et saisissez en glissant/
balayez rapidement votre doigt vers le haut, le 
bas, la gauche ou la droite.

[Conseil]
Si le contenu de l’affichage continue au-delà des bords 
de l’écran, vous pouvez le faire glisser ou le faire défiler.

Configuration du panneau tactile

Les opérations du panneau tactile peuvent 
être activées/désactivées à l’aide de Touch 
Operation (page 58) dans le menu 
Technical.
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Fixation de la poignée et du viseur

Fixation de la poignée

1	 Alignez la poignée sur les quatre orifices 
de vis situés à l’avant ou à l’arrière de la 
face supérieure.

2	 Fixez à l’aide de quatre vis hexagonales et 
serrez à un couple de 1,4 N·m avec une clé 
hexagonale (3/16 po).

Pour retirer la poignée

Dévissez les quatre vis hexagonales à l’aide 
d’une clé hexagonale et retirez la poignée.

Fixation du viseur

1	 Avec la poignée fixée à l’appareil, tournez 
la molette de verrouillage du bras du 
viseur dans le sens contraire des aiguilles 
d’une montre pour desserrer le bras, puis 
tournez ce dernier 180° vers l’avant.

	 [Conseil]
Si la molette de verrouillage est difficile à tourner 
en raison de sa position, retirez la molette de 
verrouillage et tournez-le à un angle qui facilite 
l’opération. Remettez ensuite la molette de 
verrouillage en place.

2	 Tournez la molette de verrouillage dans le 
sens horaire pour fixer en position.

Molette de 
verrouillage

Bras
Boulon  
à pans 
hexagonaux

	 [Remarque]
Si la tige de fixation du bras pivote par rapport 
à la poignée, serrez le boulon à tête creuse 
hexagonale (3 mm) sous la poignée à l’aide d’une 
clé hexagonale (couple de serrage : 1,6 N·m).

3	 Fixez l’adaptateur de fixation du viseur à 
l’arrière du moniteur LCD et tournez la 
molette de verrouillage dans le sens 
horaire pour fixer en position.
Adaptateur de fixation du viseur

Molette de verrouillage

4	 Maintenez enfoncée la broche du bras 
avec votre doigt, fixez l’adaptateur de 
fixation du viseur sur le bras et tournez la 
molette de verrouillage dans le sens 
horaire pour fixer en position.

Broche Molette de 
verrouillage

Adaptateur de 
fixation du viseur

	 [Remarque]
Si le bras se relâche trop lorsque vous desserrez la 
molette de verrouillage de fixation, réglez la vis de 
verrouillage à l’aide d’une clé hexagonale (2,5 mm).

Vis de verrouillage

5	 Alignez la marque  sur la fiche du viseur 
de l’appareil avec la marque  sur la fiche 
du câble du moniteur LCD et insérez le 
câble.
Vérifiez l’orientation pour vous assurer 
que la marque  se trouve sur le côté 
externe avant d’insérer.

6	 Placez le câble dans les porte-câbles (trois 
emplacements).

Porte-câble
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7	 Fixez la loupe du viseur en la faisant 
glisser dans la rainure en haut du 
moniteur LCD, comme indiqué sur le 
schéma.

8	 Poussez la loupe du viseur dans la 
direction de la flèche pour la fermer.

Retrait de la loupe du viseur

Appuyez sur le loquet de la loupe du viseur, 
relevez la loupe pour l’ouvrir , pressez 
et maintenez enfoncé la languette de 
verrouillage de fixation de la loupe du viseur 
dans la direction de la flèche , puis glissez 
la loupe du viseur dans le sens opposé à celui 
suivi lors de la fixation pour la retirer .

Languette  
de verrouillage 
de la loupe

Loquet

Retrait du viseur

1	 Retirez le câble des porte-câbles, appuyez 
sur chaque côté de la fiche du connecteur, 
puis débranchez le câble.

2	 Desserrez la molette de verrouillage du 
viseur et utilisez la procédure inverse de 
celle utilisée pour la fixation du viseur 
pour le retirer.

Fixation du viseur (lorsque vous 
n’utilisez pas la loupe du viseur)

1	 Avec la poignée fixée à l’appareil, tournez 
la molette de verrouillage du bras dans le 
sens contraire des aiguilles d’une montre 
pour desserrer le bras, puis tournez ce 
dernier 180° vers l’avant.

2	 Tournez la molette de verrouillage dans le 
sens horaire pour fixer en position.

Molette de 
verrouillage

Bras
Boulon  
à pans 
hexagonaux

	 [Remarque]
Si la tige de fixation du bras pivote par rapport 
à la poignée, serrez le boulon à tête creuse 
hexagonale (3 mm) sous la poignée à l’aide d’une 
clé hexagonale (couple de serrage : 1,6 N·m).

3	 Fixez l’adaptateur de fixation du viseur sur 
le côté du moniteur LCD et tournez la 
molette de verrouillage dans le sens 
horaire pour fixer en position.

Adaptateur de 
fixation du viseur

Molette de verrouillage

4	 Maintenez enfoncée la broche du bras 
avec votre doigt, fixez l’adaptateur de 
fixation du viseur sur le bras et tournez la 
molette de verrouillage dans le sens 
horaire pour fixer en position.

Broche
Molette de 
verrouillage

Adaptateur de fixation 
du viseur

	 [Remarque]
Si le bras se relâche trop lorsque vous desserrez la 
molette de verrouillage de fixation, réglez la vis de 
verrouillage à l’aide d’une clé hexagonale (2,5 mm).
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Vis de verrouillage

5	 Alignez la marque  sur la fiche du viseur 
de l’appareil avec la marque  sur la fiche 
du câble du moniteur LCD et insérez le 
câble.
Vérifiez l’orientation pour vous assurer 
que la marque  se trouve sur le côté 
externe avant d’insérer.

6	 Placez le câble dans les porte-câbles (trois 
emplacements).

Porte-câble

Exemple de montage lorsque vous 
utilisez le moniteur LCD comme 
panneau de commande

Vous pouvez installer le moniteur LCD en 
fixant le côté de l’adaptateur de fixation du 
viseur au bras, comme indiqué ci-dessous. 
Ce montage est adapté à une utilisation du 
moniteur LCD comme panneau de commande.

Adaptateur 
de fixation du 
viseur
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Alimentation
Vous pouvez utiliser un pack batterie ou une 
alimentation CA à partir d’un adaptateur CA.
Pour des raisons de sécurité, utilisez 
uniquement les packs de batteries et les 
adaptateurs CA Sony listés ci-dessous.

Pack batterie au lithium-ion
BP-GL95B

Adaptateur CA
AC-DN10A

Utilisation d’un pack batterie

Insérez le pack de batteries dans la monture 
du pack de batteries (page 7) sur 
l’adaptateur de batterie, puis faites glisser le 
pack de batteries vers le bas pour le bloquer 
en position.
Pour le retirer, maintenez enfoncé le levier de 
déverrouillage de la batterie (page 7) afin 
de déverrouiller le pack de batteries et faites 
glisser le pack de batteries vers le haut.

[Remarques]
•• Avant toute utilisation, chargez le pack de batteries à 

l’aide du chargeur de batterie.
•• Juste après utilisation, le pack de batteries est chaud 

et ne pourra pas être rechargé complètement.
•• Retirez l’adaptateur de batterie tout en soutenant 

l’appareil avec la main.

Vérification de la capacité restante

Lorsque l’enregistrement ou la lecture à l’aide 
du pack de batteries est en cours, la durée 
restante d’utilisation de batterie et la tension 
de batterie s’affichent sur l’écran du moniteur 
LCD.
L’appareil indique le temps d’utilisation 
restant en minutes en calculant l’autonomie 
du pack de batteries si l’appareil continue 
de fonctionner avec son niveau de 
consommation électrique actuel.

Si la capacité restante de la batterie 
devient insuffisante

Si la capacité restante de la batterie passe 
en dessous d’un certain niveau pendant le 
fonctionnement, l’indicateur de capacité 
restante de la batterie clignote et le témoin 
REC clignote pour vous prévenir.
Si la capacité restante continue de diminuer 
jusqu’à un niveau empêchant toute poursuite 
du fonctionnement, un message de batterie 
vide s’affiche.
Remplacez-le par un pack de batteries 
totalement chargé.

Modification des niveaux 
d’avertissement

Modifiez les niveaux à l’aide de Technical 
>Camera Battery Alarm (page 60) dans le 
menu complet.

Utilisation de l’alimentation CA 
(Alimentation DC IN) 

L’appareil fonctionne sur l’alimentation CA à 
l’aide d’un adaptateur CA 100W.
Prend en charge une plage de tension 
d’entrée de 11 V à 17 V.
Une alarme apparaît si la tension d’entrée 
chute sous les niveaux définis. Vous pouvez 
changer les niveaux à l’aide de Technical 
>Camera DC IN Alarm (page 60) dans le 
menu complet.

[Remarque]
Lors du passage à l’alimentation DC IN pendant le 
fonctionnement de la batterie, utilisez une alimentation 
dont la tension se trouve dans une plage de 12 V à 17 V 
pour une commutation de l’alimentation plus sûre.

Utilisation conjointe d’un pack de 
batteries et d’une alimentation DC 
IN

À chaque fois qu’une alimentation active est 
utilisée à l’aide d’un pack de batteries et d’une 
alimentation DC IN, l’alimentation DC IN prend 
le dessus.

[Remarque]
Lorsque l’alimentation bascule entre le fonctionnement 
de la batterie et l’alimentation DC IN, le fonctionnement 
de l’appareil peut s’arrêter si ce qui suit se produit.
•• Broutage des contacts du connecteur lors de 

l’insertion du connecteur DC
•• Chute de tension lors du basculement entre 

alimentations (plus fréquente lorsque la 
consommation électrique est élevée)
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Réglage de l’horloge
Lorsque vous utilisez l’appareil pour la 
première fois, l’écran de configuration initiale 
apparaît sur le moniteur LCD lors de la mise 
sous tension.
Réglez la date et l’heure de l’horloge interne 
en utilisant cet écran.

Time Zone

La valeur indique le décalage horaire par 
rapport à UTC (temps universel coordonné). 
Changez le réglage si nécessaire.

[Remarque]
Lorsque Time Zone est modifié, le réglage de l’horloge 
change en fonction de la différence horaire.

Réglage de la date et de l’heure

Tournez la molette multifonction (page 4) 
pour sélectionner des éléments et des 
valeurs, puis appuyez sur la molette pour 
appliquer la sélection. Si vous appuyez sur la 
molette quand le curseur se trouve sur « Set », 
l’affichage du réglage disparaît et le réglage 
de l’horloge est terminé.
Une fois que l’affichage de configuration 
initiale disparaît, vous pouvez changer Time 
Zone et les réglages de la date et de l’heure à 
l’aide de Maintenance >Clock Set (page 65) 
dans le menu complet.

[Remarques]
•• Si le réglage de l’heure disparaît à la suite de 

l’épuisement de la batterie de secours et qu’aucune 
alimentation n’est fournie à l’appareil (absence de 
pack de batteries et d’alimentation via le connecteur 
DC IN), l’affichage de la configuration initiale 
s’affichera lors de la prochaine mise sous tension de 
l’appareil.

•• Lorsque l’affichage de la configuration initiale est 
affiché, aucune autre opération n’est autorisée, à 
l’exception de la mise hors tension de l’appareil, 
jusqu’à ce que vous ayez terminé le réglage sur 
l’écran.

[Conseil]
Vous pouvez aussi utiliser le sélecteur multiple.
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Pour plus de détails sur les objectifs disponibles avec 
l’appareil, contactez un représentant du service après-
vente Sony.

[Danger]
Ne laissez pas l’objectif orienté en plein soleil. 
Les rayons directs du soleil peuvent entrer 
par l’objectif, se concentrer dans l’appareil et 
provoquer un incendie.

[Remarques]
•• Mettez l’appareil hors tension avant de fixer ou de 

retirer l’objectif et l’adaptateur.
•• Un objectif est un composant de précision. Ne 

placez pas l’objectif sur une surface avec le côté 
de la monture d’objectif tourné vers le bas. Fixez le 
capuchon de la monture d’objectif fourni.

•• L’interface d’objectif PL de l’appareil est configurée 
par défaut pour des objectifs équipés d’un 
connecteur de type Cooke. Pour utiliser des objectifs 
sans connecteur de type Cooke, réglez Technical 
>Lens >PL-Mt Interface Position (page 59) sur Off 
dans le menu complet.

Fixation d’un objectif à monture 
PL

1	 Retirez le capuchon de la monture PL de 
la monture d’objectif en faisant tourner le 
levier de la monture PL dans le sens 
contraire des aiguilles d’une montre.

Levier de la 
monture PL

Capuchon de 
la monture PL

	 [Remarque]
Tournez le levier de la monture PL dans le sens 
contraire des aiguilles d’une montre jusqu’à la 
butée.

2	 Insérez l’objectif dans la monture de 
l’objectif en alignant la partie concave de 
l’objectif avec la broche de 
positionnement dans le coin supérieur 
droit de la monture de l’objectif.

3	 Fixez fermement l’objectif en faisant 
tourner le levier de la monture PL dans le 
sens des aiguilles d’une montre en 
soutenant l’objectif.

	 [Remarque]
Ne tournez pas l’objectif lorsque vous fixez un 
objectif à monture PL. Si vous tournez l’objectif, 
vous risquez de plier les broches de contact 
électrique de l’objectif PL.

Pour fixer un objectif Cooke /i

Alignez les contacts de l’objectif avec les 
contacts électriques d’objectif PL de l’appareil. 
Il y a deux connecteurs sur l’appareil, et 
n’importe lequel peut être utilisé. Définissez 
la position du connecteur utilisé via Technical 
>Lens >PL-Mt Interface Position (page 59) 
dans le menu complet.

Pour retirer l’objectif

1	 Tournez le levier de la monture PL dans le 
sens contraire des aiguilles d’une montre 
en soutenant le dessous de l’objectif.

2	 Tirez l’objectif vers l’avant.

	 [Remarque]
Si vous ne fixez pas rapidement un autre objectif, 
alignez avec soin la partie concave du capuchon 
de la monture PL, puis fixez fermement le 
capuchon de la monture PL en tournant le levier 
de la monture PL dans le sens des aiguilles d’une 
montre.

Réglage de la longueur focale de 
collerette

L’appareil est expédié avec la longueur focale 
de collerette déjà réglée. Si vous avez besoin 
de régler la longueur focale de collerette, 
retirez la monture PL et remplacez les cales 
par d’autres de l’épaisseur appropriée. Vous 
pouvez régler l’épaisseur de ±0,1 mm, par 
incréments de 0,01 mm.

Cales
Les cales suivantes sont fournies avec 
l’appareil.
0,05 mm × 1 (circulaire)
0,01 mm × 15 (tiers de cercle)
Les cales en tiers de cercle doivent toujours 
être utilisées par trois. Insérez les cales pour 
augmenter la longueur focale de collerette. 
L’appareil est expédié avec la longueur focale 
de collerette déjà réglée à l’aide des trois 
types de cales suivants.
0,10 mm (circulaire)
0,05 mm (circulaire)
0,01 mm (tiers de cercle)
Un sceau indiquant l’épaisseur de la cale est 
fixé lors de l’expédition.

[Remarque]
Lors de la vérification de la longueur focale de collerette, 
attendez au moins 10 minutes après la mise sous 
tension de l’appareil avant de procéder au réglage, afin 
d’obtenir une meilleure précision.
En outre, toute erreur pendant le fonctionnement peut 
être minimisée en vérifiant et en réglant la température 
ambiante qui est la plus proche des conditions réelles 
de prise de vue.

Réglage de la longueur focale de 
collerette

1	 Retirez les six vis Torx et retirez la 
collerette de la monture PL.

1

Collerette de la 
monture PL

2	 Desserrez les quatre vis cruciformes des 
deux côtés des connecteurs PL (deux 
emplacements) et retirez les connecteurs 
PL et les plaques de connecteur PL.

Montage d’un objectif et réglage de la longueur focale de collerette
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3	 Fixez les cales à l’adaptateur de la 
monture PL (trois emplacements).

33

33
33

22
22

Connecteurs PL

Plaques de 
connecteur PL

Lors de l’utilisation de cales en tiers de 
cercle
Fixez des cales de façon à ce qu’ils aient la 
même épaisseur aux trois emplacements.

Cales

Lors de l’utilisation de cales circulaires
Fixez-les à la surface portant des repères 
vers l’avant.

Repères

Repères

4	 Fixez à nouveau les connecteurs PL (deux 
emplacements) à leurs positions d’origine 
et serrez les quatre vis cruciformes à un 
couple de serrage de 0,18 N·m.

5	 Fixez à nouveau la collerette de la 
monture PL à sa position d’origine et 
serrez les six vis Torx à un couple de 
serrage de 0,35 N·m en utilisant une clé 
dynamométrique T8.

Nettoyage du filtre optique

Pour nettoyer le filtre optique, commencez par 
retirer l’adaptateur. Faites attention lorsque 
vous essuyez la partie centrale de l’adaptateur 
(partie ombrée) avec un tissu ou une autre 
matière, pour éviter que des fibres adhèrent à 
la surface. Si des fibres adhèrent, essuyez-les 
avec une brosse douce.

Adaptateur

Retrait de l’adaptateur de la 
monture PL

Retirez l’adaptateur de la monture PL lorsque 
vous souhaitez monter un objectif à monture 
E sur l’appareil. La fixation/le retrait s’effectue 
avec le côté arrière de l’appareil orienté vers 
le bas.
Desserrez les six vis hexagonales (2,5 mm) et 
retirez l’adaptateur de la monture PL.

Adaptateur 
de la 
monture PL

[Remarque]
Lorsque vous fixez/retirez l’adaptateur, veillez à ne pas 
toucher les contacts du connecteur de l’appareil et de 
l’adaptateur de la monture PL.

[Conseil]
Retirer la batterie et placer le côté arrière de l’appareil 
vers le bas permet d’améliorer la stabilité.
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Pour fixer l’adaptateur de la monture PL

1	 Vérifiez que le levier de la monture E est 
en position verrouillée.

Levier de la 
monture E

2	 Placez l’adaptateur de la monture PL dans 
sa position d’origine, insérez les six vis 
hexagonales (2,5 mm) et serrez les vis à 
un couple de serrage de 0,8 ± 0,12 N·m à 
l’aide d’une clé hexagonale (2,5 mm).

Fixation d’un objectif à monture E

1	 Retirez l’adaptateur de la monture PL 
(page 16).

2	 Poussez le commutateur de verrouillage 
vers le haut, puis tournez le levier de la 
monture E dans le sens des aiguilles 
d’une montre pour déverrouiller.

Levier de la 
monture E

Commutateur 
de verrouillage

3	 Alignez les repères de monture (blancs) 
de l’appareil et de la monture d’objectif, 
puis enfoncez l’objectif dans la monture.

4	 Fixez l’objectif en faisant tourner le levier 
de la monture E dans le sens contraire des 
aiguilles d’une montre pendant que vous 
soutenez l’objectif.

 

Repères de monture 
(blancs)

[Remarque]
Le contrôle peut ne pas être pris en charge avec certains 
objectifs à monture E. Utilisez un objectif recommandé.

Pour plus de détails sur les objectifs disponibles avec 
l’appareil, contactez un représentant du service après-
vente Sony.

Pour retirer l’objectif

1	 Poussez le commutateur de verrouillage 
vers le haut, puis tournez le levier de la 
monture E dans le sens des aiguilles 
d’une montre pour déverrouiller.

2	 Tirez l’objectif vers l’avant.

	 [Remarque]
Si vous ne fixez pas rapidement un autre objectif, 
alignez avec soin la partie concave du capuchon de 
la monture E, puis fixez fermement le capuchon de 
la monture E en tournant le levier de la monture E 
dans le sens contraire des aiguilles d’une montre.
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Gestion des cartes mémoire CFexpress Type B
Utilisez les cartes mémoire Sony CFexpress Type B* répertoriées dans « Supports 
d’enregistrement recommandés » dans l’appareil.
Pour plus de détails sur le fonctionnement avec des supports provenant d’autres fabricants, 
reportez-vous aux instructions d’utilisation du support ou consultez les informations du 
fabricant.
*	 Désignées sous le nom de « cartes CFexpress » dans ce document.

[Remarques]
•• Vous ne pouvez pas utiliser de cartes mémoire CFexpress Type B d’une capacité de 2 To ou plus.
•• Vous ne pouvez pas utiliser de cartes mémoire XQD.

Supports d’enregistrement recommandés

Les conditions de fonctionnement garanti varient en fonction des réglages Rec Format et 
Recording.
Oui : fonctionnement pris en charge
Non : le fonctionnement normal n’est pas garanti

Format d’enregistrement CFexpress Type B (exFAT)

Non-VPG VPG200 VPG400

XAVC H Intra HQ 8192×4320 Non Non Oui

7680×4320 Non Non Oui

XAVC H Intra SQ 8192×4320 Non Non Oui

7680×4320 Non Non Oui

XAVC H Long 7680×4320 Non Oui Oui

XAVC Intra 4096×2160 Non Non Oui

3840×2160 Non Oui Oui

1920×1080 Non Oui Oui

XAVC Long 3840×2160 Non Oui Oui

1920×1080 Non Oui Oui

X-OCN (LT) 8.6K 17:9 Non Non Oui

8.6K 16:9 Non Non Oui

6K 17:9 Non Non Oui

6K 16:9 Non Non Oui

5.8K 17:9 Non Non Oui

5.8K 16:9 Non Non Oui

X-OCN (LT) 4K 17:9 Non Non Oui

Insertion d’une carte mémoire

1	 Ouvrez le cache du support de la section 
de logements pour carte.

2	 Insérez une carte CFexpress avec 
l’étiquette orientée vers la gauche.

Étiquette

L’indicateur d’accès (page 4) est 
allumé en rouge, puis passe au vert si la 
carte est utilisable.

	 [Remarque]
Si l’indicateur d’accès clignote en rouge en continu 
et ne passe pas au vert, éteignez temporairement 
l’appareil, puis retirez et réinsérez la carte mémoire.

3	 Fermez le cache du support.

[Remarques]
•• La carte mémoire, le logement de carte mémoire et 

les données d’images sur la carte mémoire peuvent 
être endommagés si la carte est enfoncée de force 
dans le logement dans le mauvais sens.

•• Lorsque vous enregistrez sur des supports situés 
dans les logements A et B de carte CFexpress Type 
B, insérez dans ces deux logements des supports 
recommandés pour l’utilisation avec le format 
d’enregistrement.

Éjection d’une carte mémoire

Ouvrez le cache du support de la section de 
logements pour carte et appuyez légèrement 
sur la carte mémoire pour l’éjecter.

[Remarques]
•• Si l’appareil est arrêté ou la carte mémoire enlevée 

pendant que le système accède à la carte mémoire, 
l’intégrité des données sur la carte ne peut pas être 
garantie. Toutes les données enregistrées sur la carte 
peuvent être supprimées. De plus, le fonctionnement 
de l’appareil peut être affecté. Assurez-vous toujours 
que l’indicateur d’accès est vert ou éteint avant 
d’arrêter l’appareil ou de retirer la carte mémoire.

•• Si une carte mémoire est retirée immédiatement 
après l’enregistrement, elle peut être chaude, mais 
cela n’indique pas un problème.

Formatage (initialisation) de cartes 
mémoire

Si une carte mémoire non formatée ou 
une carte mémoire formatée selon une 
spécification différente est insérée, le message 
« Media Needs to be Formatted » s’affiche sur 
le moniteur LCD.
Formatez la carte en utilisant la procédure 
suivante.

1	 Sélectionnez Format Media (page 51) 
dans le menu TC/Media du menu 
complet.

2	 Sélectionnez Media(A) (logement A) ou 
Media(B) (logement B), puis sélectionnez 
Full Format.
Un message de confirmation apparaît.

3	 Sélectionnez Execute.
Un message s’affiche pendant le 
formatage et l’indicateur d’accès est 
allumé en rouge.
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Une fois le formatage terminé, un 
message indiquant la fin de l’opération 
s’affiche. Appuyez sur la molette 
multifonction pour ignorer le message.

[Remarques]
•• Pour maximiser les performances du support 

d’enregistrement, exécutez toujours un formatage 
complet avec l’appareil.

•• Le formatage d’une carte mémoire efface toutes les 
données, y compris les données vidéo et les fichiers 
de configuration enregistrés.

•• Des messages peuvent apparaître pendant 
l’exécution selon la durée du processus de formatage.

En cas d’échec du formatage

Les cartes mémoire non prises en charge par 
l’appareil ne peuvent pas être formatées.
Un message d’avertissement est affiché. 
Suivez les instructions pour remplacer la carte 
par une carte mémoire prise en charge.

Pour utiliser une carte formatée sur 
l’appareil dans le logement d’un autre 
dispositif

Effectuez d’abord une copie de sauvegarde 
de la carte, puis reformatez la carte dans le 
dispositif à utiliser.

Vérification de la durée 
d’enregistrement restante

Lors d’une prise de vue (enregistrement/
veille), vous pouvez surveiller la capacité 
restante de la carte mémoire dans chacun des 
logements à l’aide des indicateurs de capacité 
restante du support des logements A/B sur 
l’écran de prise de vue et l’écran d’accueil 
(page 22).

Le temps d’enregistrement restant est 
calculé à partir de la capacité restante du 
support de chaque logement et du format 
d’enregistrement actuel et est affiché en 
unités de minutes.

Synchronisation de remplacement de 
carte mémoire

•• Quand le temps d’enregistrement total 
restant sur les deux cartes mémoire 
devient inférieur à 5 minutes, le message 
« Media Near Full » s’affiche, le témoin 
d’enregistrement/de signalisation 
commence à clignoter et un signal sonore 
(émis à partir du casque) vous avertit.  
Remplacez les cartes par un support ayant 
de l’espace libre.

•• Si vous continuez d’enregistrer jusqu’à ce 
que le temps total d’enregistrement restant 
atteigne 0, le message passe à « Media Full » 
et l’enregistrement s’arrête.

[Remarque]
Un maximum de 600 plans environ peut être enregistré 
sur une carte mémoire.

Restauration de cartes mémoire

Si, pour quelque raison que ce soit, une erreur 
se produit dans une carte mémoire, celle-ci 
doit être restaurée avant l’utilisation.
Lorsque vous insérez une carte mémoire qui 
doit être restaurée, un message apparaît sur 
le moniteur LCD pour vous demander si vous 
souhaitez effectuer la restauration.

Restauration d’une carte

Tournez la molette multifonction (page 4) 
pour sélectionner Execute, puis appuyez sur la 
molette multifonction.

Un message et l’état de progression 
(%) s’affichent pendant le formatage et 
l’indicateur d’accès est allumé en rouge.
À la fin de la restauration, un message 
indiquant la fin de l’opération s’affiche.

En cas d’échec de la restauration

•• Les cartes mémoire sur lesquelles des 
erreurs de mémoire se sont produites ne 
peuvent pas être restaurées. Un message 
d’avertissement est affiché. Suivez les 
instructions pour remplacer la carte 
mémoire.

•• Les cartes mémoire sur lesquelles des 
erreurs de mémoire se sont produites 
peuvent être utilisables si vous les 
reformatez.

•• Dans certains cas, certains plans peuvent 
être restaurés et d’autres non. Les plans 
restaurés peuvent être lus normalement.

[Remarques]
•• Veillez à utiliser cet appareil pour restaurer un support 

enregistré sur celui-ci.
•• Un support enregistré sur un autre appareil ou sur 

un appareil d’une autre version (même s’il s’agit du 
même modèle) risque de ne pas pouvoir être restauré 
à l’aide du présent appareil.

•• Les plans de moins de 2 secondes ne peuvent pas 
être restaurés.

•• Il se peut que le support restauré ne fonctionne pas 
avec ses performances d’origine. Sauvegardez tous 
les plans requis, puis exécutez un formatage complet 
avant l’utilisation.
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Gestion des cartes SD Utility
La carte SD UTILITY est utilisée pour 
l’enregistrement proxy et pour stocker et 
charger des réglages. Elle est également 
utilisée pour de futures mises à niveau (mise à 
jour logicielle).

Cartes SD prises en charge

Cartes mémoire SDXC*
Cartes mémoire SDHC*
Cartes mémoire SD*
*	 Désignées sous le nom de « Cartes SD » dans ce 

manuel.

[Remarque]
La classe de vitesse 10 est recommandée pour utiliser 
l’enregistrement proxy.

Insertion d’une carte SD

Insérez une carte SD dans le logement de 
carte SD Utility (page 4).
L’indicateur d’accès (page 4) s’allume en 
rouge, puis s’éteint lorsque la carte est prête à 
être utilisée.

Indicateur de l’état d’accès

Indicateur État du logement

S’allume en 
rouge

Accès à la carte SD (écriture/
lecture de données)

Retrait d’une carte SD

Enfoncez la carte SD légèrement, puis enlevez 
la carte.

[Remarques]
•• Si l’appareil est arrêté ou la carte mémoire enlevée 

pendant que le système accède à la carte mémoire, 
l’intégrité des données sur la carte ne peut pas être 
garantie. Toutes les données enregistrées sur la carte 
peuvent être supprimées. Assurez-vous toujours que 
l’indicateur d’accès est éteint avant d’arrêter l’appareil 
ou de retirer la carte mémoire.

•• Assurez-vous que la carte mémoire ne s’éjecte pas 
quand vous l’insérez ou la retirez.

Formatage (initialisation) d’une 
carte SD

Les cartes SD doivent être formatées lors de 
leur première utilisation dans l’appareil.
Les cartes SD devant être utilisées dans 
l’appareil doivent être formatées à l’aide de 
la fonction de formatage de l’appareil. Vous 
devez aussi formater une carte SD si un 
message d’avertissement s’affiche au moment 
de son insertion.
Si une carte SD qui a été formatée dans 
un format non pris en charge est insérée 
dans l’appareil, un message de disparité du 
système de fichier s’affiche.

1	 Sélectionnez Format Media (page 51) 
dans le menu TC/Media du menu 
complet.

2	 Sélectionnez Utility SD, puis sélectionnez 
la méthode de formatage (formatage 
complet ou formatage rapide).
Un message de confirmation apparaît.

•• Full Format : initialise complètement le 
support, y compris la zone des données 
et les informations de gestion des 
données.

•• Quick Format : initialise uniquement les 
informations de gestion des données 
du support.

3	 Sélectionnez Execute.
Un message s’affiche pendant le 
formatage et l’indicateur d’accès est 
allumé en rouge.
Une fois le formatage terminé, un 
message indiquant la fin de l’opération 
s’affiche. Appuyez sur la molette 
multifonction pour ignorer le message.

[Remarque]
Lors du formatage d’une carte SD, toutes les données 
sont effacées et ne peuvent plus être restaurées.

Différence entre le formatage rapide et 
le formatage complet

Effectuez un formatage complet lorsque 
vous estimez que la carte exécute moins 
rapidement l’enregistrement/la lecture ou 
lorsque vous souhaitez effacer toutes les 
données. Le formatage complet dure plus 
longtemps que le formatage rapide, car il 
initialise tous les secteurs de la carte mémoire.

Pour utiliser un support formaté avec cet 
appareil dans les logements d’autres 
périphériques

Effectuez une sauvegarde du support, puis 
formatez-le à l’aide de l’autre périphérique.
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Structure de l’écran du moniteur LCD
L’écran du moniteur LCD fonctionne dans deux modes articulés autour de l’écran d’accueil : le mode de surveillance vidéo où vous pouvez vérifier les réglages tout en suivant la vidéo, et le mode 
d’affichage d’informations vous permettant de vérifier et de modifier des informations et des réglages. Vous pouvez commuter entre ces modes à l’aide de la touche HOME. Vous pouvez afficher 
l’écran d’état, l’écran de menu complet, l’écran de lecture et l’écran des plans dans chaque mode.
Vous pouvez passer d’un écran à l’autre sur le moniteur LCD via la touche HOME, la touche MENU et la touche CLIPS.

Mode de surveillance vidéo

Écran d’état

Écran de lecture Sélectionnez  
le plan 

(lecture)

Sélectionnez  
le plan 

(lecture)

Touche 
CLIPS

Touche 
CLIPS

Écran d’état

Écran de contrôle  
de la lecture

Écran de menu complet

Écran des plans

Touche HOME

Écran de prise de 
vue

Écran d’accueil

Touche HOME

Touche MENU Touche HOME Touche MENU

Touche CLIPS Touche HOME Touche CLIPS

Touche 
MENU

Touche 
MENU

Touche HOME

Écran de menu complet

Écran des plans

Mode d’affichage d’informations

[Conseils]
•• En mode de surveillance vidéo, vous pouvez envoyer le même écran d’affichage que celui du moniteur LCD vers un moniteur externe.
•• Le mode d’affichage d’informations est conçu pour une utilisation du moniteur LCD en combinaison avec un moniteur externe connecté pour la sortie HDMI. Vous devez placer le moniteur externe du côté des commutateurs de l’opérateur 

de l’appareil pour suivre la vidéo et vous pouvez placer le moniteur LCD du côté des commutateurs de l’opérateur ou du côté des connecteurs pour configurer les réglages, selon la composition de l’équipe de prise de vue. L’affichage de 
l’écran ne peut pas être superposé à la sortie SDI, sauf si le codec est réglé sur X-OCN.
–– Vous pouvez utiliser les fonctions affichées sur le moniteur LCD à l’aide du sélecteur multiple du moniteur LCD ou de la molette multifonction du côté des commutateurs de l’opérateur.
–– Vous pouvez utiliser les fonctions affichées sur le moniteur externe à l’aide du sélecteur multiple du côté des commutateurs de l’opérateur. Vous pouvez sélectionner un cadre de reconnaissance du sujet, déplacer la zone de mise au 

point et déplacer la position de la loupe de mise au point.
•• Pour X-OCN, l’image de l’index n’est pas affichée sur l’écran des plans.
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Écran de prise de vue/Écran de lecture
En mode de surveillance vidéo, l’état de l’appareil et les réglages s’affichent autour de l’image 
sur le moniteur LCD pendant la prise de vue (enregistrement/veille) et la lecture.
En mode d’affichage d’informations, l’état de l’appareil et certains réglages peuvent s’afficher 
en superposition lors de la prise de vue et de la lecture sur l’image d’un moniteur HDMI externe. 
Réglez d’abord la colonne Info Disp de la rangée HDMI de l’écran d’état Monitoring (page 28) 
sur On.
Vous pouvez afficher/masquer ces informations en utilisant la touche DISPLAY. Même masquées, 
elles s’affichent en superposition lorsque vous effectuez des opérations de menu direct 
(page 101).
Vous pouvez également choisir d’afficher/masquer chaque élément de manière indépendante 
(page 52).
Les éléments accompagnés d’un astérisque peuvent s’afficher sur un moniteur HDMI externe en 
mode d’affichage d’informations.

Informations affichées sur l’écran pendant la prise de vue

11

54

16
10

76

98

1

32

2

31

30

29
222328 27 26 2425

1415
13

12
18
19

333

17

20
21

1.	 Indicateur de mode de mise au point* 
(page 93)

Signification Affichage

Mode Focus Hold Focus Hold

Mode MF MF

Mode AF AF

Mode AF de suivi en temps 
réel

AF de reconnaissance du sujet (AF/ /Only/ )

Signification Affichage

Icône de détection des 
humains

Icône Human only AF Only

Icône de pause AF1)

1)	 S’affiche pendant l’opération AF lorsque l’opération 
AF ne peut pas continuer et s’arrête temporairement. 
L’icône disparaît lorsque la cause de l’arrêt de 
l’opération AF est résolue et que l’opération AF 
reprend.

2.	 Indicateur de position de mise au point*
Affiche la position de mise au point 
(uniquement lorsqu’un objectif compatible 
avec la fonction d’affichage du réglage de 
mise au point est fixé).

3.	 Indicateur d’état du réseau* (page 24)
Affiche l’état de connexion au réseau sous 
forme d’icône.

4.	 Indicateur de téléchargement/indicateur 
de fichiers restants* (page 78)

5.	 Indicateur du mode d’enregistrement et 
d’état de logements A/B, indicateur 
d’intervalle d’enregistrement Interval 
Rec* (page 102)

Affichage Signification

Rec Enregistrement

Stby Veille d’enregistrement

6.	 Indicateur du statut Rec Control de sortie 
SDI/sortie HDMI* (page 107)

Affiche le statut de sortie du signal de contrôle 
REC.

7.	 Indicateur de capacité restante de la 
batterie/de tension DC IN* (page 13)

8.	 Indicateur de profondeur de champ*

9.	 Affichage des noms d’apparence 
(page 87)

10.	 Indicateur d’état de la série UWP-D 
(page 24)

Affiche l’intensité du signal de niveau RF 
sous forme d’icône lorsqu’un appareil de 
série UWP-D est connecté à la griffe MI d’une 
poignée (en option) équipée d’une griffe MI 
configurée pour le transfert audio numérique.

11.	 Indicateur de zone de mise au point* 
(page 90)

Affiche la zone de mise au point pour la mise 
au point automatique.

12.	 Indicateur d’aide pour l’affichage gamma
En mode Custom (page 81), il affiche 
l’état d’aide pour l’affichage gamma. Vous 
pouvez activer/désactiver la fonction d’aide 
pour l’affichage gamma en affectant Gamma 
Display Assist à une touche personnalisable 
(page 101).

13.	 Moniteur de signal vidéo* (page 104)
Affiche une forme d’onde, un vecteurscope et 
un histogramme.
La ligne orange indique la valeur définie du 
niveau zébré.
En mode Cine EI (page 81), la gamme de 
couleurs du système SDI, du moniteur cible, 
s’affiche en haut de l’écran.
Lorsque LUT On est sélectionné, « Look » 
s’affiche quel que soit le type de LUT appliqué.
Lorsque LUT Off est sélectionné, la valeur de 
Color Gamut s’affiche.

14.	 Indicateur d’avertissement du niveau de 
vidéo

15.	 Affichage du nom de plan (page 51)
Affiche le nom du plan en cours 
d’enregistrement ou à enregistrer ensuite.
Le nom de plan clignote dans les cas suivants.
•• Lorsque vous insérez un nouveau support 

d’enregistrement
•• Lorsque le dernier plan du support 

d’enregistrement ne correspond pas au 
réglage Clip Name Format (page 51) 
>Camera ID ou Reel Number du menu TC/
Media du menu complet.

16.	 Indicateur du mode de numérisation par 
imageur (page 81)

17.	 Indicateur de fréquence d’images de 
prise de vue en ralenti et accéléré 
(page 102)

18.	 Indicateur du format d’enregistrement 
(fréquence d’images)/format 
d’enregistrement (codec) (page 43)

Affiche le nom du format pour 
l’enregistrement sur des cartes mémoire.
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19.	 Indicateur d’apparence pour 
l’enregistrement (page 87)

20.	 Indicateur de niveau à bulle*
Affiche le niveau horizontal en incréments de 
±1° jusqu’à ±15°.

21.	 Vumètre audio*
Affiche le niveau audio de CH1 à CH4.

22.	 Indicateur de mode de balance des 
blancs (page 97)

Affichage Signification

Mode automatique

 Hold Mode automatique en 
pause

W:A Mode de mémoire A

W:B Mode de mémoire B

W:C Mode de mémoire C

23.	 Indicateur d’obturateur (page 96)

Affichage Signification

Mode automatique

24.	 Indicateur Base ISO/Base Sensitivity 
(page 95)

En mode Cine EI (page 81), cela affiche la 
sensibilité de Base ISO réglée à l’aide de Base 
ISO/Sensitivity sur l’écran Main Status ou de 
ISO/Gain/EI >Base ISO dans le menu Shooting 
du menu complet.
En mode Custom (page 81), cela affiche 
la sensibilité de base réglée à l’aide de Base 
ISO/Sensitivity sur l’écran Main Status ou de 
ISO/Gain/EI >Base Sensitivity dans le menu 
Shooting du menu complet.

25.	 Indicateur de verrouillage externe du 
code temporel/affichage des données 
temporelles* (page 83)

Affiche « EXT-LK » en cas de verrouillage sur le 
code temporel d’un dispositif externe.

26.	 Indicateur d’indice d’exposition 
(page 95)

En mode Custom (page 81), il affiche la 
sensibilité ISO ou le gain.

Affichage Signification

Mode automatique

Mode d’ajustement 
provisoire

Mode de contrôle du bokeh 
(page 104)

27.	 Indicateur de diaphragme
Affiche la valeur du diaphragme (valeur T-stop 
ou valeur F-stop) (si un objectif prenant en 
charge l’affichage du réglage du diaphragme 
est fixé).

Affichage Signification

Mode automatique

[Remarque]
La valeur F-stop s’affiche au lieu de la valeur T-stop si la 
valeur T-stop ne peut être obtenue.

28.	 Indicateur de filtre ND (page 96)
Affiche la densité du filtre ND.

Affichage Signification

Mode automatique

Mode de contrôle du bokeh 
(page 104)

29.	 Indicateur du mode AE/niveau AE 
(page 49)

30.	 Indicateur de l’état du support

Affichage Signification

Montage en cours/état de 
montage (support A)

Montage en cours/état de 
montage (support B)

Affichage Signification

Montage avec enregistrement 
proxy activé/état du montage 
(support proxy (carte SD))

(clignotement)

Enregistrement proxy activé mais 
pas prêt (support non inséré, etc.)

(clignotement)

Enregistrement proxy arrêté

L’icône  s’affiche si la carte mémoire est 
protégée en écriture.

31.	 Indicateur de mode de stabilisation 
d’image/de longueur focale de 
stabilisation d’image (page 98)

Affi-
chage

Signification Adaptateur 
de la 
monture 
PL

Stabilisation d’image ON 
(High)

Fixé

Stabilisation d’image ON 
(Low)

Stabilisation d’image OFF

Stabilisation d’image ON 
(Active)

Non fixé

Stabilisation d’image ON 
(Standard)

Stabilisation d’image OFF

Lorsque Image Stabilization >Stabilization 
Adjustment (page 42) dans le menu 
Shooting du menu complet est réglé sur 
Manual, la distance focale de stabilisation 
d’image est affichée sous l’icône du mode de 
stabilisation d’image.

32.	 Indicateur de position de zoom 
(page 88)

Affiche la longueur focale du zoom (affiché 
uniquement lorsqu’un objectif prenant en 
charge l’indicateur de réglage de zoom est 
fixé).
Vous pouvez régler l’affichage sur un 
indicateur à barre ou sur un indicateur 
numérique (page 59).
Une indication numérique 0 indique un grand 
angle et 99 indique le téléobjectif.
Les éléments suivants sont ajoutés à 
l’affichage lorsque Clear Image Zoom est 
activé.

Affichage Signification

Clear Image Zoom est activé

Valeur 
d’agrandis-
sement

Lors de l’utilisation de Clear Image 
Zoom

33.	 Touche d’arrêt AF de suivi en temps réel 
(page 94)
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Informations affichées sur l’écran pendant la lecture

Les informations suivantes sont superposées sur l’image de lecture.

43

7

65

15

1314

9
10

21

8

11
12

004/004

1.	 Numéro de plan/Nombre total de plans*

2.	 Indicateur d’état du réseau*

3.	 Indicateur de téléchargement/indicateur 
de fichiers restants*

4.	 Indicateur de l’état de lecture*

5.	 Affichage des noms d’apparence

6.	 Indicateur de capacité restante de la 
batterie/de tension DC IN*

7.	 Indicateur de taille d’image X-OCN
Affiche la résolution enregistrée et le rapport 
d’aspect d’un plan X-OCN lu.

8.	 Indicateur de fréquence d’images de 
prise de vue en ralenti et accéléré

9.	 Format de lecture
Affiche la fréquence d’images et le codec du 
plan lu. Pour XAVC, la taille de l’image est 
également affichée.

10.	 Indicateur d’apparence pour 
l’enregistrement

11.	 Aide d’affichage du gamma

12.	 Vumètre audio*
Affiche le niveau audio de lecture.

13.	 Affichage des données temporelles*

14.	 Affichage du nom de plan

15.	 Indicateur de capacité restante du 
support

L’icône  s’affiche si la carte mémoire est 
protégée en écriture.

Affichage d’icône

Affichage d’icônes de connexion au réseau

Mode réseau État de connexion Icône

Mode de point d’accès Fonctionnement en tant que point 
d’accès

Erreur de fonctionnement du point 
d’accès

Mode de station Connexion Wi-Fi
L’icône change selon l’intensité du 
signal (4 incréments)

   

Wi-Fi déconnecté (y compris pendant 
l’établissement d’une connexion)

Erreur de connexion Wi-Fi

Raccordement modem USB Raccordement modem USB connecté

Raccordement modem USB déconnecté

Erreur du raccordement modem USB

LAN filaire LAN filaire connecté

LAN filaire débranché

Erreur de LAN filaire

Affichage de l’icône de la série UWP-D

État de l’émetteur État de réception Icône

Hors tension Pas de réception

État de transmission normal Réception en cours
 –  (niveau de 

réception (4 incréments))

État silencieux Réception en cours 
(silencieux)

État d’avertissement de la capacité 
restante de la batterie

Réception en cours
 (Icône clignotante)

État d’avertissement de la capacité 
restante de la batterie et de silencieux

Réception en cours
 (Icône clignotante)
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Écran d’accueil
Appuyez sur la touche HOME pour afficher l’écran d’accueil. Vous pouvez contrôler l’état de 
l’appareil et définir ses réglages de base sur l’écran d’accueil.

Zone d’affichage 
Nom d’élément/
Valeur de 
réglage/Fonction

Zone 
d’affichage 
d’état

[Remarques]
•• Vous ne pouvez pas commuter les fonctions entre Auto/Manuel sur l’écran d’accueil. Configurez à l’aide du menu 

direct (page 101) ou du menu Shooting du menu complet.
•• En mode d’affichage d’informations, vous ne pouvez pas utiliser le menu direct (page 101). Basculez d’abord sur 

l’écran de prise de vue via la touche HOME, puis configurez.

[Conseil]
Vous pouvez configurer les éléments affichés sur l’écran d’accueil à l’aide du moniteur LCD uniquement en assignant 
ce qui suit à une touche personnalisable (page 101) sur le moniteur LCD.
•• MENU
•• IRIS (lorsque vous utilisez un objectif à monture E)

Zone d’affichage Nom d’élément/Valeur de réglage/Fonction

1 2 3

4 5 6

Touche ITEM 4 Touche ITEM 5 Touche ITEM 6

Touche ITEM 3Touche ITEM 2Touche ITEM 1

[Remarque]
Les zones étiquetées 1 à 6 correspondent aux touches 
ITEM 1 à 6. Appuyez sur une touche ITEM pour 
sélectionner l’élément correspondant.

1.	 FPS
Affiche et règle la fréquence d’images de prise 
vue.

2.	 Exposure Index/Base ISO
Affiche et règle l’indice d’exposition (EI) et 
Base ISO.

[Conseil]
En mode Custom, ceci affiche et règle ISO/Base 
Sensitivity ou Gain/Base Sensitivity.

3.	 Shutter
Affiche et règle l’obturateur électronique.

4.	 ND Filter
Affiche et règle le filtre ND.

[Remarque]
En mode VARIABLE, vous ne pouvez pas configurer le 
filtre ND sur l’écran d’accueil. Configurez à l’aide des 
touches du filtre ND et de la molette sur le côté des 
commutateurs de l’opérateur de l’appareil.

5.	 Look
Affiche et règle l’apparence.

[Conseil]
En mode Custom, ceci affiche et règle les fichiers de 
scène.

6.	 WB (White Balance)
Affiche et règle la balance des blancs.
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Zone d’affichage d’état

1 3 5

8 79

42

610
11

1.	 Affichage des données temporelles
Affiche la durée, les bits d’utilisateur ou le 
code temporel, selon le réglage de TC Display 
dans le menu TC/Media du menu complet 
(page 51).
Affiche le type de données actuellement 
affichées sur l’affichage des données 
temporelles, comme suit.

TCG : code temporel enregistré 
EXT-LK : verrouillage de synchronisation 
externe

UBG : bits d’utilisateur enregistrés
TCR : code temporel de lecture
UBR : bits d’utilisateur de lecture
Clk : horloge
Dur : durée

2.	 Indicateur du mode de numérisation par 
imageur

Affiche le réglage Imager Scan sur l’écran 
d’état Project.

3.	 Indicateur de fréquence d’images
Affiche le réglage Frequency sur l’écran d’état 
Project.

4.	 Indicateur du format d’enregistrement 
(codec)/de résolution d’image

Affiche le nom du format utilisé pour 
l’enregistrement sur une carte CFexpress et la 
résolution d’image.

5.	 Indicateur de tension d’alimentation/
capacité restante de la batterie

Affiche la tension d’alimentation ou la 
capacité restante de la batterie.

6.	 Vu-mètres audio
Affiche les niveaux d’enregistrement ou de 
lecture audio. Les numéros 1 à 4 indiquent les 
canaux 1 à 4.

7.	 Affichage du nom de plan
Affiche « Reel: Camera ID + Reel Number » et 
« Shot: Camera Position + Shot Number ».

8.	 Indicateur de capacité restante du 
support

Affiche l’état et le temps d’enregistrement 
restant (lorsque vous enregistrez avec le 
format d’enregistrement actuel) de chaque 
support d’enregistrement.

9.	 Indicateur de diaphragme
Affiche la position du diaphragme (valeur 
T-stop ou valeur F-stop).

10.	 Icône d’avertissement/d’erreur
S’affiche en cas d’avertissement ou d’erreur.
Vous pouvez vérifier le contenu des 
avertissements et des erreurs en affichant le 
menu. Si l’affichage de l’écran est superposé 
sur un moniteur externe, vous pouvez aussi 
vérifier depuis le moniteur externe.

11.	 Indicateur de l’état d’enregistrement
Affiche les états d’opération d’enregistrement 
suivants de l’appareil.

Affichage Description

   Stby Veille d’enregistrement

Rec Enregistrement

Cache Veille d’enregistrement en 
cache d’image

Opérations sur l’écran d’accueil

1	 Appuyez sur la touche HOME.
L’écran d’accueil apparaît.

2	 Sélectionnez l’élément à régler en utilisant 
les touches ITEM 1 à 6.
Le diagramme suivant montre un exemple 
avec la touche ITEM 3 enfoncé.

3	 Déplacez le curseur vers l’élément ou la 
valeur de réglage à l’aide de la touche  
(touche ITEM 1) ou de la touche  (touche 
ITEM 4).

4	 Appuyez sur la touche Set (touche ITEM 3) 
pour appliquer le réglage.

[Conseil]
Vous pouvez aussi utiliser le sélecteur multiple du 
moniteur LCD ou la molette multifonction du côté des 
commutateurs de l’opérateur de l’appareil. Tout d’abord, 
appuyez pour afficher un curseur, puis actionnez.
L’utilisation tactile est également possible.
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Éléments de l’écran d’accueil

Vous trouverez ci-dessous les réglages que vous pouvez configurer pour chaque élément. Pour 
plus de détails sur les éléments disposant des mêmes réglages dans le menu complet, consultez 
la description du menu complet (page 31).

Élément Description

FPS Définit si la fréquence d’images de prise de vue est réglée sur la fréquence 
du système ou diffère de celle-ci.
•• Fixed 

Lorsque vous sélectionnez « Fixed » sur l’écran, la fréquence d’images de 
prise de vue correspond à la fréquence du système, et « Fixed » et la 
fréquence du système s’affichent.

•• Variable 
Lorsque vous sélectionnez « Variable » sur l’écran, vous pouvez définir 
une fréquence d’images de prise de vue qui diffère de la fréquence du 
système.  
1fps à 60fps / 100fps / 120fps

[Remarque]
Les réglages disponibles varient en fonction de la fréquence du système, du codec et 
du format vidéo sélectionnés.  

[Conseil]
Ce réglage correspond à Rec Function >S&Q Motion sur l’écran d’état Project et à S&Q 
Motion dans le menu Shooting du menu complet.

Exposure Index/Base 
ISO
(En mode Cine EI)

Règle l’indice d’exposition (page 37).
Vous pouvez appuyer sur Base ISO pour régler l’ISO de base (page 37).

[Conseil]
Exposure Index correspond à ISO/Gain/EI >Exposure Index dans le menu Shooting du 
menu complet. Base ISO correspond à ISO/Gain/EI >Base ISO dans le menu Shooting 
du menu complet.

ISO/Gain / Base 
Sensitivity
(En mode Custom)

Règle le gain (page 37).
Vous pouvez appuyer sur Base Sensitivity pour régler la sensibilité de base 
(page 37).

[Conseil]
ISO/Gain correspond à ISO/Gain/EI >ISO ou Gain dans le menu Shooting du menu 
complet. Base Sensitivity correspond à ISO/Gain/EI >Base Sensitivity dans le menu 
Shooting du menu complet.

Élément Description

Shutter Règle l’obturateur électronique (page 38).
Appuyez sur Angle ou ECS pour passer au réglage de l’obturateur selon 
l’angle ou la fréquence, respectivement.

[Conseils]
•• Angle correspond à Shutter >Shutter Angle dans le menu Shooting du menu 

complet. ECS correspond à Shutter >ECS On/Off et ECS Frequency dans le menu 
Shooting du menu complet.

•• Vous pouvez définir la vitesse d’obturateur plutôt que l’angle en réglant Shutter 
>Mode sur Speed dans le menu Shooting du menu complet.

ND Filter Règle la position du filtre ND. Actif uniquement lorsque le commutateur ND 
STEP/VARIABLE est en position STEP.

Look
(En mode Cine EI)

Règle l’apparence (page 49). Appuyez sur la touche Edit Look (touche 
ITEM 4) et sélectionnez une apparence. Vous pouvez définir les systèmes 
de sortie auxquels appliquer une apparence à l’aide des touches ITEM 1, 5 
et 6. Selon l’état, certaines combinaisons ne peuvent être définies ou 
certains réglages peuvent être interdépendants.

[Conseil]
Ce réglage correspond à un réglage de l’écran d’état Monitoring, à Base Look >Select 
dans le menu Paint/Look du menu complet, et à chaque élément sous LUT On/Off 
dans le menu Shooting du menu complet.

Scene File
(En mode Custom)

Bascule sur les réglages de qualité d’image préconfigurés.
Outre les réglages de qualité d’image déjà installés, vous pouvez 
enregistrer et basculer sur vos réglages de qualité d’image favoris 
(page 49).

[Conseil]
Ce réglage correspond à Scene File >Recall dans le menu Paint/Look du menu 
complet.

WB (White Balance) Permet de régler la balance des blancs (page 40).
Trois positions de mémoire des blancs sont fournies (A/B/C). Vous pouvez 
régler la valeur de chaque position via les méthodes suivantes.
•• Réglage de valeurs distinctes de température de couleur et de teinte
•• Réglage automatique à l’aide de la balance des blancs automatique
•• Sélection de valeurs prédéfinies spécifiques

[Conseil]
Ce réglage correspond aux éléments de White dans le menu Shooting du menu 
complet.
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Écran d’état
Vous pouvez vérifier les réglages et l’état de 
l’appareil sur l’écran d’état. Les réglages des 
éléments marqués d’un astérisque (*) peuvent 
être modifiés.
L’écran d’état prend en charge les opérations 
tactiles.

Pour afficher l’écran d’état
•• Appuyez sur la touche MENU.

[Conseil]
Vous pouvez afficher/masquer chaque écran d’état à 
l’aide de Menu Page On/Off (page 59) dans le menu 
Technical.

Pour commuter l’écran d’état
•• Tournez la molette multifonction.
•• Poussez le sélecteur multiple vers le haut/

bas.
•• Balayez l’écran d’état vers le haut/le bas.

[Remarque]
Lorsque le moniteur LCD est en mode d’affichage 
d’informations, l’utilisation du sélecteur multiple situé 
sur le côté du commutateur de l’opérateur de l’appareil 
ou de la télécommande n’est pas possible.

Pour masquer l’écran d’état
•• Appuyez sur la touche MENU.

Pour modifier un réglage
Lorsque l’écran d’état est affiché, appuyez 
sur la molette multifonction ou le sélecteur 
multiple pour permettre la sélection d’un 
élément de configuration dans une page. 
Sélectionnez un numéro de page et appuyez 
pour changer de page.
Vous pouvez également sélectionner des 
éléments directement à l’aide d’une opération 
tactile.

[Remarque]
Vous pouvez désactiver les modifications à partir de 
l’écran d’état en réglant Menu Settings >User Menu Only 
(page 58) dans le menu Technical du menu complet 
sur On.

Écran d’état Project

Affiche les réglages de base liés au projet de 
prise de vue.

Elément affiché Description

Frequency/Scan* Réglages de la fréquence du 
système et de la méthode 
de balayage

Codec* Réglage de codec pour 
l’enregistrement

Rec Function* Réglage d’activation/
désactivation et réglages 
principaux de la fonction 
d’enregistrement spécial

Simul Rec* Réglage et état d’activation/
de désactivation de la 
fonction d’enregistrement 
simultané sur 2 logements

Reel Valeurs définies de Camera 
ID et Reel Number du nom 
de plan

Imager Scan* Mode de numérisation du 
capteur d’image

Video Format* Taille d’image pour 
l’enregistrement sur des 
cartes mémoire

Picture Cache 
Rec*

Activation/désactivation de 
la fonction d’enregistrement 
en cache d’image et réglage 
de la taille du cache

Shot Valeur définie de Camera 
Position et valeur de Shot 
Number d’enregistrement 
suivant/actuel du nom de 
plan

Shooting Mode* Réglages du mode de prise 
de vue

Proxy Rec* Réglage d’activation/
désactivation de la fonction 
d’enregistrement proxy

Genlock État de verrouillage de la 
synchronisation

Écran d’état Audio

Affiche le réglage d’entrée, le vumètre audio 
et le réglage du moniteur de volume pour 
chaque canal.

Elément affiché Description

CH1 Level 
Control

État d’activation/
désactivation du réglage 
automatique

Level Meter Vumètre audio

Source* Source d’entrée

Reference* Niveau de référence d’entrée

Wind 
Filter*

Réglage du filtre de 
réduction du bruit du vent 
du microphone

CH2 Level 
Control

État d’activation/
désactivation du réglage 
automatique

Level Meter Vumètre audio

Source* Source d’entrée

Reference* Niveau de référence d’entrée

Wind 
Filter*

Réglage du filtre de 
réduction du bruit du vent 
du microphone

CH3 Level 
Control*

État d’activation/
désactivation du réglage 
automatique

Level 
Meter*

Vumètre audio

Source* Source d’entrée

Reference* Niveau de référence d’entrée

Wind 
Filter*

Réglage du filtre de 
réduction du bruit du vent 
du microphone

Elément affiché Description

CH4 Level 
Control*

État d’activation/
désactivation du réglage 
automatique

Level 
Meter*

Vumètre audio

Source* Source d’entrée

Reference* Niveau de référence d’entrée

Wind 
Filter*

Réglage du filtre de 
réduction du bruit du vent 
du microphone

Audio Input 
Level*

Réglage du niveau d’entrée 
audio (volume principal)

HDMI Output CH* Réglage de canal audio de 
sortie HDMI

Volume* Réglage du volume du 
casque/haut-parleurs 
intégrés

Monitor CH* Réglage de canal de 
contrôle

Écran d’état Monitoring

Affiche les réglages de sortie SDI et HDMI.

Elément affiché Description

SDI1 Signal* Taille d’image de sortie

Info. 
Disp.*

Réglage d’activation/
désactivation de l’affichage 
de sortie

Gamut/
Gamma*

État de l’application 
Monitor LUT/valeur définie 
de la gamme de couleurs

SDI2 Signal* Taille d’image de sortie

Info. 
Disp.*

Réglage d’activation/
désactivation de l’affichage 
de sortie

Gamut/
Gamma*

État de l’application 
Monitor LUT/valeur définie 
de la gamme de couleurs
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Elément affiché Description

HDMI Signal* Taille d’image de sortie

Info. 
Disp.*

Réglage d’activation/
désactivation de l’affichage 
de sortie

Gamut/
Gamma*

État de l’application 
Monitor LUT/valeur définie 
de la gamme de couleurs

LCD/
Stream

Gamut/
Gamma*

État de l’application 
Monitor LUT/valeur définie 
de la gamme de couleurs

Base Look/LUT* Réglage Base Look/LUT

Gamma Display 
Assist*

Réglage d’activation/de 
désactivation de Gamma 
Display Assist

[Conseil]
En mode Custom, Color Gamut s’affiche au lieu de 
Gamut/Gamma.

Écran d’état Assignable Button

Affiche les fonctions attribuées à chacune des 
touches attribuables.

Elément affiché Description

1 Fonction attribuée au touche 
ASSIGN 1

2 Fonction attribuée au touche 
ASSIGN 2

3 Fonction attribuée au touche 
ASSIGN 3

4 Fonction attribuée au touche 
ASSIGN 4

5 Fonction attribuée au touche 
ASSIGN 5

6 Fonction attribuée au touche 
ASSIGN 6

7 Fonction attribuée au touche 
ASSIGN 7

8 Fonction attribuée au touche 
ASSIGN 8

9 Fonction attribuée au touche 
ASSIGN 9

10 Fonction attribuée au touche 
ASSIGN 10

11 Fonction attribuée au touche 
ASSIGN 11

Focus Hold 
Button

Fonction attribuée à la 
touche Focus Hold de 
l’objectif

Multi Function 
Dial

Fonction attribuée à la 
molette multifonction

Grip Dial Fonction attribuée à la 
molette personnalisable de 
la poignée 1)

1)	 Télécommande de poignée (option)

Écran d’état Battery

Affiche des informations à propos de la 
batterie et de la source DC IN.

Elément affiché Description

Detected Battery Type de batterie

Remaining Capacité restante (%)

Charge Count Nombre de charges

Capacity Capacité restante (Ah)

Voltage Tension de batterie (V)

Manufacture 
Date

Date de fabrication de la 
batterie

Video Light 
Remaining

Affiche la capacité restante 
de la batterie de la lampe 
vidéo.

Power Source Source d’alimentation

Supplied Voltage Tension de la source 
d’alimentation

Écran d’état Media

Affiche la capacité restante et la durée 
d’enregistrement restante du support 
d’enregistrement.

Elément affiché Description

Informations du 
support A

Affiche l’icône de support 
lorsque le support 
d’enregistrement est inséré 
dans le logement A.

Mesure de la 
capacité restante 
du support A

Affiche la capacité restante 
du support d’enregistrement 
inséré dans le logement A, 
exprimée en pourcentage 
sur un graphique en barres.

Durée 
d’enregistrement 
restante du 
support A

Affiche une estimation de la 
durée d’enregistrement 
restante sur le support 
d’enregistrement inséré 
dans le logement A, en 
minutes et sous les 
conditions d’enregistrement 
actuelles.

Elément affiché Description

Informations du 
support B

Affiche l’icône de support 
lorsque le support 
d’enregistrement est inséré 
dans le logement B.

Mesure de la 
capacité restante 
du support B

Affiche la capacité restante 
du support d’enregistrement 
inséré dans le logement B, 
exprimée en pourcentage 
sur un graphique en barres.

Durée 
d’enregistrement 
restante du 
support B

Affiche une estimation de la 
durée d’enregistrement 
restante sur le support 
d’enregistrement inséré 
dans le logement B, en 
minutes et sous les 
conditions d’enregistrement 
actuelles.

Informations de 
support de carte 
SD Utility

Affiche l’icône de support 
lorsque le support est inséré 
dans le logement de carte 
SD Utility.

Protection de 
carte SD Utility

Affiche l’icône de verrou 
lorsque le support inséré 
dans le logement de carte 
SD Utility est protégé 
(verrouillé).

Mesure de la 
capacité restante 
de la carte SD 
Utility

Affiche la capacité restante 
du support inséré dans le 
logement de carte SD Utility, 
exprimée en pourcentage 
sur un graphique en barres.

Capacité restante 
de la carte SD 
Utility

Affiche une estimation de la 
durée d’enregistrement 
proxy restante sur le support 
d’enregistrement inséré 
dans le logement de carte 
SD Utility, en minutes, ou 
affiche la capacité restante 
en Go.
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Écran d’état Network

Affiche l’état de connexion au réseau.

Elément affiché Description

Wireless LAN Réglages du réseau sans fil 
et état de connexion

Wired LAN Réglages du réseau LAN 
filaire et état de connexion

USB Tethering Réglages du réseau et état 
de connexion du 
raccordement modem USB

Écran d’état File Transfer

Affiche les informations de transfert de 
fichiers.

Elément affiché Description

Auto Upload État d’activation/
désactivation du 
téléchargement 
automatique du plan 
original

Auto Upload 
(Proxy)

État d’activation/
désactivation du 
téléchargement 
automatique du plan proxy

Total Transfer 
Progress

Progression du transfert de 
toutes les tâches

Default Upload 
Server

Nom du serveur de 
destination du 
téléchargement 
automatique du plan

Job Status 
(Remain / Total)

Nombre de tâches restantes 
et nombre total de tâches

Current File 
Transfer Progress

Progression du transfert du 
fichier actuel

Current 
Transferring File 
Name

Nom du fichier en cours de 
transfert

Server Address Adresse du serveur de 
destination de transfert de 
fichiers

Destination 
Directory

Répertoire de destination du 
serveur de destination de 
transfert de fichiers

Utilisation des écrans de réglages tactiles

Disposition de l’écran

Élément

Marque indiquant 
le réglage actuel

Touche Set 
(appliquer)

Curseur de sélection 
de réglage 
(cadre orange)

Nom d’élément

Options de sélection

Fonctionnement

1	 Touchez un élément de configuration.

Toucher

Les options de sélection pour la valeur 
apparaissent.

2	 Faites glisser ou saisissez en glissant un 
réglage pour sélectionner la valeur.

Saisir en glissant

3	 Touchez la touche de réglage ou le 
curseur de sélection de la valeur.
La valeur est appliquée, et l’affichage 
revient à l’écran précédent.

[Conseils]
•• Appuyez sur la touche BACK pour retourner à la valeur 

précédente.
•• Vous pouvez également utiliser la molette 

multifonction ou le sélecteur multiple.
•• Les opérations tactiles peuvent également être 

désactivées (page 58).
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Configuration et hiérarchie du menu complet
Maintenez la touche MENU enfoncée pour 
afficher le menu complet sur le moniteur 
LCD et spécifier divers éléments pour la prise 
de vue et la lecture. Le menu complet se 
compose des menus suivants.

Configuration du menu

Menu User
Contient des éléments de menu 
configurés par l’utilisateur depuis le menu 
Edit User.

Menu Edit User
Contient des éléments de menu pour 
éditer le menu User.

Menu Shooting
Contient des réglages liés à la prise de 
vue.

Menu Project
Contient des réglages de base du projet.

Menu Paint/Look
Contient des réglages liés à la qualité 
d’image.

Menu TC/Media
Contient des réglages liés aux codes 
temporels et au support d’enregistrement.

Menu Monitoring
Contient des réglages liés à la sortie vidéo 
et à l’affichage du viseur.

Menu Audio
Contient des réglages liés à l’audio.

Menu Clip Operations
Contient des réglages relatifs aux 
opérations sur les plans.

Menu Technical
Contient des réglages liés aux éléments 
techniques.

Menu Network
Contient des réglages liés aux réseaux.

Menu Maintenance
Contient des réglages liés aux appareils, 
par exemple l’horloge et la langue.

Hiérarchie du menu complet

User 
(réglages par 
défaut)

Focus

Auto Exposure

Noise Suppression

Image Stabilization

Rec Format

Assignable Button

Multi Function Dial

All File

User File

Base Look

Clip Name Format

Format Media

De-Squeeze

Marker

LCD Monitor Setting

Peaking

Zebra

Menu Settings

Lens

APR

Edit User Menu Add Item

Customize Reset

Shooting ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

Image Stabilization

Project Base Setting

Rec Format

Cine EI Setting

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Assignable Dial

Multi Function Dial

User File

All File

Paint/Look Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

TC/Media Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Monitoring Output Format

De-Squeeze

Output Display

Display On/Off

Marker

LCD Monitor Setting

Gamma Display Assist

Peaking

Zebra

Focus Magnifier

Audio Audio Input

Audio Output

Clip Operations Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View
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Technical Color Bars

ND Dial

Rec/Tally

LOCK Switch Settings

Touch Operation

Rec Review

Zoom

Handle Zoom

Menu Settings

Menu Page On/Off

Fan Control

Lens

Video Light Set

APR

Camera Battery Alarm

Camera DC IN Alarm

Network Network Setup

Wireless LAN

AP Mode Settings

ST Mode Settings

Wired LAN

USB Tethering

File Transfer

Network Reset

Maintenance Language

Clock Set

All Reset

Hours Meter

Version
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Opérations du menu complet
Maintenez la touche MENU enfoncée pour 
afficher le menu complet sur le moniteur LCD 
et spécifier divers réglages détaillés (le menu 
peut également être affiché sur un moniteur 
HDMI externe en mode de surveillance vidéo).

Commandes de menu

Touche MENU (page 4)
Appuyez et maintenez pour afficher le 
menu complet. Appuyez à nouveau 
lorsque le menu complet est affiché pour 
le masquer.

Sélecteur multiple (touches 8 voies D-pad et 
de mise en application) (page 4)

Appuyez sur les touches 8 voies D-pad 
pour déplacer le curseur vers le haut/le 
bas/la gauche/la droite et sélectionner 
des éléments ou des réglages de menu.
Appuyez sur la touche de mise en 
application du sélecteur multiple pour 
appliquer l’élément sélectionné.

Molette multifonction (page 4)
Tournez la molette multifonction pour 
déplacer le curseur vers le haut/bas et 
sélectionner des éléments ou des 
réglages de menu.
Appuyez sur la molette multifonction pour 
appliquer l’élément sélectionné.

Touche BACK (page 4)
Appuyez pour revenir au menu précédent. 
Les changements non confirmés sont 
annulés.

[Remarques]
•• Le menu complet ne peut pas être actionné en mode 

de loupe de mise au point (page 89).
•• Certains éléments ne peuvent pas être sélectionnés, 

selon l’état lorsque le menu a été affiché.
•• Lorsque le moniteur LCD est en mode d’affichage 

d’informations, l’utilisation du sélecteur multiple 
situé sur le côté du commutateur de l’opérateur de 
l’appareil ou de la télécommande n’est pas possible.

Réglage d’éléments de menu

Appuyez sur les touches 8 voies D-pad 
ou tournez la molette multifonction pour 
déplacer le curseur vers l’élément de menu à 
régler, puis appuyez sur la touche de mise en 
application ou la molette multifonction pour 
sélectionner l’élément.
•• La zone de sélection d’élément de menu 

affiche jusqu’à huit lignes. Si les options 
disponibles pour un élément ne peuvent 
pas être affichées en même temps, faites 
défiler l’affichage en déplaçant le curseur 
vers le haut/bas.

•• Pour les sous-éléments avec une grande 
plage de réglages (par exemple –99 à +99), 
la zone des réglages n’est pas affichée. Le 
paramètre actuel est mis en surbrillance 
pour indiquer que la valeur peut être 
changée.

•• Le fait de sélectionner Execute pour une 
fonction permet d’exécuter la fonction 
correspondante.

•• Le fait de sélectionner un élément qui 
nécessite confirmation avant exécution 
cache temporairement le menu et affiche 
un message de confirmation. Vérifiez le 
message, puis sélectionnez l’exécution ou 
l’annulation de la fonction.

Saisie d’une chaîne de caractères

Quand vous sélectionnez un élément, tel 
qu’un nom de fichier, qui exige la saisie de 
caractères, l’écran de saisie de caractères 
s’affiche.

1

2 3

1	 Appuyez sur les touches 8 voies D-pad ou 
tournez la molette multifonction pour 
sélectionner un type de caractère, puis 
appliquez le réglage.
ABC : lettres majuscules
abc : lettres minuscules
123 : caractères numériques
!#$ : caractères spéciaux

2	 Sélectionnez un caractère dans le type de 
caractère sélectionné, puis appliquez le 
réglage.
Le curseur passe au champ suivant.
Space : permet de saisir un espace au 

niveau du curseur.
/ : permet de déplacer le curseur.
BS : permet de supprimer le caractère à 

gauche du curseur (espacement 
arrière).

3	 Lorsque vous avez terminé, sélectionnez 
Done et appliquez le réglage.
La chaîne de caractères est confirmée et 
l’écran de saisie de caractères disparaît.

Verrouillage et déverrouillage du 
menu

Vous pouvez verrouiller le menu complet de 
sorte que seul le menu User s’affiche.
Dans cet état, vous ne pouvez pas modifier les 
réglages à l’aide de l’écran d’accueil ou des 
écrans d’état.

Verrouillage du menu

1	 Maintenez la molette multifonction 
enfoncée et maintenez la touche MENU.

2	 Sélectionnez Menu Settings >User Menu 
with Lock dans le menu Technical.

	 [Remarque]
Lorsque vous maintenez enfoncée uniquement 
la touche MENU pour afficher le menu complet 
normal, User Menu Only s’affiche sous Menu 
Settings dans le menu Technical. Maintenez la 
molette multifonction enfoncée et maintenez la 
touche MENU pour afficher User Menu with Lock.

3	 Réglez sur On et appuyez sur la touche de 
mise en application ou la molette 
multifonction.
L’affichage du moniteur LCD bascule sur 
l’écran de saisie du numéro de code.

4	 Saisissez un numéro arbitraire.
Saisissez un numéro à 4 chiffres compris 
entre 0000 et 9999. La valeur par défaut 
est 0000.
Saisissez un numéro et appuyez sur la 
touche de mise en application ou la 
molette multifonction pour déplacer le 
curseur sur le chiffre suivant.
Une fois tous les chiffres saisis, déplacez 
le curseur sur SET.
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5	 Appuyez sur la touche de mise en 
application ou la molette multifonction.
La saisie s’applique.
Un message de confirmation apparaît, et 
l’écran bascule sur l’affichage du menu 
User.

Déverrouillage du menu

1	 Maintenez la molette multifonction 
enfoncée et maintenez la touche MENU.

2	 Sélectionnez Menu Settings >User Menu 
with Lock dans le menu User.

	 [Remarque]
Lorsque vous maintenez enfoncée uniquement 
la touche MENU pour afficher le menu complet 
normal, User Menu Only s’affiche sous Menu 
Settings dans le menu Technical. Maintenez la 
molette multifonction enfoncée et maintenez la 
touche MENU pour afficher User Menu with Lock.

3	 Réglez sur Off et appuyez sur la touche de 
mise en application ou la molette 
multifonction.
L’affichage du moniteur LCD bascule sur 
l’écran de saisie du numéro de code.

4	 Saisissez le numéro de code utilisé pour 
verrouiller le menu.
Saisissez un numéro et appuyez sur la 
touche de mise en application ou la 
molette multifonction pour déplacer le 
curseur sur le chiffre suivant.
Une fois tous les chiffres saisis, déplacez 
le curseur sur Set.

5	 Appuyez sur la touche de mise en 
application ou la molette multifonction.
La saisie s’applique.
Si le numéro de code saisi correspond au 
numéro de code utilisé pour verrouiller le 
menu, le menu se déverrouille et s’affiche.

[Remarques]
•• Si le numéro de code saisi ne correspond pas au 

numéro de code utilisé pour verrouiller le menu, le 
menu n’est pas déverrouillé.

•• Il est recommandé de prendre note du numéro 
de code et le laisser à proximité, au cas où vous 
l’oublieriez. Si vous oubliez votre numéro de code, 
contactez votre représentant du service à la clientèle 
Sony.

•• Si le menu est verrouillé avant l’enregistrement des 
éléments du menu complet depuis le tableau suivant 
dans le menu User, ces fonctions ne pourront pas être 
affectées aux touches personnalisables.

•• Si ces fonctions ont déjà été affectées aux touches 
attribuables, le réglage affecté est forcément 
désactivé lorsque le menu est verrouillé.

Élément du menu 
complet

Sélection de la 
touche 
personnalisable

Shooting >ISO/Gain/EI 
>Base Sensitivity,  
Shooting >ISO/Gain/EI> 
Base ISO

Base ISO/Sensitivity

Shooting >Auto 
Exposure >AGC

AGC

Shooting >Auto 
Exposure >Auto ND 
Filter

Auto ND Filter

Shooting >Auto 
Exposure >Auto Iris

Auto Iris

Shooting >Iris >Bokeh 
Control

Bokeh Control

Shooting >Auto 
Exposure >Auto Shutter

Auto Shutter

Shooting >Auto 
Exposure >Level

Auto Exposure Level

Shooting >Auto 
Exposure >Mode

Backlight

Shooting >Auto 
Exposure >Mode

Spotlight

Shooting >White >Auto 
White Balance

Auto White Balance

Shooting >White >ATW ATW

Élément du menu 
complet

Sélection de la 
touche 
personnalisable

Shooting >Focus > 
AF Transition Speed,  
Shooting >Focus > 
AF Subj. Shift Sens.

AF Speed/Sens.

Shooting >Focus> 
Subject Recognition AF

Subject Recognition 
AF

Monitoring >Focus 
Magnifier >Focus Mag 
Button Target

LCD Focus Magnifier

Monitoring >Focus 
Magnifier >Focus Mag 
Button Target

Output Focus 
Magnifier

Shooting >S&Q Motion 
>Setting

S&Q Motion

Shooting >LUT On/Off 
>SDI/HDMI, Shooting 
>LUT On/Off >SDI

LUT On/Off

Shooting >LUT On/Off 
>LCD/Proxy/Stream, 
Shooting >LUT On/Off 
>LCD/HDMI/Px/
Stream

LUT On/Off

Monitoring >Display 
On/Off >Image 
Stabilization

Image Stabilization

Project >Rec Format 
>Imager Scan Mode

Crop Select

Project >Picture Cache 
Rec >Setting

Picture Cache Rec

Technical >Rec Review 
>Setting

Rec Review

Clip Operations >Set 
Clip Flag >Add OK

Clip Flag OK

Clip Operations >Set 
Clip Flag >Add NG

Clip Flag NG

Clip Operations >Set 
Clip Flag >Add KEEP

Clip Flag Keep

Technical >Color Bars 
>Setting

Color Bars

Élément du menu 
complet

Sélection de la 
touche 
personnalisable

TC/Media >TC Display 
>Display Select

DURATION/TC/U-
BIT

Monitoring >Display 
On/Off >Lens Info

Lens Info

Monitoring >Display 
On/Off >Video Signal 
Monitor

Video Signal 
Monitor

Monitoring >Marker 
>Setting

Marker

Monitoring >LCD 
Monitor Setting >Color 
Mode

LCD Monitor Mode

Monitoring >Gamma 
Display Assist >Setting

Gamma Display 
Assist

Monitoring >Peaking 
>Setting

Peaking

Monitoring >Zebra 
>Setting

Zebra

Audio >Audio Output 
>Volume

Volume

Technical >Touch 
Operation >Setting

Touch Operation

Technical >Handle 
Zoom >Setting

Handle Zoom

Network >File Transfer 
>Auto Upload (Proxy)

Auto Upload (Proxy)
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Menu User
Cette section décrit la fonction et les réglages des éléments de chaque menu (réglages par 
défaut).

User

Élément de menu Description

Focus Élément Shooting >Focus

Auto Exposure Élément Shooting >Auto Exposure

Noise Suppression Élément Shooting >Noise Suppression

Image Stabilization Élément Shooting >Image Stabilization

Rec Format Élément Project >Rec Format

Assignable Button Élément Project >Assignable Button

Multi Function Dial Élément Project >Multi Function Dial

All File Élément Project >All File

User File Élément Project >User File

Base Look Élément Paint/Look >Base Look

Clip Name Format Élément TC/Media >Clip Name Format

Format Media Élément TC/Media >Format Media

De-Squeeze Élément Monitoring >De-Squeeze

Marker Élément Monitoring >Marker

LCD Monitor Setting Élément Monitoring >LCD Monitor Setting

Peaking Élément Monitoring >Peaking

Zebra Élément Monitoring >Zebra

Menu Settings Élément Technical >Menu Settings

Lens Élément Technical >Lens

APR Élément Technical >APR

[Remarque]
Vous pouvez ajouter et supprimer des éléments de menu dans le menu User à l’aide du menu Edit User. Jusqu’à 
20 éléments peuvent être configurés.
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Menu Edit User
Le menu Edit User est affiché au niveau supérieur quand Edit User Menu est sélectionné dans le 
menu User.

Edit User

Élément de menu Réglage de sous-éléments Description

Add Item
Ajouter un élément au 
menu User

Ajoute un élément de menu au 
menu User.

Customize Reset
Réinitialiser les 
éléments dans le menu 
User

Restaure les éléments de menu 
enregistrés dans le menu User aux 
réglages par défaut.

Elément de menu 
sélectionné pendant 
l’édition

Delete Supprime l’élément de menu 
enregistré du menu User.

Move Réorganise les éléments de menu 
enregistrés du menu User.

Edit Sub Item Édite (enregistrer/supprimer) les 
sous-éléments de menu enregistrés 
dans le menu User.
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Menu Shooting
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Shooting >ISO/Gain/EI
Définit les réglages de gain.

Élément de 
menu

Réglage de sous-éléments Description

Mode ISO / dB Sélectionne le mode de réglage du gain.

ISO/Gain Règle le gain.
Activé uniquement en mode Custom.

Lorsque Mode est réglé sur ISO

Base Look >Select S-Cinetone / Standard / 
Still / ITU709

Autre

Base Sensitivity Low High Low High

ISO/Gain ISO 320 ISO 1250 ISO 800 ISO 3200

ISO 400 ISO 1600 ISO 1000 ISO 4000

ISO 500 ISO 2000 ISO 1250 ISO 5000

ISO 640 ISO 2500 ISO 1600 ISO 6400

ISO 800 ISO 3200 ISO 2000 ISO 8000

ISO 1000 ISO 4000 ISO 2500 ISO 10000

ISO 1250 ISO 5000 ISO 3200 ISO 12800

ISO 1600 ISO 6400 ISO 4000 ISO 16000

ISO 2000 ISO 8000 ISO 5000 ISO 20000

ISO 2500 ISO 10000 ISO 6400 ISO 25600

Lorsque Mode est réglé sur dB 
–3dB à 0dB à 18dB (incréments de 1 dB)

Shooting >ISO/Gain/EI
Définit les réglages de gain.

Élément de 
menu

Réglage de sous-éléments Description

Exposure 
Index

Lorsque Base ISO est réglé sur ISO 800
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E

Lorsque Base ISO est réglé sur ISO 3200
800EI / 4.0E
1000EI / 4.3E
1250EI / 4.7E
1600EI / 5.0E
2000EI / 5.3E
2500EI / 5.7E
3200EI / 6.0E
4000EI / 6.3E
5000EI / 6.7E
6400EI / 7.0E
8000EI / 7.3E
10000EI / 7.7E
12800EI / 8.0E

Règle l’indice d’exposition.
Disponible en mode Cine EI uniquement.

Shockless 
Gain

On / Off Active/désactive la fonction Shockless 
gain.

Base 
Sensitivity

High / Low Règle la sensibilité de base pour le mode 
Custom.

Base ISO ISO 3200 / ISO 800 Règle la sensibilité ISO de base pour le 
mode Cine EI.
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Shooting >ND Filter
Règle le mode d’affichage utilisé pour exprimer le niveau de transmittance de lumière du filtre 
ND.

Élément de 
menu

Réglage de sous-éléments Description

Display Mode Optical Density / Transmittance Règle le mode d’affichage utilisé pour 
exprimer le niveau de transmittance de 
lumière du filtre ND. L’affichage et le 
contrôle sont exécutés à l’aide du mode 
d’affichage sélectionné.
Optical Density : 

Affiche et contrôle la quantité de 
lumière transmise via le filtre ND du 
point de vue de la densité optique 
(notation logarithmique).

Transmittance : 
Affiche et contrôle la quantité de 
lumière transmise via le filtre ND du 
point de vue de la transmittance 
(affichage fractionné).

Shooting >Shutter
Règle le fonctionnement de l’obturateur électronique.

Élément de 
menu

Réglage de sous-éléments Description

Mode Speed / Angle Sélectionne le mode de l’obturateur 
électronique.
Sélectionne le mode pour régler la 
vitesse d’obturateur en secondes (Speed) 
ou comme angle d’obturateur (Angle).

Shutter 
Speed  
On/Off

On / Off Définit si, lorsque le mode Speed est 
sélectionné, la durée d’exposition suit la 
valeur de Shutter Speed ou est réglée 
pour l’exposition totale.

Shooting >Shutter
Règle le fonctionnement de l’obturateur électronique.

Élément de 
menu

Réglage de sous-éléments Description

Shutter 
Speed

64F à 1/8000
Les réglages disponibles varient en 
fonction de la fréquence du système du 
format d’enregistrement sélectionné.
59.94P : 

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

50P : 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

29.97P : 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

25P : 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

24P/23.98P : 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 
1/60 / 1/96 / 1/100 / 1/120 / 1/125 / 
1/250 / 1/500 / 1/1000 / 1/2000 / 
1/4000 / 1/8000

Définit la vitesse de l’obturateur lorsque 
le mode Speed est sélectionné.

Shutter Angle 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 360.0° / 300.0° / 270.0° / 240.0° / 
216.0° / 210.0° / 180.0° / 172.8° / 150.0° / 
144.0° / 120.0° / 90.0° / 86.4° / 72.0° / 
45.0° / 30.0° / 22.5° / 11.25° / 5.6°

Règle l’angle de l’obturateur lorsque le 
mode Angle est sélectionné.

ECS On/Off On / Off Permet d’activer/de désactiver la 
fonction d’atténuation de balayage 
étendue.
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Shooting >Shutter
Règle le fonctionnement de l’obturateur électronique.

Élément de 
menu

Réglage de sous-éléments Description

ECS 
Frequency

23.99 à 8000
Les réglages disponibles varient en 
fonction de la fréquence du système du 
format d’enregistrement sélectionné.
Les valeurs par défaut sont données 
ci-dessous.
59.94P : 60.00
50P : 50.00
29.97P : 30.00
23.98P : 23.99
25P : 25.02
24P : 24.02

Règle la fréquence ECS lorsque le mode 
ECS est sélectionné.

Shooting >Iris
Définit les réglages de la fonction de contrôle du bokeh.

Élément de 
menu

Réglage de sous-éléments Description

Bokeh 
Control

On / Off Active/désactive la fonction de contrôle 
du bokeh.

Shooting >Auto Exposure
Définit les réglages d’ajustement de l’exposition automatique.

Élément de 
menu

Réglage de sous-éléments Description

Level +3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 / 
+1.5 / +1.25 / +1.0 / +0.75 / +0.5 / +0.25 / 
±0 / –0.25 / –0.5 / –0.75 / –1.0 / –1.25 / 
–1.5 / –1.75 / –2.0 / –2.25 / –2.5 / –2.75 / 
–3.0

Règle le niveau de luminosité pour 
l’exposition détectée de manière 
automatique.

Mode Backlight / Standard / Spotlight Règle le mode de fonctionnement du 
réglage d’exposition automatique.
Backlight : 

Mode Backlight (mode qui atténue 
l’obscurité d’un sujet lorsque le sujet 
est rétroéclairé)

Standard : 
Mode Standard

Spotlight : 
Mode Spotlight (mode qui atténue 
les blancs écrêtés lorsque le sujet est 
éclairé par la lumière d’un spot)

Speed –99 à +99 (±0) Règle la vitesse de réglage du réglage 
d’exposition automatique.

Shooting >Auto Exposure
Définit les réglages d’ajustement de l’exposition automatique.

Élément de 
menu

Réglage de sous-éléments Description

Auto ND Filter On / Off Active/désactive la fonction d’ajustement 
automatique du niveau de transmittance 
du filtre ND.

AGC On / Off Active/désactive la fonction AGC 
(commande de gain automatique).

AGC Limit Règle le gain maximum de la fonction AGC.

Lorsque Mode est réglé sur ISO

Base Look >Select S-Cinetone / Standard / 
Still / ITU709

Autre

Base Sensitivity Low High Low High

AGC Limit ISO 400 ISO 1600 ISO 1000 ISO 4000

ISO 500 ISO 2000 ISO 1250 ISO 5000

ISO 640 ISO 2500 ISO 1600 ISO 6400

ISO 800 ISO 3200 ISO 2000 ISO 8000

ISO 1000 ISO 4000 ISO 2500 ISO 10000

ISO 1250 ISO 5000 ISO 3200 ISO 12800

ISO 1600 ISO 6400 ISO 4000 ISO 16000

ISO 2000 ISO 8000 ISO 5000 ISO 20000

ISO 2500 ISO 10000 ISO 6400 ISO 25600

Lorsque Mode est réglé sur dB 
3dB, 6dB, 9dB, 12dB, 15dB, 18dB

AGC Point F2.8 / F4 / F5.6 Règle la valeur F-stop du diaphragme là 
où démarre l’opération de commande de 
gain automatique lorsque la fonction 
AGC est réglée sur On.

Auto Shutter On / Off Active/désactive la fonction de 
commande d’obturateur automatique.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 Règle la vitesse d’obturateur la plus 
rapide de la fonction d’obturateur 
automatique.

A.SHT Point F5.6 / F8 / F11 / F16 Règle la valeur F-stop du diaphragme là 
où démarre l’opération de commande 
d’obturateur automatique.

Auto Iris On / Off Active/désactive le diaphragme 
automatique.

Clip High 
light

On / Off Active/désactive la fonction qui ignore 
les zones les plus lumineuses pour 
fournir une réponse plus plate avec une 
luminance élevée.
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Shooting >Auto Exposure
Définit les réglages d’ajustement de l’exposition automatique.

Élément de 
menu

Réglage de sous-éléments Description

Detect 
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom Règle la plage d’intégrateur de lumière 
pour l’ajustement automatique de 
l’exposition en fonction de la luminosité 
du sujet. (Non disponible en cas de 
réglage manuel de la pose)

Detect 
Window 
Indication

On / Off Active/désactive l’indication de la plage 
d’intégrateur de lumière.

Custom 
Width

40 à 999 (500) Permet de régler la largeur de la plage 
d’intégrateur de lumière.

Custom 
Height

70 à 999 (500) Permet de régler la hauteur de la plage 
d’intégrateur de lumière.

Custom H 
Position

–479 à +479 (±0) Permet de régler la position horizontale 
de la plage d’intégrateur de lumière.

Custom V 
Position

–464 à +464 (±0) Permet de régler la position verticale de 
la plage d’intégrateur de lumière.

Shooting >White
Définit les réglages de la balance des blancs.

Élément de 
menu

Réglage de sous-éléments Description

White Select A / B / C Sélectionne la position de la mémoire 
des blancs.

Auto White 
Balance

Execute / Cancel Exécute la balance des blancs 
automatique pour la position de 
mémoire des blancs sélectionnée 
(exécutez via Execute).

ATW On / Off Active/désactive la fonction ATW.

[Remarque]
Lorsque vous passez à une position de 
mémoire des blancs, la fonction ATW est réglée 
sur Off.

Color Temp 2000K à 15000K (3200K) Règle la température de couleur de 
balance des blancs à enregistrer dans la 
position de mémoire des blancs 
sélectionnée.

[Remarque]
Comme Color Temp est écrêté à 2000K et 
15000K pendant l’opération R/B Gain, il n’est 
pas possible d’afficher la valeur correcte de 
Color Temp correspondant à la valeur R/B Gain.

Shooting >White
Définit les réglages de la balance des blancs.

Élément de 
menu

Réglage de sous-éléments Description

Tint –99 à +99 (±0) Règle la valeur de teinte de la balance 
des blancs à enregistrer dans la position 
de mémoire des blancs sélectionnée.

[Remarque]
Comme Tint est écrêté à ±99 pendant 
l’opération R/B Gain, il n’est pas possible 
d’afficher la valeur correcte de Tint 
correspondant à la valeur R/B Gain.

R Gain –99.0 à +99.0 (±0.0) Règle la valeur de gain R de balance des 
blancs à enregistrer dans la position de 
mémoire des blancs sélectionnée.

B Gain –99.0 à +99.0 (±0.0) Règle la valeur de gain B de balance des 
blancs à enregistrer dans la position de 
mémoire des blancs sélectionnée.

Preset White 
Select

En mode de prise de vue Custom 
3200K ±00 
4300K ±00 
5600K ±00 
6300K ±00

En mode de prise de vue Cine EI 
3200K ±00 
4300K ±00 
5500K ±00

Règle la température de couleur de 
balance des blancs à enregistrer dans la 
position de mémoire des blancs 
sélectionnée à l’aide d’une valeur 
prédéfinie spécifiée. La valeur de teinte 
est réglée sur ±0.

Shooting >White Setting
Définit les réglages de balance des blancs.

Élément de 
menu

Réglage de sous-éléments Description

Shockless 
White

Off / 1 / 2 / 3 Règle la vitesse de réaction de balance 
des blancs en cas de commutation du 
mode de balance des blancs.
Off : commute instantanément.
1 à 3 : plus la valeur est élevée, plus la 

commutation est lente.

ATW Speed 1 / 2 / 3 / 4 / 5 Règle la vitesse de réaction en mode 
ATW.
1 : vitesse de réaction la plus rapide

Shooting >Focus
Définit les réglages de mise au point.

Élément de 
menu

Réglage de sous-éléments Description

AF Transition 
Speed

1(Slow) / 2 / 3 / 4 / 5 / 6 / 7(Fast) Permet de régler la vitesse 
d’entraînement de la mise au point pour 
le changement de sujet lors de la mise 
au point automatique.
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Shooting >Focus
Définit les réglages de mise au point.

Élément de 
menu

Réglage de sous-éléments Description

AF Subj. Shift 
Sens.

1(Locked On) / 2 / 3 / 4 / 5(Responsive) Permet de régler la sensibilité de la mise 
au point en cas de changement de sujet 
pendant la mise au point automatique.

Focus Area Wide / Zone / Flexible Spot Règle la zone cible pour la mise au point 
automatique et la mise au point 
automatique par pression (AF) 
(page 90).
Wide : 

Recherche un sujet dans un grand 
angle de l’image lors de la mise au 
point.

Zone : 
Recherche automatiquement un 
point de mise au point dans la zone 
spécifiée.

Flexible Spot : 
Effectue la mise au point sur une 
position spécifique dans l’image.

Subject 
Recognition 
AF

Human Only AF / Human Priority AF / Off Règle l’opération de la fonction d’AF de 
reconnaissance du sujet.
Human Only AF : 

La caméra détecte les sujets 
(personnes) et effectue la mise au 
point sur leurs yeux, leur visage et 
leur corps. Si une personne n’est pas 
détectée, la mise au point manuelle 
est activée.

Human Priority AF : 
La caméra détecte les sujets 
(personnes) et effectue la mise au 
point sur leurs yeux, leur visage et 
leur corps. Si une personne n’est pas 
détectée, la mise au point 
automatique est activée.

Touch 
Function in 
MF

Tracking AF / Spot Focus Règle l’action qui se produit lorsque vous 
appuyez sur le panneau tactile pendant 
la mise au point manuelle.

AF Assist On / Off Quand ce réglage est réglé sur On, il est 
possible de changer temporairement la 
mise au point automatique et d’effectuer 
la mise au point manuellement.

Shooting >S&Q Motion
Définit les réglages du mode Slow & Quick Motion (page 102).

Élément de 
menu

Réglage de sous-éléments Description

Setting On / Off Active/désactive le mode 
d’enregistrement ralenti et accéléré.
Lorsqu’il est sur On, les fonctions 
suivantes sont désactivées.
•• Diaphragme automatique
•• Mise au point automatique

Frame Rate 1fps à 60fps / 100fps / 120fps Règle la fréquence d’images pour la prise 
de vue au ralenti et accéléré.

[Remarque]
Les réglages disponibles varient en fonction 
de la fréquence du système, du codec et du 
format vidéo sélectionnés.

Shooting >LUT On/Off
Définit les réglages LUT.

Élément de 
menu

Réglage de sous-éléments Description

SDI/HDMI LUT On / LUT Off Sélectionne l’application ou non de LUT 
du moniteur aux sorties vidéo SDI et 
HDMI.

[Remarque]
Configurable lorsque Rec Format >Codec 
(page 43) est réglé sur le format X-OCN dans 
le menu Project.

SDI LUT On / LUT Off Sélectionne s’il faut appliquer ou non le 
LUT du moniteur à la sortie vidéo SDI.

[Remarque]
Configurable lorsque Rec Format >Codec 
(page 43) n’est pas réglé sur le format 
X-OCN dans le menu Project.

LCD/
Proxy/Stream

LUT On / LUT Off Sélectionne s’il faut appliquer ou non le 
LUT du moniteur aux sorties vidéo LCD, 
Proxy et Stream.

[Remarque]
Configurable lorsque Rec Format >Codec 
(page 43) est réglé sur le format X-OCN dans 
le menu Project.

LCD/
HDMI/Px/
Stream

LUT On / LUT Off Sélectionne s’il faut appliquer ou non le 
LUT du moniteur aux sorties vidéo LCD, 
HDMI, Proxy et Stream.

[Remarque]
Configurable lorsque Rec Format >Codec 
(page 43) n’est pas réglé sur le format 
X-OCN dans le menu Project.
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Shooting >Noise Suppression
Définit les réglages de suppression de bruit.

[Conseil]
Les réglages Setting(Custom) et Level(Custom) sont reflétés dans le réglage Target Display (page 66).

Élément de 
menu

Réglage de sous-éléments Description

Setting 
(Custom)

On / Off Active/désactive la fonction de 
suppression de bruit en mode Custom.

Level 
(Custom)

Low / Mid / High Permet de régler le niveau de 
suppression de bruit en mode Custom.

Setting 
(Cine EI)

On / Off Active/désactive la fonction de 
suppression de bruit en mode Cine EI.

Level 
(Cine EI)

Low / Mid / High Permet de régler le niveau de 
suppression de bruit en mode Cine EI.

Shooting >Flicker Reduce
Définit les réglages de correction de scintillement.

Élément de 
menu

Réglage de sous-éléments Description

Mode Auto / On / Off Règle le mode de correction de 
scintillement.

Frequency 50Hz / 60Hz Règle la fréquence de la source 
d’alimentation qui fournit l’éclairage qui 
cause le scintillement.

Shooting >Image Stabilization
Définit les réglages de stabilisation d’image (page 98).

Élément de 
menu

Réglage de sous-éléments Description

PL 
Stabilization

High / Low / Off Règle la fonction de stabilisation 
d’image.

[Remarque]
Configurable uniquement lorsqu’un adaptateur 
de la monture PL est fixé.

Shooting >Image Stabilization
Définit les réglages de stabilisation d’image (page 98).

Élément de 
menu

Réglage de sous-éléments Description

SteadyShot Active / Standard / Off Règle la fonction de stabilisation 
d’image.

[Remarques]
•• Configurable uniquement lorsque aucun 

adaptateur de la monture PL n’est fixé.
•• Si un objectif équipé d’un commutateur de 

stabilisation d’image est fixé et si ce dernier 
est réglé sur OFF, le réglage de l’objectif 
est prioritaire et le réglage ne peut pas être 
modifié sur l’appareil.

Stabilization 
Adjustment

Auto / Manual Règle la fonction de stabilisation d’image 
adaptée à l’objectif utilisé.
Auto : 

La stabilisation de l’image s’effectue 
automatiquement d’après les 
informations fournies par l’objectif.

Manual : 
Stabilisation d’image correspondant 
à la longueur focale définie par Focal 
Length (8 mm à 1000 mm).

Focal Length 8mm / 9mm / 10mm / 11mm / 12mm / 
13mm / 14mm / 15mm / 16mm / 17mm / 
18mm / 19mm / 20mm / 21mm / 24mm / 
25mm / 28mm / 30mm / 32mm / 35mm / 
40mm / 45mm / 50mm / 55mm / 60mm / 
70mm / 75mm / 80mm / 85mm / 90mm / 
100mm / 105mm / 120mm / 135mm / 
150mm / 180mm / 200mm / 210mm / 
250mm / 300mm / 350mm / 400mm / 
450mm / 500mm / 600mm / 800mm / 
1000mm

Règle les informations de longueur 
focale pour la fonction de stabilisation 
d’image dans la caméra lorsque le 
réglage de la stabilisation d’image est 
réglé sur Manual.

[Remarques]
•• La stabilisation d’image ne peut pas 

s’exécuter correctement si l’objectif ne 
fournit pas la longueur focale et d’autres 
informations. Réglez Stabilization 
Adjustment sur Manual et configurez Focal 
Length pour adapter à l’objectif utilisé. La 
valeur de la longueur focale de stabilisation 
d’image configurée s’affiche sous l’icône de 
la stabilisation d’image.

•• Si un objectif de conversion est installé 
sur l’objectif SEL16F28 (en option), réglez 
Stabilization Adjustment sur Manual et 
configurez Focal Length.
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Menu Project
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Project >Base Setting
Définit les réglages de base.

Élément de 
menu

Réglage de sous-éléments Description

Shooting 
Mode

Custom / Cine EI Règle le mode de prise de vue 
(page 81).

Target 
Display

SDR(BT.709) / HDR(HLG) Règle la gamme de couleurs de 
l’enregistrement/la sortie en mode 
Custom.

Project >Rec Format
Définit les réglages du format d’enregistrement.

Élément de 
menu

Réglage de sous-éléments Description

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 Sélectionne la fréquence du système.

Imager Scan 
Mode

FF 8.6K 17:9 / FF 8.6K 16:9 / FFc 6K 17:9 / 
FFc 6K 16:9 / S35 5.8K 17:9 / S35 5.8K 16:9 /  
S35c 4K 17:9

Sélectionne la taille de l’imageur.

[Conseil]
Si vous souhaitez enregistrer en 8K, réglez la 
fréquence du système sur 29.97 ou moins.

Codec X-OCN(LT) / XAVC H-I HQ / XAVC H-I SQ / 
XAVC H-L / XAVC-I / XAVC-L

Règle le codec d’enregistrement/de 
lecture de plan.

[Conseils]
•• Si vous souhaitez enregistrer en 8K, 

sélectionnez X-OCN ou XAVC H.
•• Vous ne pouvez sélectionner X-OCN qu’en 

mode Cine EI.

Project >Rec Format
Définit les réglages du format d’enregistrement.

Élément de 
menu

Réglage de sous-éléments Description

Video Format Les réglages disponibles varient selon les 
réglages Frequency et Codec.

Règle la taille de l’image et le débit 
binaire.

[Conseil]
La taille d’image X-OCN est déterminée par le 
mode Imager Scan. XAVC H n’est compatible 
qu’avec 8K.

Frequency Codec Options de 
sélection

59.94 X-OCN(LT) –

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P

50 X-OCN(LT) –

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P
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Project >Rec Format
Définit les réglages du format d’enregistrement.

Élément de 
menu

Réglage de sous-éléments Description

Video Format 29.97 X-OCN(LT) –

XAVC H-I HQ 8192×4320P

7680×4320P

XAVC H-I SQ 8192×4320P

7680×4320P

XAVC H-L 7680×4320P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P

25 X-OCN(LT) –

XAVC H-I HQ 8192×4320P

7680×4320P

XAVC H-I SQ 8192×4320P

7680×4320P

XAVC H-L 7680×4320P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P

23.98 X-OCN(LT) –

XAVC H-I HQ 8192×4320P

7680×4320P

XAVC H-I SQ 8192×4320P

7680×4320P

XAVC H-L 7680×4320P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P

Project >Rec Format
Définit les réglages du format d’enregistrement.

Élément de 
menu

Réglage de sous-éléments Description

Video Format 24 X-OCN(LT) –

XAVC H-I HQ 8192×4320P

XAVC H-I SQ 8192×4320P

XAVC-I 4096×2160P

Project >Cine EI Setting
Définit les réglages de mode Cine EI.

Élément de 
menu

Réglage de sous-éléments Description

Color Gamut S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Permet de régler la gamme de couleurs 
en mode Cine EI.

Embed LUT 
File

On / Off Active/désactive l’enregistrement des 
métadonnées du fichier 3D LUT file 
(fichier CUBE).

Project >Simul Rec
Permet de configurer les réglages du mode d’enregistrement simultané (page 104).

Élément de 
menu

Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction 
d’enregistrement simultané et définit le 
support de destination d’enregistrement.

Project >Proxy Rec
Permet de configurer les réglages du mode d’enregistrement proxy.

Élément de 
menu

Réglage de sous-éléments Description

Setting On / Off Active/désactive le mode 
d’enregistrement proxy.

Audio 
Channel

CH1/CH2 / CH3/CH4 Sélectionne le canal audio pour 
enregistrer les données proxy.
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Project >Interval Rec
Permet de configurer les réglages du mode d’enregistrement par intervalles (page 102).

Élément de 
menu

Réglage de sous-éléments Description

Setting On / Off Active/désactive le mode 
d’enregistrement à intervalle. (Le réglage 
de ce mode sur On met tous les autres 
modes spéciaux sur Off.)

Interval Time 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 
20 / 30 / 40 / 50 (s)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20 / 
30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (h)

Règle l’intervalle entre les 
enregistrements en mode 
d’enregistrement Interval Rec (lorsque 
Interval Rec est réglé sur On).

Number of 
Frames

1frame / 2frames / 3frames / 6frames / 
9frames / 12frames
Les réglages disponibles varient en 
fonction de la fréquence d’images du 
format vidéo sélectionné.
59.94P/50P : 

2frames / 6frames / 12frames
29.97P/25P/24P/23.98P : 

1frame / 3frames / 6frames / 9frames

Règle le nombre d’images à enregistrer 
par prise en mode d’enregistrement 
Interval Rec (lorsque Interval Rec est 
réglé sur On).

Pre-Lighting Off / 2 s / 5 s / 10 s Règle le nombre de secondes après 
lesquelles la lampe vidéo s’allume avant 
le démarrage de l’enregistrement en 
mode d’enregistrement Interval Rec.

[Conseil]
Disponible uniquement lors de l’utilisation du 
HVL-LBPC (optionnel).

Project >Picture Cache Rec
Définit les réglages du mode d’enregistrement en cache d’image (page 103).

Élément de 
menu

Réglage de sous-éléments Description

Setting On / Off Active/désactive le mode 
d’enregistrement de cache d’image.

Cache Size Short / Medium / Long / Max Règle le temps pour l’accumulation 
d’images dans la mémoire de cache 
d’image (temps d’enregistrement de 
cache d’image).

Cache Rec 
Time

Affiche le temps pour l’accumulation 
d’images dans la mémoire de cache 
d’image (temps d’enregistrement de 
cache d’image).

Project >SDI/HDMI Rec Control
Définit les réglages de contrôle d’enregistrement SDI/HDMI.

Élément de 
menu

Réglage de sous-éléments Description

Setting Off / SDI/HDMI Remote I/F / Parallel Rec Permet de configurer le contrôle de 
démarrage/d’arrêt d’enregistrement d’un 
dispositif externe via le signal de sortie 
SDI/HDMI.
Off : 

Ne pas utiliser la télécommande.
SDI/HDMI Remote I/F : 

Contrôle d’arrêt/de démarrage 
d’enregistrement d’un dispositif 
externe connecté, quand aucun 
support n’est inséré dans l’appareil. 
Pas de synchronisation avec la 
précision d’images pour le support 
de l’appareil.

Parallel Rec : 
Contrôle d’arrêt/de démarrage 
d’enregistrement d’un dispositif 
externe connecté, quand un support 
est inséré dans l’appareil. 
Synchronisation avec la précision 
d’images pour le support de 
l’appareil.

[Remarques]
•• Pour le contrôle à l’aide du signal de 

sortie HDMI, réglez HDMI TC Out >Setting 
(page 51) dans le menu TC/Media du 
menu complet sur On.

•• 	Vous ne pouvez pas sélectionner Parallel Rec 
pendant l’enregistrement X-OCN.
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Project >Assignable Button
Règle les attributions de fonction des touches personnalisables.

Élément de 
menu

Réglage de sous-éléments Description

<1> à <11>, 
Focus Hold 
Button

Off / Base ISO/Sensitivity / AGC / Push 
AGC / ND Filter Position / Auto ND Filter / 
Push Auto ND / Iris / Auto Iris / Push Auto 
Iris / Bokeh Control / Auto Shutter / Auto 
Exposure Level / Backlight / Spotlight / 
Auto White Balance / ATW / ATW Hold / 
AF Speed/Sens. / Focus Setting / Subject 
Recognition AF / Push AF/Push MF / Focus 
Hold / LCD Focus Magnifier / Output Focus 
Magnifier / S&Q Motion / LUT On/Off / 
LUT On/Off / Image Stabilization / Crop 
Select / Rec / Picture Cache Rec / Rec 
Review / Clip Flag OK / Clip Flag NG / Clip 
Flag Keep / Color Bars / DURATION/
TC/U-BIT / Display / Lens Info / Video 
Signal Monitor / Marker / LCD Monitor 
Adjust / LCD Monitor Mode / Gamma 
Display Assist / Peaking / Zebra / Volume / 
Clips / Touch Operation / Handle Zoom / 
Auto Upload (Proxy) / Direct Menu / User 
Menu / Menu

Assigne des fonctions aux touches 
personnalisables.
Base ISO/Sensitivity : 

Permet de changer la sensibilité de 
base du capteur d’image.

AGC : 
Active/désactive la fonction AGC.

Push AGC : 
Active la fonction AGC pendant 
l’activation de la touche.

ND Filter Position : 
Commute entre les filtres ND.

Auto ND Filter : 
Active/désactive la fonction de filtre 
ND automatique.

Push Auto ND : 
Active la fonction de filtre ND 
automatique pendant l’activation de 
la touche.

Iris : 
Sélectionne le réglage de position du 
diaphragme. 
En mode de surveillance vidéo, 
pressez et maintenez enfoncé pour 
sélectionner les réglages auto/
manuels.

Auto Iris : 
Active/désactive la fonction de 
diaphragme automatique.

Push Auto Iris : 
Active la fonction de diaphragme 
automatique pendant l’activation de 
la touche.

Bokeh Control : 
Active/désactive le mode de contrôle 
du bokeh.

Auto Shutter : 
Active/désactive la fonction 
d’obturation automatique.

Auto Exposure Level : 
Affiche/ferme le menu direct Auto 
Exposure Level.

Backlight : 
Bascule entre les fonctions Backlight 
et Standard.

Spotlight : 
Bascule entre les fonctions Spotlight 
et Standard.

Auto White Balance : 
Exécute la balance des blancs 
automatique.

ATW : 
Active/désactive la fonction ATW.

Project >Assignable Button
Règle les attributions de fonction des touches personnalisables.

Élément de 
menu

Réglage de sous-éléments Description

<1> à <11>, 
Focus Hold 
Button

ATW Hold : 
Met la fonction ATW en pause.

AF Speed/Sens. : 
Commute le réglage de la vitesse de 
transition AF et le réglage de la 
sensibilité de changement de sujet 
AF.

Focus Setting : 
Permet de régler la zone de mise au 
point.

Subject Recognition AF : 
Commute le réglage Subject 
Recognition AF.

Push AF/Push MF : 
En mode de mise au point MF, active 
AF tant que la touche est enfoncée. 
En mode de mise au point AF, active 
MF tant que la touche est enfoncée.

Focus Hold : 
En mode de mise au point AF, la mise 
au point est fixée tant que la touche 
est enfoncée.

LCD Focus Magnifier :
Output Focus Magnifier : 

Commute le rapport de la loupe de 
mise au point pour le moniteur LCD 
ou la sortie externe.

[Conseil]
Vous pouvez sélectionner LCD Focus 
Magnifier lorsque Focus Magnifier >Focus 
Mag Button Target (page 54) dans 
le menu Monitoring du menu complet 
est réglé sur LCD Monitor. Vous pouvez 
sélectionner Output Focus Magnifier avec 
le réglage sur Output.

S&Q Motion : 
Active/désactive le mode ralenti et 
accéléré. 
Règle la fréquence d’images de prise 
de vue si elle est maintenue 
enfoncée.

LUT On/Off : 
Commute le réglage LUT On/Off 
>SDI ou SDI/HDMI dans le menu 
Shooting.
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Project >Assignable Button
Règle les attributions de fonction des touches personnalisables.

Élément de 
menu

Réglage de sous-éléments Description

<1> à <11>, 
Focus Hold 
Button

LUT On/Off< : 
Commute le réglage LUT On/Off 
>LCD/HDMI/Px/Stream ou LCD/
Proxy/Stream dans le menu Shooting.

Image Stabilization : 
Commute l’opération de la fonction 
de stabilisation d’image.

Crop Select : 
Règle le mode de numérisation par 
imageur.

Rec : 
Démarre/arrête l’enregistrement.

Picture Cache Rec : 
Active/désactive le mode 
d’enregistrement de cache d’image.

Rec Review : 
Active/désactive la fonction Rec 
Review.

Clip Flag OK : 
Exécute la fonction Add OK. 
Appuyez deux fois pour exécuter 
Delete Clip Flag.

Clip Flag NG : 
Exécute la fonction Add NG. 
Appuyez deux fois pour exécuter 
Delete Clip Flag.

Clip Flag Keep : 
Exécute la fonction Add Keep. 
Appuyez deux fois pour exécuter 
Delete Clip Flag.

Color Bars : 
Active/désactive les barres de 
couleur.

DURATION/TC/U-BIT : 
Commute entre Time Code, Users Bit 
et Duration.

Display : 
Active/désactive les indicateurs de 
l’écran.

Lens Info : 
Commute l’indicateur de profondeur 
de champ.

Video Signal Monitor : 
Commute le moniteur de signal vidéo 
(tel que le moniteur de forme 
d’onde).

Project >Assignable Button
Règle les attributions de fonction des touches personnalisables.

Élément de 
menu

Réglage de sous-éléments Description

<1> à <11>, 
Focus Hold 
Button

Marker : 
Active/désactive la fonction de 
repère.

LCD Monitor Adjust : 
Affiche les barres de niveau pour 
l’ajustement de la luminosité de 
l’écran du moniteur LCD.

LCD Monitor Mode : 
Commute le moniteur LCD entre 
couleur et noir et blanc.

Gamma Display Assist : 
Commute la fonction d’aide pour 
l’affichage gamma.

Peaking : 
Active/désactive la fonction de 
réglage du contour.

Zebra : 
Active/désactive la fonction des 
zébrures.

Volume : 
Ajuste la sortie de niveau audio du 
moniteur vers la prise casque et le 
haut-parleur intégré.

Clips : 
Affiche/ferme l’écran des plans.

Touch Operation : 
Active/désactive les opérations 
tactiles.

Handle Zoom : 
Commute l’opération de zoom de la 
poignée.

Auto Upload (Proxy) : 
Active/désactive le téléchargement 
automatique des plans proxy.

Direct Menu : 
Affiche/ferme le menu direct.

User Menu : 
Affiche/ferme le menu User.

Menu : 
Affiche/ferme le menu complet.
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Project >Assignable Dial
Règle les attributions de fonction de la molette personnalisable et règle la direction de rotation.

Élément de 
menu

Réglage de sous-éléments Description

Grip/Remote 
Dial

Off / ISO/Gain/EI / ND Filter / IRIS /  
Auto Exposure Level / Audio Input Level / 
Multi Function Dial

Assigne des fonctions à la molette 
personnalisable de la télécommande de 
poignée (en option) ou RM-30BP.
ISO/Gain/EI : 

Ajuste le gain ou EI.
ND Filter : 

Règle le filtre ND.
IRIS : 

Ajuste le diaphragme.
Auto Exposure Level : 

Ajuste le niveau d’exposition 
automatique.

Audio Input Level : 
Règle le niveau d’enregistrement 
audio.

Multi Function Dial : 
Fonctionne comme une molette 
multifonction.

Grip Dial 
Direction

Normal / Opposite Règle le sens de rotation de la molette 
personnalisable de la télécommande de 
poignée (en option) ou RM-30BP.
Normal : tourne dans le sens normal.
Opposite : tourne dans le sens opposé.

Project >Multi Function Dial
Affecte des fonctions à la molette multifonction.

Élément de 
menu

Réglage de sous-éléments Description

Default 
Function

Off / ISO/Gain/EI / IRIS / Auto Exposure 
Level / Audio Input Level 

Affecte la fonction par défaut à la 
molette multifonction.
IRIS : 

Ajuste le diaphragme.
ISO/Gain/EI : 

Ajuste le gain ou EI.
Auto Exposure Level : 

Ajuste le niveau d’exposition 
automatique.

Audio Input Level : 
Règle le niveau d’enregistrement 
audio.

Project >User File
Définit les réglages relatifs aux opérations sur les fichiers utilisateur.

Élément de 
menu

Réglage de sous-éléments Description

Load from 
UTILITY SD

Execute / Cancel Charge les réglages de fichiers utilisateur 
depuis une carte SD.
Execute : fonction Execute.

Save to 
UTILITY SD

Execute / Cancel Enregistre les réglages de fichiers 
utilisateur sur une carte SD.
Execute : fonction Execute.

File ID Affiche un écran pour l’affichage/l’édition 
de l’identifiant de fichier des fichiers 
utilisateur.

Load 
Customize 
Data

On / Off Définit le chargement ou non des 
informations personnalisées du menu 
User lorsque Load from UTILITY SD est 
exécuté.

Load White 
Data

On / Off Définit le chargement ou non des 
informations de balance des blancs 
lorsque Load from UTILITY SD est 
exécuté.

Project >All File
Effectue les réglages relatifs aux fichiers ALL (tous les réglages).

Élément de 
menu

Réglage de sous-éléments Description

Load from 
UTILITY SD

Execute / Cancel Charge un fichier ALL depuis une carte SD.
Execute : fonction Execute.

Load from 
Cloud(Private)

Execute / Cancel Charge un fichier ALL téléchargé depuis 
le service cloud C3 Portal (privé).
Execute : fonction Execute.

Load from 
Cloud(Share)

Execute / Cancel Charge un fichier ALL téléchargé depuis 
le service cloud C3 Portal (partagé).
Execute : fonction Execute.

Save to 
UTILITY SD

Execute / Cancel Sauvegarde les réglages du fichier ALL 
sur une carte SD.
Execute : fonction Execute.

Save to 
Cloud(Private)

Execute / Cancel Sauvegarde les réglages du fichier ALL 
sur le service cloud C3 Portal (privé).
Execute : fonction Execute.

Save to 
Cloud(Share)

Execute / Cancel Sauvegarde les réglages du fichier ALL 
sur le service cloud C3 Portal (partagé).
Execute : fonction Execute.

File ID Attribue un nom au fichier.

Load Network 
Data

On / Off Définit le chargement ou non des 
informations des réglages du menu 
Network lorsque Load from UTILITY SD, 
Load from Cloud(Private) ou Load from 
Cloud(Share) est exécuté.
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Menu Paint/Look
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Paint/Look >Scene File
Définit les réglages liés aux fichiers de scène.

Élément de 
menu

Réglage de sous-éléments Description

Recall Charge un fichier de scène stocké dans la 
mémoire interne et applique les réglages 
en tant que réglages de qualité d’image 
actuels.

Store Enregistre l’état de qualité d’image actuel 
sous forme de fichier de scène dans la 
mémoire interne.

Delete Supprime un fichier de scène stocké dans 
la mémoire interne.

Preset Recall Lorsque Shooting Mode est réglé sur 
Custom et Target Display est réglé sur 
SDR(BT.709)

S-Cinetone / Standard / Still / ITU709
Lorsque Shooting Mode est réglé sur 
Custom et Target Display est réglé sur 
HDR(HLG)

HLG Live / HLG Natural

Applique les réglages de qualité d’image 
prédéfinis (non réinscriptibles) en tant 
que réglages de qualité d’image actuels.

Paint/Look >Base Look
Définit les réglages liés à l’apparence de base.

Élément de 
menu

Réglage de sous-éléments Description

Select Lorsque Shooting Mode est réglé sur 
Custom et Target Display est réglé sur 
SDR(BT.709)

S-Cinetone / Standard / Still / ITU709 / 
User1 à User16

Lorsque Shooting Mode est réglé sur 
Custom et Target Display est réglé 
HDR(HLG) :

HLG Live / HLG Natural / User1 à 
User16

Lorsque Shooting Mode est réglé sur Cine 
EI

709(800%) / S-Log3 / s709 / Warm / 
Cool / Vintage / Teal and Orange / 
ACESproxy / ACEScct / ACES 1.0 
Output-Rec.709 / User1 à User16

Permet de sélectionner une apparence 
de base.

[Remarque]
Vous pouvez sélectionner les apparences de 
base suivantes lorsque Cine EI Setting >Color 
Gamut (page 44) dans le menu Project du 
menu complet est réglé sur S-Gamut3/SLog3.
•• ACESproxy
•• ACEScct
•• ACES 1.0 Output-Rec.709

Paint/Look >Base Look
Définit les réglages liés à l’apparence de base.

Élément de 
menu

Réglage de sous-éléments Description

Delete Supprime l’apparence de base 
sélectionnée.

Delete All Supprime toutes les apparences de base.

Import from 
Utility SD

Execute / Cancel Charge un fichier d’apparence de base 
depuis une carte SD.
Execute : fonction Execute.

Import from 
Cloud(Private)

Execute / Cancel Importe un fichier d’apparence de base 
téléchargé depuis le service Cloud C3 
Portal (privé).
Execute : fonction Execute.

Import from 
Cloud(Share)

Execute / Cancel Importe un fichier d’apparence de base 
téléchargé depuis le service Cloud C3 
Portal (partagé).
Execute : fonction Execute.

Input S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Définit la gamme d’entrée de l’apparence 
de base sélectionnée.

Output BT.709 / HLG Définit la gamme de couleurs de sortie 
de l’apparence de base sélectionnée.

AE Level 
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV / 
5/3EV / 2EV

Définit la valeur de référence d’exposition 
de l’apparence de base sélectionnée.

Paint/Look >Reset Paint Settings
Réinitialise les réglages du menu Paint/Look, à l’exclusion de l’apparence de base.

Élément de 
menu

Réglage de sous-éléments Description

Reset without 
Base Look

Execute / Cancel Réinitialise les réglages du menu Paint/
Look, à l’exclusion de l’apparence de 
base.
Execute : fonction Execute.

Paint/Look >Black
Définit les réglages des noirs.

Élément de 
menu

Réglage de sous-éléments Description

Master Black –99.0 à +99.0 (±0.0) Règle le niveau de noir maître.

R Black –99.0 à +99.0 (±0.0) Règle le niveau de noir R.

B Black –99.0 à +99.0 (±0.0) Règle le niveau de noir B.
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Paint/Look >Knee
Définit les réglages de correction de courbe.

Élément de 
menu

Réglage de sous-éléments Description

Setting Lorsque Target Display est réglé sur 
SDR(BT.709)

On / Off
Lorsque Target Display est réglé sur 
HDR(HLG)

On / Off

Active/désactive la fonction de correction 
de Knee.

[Conseil]
Activé uniquement lorsque Base Look >Select 
est réglé sur Standard, ITU709, HLG Live ou HLG 
Natural.

Auto Knee Lorsque Target Display est réglé sur 
SDR(BT.709) :

On / Off
Lorsque Target Display est réglé sur 
HDR(HLG)

On / Off

Active/désactive la fonction de coude 
automatique.

[Conseil]
Activé uniquement lorsque le réglage de 
correction de courbe est réglée sur On et que 
Base Look >Select est réglé sur Standard ou 
ITU709. 

Point 75% à 109% (90%) Règle le point de courbe.

Slope –99 à +99 (±0) Règle la pente de courbe.

Paint/Look >Detail
Définit les réglages d’ajustement des détails.

Élément de 
menu

Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction de détails.

Level –7 à +7 (±0) Règle le niveau de détail.

H/V Ratio –2 à +2 (±0) Règle la balance entre le détail vertical 
(V) et le détail horizontal (H).

B/W Balance Type1 / Type2 / Type3 / Type4 / Type5 Règle la balance entre le détail des noirs 
(B) pour les zones à faible luminance et le 
détail des blancs (W) pour les zones à 
luminance élevée.

Limit 0 à 7 Règle le niveau de détail limite.

Crispening 0 à 7 Règle le niveau de netteté.

High Light 
Detail

0 à 4 Règle le niveau de détail des zones à 
luminance élevée.

Paint/Look >Matrix
Définit les réglages de correction de matrice.

Élément de 
menu

Réglage de sous-éléments Description

User Matrix On / Off Active ou désactive la fonction de 
correction de matrice utilisateur.

Paint/Look >Matrix
Définit les réglages de correction de matrice.

Élément de 
menu

Réglage de sous-éléments Description

User Matrix 
Level

–99 à +99 (±0) Ajuste la saturation de couleur de l’image 
entière.

User Matrix 
Phase

–99 à +99 (±0) Ajuste la nuance de couleur (phase) de 
l’image entière.

User Matrix 
R-G

–99 à +99 (±0) Règle une matrice utilisateur R-V définie 
par l’utilisateur.

User Matrix 
R-B

–99 à +99 (±0) Règle une matrice utilisateur R-B définie 
par l’utilisateur.

User Matrix 
G-R

–99 à +99 (±0) Règle une matrice utilisateur V-R définie 
par l’utilisateur.

User Matrix 
G-B

–99 à +99 (±0) Règle une matrice utilisateur V-B définie 
par l’utilisateur.

User Matrix 
B-R

–99 à +99 (±0) Règle une matrice utilisateur B-R définie 
par l’utilisateur.

User Matrix 
B-G

–99 à +99 (±0) Règle une matrice utilisateur B-V définie 
par l’utilisateur.

Paint/Look >Multi Matrix
Définit les réglages de correction de matrice multiple.

Élément de 
menu

Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction de correction 
de matrice multiple.

Reset Execute / Cancel Réinitialise la teinte et la saturation de 
chaque couleur d’axe aux valeurs par 
défaut.

Axis B / B+ / MG– / MG / MG+ / R / R+ / YL– / 
YL / YL+ / G– / G / G+ / CY / CY+ / B–

Sélectionne l’axe.

Hue –99 à +99 (±0) Règle la teinte de la couleur utilisée pour 
la correction de matrice multiple.

Saturation –99 à +99 (±0) Règle la saturation de la couleur utilisée 
pour la correction de matrice multiple.
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Menu TC/Media
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

TC/Media >Timecode
Définit les réglages de code temporel.

Élément de 
menu

Réglage de sous-éléments Description

Mode Preset / Regen / Clock Règle le mode de fonctionnement du 
code temporel.
Preset : 

Commence à fonctionner à partir 
d’une valeur préréglée.

Regen : 
Commence à fonctionner à partir du 
code temporel de la fin du plan 
précédent.

Clock : 
Utilise l’horloge interne comme code 
temporel.

Run Rec Run / Free Run Rec Run : fonctionne uniquement en 
cours d’enregistrement.

Free Run : fonctionne constamment, que 
l’appareil enregistre ou non.

Setting Règle le code temporel sur une valeur 
arbitraire.
SET : règle la valeur.

Reset Execute / Cancel Réinitialise le code temporel sur 
00:00:00:00.
Execute : fonction Execute.

TC Format DF / NDF Règle le format de code temporel.
DF : drop frame
NDF : non-drop frame

TC/Media >TC Display
Définit les réglages d’affichage des données temporelles.

Élément de 
menu

Réglage de sous-éléments Description

Display Select Timecode / Users Bit / Duration Commute l’affichage des données 
temporelles.

TC/Media >Users Bit
Définit les réglages liés aux bits d’utilisateur.

Élément de 
menu

Réglage de sous-éléments Description

Mode Fix / Time Règle le mode de bit d’utilisateur.
Fix : utilise une valeur fixe arbitraire dans 

les bits d’utilisateur.
Time : utilise l’heure, les minutes et les 

secondes actuelles dans les bits 
d’utilisateur.

Setting Règle les bits d’utilisateur sur une valeur 
arbitraire.

TC/Media >HDMI TC Out
Définit les réglages liés à la sortie du code temporel lors de l’utilisation de HDMI.

Élément de 
menu

Réglage de sous-éléments Description

Setting On / Off Règle s’il faut envoyer le code temporel 
vers des dispositifs à d’autres fins à l’aide 
de la sortie HDMI.

TC/Media >Clip Name Format
Configure les réglages relatifs à l’attribution d’un nom et aux dossiers.

Élément de 
menu

Réglage de sous-éléments Description

Camera ID A à Z Règle l’ID de caméra utilisé lors de la 
génération de noms de plan.

Reel Number 001 à 999 Définit la partie numérique Reel Number 
utilisé lors de la génération de noms de 
plan.

Camera 
Position

C / L / R Définit la partie du premier caractère du 
Shot Number utilisé lors de la génération 
de noms de plan.

XAVC Root 
Folder Name

XDROOT / Cam ID + Reel# Règle le nom de l’étiquette de volume et 
le nom de dossier racine du support 
d’enregistrement.

TC/Media >Update Media
Met à jour le fichier de gestion sur les cartes mémoire.

Élément de 
menu

Réglage de sous-éléments Description

Media(A) Execute / Cancel Met à jour le fichier de gestion sur la 
carte mémoire dans le logement A.
Execute : fonction Execute.

Media(B) Execute / Cancel Met à jour le fichier de gestion sur la 
carte mémoire dans le logement B.
Execute : fonction Execute.

TC/Media >Format Media
Initialise les cartes mémoire.

Élément de 
menu

Réglage de sous-éléments Description

Media(A) Full Format / Cancel Formate la carte mémoire insérée dans le 
logement A.

Media(B) Full Format / Cancel Formate la carte mémoire insérée dans la 
logement B.

Utility SD Full Format / Quick Format / Cancel Formate la carte SD.
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Menu Monitoring
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Monitoring >Output Format
Définit les réglages du format de sortie.

Élément de 
menu

Réglage de sous-éléments Description

SDI1 Pour en savoir plus sur les réglages, 
consultez « Formats de sortie et limites » 
(page 112).

Règle la résolution de sortie SDI et HDMI.

SDI2

HDMI

REF HD Sync Affiche le format de sortie du signal de 
synchronisation. (HD Sync uniquement)

Monitoring >De-Squeeze
Définit les réglages De-Squeeze.

Élément de 
menu

Réglage de sous-éléments Description

Ratio Off(1.0×) / 1.3× / 2.0× Sélectionne le rapport de décompression 
de l’image affichée pour le système de 
sortie spécifié lors de la prise de vue avec 
un objectif anamorphique.

SDI (X-OCN) On / Off Règle s’il faut décompresser ou non 
l’affichage de l’image de sortie SDI lors 
de l’enregistrement au format X-OCN.

HDMI (FHD 
Output)

On / Off Règle s’il faut décompresser ou non 
l’affichage de l’image de sortie HDMI 
pour la taille d’image de sortie FHD.

Moniteur LCD On / Off Règle s’il faut décompresser ou non 
l’affichage de l’image de sortie du 
moniteur LCD.

Monitoring >Output Display
Définit les réglages de sortie d’affichage de l’écran.

Élément de 
menu

Réglage de sous-éléments Description

SDI On / Off Définit si le menu, l’état et l’affichage de 
l’écran sont intégrés dans le signal de 
sortie SDI.

HDMI On / Off Définit si le menu, l’état et l’affichage de 
l’écran sont intégrés dans le signal de 
sortie HDMI.

Monitoring >Display On/Off
Définit les réglages de l’élément d’affichage.

Élément de 
menu

Réglage de sous-éléments Description

Focus Mode On / Off Sélectionne les éléments à afficher sur le 
moniteur LCD.Focus 

Position
On / Off

Network 
Status

On / Off

File Transfer 
Status

On / Off

Rec/Play 
Status

Always On / On / Off

SDI/HDMI 
Rec Control

On / Off

Tally On / Off

Battery 
Remain

On / Off

Zoom 
Position

On / Off

Image 
Stabilization

On / Off

Media Status On / Off

Lens Info On / Off

Look Name On / Off

UWP RF Level On / Off

Focus Area 
Indicator

On / Off

Subject 
Recognition 
Frame

On / Off

Clip Name On / Off

Video Level 
Warning

On / Off

Timecode On / Off

Gamma 
Display Assist

On / Off
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Monitoring >Display On/Off
Définit les réglages de l’élément d’affichage.

Élément de 
menu

Réglage de sous-éléments Description

Video Signal 
Monitor

Off / Waveform / Vector / Histogram

Imager Scan 
Mode

On / Off

Frame Rate On / Off

Rec Format On / Off

Rec Look On / Off

Level Gauge On / Off

Audio Level 
Meter

On / Off

Auto 
Exposure 
Mode

On / Off

Auto 
Exposure 
Level

On / Off

ND Filter On / Off

Iris On / Off

ISO/Gain/EI On / Off

Base ISO/
Sensitivity

On / Off

Shutter On / Off

White 
Balance

On / Off

Clip Number On / Off

Notice 
Message

On / Off

Monitoring >Marker
Définit les réglages d’affichage de repère.

Élément de 
menu

Réglage de sous-éléments Description

Setting On / Off Active/désactive l’affichage de tous les 
repères.

Color White / Yellow / Cyan / Green / Magenta / 
Red / Blue

Sélectionne la couleur du signal de 
repère.

Monitoring >Marker
Définit les réglages d’affichage de repère.

Élément de 
menu

Réglage de sous-éléments Description

Center 
Marker

1 / 2 / 3 / 4 / Off Sélectionne le repère central.

Safety Zone On / Off Active/désactive le repère de la zone de 
sécurité.

Safety Area 80% / 90% / 92.5% / 95% Sélectionne la taille du repère de la zone 
de sécurité (en tant que pourcentage de 
la taille totale de l’écran).

Aspect 
Marker

Line / Mask / Off Sélectionne le type de repère de format.

Aspect Mask 0 à 15 (12) Règle le niveau du signal vidéo en 
dehors du repère.

Aspect Safety 
Zone

On / Off Active/désactive le repère de la zone de 
sécurité.

Aspect Safety 
Area

80% / 90% / 92.5% / 95% Sélectionne la taille du repère de la zone 
de sécurité de format (en tant que 
pourcentage de la taille totale de l’écran).

Aspect Select 1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 / 17:9 / 
1.66:1 / 1.85:1 / 2.35:1 / 2.39:1 / Custom

Règle le mode en affichant le repère de 
format.

Custom 
Aspect Ratio

Saisissez une valeur arbitraire 
(01.00:01.00)

Règle le rapport d’aspect sur une valeur 
arbitraire.

[Remarque]
Ce réglage est activé lorsque Aspect Select est 
réglé sur Custom.

Guide Frame On / Off Active/désactive l’affichage du cadre 
guide.

100% Marker On / Off Active/désactive le repère 100%.

User Box On / Off Active/désactive l’affichage du repère de 
cadre utilisateur.

User Box 
Width

3 à 479 (240) Règle la largeur du repère de cadre 
utilisateur (distance du centre aux bords 
gauche et droit).

User Box 
Height

3 à 269 (135) Règle la hauteur du repère de cadre 
utilisateur (distance du centre aux bords 
haut et bas).

User Box H 
Position

–476 à +476 (0) Définit la position horizontale du centre 
du repère de cadre utilisateur.

User Box V 
Position

–266 à +266 (0) Définit la position verticale du centre du 
repère de cadre utilisateur.
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Monitoring >LCD Monitor Setting
Définit les réglages du viseur.

Élément de 
menu

Réglage de sous-éléments Description

Brightness 1 à 15 (8) Permet d’ajuster la luminosité de l’image 
du viseur.

Color Mode Color / B&W Sélectionne le mode d’affichage du 
viseur dans le mode E-E/enregistrement.

Monitoring >Gamma Display Assist
Configure les réglages de l’aide pour l’affichage gamma.

Élément de 
menu

Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction d’aide 
d’affichage gamma en mode Custom 
lorsque Target Display est réglé sur 
HDR(HLG).

Monitoring >Peaking
Définit les réglages du contour.

Élément de 
menu

Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction de réglage 
du contour.

Peaking Level High / Mid / Low Règle le niveau de signal du contour de 
couleur.

Color B&W / Red / Yellow / Blue Sélectionne la couleur du signal de 
réglage du contour de couleur.

Monitoring >Zebra
Définit les réglages du motif de zébrures.

Élément de 
menu

Réglage de sous-éléments Description

Setting Off / Zebra1 / Zebra2 Sélectionne le type de motif de zébrures 
(Off, Zebra 1, Zebra 2).

Zebra1 Level 0% à 109% (70%) Définit le niveau d’affichage de Zebra 1.

Zebra1 
Aperture 
Level

2% à 20% (10%) Définit le niveau d’ouverture de Zebra 1.

Zebra2 Level 0% à 109% (100%) Définit le niveau d’affichage de Zebra 2.

Monitoring >Focus Magnifier
Définit les réglages de la loupe de mise au point.

Élément de 
menu

Réglage de sous-éléments Description

Focus Mag 
Button Target

LCD Monitor / Output Règle la cible de la loupe de mise au 
point pour le contrôle à l’aide d’une 
touche personnalisable.
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Menu Audio
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).
Reportez-vous à « Diagrammes bloc » (page 131).

Audio >Audio Input
Définit les réglages d’entrée audio.

Élément de 
menu

Réglage de sous-éléments Description

CH1 Input 
Select

INPUT1 / Internal MIC / Shoe CH1 Commute la source d’entrée pour 
l’enregistrement sur le canal 1.

CH2 Input 
Select

INPUT1 / INPUT2 / Internal MIC / Shoe CH2 Commute la source d’entrée pour 
l’enregistrement sur le canal 2.

CH3 Input 
Select

Off / INPUT1 / Internal MIC / Shoe CH1 Commute la source d’entrée pour 
l’enregistrement sur le canal 3.

CH4 Input 
Select

Off / INPUT1 / INPUT2 / Internal MIC / 
Shoe CH2

Commute la source d’entrée pour 
l’enregistrement sur le canal 4.

INPUT1 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Règle le niveau d’enregistrement de 
référence pour l’entrée du microphone 
XLR à partir d’INPUT1.

INPUT2 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Règle le niveau d’enregistrement de 
référence pour l’entrée du microphone 
XLR à partir d’INPUT2.

Line Input 
Reference

+4dB / 0dB / –3dB / EBUL Sélectionne le niveau d’entrée de 
référence quand le commutateur INPUT1/
INPUT2 est réglé sur LINE.

Reference 
Level

–20dB / –18dB / –16dB / –12dB / EBUL Sélectionne le niveau d’enregistrement 
du signal de tonalité de référence de 
1 kHz.

CH1 Wind 
Filter

On / Off Active/désactive le filtre de réduction 
anti-vent pour l’enregistrement sur le 
canal 1.

CH2 Wind 
Filter

On / Off Active/désactive le filtre de réduction 
anti-vent pour l’enregistrement sur le 
canal 2.

CH3 Wind 
Filter

On / Off Active/désactive le filtre de réduction 
anti-vent pour l’enregistrement sur le 
canal 3.

CH4 Wind 
Filter

On / Off Active/désactive le filtre de réduction 
anti-vent pour l’enregistrement sur le 
canal 4.

CH3 Level 
Control

Auto / Manual Sélectionne le réglage du niveau d’entrée 
audio ou le réglage manuel pour le canal 
d’enregistrement 3.

[Remarque]
Si CH3 Input Select et CH4 Input Select 
sont tous deux réglés sur Internal MIC, CH4 
est commuté sur automatic/manual en 
conjonction avec ce réglage.

Audio >Audio Input
Définit les réglages d’entrée audio.

Élément de 
menu

Réglage de sous-éléments Description

CH4 Level 
Control

Auto / Manual Sélectionne le réglage du niveau d’entrée 
audio ou le réglage manuel pour le canal 
d’enregistrement 4.

[Remarque]
Si CH3 Input Select et CH4 Input Select 
sont tous deux réglés sur Internal MIC, CH4 
est commuté sur automatic/manual en 
conjonction avec le réglage CH3 Level Control.

CH3 Input 
Level

0 à 99 (49) Règle le niveau d’entrée pour 
l’enregistrement du canal 3.

CH4 Input 
Level

0 à 99 (49) Règle le niveau d’entrée pour 
l’enregistrement du canal 4.

Audio Input 
Level

0 à 99 Règle le niveau d’entrée audio.
Peut être utilisé comme volume principal 
en fonction des réglages de CH1 Level à 
CH4 Level.

Limiter Mode Off / –6dB / –9dB / –12dB / –15dB / –17dB Sélectionne la caractéristique du limiteur 
pour les forts signaux d’entrée lors du 
réglage manuel du niveau d’entrée 
audio.

CH1&2 AGC 
Mode

Mono / Stereo Règle le mode de réglage automatique 
de niveau pour le canal d’enregistrement 
1 et canal 2. Lorsque vous réglez sur 
Stereo, AGC est relié entre les canaux.

CH3&4 AGC 
Mode

Mono / Stereo Règle le mode de réglage automatique 
de niveau pour le canal d’enregistrement 
3 et canal 4. Lorsque vous réglez sur 
Stereo, AGC est relié entre les canaux.

AGC Spec –6dB / –9dB / –12dB / –15dB / –17dB Sélectionne la caractéristique AGC.

1kHz Tone on 
Color Bars

On / Off Active/désactive le signal de tonalité de 
référence de 1 kHz lors de l’affichage des 
barres de couleur.

[Remarque]
Lorsqu’il est activé, le signal de tonalité 
de référence de 1 kHz est réglé pour 
l’enregistrement sur le canal 3 et canal 4, 
même si CH3 Input Select et CH4 Input Select 
sont désactivés.
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Audio >Audio Input
Définit les réglages d’entrée audio.

Élément de 
menu

Réglage de sous-éléments Description

CH1 Level Entrée sans adaptateur XLR
Audio Input Level / Side / Level+Side

Entrée avec adaptateur XLR (page 99)
Audio Input Level / Through

Règle la combinaison des ajustements 
de niveau d’entrée audio activés pour le 
canal d’enregistrement 1.

[Remarque]
« Side » se rapporte à la molette AUDIO 
LEVEL (CH1) sur le côté de l’appareil. Lorsque 
Level+Side est sélectionné, le niveau 
d’enregistrement audio est déterminé par la 
combinaison des réglages Audio Input Level et 
dial (page 131).

CH2 Level Entrée sans adaptateur XLR
Audio Input Level / Side / Level+Side

Entrée avec adaptateur XLR (page 99)
Audio Input Level / Through

Règle la combinaison des ajustements 
de niveau d’entrée audio activés pour le 
canal d’enregistrement 2.

[Remarque]
« Side » se rapporte à la molette AUDIO 
LEVEL (CH2) sur le côté de l’appareil. Lorsque 
Level+Side est sélectionné, le niveau 
d’enregistrement audio est déterminé par la 
combinaison des réglages Audio Input Level et 
dial (page 131).

CH3 Level Entrée sans adaptateur XLR
Audio Input Level / CH3 Input Level / 
Level+CH3 Input Level

Entrée avec adaptateur XLR (page 99)
Audio Input Level / Through

Règle la combinaison des ajustements 
de niveau d’entrée audio activés pour le 
canal d’enregistrement 3.

CH4 Level Entrée sans adaptateur XLR
Audio Input Level / CH4 Input Level / 
Level+CH4 Input Level

Entrée avec adaptateur XLR (page 99)
Audio Input Level / Through

Règle la combinaison des ajustements 
de niveau d’entrée audio activés pour le 
canal d’enregistrement 4.

Audio >Audio Output
Définit les réglages de sortie audio.

Élément de 
menu

Réglage de sous-éléments Description

Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1 / 
CH2 / CH3 / CH4

Sélectionne la sortie du canal audio vers 
la prise casque et le haut-parleur intégré.

[Remarque]
Si l’audio pour plusieurs canaux est réglée sur 
la sortie simultanée, le niveau de sortie pour 
chaque canal est réduit pour la sortie pour 
éviter le détourage.

Volume 0 à 50 Ajuste la sortie de niveau audio du 
moniteur vers la prise casque et le 
haut-parleur intégré.

Headphone 
Out

Mono / Stereo Sélectionne le mode de sortie de la prise 
casque : monaural (Mono) ou stéréo 
(Stereo).

Alarm Level 0 à 7 (4) Ajuste le volume de l’alarme.

HDMI Output 
CH

CH1/CH2 / CH3/CH4 Règle la combinaison des canaux audio 
sur la sortie HDMI.

SDI Output 
CH (X-OCN)

CH1/CH2 / CH3/CH4 Règle la combinaison des canaux audio 
sur la sortie SDI lorsque le format 
d’enregistrement est réglé sur X-OCN.
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Menu Clip Operations
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Opérations sur les plans

Élément de 
menu

Réglage de sous-éléments Description

Display Clip 
Properties

Affiche l’écran de propriétés de plans.

Clip Operations >Set Clip Flag
Définit les réglages de balise de plan.

Élément de 
menu

Réglage de sous-éléments Description

Add OK Ajoute une balise OK.

Add NG Ajoute une balise NG.

Add KEEP Ajoute une balise KEEP.

Delete Clip 
Flag

Supprime toutes les balises.

Clip Operations >Lock/Unlock Clip
Définit les réglages de protection de plan.

Élément de 
menu

Réglage de sous-éléments Description

Select Clip Sélectionne et verrouille/déverrouille un 
plan.

Lock All Clips Verrouille tous les plans.

Unlock All 
Clips

Déverrouille tous les plans.

Clip Operations >Transfer Clip
Transfère des plans.

[Remarque]
Transfer Clip ne peut pas être configuré s’il n’y a pas de mot de passe configuré à l’aide de Network Setup dans 
le menu Network.

Élément de 
menu

Réglage de sous-éléments Description

Select Clip Transfert les plans sélectionnés.

All Clips Transfert tous les plans.

[Remarque]
Jusqu’à 200 plans peuvent être transférés.

Clip Operations >Transfer Clip (Proxy)
Transfère des plans proxy.

[Remarque]
Transfer Clip (Proxy) ne peut pas être configuré s’il n’y a pas de mot de passe configuré à l’aide de Network 
Setup dans le menu Network.

Élément de 
menu

Réglage de sous-éléments Description

Select Clip Transfère les plans proxy correspondant 
aux plans sélectionnés.

All Clips Transfère les plans proxy correspondant à 
tous les plans.

[Remarque]
Jusqu’à 200 plans peuvent être transférés.

Clip Operations >Filter Clips
Définit les réglages des plans à afficher.

Élément de 
menu

Réglage de sous-éléments Description

OK Affiche uniquement les plans comportant 
une balise OK.

NG Affiche uniquement les plans comportant 
une balise NG.

KEEP Affiche uniquement les plans comportant 
une balise KEEP.

None Affiche uniquement les plans ne 
comportant pas de balise.

All Affiche tous les plans, que des balises 
soient présentes ou non.

Clip Operations >Customize View
Commute l’affichage de l’écran des plans.

Élément de 
menu

Réglage de sous-éléments Description

Clips Caption Clip Name / Date Time / Time Code / 
Duration / Sequential Number

Commute les informations affichées sous 
l’image de plan.
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Menu Technical
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Technical >Color Bars
Définit les réglages de barres de couleur.

Élément de 
menu

Réglage de sous-éléments Description

Setting On / Off Active/désactive les barres de couleur.

Type ARIB / 100% / 75% / SMPTE Sélectionne le type de barres de couleur.

Technical >ND Dial
Configure les réglages relatifs aux opérations de la molette ND VARIABLE.

Élément de 
menu

Réglage de sous-éléments Description

CLEAR with 
Dial

On / Off Permet d’autoriser ou d’interdire la 
commutation d’état ND (CLEAR  On) 
en utilisant la molette ND VARIABLE.

Technical >Rec/Tally
Configure les réglages du témoin d’enregistrement/de signalisation.

Élément de 
menu

Réglage de sous-éléments Description

Rec/Tally 
Lamp

On / Off Active/désactive le témoin 
d’enregistrement/de signalisation.

Rec Start/
Stop Beep

0 à 50 Ajuste le volume du bip sonore émis lors 
du démarrage et de l’arrêt de 
l’enregistrement.

Technical >LOCK Switch Settings
Définit les réglages du commutateur de verrouillage.

Élément de 
menu

Réglage de sous-éléments Description

with Rec 
Button

On / Off Règle s’il faut aussi verrouiller le 
fonctionnement de la touche REC 
(démarrer/arrêter l’enregistrement).

with Hand 
Grip Remote

On / Off Règle s’il faut verrouiller le 
fonctionnement de la télécommande à 
poignée.

with LCD 
Monitor

On / Off Règle s’il faut verrouiller le 
fonctionnement des touches du 
moniteur LCD.

Technical >Touch Operation
Définit les réglages relatifs aux opérations tactiles.

Élément de 
menu

Réglage de sous-éléments Description

Setting On / Off Active/désactive les opérations tactiles.

Technical >Rec Review
Définit les réglages du passage en revue de l’enregistrement.

Élément de 
menu

Réglage de sous-éléments Description

Setting 3 s / 10 s / Clip Sélectionne le temps pour la lecture de 
plans venant d’être enregistrés pour le 
passage en revue de l’enregistrement.

Technical >Zoom
Définit les réglages de zoom.

Élément de 
menu

Réglage de sous-éléments Description

Zoom Type Optical Zoom Only / On(Clear Image 
Zoom)

Définit le type de zoom.
Optical Zoom Only : 

Le zoom optique est réglé à l’aide de 
l’objectif.

On(Clear Image Zoom) : 
Zoom électronique avec aucune ou 
peu de détérioration de la qualité de 
l’image.

Technical >Handle Zoom
Définit les réglages de zoom de la poignée pour une poignée (en option) équipée d’une griffe MI.

Élément de 
menu

Réglage de sous-éléments Description

Setting Off / Low / High / Variable Règle la vitesse du zoom à poignée.

High 1 à 8 (8) Règle la vitesse de zoom du levier de 
zoom de la poignée lorsque la vitesse de 
zoom de la poignée High est 
sélectionnée.

Low 1 à 8 (3) Règle la vitesse de zoom du levier de 
zoom de la poignée lorsque la vitesse de 
zoom de la poignée Low est 
sélectionnée.

[Remarque]
Une vitesse de zoom réglée sur une faible 
valeur peut provoquer un zoom irrégulier.

Technical >Menu Settings
Définit les réglages liés au menu.

Élément de 
menu

Réglage de sous-éléments Description

User Menu 
Only

On / Off Configure s’il faut afficher le menu User 
uniquement (On) ou afficher la liste des 
menus (Off) lorsque le menu est affiché.
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Technical >Menu Settings
Définit les réglages liés au menu.

Élément de 
menu

Réglage de sous-éléments Description

User Menu 
with Lock

On / Off Règle le verrouillage ou non de 
l’affichage du menu, affichant le menu 
User uniquement.

[Remarque]
En cas d’affichage normal du menu, cet 
élément ne s’affiche pas. Pour plus de détails 
sur l’affichage du menu, consultez page  33.

Technical >Menu Page On/Off
Règle les réglages relatifs à l’affichage d’écrans d’état.

Élément de 
menu

Réglage de sous-éléments Description

Project On / Off Active/désactive l’affichage de l’écran 
d’état Project.

Audio On / Off Active/désactive l’affichage de l’écran 
d’état Audio.

Monitoring On / Off Active/désactive l’affichage de l’écran 
d’état Monitoring.

Assignable 
Button

On / Off Active/désactive l’affichage de l’écran 
d’état Assignable Button.

Battery On / Off Active/désactive l’affichage de l’écran 
d’état Battery.

Media On / Off Active/désactive l’affichage de l’écran 
d’état Media.

Network On / Off Active/désactive l’affichage de l’écran 
d’état Network.

File Transfer On / Off Active/désactive l’affichage de l’écran 
d’état File Transfer.

Technical >Fan Control
Définit les réglages de mode de commande du ventilateur.

Élément de 
menu

Réglage de sous-éléments Description

Setting Auto / Minimum / Off in Rec Règle le mode de commande du 
ventilateur de l’appareil.

[Remarque]
Même lorsque Off in Rec est sélectionné, le 
ventilateur fonctionnera si la température 
interne de l’appareil dépasse une certaine 
valeur.

Technical >Lens
Définit les réglages liés aux objectifs.

Élément de 
menu

Réglage de sous-éléments Description

PL-Mt 
Interface 
Position

Top / Side / Off Règle la position de l’interface de l’objectif à 
monture PL.

Zoom Ring 
Direction

Left(W)/Right(T) / Right(W)/Left(T) Règle la direction du fonctionnement de 
la bague de zoom.

[Remarque]
Activé uniquement lors de l’utilisation d’un 
objectif à monture E prenant en charge le 
changement de direction de la bague de zoom.

Shading 
Compensation

Auto / Auto(Low) / Off Règle la compensation automatique pour 
l’éclairage périphérique lorsqu’un 
objectif compatible est fixé.

[Remarques]
•• Selon l’objectif, il se peut que l’éclairage 

périphérique ne soit pas compensé même 
lorsque Shading Compensation est activé.

•• Selon l’objectif, il se peut qu’aucune 
différence de compensation ne soit obtenue 
entre Auto et Auto(Low).

Chroma 
Aberration 
Comp.

Auto / Off Règle la compensation automatique pour 
l’aberration chromatique lorsqu’un 
objectif compatible est fixé.

Distortion 
Comp.

Auto / Off Définit la compensation automatique de 
distorsion.

[Remarque]
Lorsque Image Stabilization >SteadyShot 
(page 42) est réglé sur Active dans le menu 
Shooting, Distortion Comp. est réglé sur Auto.

Breathing 
Compensation

Auto / Off Définit la compensation de la respiration 
de l’objectif.

Distance 
Display

Meter / Feet Configure les unités d’affichage pour les 
informations d’objectif et la position de 
mise au point.

Zoom 
Position 
Display

Focal Length / Number / Bar Définit le format d’affichage de position 
de zoom.
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Technical >Video Light Set
Règle la méthode d’éclairage de la lampe vidéo. Disponible uniquement lors de l’utilisation du 
HVL-LBPC (optionnel).

Élément de 
menu

Réglage de sous-éléments Description

Video Light 
Set

Power Link / Rec Link / Rec Link + Stby Règle la méthode de contrôle d’éclairage 
pour la lampe vidéo fixée à la griffe 
d’interface multiple.
Power Link : 

Allume/éteint la lampe vidéo quand 
l’appareil est en marche/à l’arrêt.

Rec Link : 
Allume/éteint la lampe vidéo quand 
l’appareil commence/arrête 
l’enregistrement.

Rec Link + Stby : 
Allume/met en veille la lampe vidéo 
quand l’appareil commence/arrête 
l’enregistrement.

Technical >APR
Exécute l’APR.

Élément de 
menu

Réglage de sous-éléments Description

APR Execute / Cancel Exécute l’APR (restauration automatique 
des pixels) pour l’ajustement 
automatique du capteur d’images.
Execute : fonction Execute.

[Remarque]
Fixez toujours le capuchon de l’objectif avant 
d’exécuter l’APR.

Technical >Camera Battery Alarm
Définit les réglages d’alarme de basse tension de batterie.

Élément de 
menu

Réglage de sous-éléments Description

Near End:Info 
Battery

5% à 100% (incréments de 5%) Règle seuil à laquelle l’indicateur de la 
capacité restante de batterie commence 
à clignoter lors de l’utilisation d’une 
batterie Sony Info.

End:Info 
Battery

0% à 5% Règle la valeur seuil pour l’affichage de 
l’avertissement « Battery End » lors de 
l’utilisation d’une batterie Sony Info.

Technical >Camera Battery Alarm
Définit les réglages d’alarme de basse tension de batterie.

Élément de 
menu

Réglage de sous-éléments Description

Near 
End:Sony 
Battery

11.5V à 17.0V (incréments de 0.1V) Règle la valeur seuil à laquelle 
l’indicateur de la capacité restante de 
batterie commence à clignoter lors de 
l’utilisation d’une batterie Sony autre 
qu’une batterie Info.

End:Sony 
Battery

11.0V à 12.5V (incréments de 0.1V) Règle la valeur seuil pour l’affichage de 
l’avertissement « Battery End » lors de 
l’utilisation d’une batterie Sony autre 
qu’une batterie Info.

Near 
End:Other 
Battery

11.5V à 17.0V (11.8V) (incréments de 0.1V) Règle la valeur seuil à laquelle 
l’indicateur de la capacité restante de 
batterie commence à clignoter lors de 
l’utilisation d’une batterie d’un autre 
fabricant que Sony.

End:Other 
Battery

11.0V à 14.0V (incréments de 0.1V) Règle la valeur seuil pour l’affichage de 
l’avertissement « Battery End » lors de 
l’utilisation d’une batterie d’un autre 
fabricant que Sony.

Detected 
Battery

Sony Info Battery / Sony Battery / Other 
Battery / DC IN

Affiche le résultat de la détection 
automatique du type de pack de 
batteries.

Technical >Camera DC IN Alarm
Définit les réglages d’alarme de tension en entrée.

Élément de 
menu

Réglage de sous-éléments Description

DC Low 
Voltage1

11.5V à 17.0V (incréments de 0.1V) Règle la tension nécessaire pour 
déclencher l’affichage d’une alarme de 
basse tension en entrée DC IN.

DC Low 
Voltage2

11.0V à 14.0V (incréments de 0.1V) Règle la tension nécessaire pour 
déclencher l’affichage d’une alarme de 
tension insuffisante en entrée DC IN.
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Menu Network
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Network >Network Setup
Effectue les réglages relatifs au réseau.

Élément de 
menu

Réglage de sous-éléments Description

Setup for 
Mobile App

Démarre l’outil d’aide pour la 
configuration réseau.

User Name Règle le nom d’utilisateur pour 
l’authentification d’accès.

Input 
Password

Règle le mot de passe pour 
l’authentification d’accès.

[Remarque]
Du point de vue de la sécurité, il est 
recommandé de définir un mot de passe avec 
une chaîne de caractères suffisamment longue, 
difficile à deviner par les autres, et de le stocker 
en toute sécurité.

Generate 
Password

Execute / Cancel Génère automatiquement un mot de 
passe pour l’authentification d’accès.
Execute : fonction Execute.

Show 
Authentication

Affiche le nom d’utilisateur et le mot de 
passe pour l’authentification d’accès sous 
forme de texte et de code QR.

LAN Type 
Select

WLAN (AP Mode) / WLAN (ST Mode) / 
Wired LAN / Off

Définit la méthode de connexion du LAN.

Network >Wireless LAN
Définit les réglages liés aux connexions LAN sans fil.

Élément de 
menu

Réglage de sous-éléments Description

WPS Execute / Cancel Établit une connexion à l’aide d’un WPS 
(Wi-Fi Protected Setup).
Execute : fonction Execute.

MAC Address Affiche l’adresse MAC de l’interface LAN 
sans fil de l’appareil.

Network >AP Mode Settings
Définit les réglages liés aux connexions du mode de point d’accès.

Élément de 
menu

Réglage de sous-éléments Description

Channel Auto(5GHz) / Auto / CH1 / CH2 / CH3 / 
CH4 / CH5 / CH6 / CH7 / CH8 / CH9 /  
CH10 / CH11

Définit le canal LAN sans fil. 
Auto(5GHz) est uniquement disponible 
avec le modèle WW279317.

Camera SSID 
& Password

Affiche le SSID et le mot de passe de 
l’appareil.

Network >AP Mode Settings
Définit les réglages liés aux connexions du mode de point d’accès.

Élément de 
menu

Réglage de sous-éléments Description

Regenerate 
Password

Execute / Cancel Crée un nouveau mot de passe.
Execute : fonction Execute.

IP Address Affiche l’adresse IP de l’appareil en mode 
de point d’accès.

Subnet Mask Affiche le masque de sous-réseau de 
l’appareil en mode de point d’accès.

Network >ST Mode Settings
Définit les réglages liés aux connexions du mode de station.

Élément de 
menu

Réglage de sous-éléments Description

Camera 
Remote 
Control

Enable / Disable Règle si la télécommande doit être 
activée depuis un dispositif de 
commande connecté à l’appareil par LAN 
sans fil en mode de station.

Connected 
Network

Affiche le réseau LAN sans fil connecté 
(point d’accès).

SSID Affiche le SSID du point d’accès pour la 
connexion.

Security Affiche le type de sécurité du point 
d’accès pour la connexion.

Password Affiche le mot de passe du point d’accès 
pour la connexion.
Lorsque Security est réglé sur WEP ou 

WPA : *******
Lorsque Security est réglé sur None : 

(vide)

DHCP Affiche l’état d’activation/désactivation 
du DHCP.

IP Address Affiche l’adresse IP de l’appareil lorsque 
DHCP est réglé sur Off.

Subnet Mask Affiche le masque de sous-réseau de 
l’appareil lorsque DHCP est réglé sur Off.

Gateway Affiche la passerelle par défaut de 
l’appareil lorsque DHCP est réglé sur Off.

DNS Auto Affiche l’état d’activation/désactivation 
d’acquisition du DNS.

Primary DNS Server Affiche le serveur DNS principal de 
l’appareil lorsque DNS Auto est réglé sur 
Off.

Secondary DNS Server Affiche le serveur DNS secondaire de 
l’appareil lorsque DNS Auto est réglé sur 
Off.
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Network >ST Mode Settings
Définit les réglages liés aux connexions du mode de station.

Élément de 
menu

Réglage de sous-éléments Description

Scan 
Networks

Détecte les réseaux LAN sans fil (points 
d’accès) et affiche une liste.
Sélectionnez une destination depuis la 
liste pour la connexion.

SSID Affiche le SSID du point d’accès pour la 
connexion.

Security Affiche le type de sécurité du point 
d’accès pour la connexion.

Password Saisissez le mot de passe du point 
d’accès pour la connexion.

DHCP 
On / Off

Active/désactive DHCP.

IP Address Saisissez l’adresse IP de l’appareil lorsque 
DHCP est réglé sur Off.

Subnet Mask Saisissez le masque de sous-réseau de 
l’appareil lorsque DHCP est réglé sur Off.

Gateway Saisissez la passerelle par défaut de 
l’appareil lorsque DHCP est réglé sur Off.

DNS Auto 
On / Off

Active/désactive la fonction d’acquisition 
automatique de DNS.

Primary DNS Server Saisissez le serveur DNS principal de 
l’appareil lorsque DNS Auto est réglé sur 
Off.

Secondary DNS Server Saisissez le serveur DNS secondaire de 
l’appareil lorsque DNS Auto est réglé sur 
Off.

Network >ST Mode Settings
Définit les réglages liés aux connexions du mode de station.

Élément de 
menu

Réglage de sous-éléments Description

Manual 
Register

Enregistre les réglages pour la connexion 
manuelle à un point d’accès.

SSID Saisissez le SSID du point d’accès pour la 
connexion.

Security 
None / WEP / WPA

Configurez le type de sécurité du point 
d’accès pour la connexion. Sélectionnez 
WPA si le type de sécurité du point 
d’accès de destination est WPA ou WPA2.

Password Saisissez le mot de passe du point 
d’accès pour la connexion.

DHCP 
On / Off

Active/désactive DHCP.

IP Address Saisissez l’adresse IP de l’appareil lorsque 
DHCP est réglé sur Off.

Subnet Mask Saisissez le masque de sous-réseau de 
l’appareil lorsque DHCP est réglé sur Off.

Gateway Saisissez la passerelle par défaut de 
l’appareil lorsque DHCP est réglé sur Off.

DNS Auto 
On / Off

Active/désactive la fonction d’acquisition 
automatique de DNS.

Primary DNS Server Saisissez le serveur DNS principal lorsque 
DNS Auto est réglé sur Off.

Secondary DNS Server Saisissez le serveur DNS secondaire 
lorsque DNS Auto est réglé sur Off.
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Network >Wired LAN
Définit les réglages liés aux connexions LAN filaires.

Élément de 
menu

Réglage de sous-éléments Description

Camera 
Remote 
Control

Enable / Disable Règle si la télécommande doit être 
activée depuis un dispositif de 
commande connecté à l’appareil par LAN 
filaire.

Detail 
Settings

Configure les propriétés de la connexion 
par LAN filaire.

DHCP 
On / Off

Active/désactive DHCP.

IP Address Saisissez l’adresse IP de l’appareil lorsque 
DHCP est réglé sur Off.

Subnet Mask Saisissez le masque de sous-réseau de 
l’appareil lorsque DHCP est réglé sur Off.

Gateway Saisissez la passerelle par défaut de 
l’appareil lorsque DHCP est réglé sur Off.

DNS Auto 
On / Off

Active/désactive la fonction d’acquisition 
automatique de DNS.

Primary DNS Server Saisissez le serveur DNS principal lorsque 
DNS Auto est réglé sur Off.

Secondary DNS Server Saisissez le serveur DNS secondaire 
lorsque DNS Auto est réglé sur Off.

MAC Address Affiche l’adresse MAC de l’interface LAN 
filaire de l’appareil.

Network >USB Tethering
Définit les réglages liés au raccordement modem USB.

Élément de 
menu

Réglage de sous-éléments Description

Setting On / Off Active/désactive la connexion au 
smartphone.

Camera 
Remote 
Control

Enable / Disable Définit la permission pour la 
télécommande via le raccordement 
modem USB en utilisant une application 
de smartphone, telle que Monitor & 
Control ou Creators' App for enterprise.

Device Name Affiche le nom de dispositif du 
smartphone.

IP Address Affiche l’adresse IP du smartphone.

Subnet Mask Affiche le masque de sous-réseau du 
smartphone.

Network >File Transfer
Définit les réglages liés aux transferts de fichiers.

Élément de 
menu

Réglage de sous-éléments Description

Auto Upload On / Off Active/désactive le téléchargement 
automatique des plans originaux.

[Remarque]
Lorsque Simul Rec >Setting (page 44) dans 
le menu Project est réglé sur On, les plans 
enregistrés sur le support dans le logement B 
ne sont pas téléchargés automatiquement.

Auto Upload 
(Proxy)

On / Off On :
Active le téléchargement 
automatique des plans proxy.

Off :
Désactive le téléchargement 
automatique des plans proxy.

Default 
Upload 
Server

Sélectionne le serveur de téléchargement 
pour les fichiers. Le serveur sélectionné 
ici devient la destination de 
téléchargement automatique pour les 
plans originaux et les plans proxy, ainsi 
que la destination de téléchargement 
pour les fichiers à partir de l’écran des 
plans.
Affiche le nom d’affichage configuré 
dans Server Settings1 à 3.

Clear 
Completed 
Jobs

Execute / Cancel Supprime de la liste les tâches de 
transfert terminées.
Execute : fonction Execute.

Clear All Jobs Execute / Cancel Supprime de la liste toutes les tâches de 
transfert.
Execute : fonction Execute.

View Job List Affiche la liste des tâches de transfert.
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Network >File Transfer
Définit les réglages liés aux transferts de fichiers.

Élément de 
menu

Réglage de sous-éléments Description

Server 
Settings1

Display Name Règle le nom d’affichage indiqué dans le 
menu de configuration de destination de 
transfert.

Service 
FTP

Permet d’afficher le type de serveur.

Host Name Règle le nom d’hôte du serveur de 
destination de transfert.

Port (1 à 65535 (21)) Règle le numéro de port du serveur de 
destination de transfert.

User Name Règle le nom d’utilisateur pour 
l’authentification de la connexion au 
serveur de destination de transfert.

Password Règle le mot de passe d’authentification 
de la connexion au serveur de 
destination de transfert.

Passive Mode 
On / Off (Active Mode)

Active/désactive le mode PASV.

Destination Directory Saisissez le nom du répertoire de 
destination de transfert.

Using Secure Protocol 
On / Off

Règle l’utilisation (On) ou non (Off) d’un 
transfert FTP sécurisé (Mode FTPS 
Explicit : FTPES).

Root Certificate 
Load / Clear / None

Charge un certificat racine pour un 
transfert FTP sécurisé et supprime les 
réglages.

Root Certificate Status 
Loaded / No Certificate

Affiche l’état de chargement du certificat 
racine pour un transfert FTP sécurisé.

Reset 
Execute / Cancel

Réinitialise les réglages de Server 
Settings aux réglages par défaut.
Execute : fonction Execute.

Server 
Settings2

Identique à Server Settings1.

Server 
Settings3

Identique à Server Settings1.

Network >Network Reset
Réinitialise les réglages de réseau.

Élément de 
menu

Réglage de sous-éléments Description

Reset Execute / Cancel Réinitialise les réglages de réseau.
Execute : fonction Execute.
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Menu Maintenance
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Maintenance >Language
Règle la langue d’affichage.

Élément de 
menu

Réglage de sous-éléments Description

Select Règle la langue d’affichage.
SET : règle la langue.

Maintenance >Clock Set
Définit les réglages de l’horloge interne.

Élément de 
menu

Réglage de sous-éléments Description

Time Zone UTC – 12:00 à UTC + 14:00 Règle le décalage horaire par rapport au 
temps universel, par incréments de 30 
minutes.

Date Mode YYMMDD / MMDDYY / DDMMYY Sélectionne le format d’affichage pour 
les dates.
YYMMDD : année, mois, jour
MMDDYY : mois, jour, année
DDMMYY : jour, mois, année

12h/24h 12h / 24h Sélectionne le format d’affichage de 
l’horloge.
12h : mode 12 heures
24h : mode 24 heures

Date Règle la date actuelle.
SET : règle la valeur.

Time Règle l’heure actuelle.
SET : règle la valeur.

Maintenance >All Reset
Réinitialise les réglages aux valeurs par défaut.

Élément de 
menu

Réglage de sous-éléments Description

Reset Execute / Cancel Réinitialise tous les réglages à leurs 
valeurs par défaut.
Execute : fonction Execute.

[Remarque]
Un fichier 3D LUT importé à l’aide de Base 
Look >Import from Utility SD, Import from 
Cloud(Private) ou Import from Cloud(Share) 
(page 49) dans le menu Paint/Look ne peut 
pas être supprimé. Pour supprimer tous les 
fichiers 3D LUT importés, sélectionnez Base 
Look >Delete All (page 49) dans le menu 
Paint/Look.

Maintenance >All Reset
Réinitialise les réglages aux valeurs par défaut.

Élément de 
menu

Réglage de sous-éléments Description

Reset without 
Network

Execute / Cancel Réinitialise les réglages du menu, à 
l’exception des réglages du menu 
Network, à l’état d’usine par défaut.

Maintenance >Hours Meter
Affiche la durée de fonctionnement cumulée.

Élément de 
menu

Réglage de sous-éléments Description

Hours(System) Affiche les heures d’utilisation cumulées 
(ne peut pas être réinitialisé).

Hours(Reset) Affiche les heures d’utilisation cumulées 
(peut être réinitialisé).

Reset Execute / Cancel Réinitialise l’affichage de Hours(Reset) à 
0.
Execute : fonction Execute.

Maintenance >Version
Affiche les informations de version.

Élément de 
menu

Réglage de sous-éléments Description

Version 
Number

Vx.xx Affiche la version de logiciel de l’appareil.

Version Up Execute / Cancel Met l’appareil à jour.*
Execute : fonction Execute.
*	 Cette fonction met à jour le logiciel de 

l’appareil.

Lens Version 
Number

Vxx Affiche le numéro de version du logiciel 
d’un objectif à monture E.
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Réglages de qualité d’image sauvegardés pour chaque mode de prise de vue
L’état actuel de certains éléments de configuration liés à la qualité d’image est sauvegardé dans les modes de prise de vue suivants. Les éléments communs sont enregistrés dans tous les modes de 
prise de vue. Pour les éléments enregistrés séparément, lorsque vous changez de mode de prise de vue, les réglages correspondants qui sont sauvegardés sont appliqués au mode de prise de vue 
cible.
•• Mode Cine EI
•• Mode Custom SDR(BT.709)
•• Mode Custom HDR(HLG)

Les éléments de configuration relatifs à la qualité d’image qui sont sauvegardés pour chaque mode de prise de vue sont indiqués ci-dessous.
 : enregistré (réglages communs lors d’un chevauchement entre modes de prise de vue)
– : désactivé dans le mode de prise de vue correspondant

Élément de configuration Mode de prise de vue

Mode Cine EI Mode Custom

SDR(BT.709) HDR(HLG)

Menu Shooting ISO/Gain/EI ISO/Gain – 1)

Exposure Index  –

Base Sensitivity – 
Base ISO  –

White 
White Setting 
LUT On/Off  –

Noise Suppression Setting(Custom) –  

Level(Custom) –  
Setting(Cine EI)  –

Level(Cine EI)  –

Menu Paint/Look Base Look Select   
Input2) 
Output2) 
AE Level Offset2) 

Black –  
Knee Auto Knee –  

Autre que ci-dessus –  
Detail –  
Matrix –  
Multi Matrix –  

1)	 Les réglages de sensibilité ISO distincts sont sauvegardés pour le mode Custom SDR(BT.709) et HDR(HLG).
2)	Les réglages sont sauvegardés pour chaque Base Look, et ne dépendent pas du mode de prise de vue.
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Enregistrement et chargement des données de configuration

Données de configuration

Vous pouvez sauvegarder les réglages du 
menu complet sur une carte SD. Vous pouvez 
également enregistrer un fichier ALL sur un 
service Cloud. Cela vous permet de rappeler 
rapidement un ensemble de réglages de 
menu approprié à la situation actuelle.
Les données de configuration sont 
sauvegardées dans les catégories suivantes.

Fichiers utilisateur
Les fichiers utilisateur enregistrent les 
éléments et les données de réglage du menu 
User personnalisable.
Vous pouvez sauvegarder jusqu’à 64 fichiers 
sur une carte SD.
En chargeant ce fichier dans la mémoire 
de l’appareil, vous pouvez personnaliser la 
configuration du menu User.

Fichiers All (Fichier ALL)
Les fichiers ALL sauvegardent les données 
de configuration de tous les menus. Vous 
pouvez sauvegarder jusqu’à 64 fichiers sur 
une carte SD. Jusqu’à 120 fichiers peuvent 
être enregistrés sur C3 Portal (service Cloud), 
comprenant jusqu’à 60 fichiers privés et 
60 fichiers partagés.

[Remarque]
Pour plus de détails sur le contenu enregistré dans un 
fichier ALL, consultez « Eléments enregistrés dans les 
fichiers » (page 123).

Sauvegarde d’un fichier 
utilisateur/fichier ALL

Enregistrement sur une carte SD

1	 Insérez une carte SD dans le logement de 
carte SD Utility (page 4).

2	 Pour un fichier utilisateur, sélectionnez 
User File >Save to UTILITY SD (page 48) 
>Execute dans le menu Project du menu 
complet.
Pour un fichier ALL, sélectionnez All File 
>Save to UTILITY SD (page 48) >Execute 
dans le menu Project du menu complet.
Un écran de destination de sauvegarde de 
fichiers apparaît.

3	 Sélectionnez une rangée « No File » dans 
l’écran de destination d’enregistrement.
Sélectionner une rangée avec la saisie File 
ID écrasera le fichier sélectionné.
L’identifiant de fichier attribué lors de la 
sauvegarde peut être modifié à l’aide du 
menu. Pour plus de détails sur la 
configuration, consultez « Modification de 
l’identifiant de fichier » (page 68).

4	 Sélectionnez Execute sur l’écran de 
confirmation.

Enregistrement d’un fichier ALL sur un 
service Cloud

1	 Connectez-vous à l’appareil depuis 
l’application pour smartphone « Creators' 
App for enterprise » (page 80).

2	 Sélectionnez All File >Save to 
Cloud(Private) ou Save to Cloud(Share) 
(page 48) >Execute dans le menu 
Project du menu complet.
Un écran de destination de sauvegarde de 
fichiers apparaît.

3	 Sélectionnez une rangée « No File » dans 
l’écran de destination d’enregistrement.
Sélectionner une rangée avec la saisie File 
ID écrasera le fichier sélectionné.
L’identifiant de fichier attribué lors de la 
sauvegarde peut être modifié à l’aide du 
menu. Pour plus de détails sur la 
configuration, consultez « Modification de 
l’identifiant de fichier » (page 68).

4	 Sélectionnez Execute sur l’écran de 
confirmation.

Chargement d’un fichier 
utilisateur/fichier ALL

Chargement depuis une carte SD

1	 Insérez la carte SD sur laquelle un fichier 
est enregistré dans le logement de carte 
SD Utility (page 4).

2	 Pour un fichier utilisateur, sélectionnez 
User File >Load from UTILITY SD 
(page 48) >Execute dans le menu 
Project du menu complet.
Pour un fichier ALL, sélectionnez All File 
>Load from UTILITY SD (page 48) 
>Execute dans le menu Project du menu 
complet.
Un écran de liste de fichiers s’affiche.

3	 Sélectionnez un fichier à charger.
Un écran de confirmation apparaît.

4	 Sélectionnez Execute.

[Remarques]
•• L’appareil redémarrera automatiquement après avoir 

chargé les données de configuration.
•• Lorsque All File >Load Network Data dans le menu 

Project du menu complet est réglé sur Off, tous les 
réglages du fichier ALL sont chargés à l’exception des 
réglages du menu Network.

Chargement d’un fichier ALL depuis un 
service Cloud

1	 Connectez-vous à l’appareil depuis 
l’application pour smartphone « Creators' 
App for enterprise » (page 80).

2	 Sélectionnez All File >Load from 
Cloud(Private) ou Load from Cloud(Share) 
(page 48) >Execute dans le menu 
Project du menu complet.
Un écran de liste de fichiers s’affiche.

3	 Sélectionnez un fichier à charger.
Un écran de confirmation apparaît.

4	 Sélectionnez Execute.

[Remarques]
•• L’appareil redémarrera automatiquement après avoir 

chargé les données de configuration.
•• Lorsque All File >Load Network Data dans le menu 

Project du menu complet est réglé sur Off, tous les 
réglages du fichier ALL sont chargés à l’exception des 
réglages du menu Network.
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Modification de l’identifiant de 
fichier

1	 Pour un fichier utilisateur, sélectionnez 
User File >File ID (page 48) dans le 
menu Project du menu complet.
Pour un fichier ALL, sélectionnez All File 
>File ID (page 48) dans le menu Project 
du menu complet.
Un écran permettant de modifier 
l’identifiant de fichier apparaît.

2	 Sélectionnez un caractère à l’aide du 
sélecteur multiple (page 8) ou de la 
molette multifonction (page 4), puis 
appuyez sur la touche de mise en 
application du sélecteur multiple ou sur la 
molette multifonction.

3	 Répétez l’étape 2 si nécessaire.

4	 Lorsque vous avez saisi tous les 
caractères, sélectionnez Done.
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Lorsque vous appuyez sur la touche CLIPS (page 4), les plans enregistrés sur la carte mémoire s’affichent dans l’écran des plans.
Vous pouvez sélectionner un plan dans l’écran des plans et lire ce plan. Sur l’écran des plans, vous pouvez utiliser des plans ou vérifier les propriétés d’un plan en utilisant le menu Clip Operations du 
menu complet. En mode d’affichage d’informations, vous pouvez contrôler la lecture sur le moniteur LCD (écran de contrôle de la lecture).
Appuyer à nouveau sur la touche CLIPS ferme l’écran des plans et revient à l’image de caméra.

[Remarques]
•• Seuls les plans enregistrés au format d’enregistrement actuellement sélectionné sont affichés dans l’écran des plans. Si un plan enregistré que vous vous attendiez à voir n’est pas affiché, vérifiez le format d’enregistrement. Gardez ceci à 

l’esprit avant de formater (initialiser) le support.
•• Notez que la page du menu s’affiche sur un moniteur externe si vous ouvrez un réglage associé au mot de passe dans le menu complet alors que l’écran des plans est ouvert.

Écran des plans

Les informations du plan à la position du curseur sont affichées au bas de l’écran.

4 6

7

53

1

2

Indicateur de la carte mémoire 
actuellement sélectionnée
(Une icône de verrou s’affiche 
si la carte est protégée.)

Curseur 
(jaune)

Numéro de plan/Nombre 
total de plans

1.	 Miniature (image d’index)
Affiche l’image d’index d’un plan. Lorsqu’un 
plan est enregistré, sa première image est 
automatiquement définie comme image 
d’index.
Les informations du plan/de l’image sont 
affichées sous la miniature. Vous pouvez 
changer les informations affichées en utilisant 
Customize View (page 57) >Clips Caption 
dans le menu Clip Operations du menu 
complet. Affiche également l’état des plans à 
l’aide d’icônes.

Icône Signification

(Ne peut pas 
être lu)

Impossible de lire le plan

[Remarque]
Au format X-OCN(LT), la chaîne de caractères « X-OCN » 
s’affiche à la place de l’image d’index des miniatures.

2.	 Nom de plan
Affiche le nom du plan sélectionné.

3.	 Format vidéo pour l’enregistrement
Affiche le format de fichier du plan 
sélectionné.

4.	 Informations d’enregistrement spécial
Affiche le mode d’enregistrement uniquement 
si le plan a été enregistré à l’aide d’un mode 
d’enregistrement spécial.
Pour les plans en ralenti et accéléré, la 
fréquence d’images est affichée à droite.

5.	 Date de création

6.	 Durée du plan

7.	 Timecode

Opérations sur les plans
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Écran de contrôle de la lecture

Lorsque le moniteur LCD est en mode d’affichage d’informations, vous pouvez sélectionner un 
plan dans l’écran des plans pour afficher l’écran de contrôle de la lecture. La zone d’affichage des 
fonctions prend en charge les opérations tactiles.

Zone d’affichage de fonction

1 2 3

4 5 6

Touche ITEM 4 Touche ITEM 5 Touche ITEM 6

Touche ITEM 3Touche ITEM 2Touche ITEM 1

[Remarque]
Les zones étiquetées 1 à 6 correspondent aux touches 
ITEM 1 à 6. Appuyez sur une touche ITEM pour 
sélectionner l’élément correspondant.

1.	 Touche F Rev
Permet la lecture rapide en arrière.
Appuyez à plusieurs reprises sur la touche 
pour basculer entre trois vitesses.

2.	 Touche Play/Pause
Permet de lire un plan ou de mettre en pause 
la lecture.

3.	 Touche F Fwd
Permet la lecture rapide en avant.
Appuyez à plusieurs reprises sur la touche 
pour basculer entre trois vitesses.

4.	 Touche Prev
Permet de passer au début du plan précédent.

5.	 Touches Stop/Clips
Permet d’arrêter la lecture et de revenir à 
l’écran des plans.

6.	 Touche Next
Permet de passer au début du plan suivant.

Zone d’affichage d’état

1 2 3

7 6 58910

412
11

13

1.	 Affichage des données temporelles
Affiche le code temporel de la position de 
lecture.

2.	 Indicateur de fréquence d’images
Affiche la fréquence d’images du plan lu.

3.	 Indicateur de tension d’alimentation/
capacité restante de la batterie

Affiche la tension d’alimentation ou la 
capacité restante de la batterie.

4.	  Vu-mètres audio
Affiche le niveau audio de lecture.

5.	 Indicateur de mode d’enregistrement 
spécial

Affiche les informations sur le mode 
d’enregistrement spécial du plan lu.	

6.	 Indicateur de résolution d’image
Affiche la résolution de l’image.

7.	 Affichage du nom de codec
Affiche le nom du codec.

8.	 Indicateur de taille d’image
Affiche la taille de l’image.

9.	 Indicateur du numéro de plan/nombre 
total de plans

Affiche le numéro du plan actuellement lu/
nombre total de plans lisibles.

10.	 Affichage du nom de plan
Affiche le nom du plan.

11.	 Indicateur de support
Affiche le support en cours de lecture.
Une icône  (protection) s’affiche sur la droite 
si la carte mémoire est protégée en écriture.

12.	 Icône d’avertissement/d’erreur
S’affiche en cas d’avertissement ou d’erreur.
Vous pouvez vérifier le contenu des 
avertissements et des erreurs en affichant le 
menu. Si l’affichage de l’écran est superposé 
sur un moniteur externe, vous pouvez aussi le 
vérifier depuis le moniteur externe.

13.	 Indicateur de l’état de lecture
Affiche l’état d’exécution de la lecture.
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Fonctionnement du menu Clip 
Operations

Le menu Clip Operations (page 57) apparaît 
lorsque vous maintenez la touche MENU 
enfoncé et sélectionnez Clip Operations.
Avec le sélecteur multiple (page 4) 
ou la molette multifonction (page 4), 
sélectionnez une fonction, puis appuyez sur 
la touche de mise en application du sélecteur 
multiple ou sur la molette multifonction.
Appuyez sur la touche BACK (page 4) pour 
retourner à l’écran précédent.

[Remarque]
Certains éléments ne peuvent pas être sélectionnés, 
selon l’état lorsque le menu a été affiché.

Affichage des propriétés de plan

Sélectionnez Display Clip Properties 
(page 57) dans le menu Clip Operations 
pour afficher l’écran de propriétés de plan.
Appuyez sur les touches gauche/droite 
du sélecteur multiple pour passer au plan 
précédent/suivant.

Ajout de balises de plan

Vous pouvez ajouter des balises (repères OK, 
NG ou KP) aux plans pour filtrer l’affichage des 
plans en fonction des balises.
Sélectionnez le plan auquel ajouter une balise 
de plan, puis sélectionnez la balise de plan 
à l’aide de Set Clip Flag (page 57) dans le 
menu Clip Operations du menu complet.

Réglage Balise de plan ajoutée

Add OK OK

Add NG NG

Add KEEP KP

Affichage de l’écran des plans filtrés

Sélectionnez Filter Clips (page 57) dans le 
menu Clip Operations du menu complet et 
sélectionnez un type de balise de plan pour 
afficher uniquement les plans qui possèdent 
la balise spécifiée.
Pour afficher tous les plans, sélectionnez All.

[Conseil]
Vous pouvez également commuter les filtres dans 
l’ordre à l’aide de la touche DISPLAY.

Modification des informations sur 
l’écran des plans

Vous pouvez modifier les informations de 
plans/images affichées sous la miniature.
Sélectionnez Customize View >Clips Caption 
dans le menu Clip Operations du menu 
complet et sélectionnez les informations à 
afficher.
Clip Name : 

Affiche le nom du plan.
Date Time : 

Affiche la date et l’heure à laquelle le plan 
a été créé et modifié pour la dernière fois.

Time Code : 
Affiche le code temporel.

Duration : 
Affiche la durée du plan.

Sequential Number : 
Affiche un numéro séquentiel sur chaque 
miniature.
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Lecture
Lorsque l’appareil est en mode de veille 
d’enregistrement (Stby), vous pouvez lire les 
plans enregistrés.

1	 Insérez la carte mémoire à lire.

2	 Appuyez sur la touche CLIPS (page 4).
L’écran des plans du support de lecture 
actif s’affiche sur le moniteur LCD.

3	 Utilisez le sélecteur multiple (page 4) 
ou la molette multifonction (page 4) 
pour déplacer le curseur vers le plan que 
vous souhaitez lire.

4	 Appuyez sur la touche de mise en 
application du sélecteur multiple ou la 
molette multifonction.
La lecture commence au début du plan 
sélectionné.

[Remarque]
L’appareil n’exécute pas la lecture continue.

Opérations de lecture

Vous pouvez contrôler la lecture en appuyant 
sur l’une des touches suivantes.
Appuyez sur la touche de mise en application 

du sélecteur multiple ou la molette 
multifonction : la lecture se met en pause. 
Appuyez de nouveau sur la molette pour 
revenir à la lecture normale.

Appuyez sur les touches gauche/droite du 
sélecteur multiple : passe au début du 
plan ou au plan précédent/suivant.

Maintenez les touches gauche/droite du 
sélecteur multiple enfoncées : lecture 
accélérée arrière/avant. Revient en lecture 
normale lorsque vous relâchez la touche.

Touche BACK : arrête la lecture et revient en 
mode de veille d’enregistrement. L’écran 
de prise de vue ou l’écran d’accueil 
s’affiche.

Pour contrôler à l’aide des touches de 
l’écran de contrôle de la lecture
Lorsque le moniteur LCD est en mode 
d’affichage d’informations, vous pouvez 
contrôler la lecture via les touches de l’écran 
de contrôle de la lecture.
Touche Play/Pause : mettre en pause la 
lecture. Pour poursuivre la lecture, appuyez à 
nouveau sur cette touche.
Touche Prev/Next : passe au début du plan ou 
au plan précédent/suivant.
Touche F Fwd/Touche F Rev : lecture accélérée 

avant/arrière. Pour revenir en mode de 
lecture normale, appuyez sur la touche 
Play/Pause.

Touche Stop/Clips : permet d’arrêter la lecture 
et de revenir à l’écran des plans.

[Conseil]
Vous pouvez également actionner des éléments 
directement à l’aide d’une opération tactile.

Surveillance de l’audio

En mode de lecture normale, vous pouvez 
contrôler l’audio enregistré grâce au haut-
parleur intégré (page 4) ou aux écouteurs 
branchés.
Lorsque les écouteurs sont branchés au 
connecteur de casque (page 4), le haut-
parleur intégré est coupé.
Vous pouvez sélectionner le canal à surveiller 
et régler le volume à l’aide de Audio Output 
>Monitor CH and Volume (page 56) dans le 
menu Audio du menu complet.

Navigation

Pour lire depuis le début d’un plan, appuyez 
sur la touche Prev sur l’écran de lecture.
Vous pouvez sauter des plans et accéder à un 
autre plan en appuyant à plusieurs reprises 
sur la touche Prev ou Next.

Sélection alternative des cartes mémoire

Lorsque deux cartes mémoire sont insérées, 
appuyez sur la touche SLOT SELECT 
(page 4) pour basculer les cartes sur 
l’écran des plans.

[Remarque]
Vous ne pouvez pas basculer entre les cartes mémoire 
lors de la lecture. La lecture continue de cartes dans les 
logements A et B est impossible.
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Connexion à d’autres dispositifs via le LAN
L’appareil peut se connecter à un smartphone, 
une tablette et d’autres dispositifs de contrôle 
via une connexion LAN, à l’aide de la fonction 
LAN de l’appareil.
L’établissement d’une connexion LAN entre 
un dispositif et l’appareil vous permet 
d’effectuer les opérations suivantes à l’aide de 
l’application « Monitor & Control ».
•• Télécommande 

Vous pouvez contrôler l’appareil à partir 
d’un smartphone ou d’une tablette 
connectés à l’appareil via un réseau LAN.

•• Transfert de fichiers 
Vous pouvez transférer un plan proxy 
(basse résolution) ou un plan original (haute 
résolution) enregistré sur une carte mémoire 
de l’appareil vers un serveur via un réseau 
LAN.

•• Surveillance vidéo 
Vous pouvez surveiller l’image de la caméra 
ou de vidéo de lecture de l’appareil à l’aide 
de l’application « Monitor & Control » sur un 
dispositif.

	 [Remarques]
•• 	La surveillance de la vidéo n’est pas prise en 

charge avec les réglages suivants.
–– Mode Slow & Quick Motion
–– Fréquence du système de 24
–– Mode Interval Rec
–– Lorsque Codec est réglé sur XAVC H-I ou XAVC 

H-L
•• Le LAN sans fil et le LAN filaire ne peuvent pas être 

utilisés en même temps sur l’appareil.

Application « Monitor & Control »

Vous pouvez utiliser cette application pour 
actionner l’appareil à distance et configurer les 
réglages de l’appareil tout en suivant la vidéo 
de l’appareil sur l’écran du dispositif.

Pour plus de détails sur l’application « Monitor & Control », 
contactez un représentant commercial ou un technicien 
Sony.

Configuration du nom d’utilisateur 
et du mot de passe

Réglez le nom d’utilisateur et le mot de passe 
de l’appareil pour utiliser la fonction réseau.

1	 Réglez Network Setup >User Name 
(page 61) dans le menu Network du 
menu complet.

2	 Réglez Network Setup >Input Password 
(page 61) dans le menu Network du 
menu complet.

	 [Conseils]
•• Vous pouvez également générer un mot de 

passe automatiquement. Exécutez Generate 
Password au lieu de Input Password.

•• Le nom d’utilisateur et le mot de passe peuvent 
être affichés sous forme de texte et de code QR 
à l’aide de Show Authentication.

	 [Remarque]
Veillez à ce que le code QR et le mot de passe 
ne puissent pas être vus par d’autres personnes. 
Spécifiquement, pendant l’enregistrement X-OCN, 
notez que la page du menu s’affiche sur un 
moniteur SDI ainsi que sur un moniteur HDMI si 
vous affichez le code QR et le mot de passe dans 
le menu complet alors que l’écran des plans est 
ouvert.

Connexion à l’aide du mode de 
point d’accès de LAN sans fil

L’appareil sert de point d’accès et se connecte 
à un dispositif de contrôle via un réseau local 
sans fil.

Smartphone/Tablette

Connexion à un dispositif compatible 
WPS

Les dispositifs qui prennent en charge le WPS 
peuvent être connectés à l’aide du WPS.

1	 Réglez Network Setup >LAN Type Select 
>WLAN (AP Mode) dans le menu Network 
du menu complet.

2	 Sélectionnez Wireless LAN >WPS >Execute 
dans le menu Network du menu complet.

3	 Ouvrez les réglages réseau ou les 
réglages Wi-Fi du dispositif et activez la 
Wi-Fi.

4	 Sélectionnez le SSID de l’appareil dans la 
liste des SSID sous Wi-Fi Network sur le 
dispositif, puis sélectionnez WPS Push 
Button sous Option pour connecter le 
dispositif.

	 [Remarques]
•• La méthode de fonctionnement diffère selon le 

dispositif.
•• Pour le SSID et le mot de passe de l’appareil, 

vérifiez AP Mode Settings >Camera SSID & 
Password (page 61) dans le menu Network du 
menu complet.

5	 Connectez-vous à l’aide de l’application 
Monitor & Control.

	 [Conseil]
Vous pouvez vérifier les informations requises pour 
la connexion à l’appareil à l’aide de Network Setup 
>Show Authentication (page 61) dans le menu 
Network du menu complet.
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Connexion par saisie d’un SSID et d’un 
mot de passe sur un dispositif

Vous pouvez connecter l’appareil à un 
dispositif en saisissant le SSID et le mot de 
passe de l’appareil sur un dispositif.

1	 Réglez Network Setup >LAN Type Select 
>WLAN (AP Mode) dans le menu Network 
du menu complet.

2	 Ouvrez les réglages réseau ou les 
réglages Wi-Fi du dispositif et activez la 
Wi-Fi.

3	 Connectez le dispositif à l’appareil en 
sélectionnant le SSID de l’appareil dans la 
liste des SSID sous Wi-Fi Network et en 
saisissant le mot de passe.
Pour le SSID et le mot de passe de 
l’appareil, vérifiez AP Mode Settings 
>Camera SSID & Password (page 61) 
dans le menu Network.

	 [Remarque]
La méthode de fonctionnement diffère selon le 
dispositif.

4	 Connectez-vous à l’aide de l’application 
Monitor & Control.

	 [Conseil]
Vous pouvez vérifier les informations requises pour 
la connexion à l’appareil à l’aide de Network Setup 
>Show Authentication (page 61) dans le menu 
Network du menu complet.

Connexion à l’aide du mode de 
station de LAN sans fil

L’appareil se connecte à un point d’accès 
existant du réseau local sans fil en tant que 
client. Le dispositif de contrôle se connecte 
par l’intermédiaire du point d’accès.
Les 10 derniers points d’accès où une 
connexion s’est produite sont affichés dans 
l’historique.
L’historique de connexion est sauvegardé 
dans un fichier ALL file mais les mots de passe 
d’accès ne sont pas enregistrés. La saisie d’un 
mot de passe sera requise à la prochaine 
connexion après le chargement du fichier ALL.

Smartphone/
Tablette

Point d’accès

Ordinateur

Connexion à un point d’accès à l’aide de 
la fonction WPS

Si le point d’accès est compatible avec la 
fonction WPS, vous pouvez vous connecter au 
point d’accès avec des réglages simples.

1	 Activez le point d’accès.

2	 Allumez l’appareil.

3	 Sélectionnez Network Setup >LAN Type 
Select >WLAN (ST Mode) dans le menu 
Network du menu complet.

4	 Sélectionnez ST Mode Settings >Camera 
Remote Control (page 61) >Enable 
dans le menu Network du menu complet.

5	 Sélectionnez Wireless LAN >WPS >Execute 
dans le menu Network du menu complet.

6	 Appuyez sur la touche WPS du point 
d’accès.
Pour les détails sur le fonctionnement de 
la touche WPS, consultez le mode 
d’emploi du point d’accès.
Une fois la connexion réussie, l’icône 
d’indicateur d’état du réseau affiche une 
puissance de 1 ou plus sur l’écran du 
moniteur LCD.

	 [Remarque]
Si la connexion échoue, recommencez toutes les 
étapes à partir de l’étape 1.

7	 Connectez le dispositif au point d’accès.
Pour plus de détails sur la connexion, 
consultez le mode d’emploi du dispositif.

8	 Lancez l’application Monitor & Control sur 
un dispositif et sélectionnez l’appareil.

	 [Conseil]
Vous pouvez vérifier les informations requises pour 
la connexion à l’appareil à l’aide de Network Setup 
>Show Authentication (page 61) dans le menu 
Network du menu complet.

Connexion à l’aide de la fonction de 
détection automatique de point d’accès

1	 Effectuez les étapes 1 à 3 dans 
« Connexion à un point d’accès à l’aide de 
la fonction WPS » (page 74).

2	 Sélectionnez ST Mode Settings >Scan 
Networks (page 62) >Execute dans le 
menu Network du menu complet.
L’appareil lance la détection des 
destinations réseau.
Les destinations possibles ayant été 
détectées s’affichent sous forme de liste.

3	 Sélectionnez une destination dans la liste.
L’écran des détails du réseau (point 
d’accès) apparaît. La connexion choisie est 
affichée dans le SSID.

4	 Sélectionnez Password et saisissez le mot 
de passe du point d’accès à connecter sur 
l’écran de saisie du mot de passe.
La sélection d’un SSID dans l’historique de 
connexion configure automatiquement 
les réglages, y compris le mot de passe.
Réglez le mot de passe pour revenir à 
l’écran des détails du réseau (point 
d’accès).

5	 Configurez les réglages de connexion 
suivants.
•• DHCP 

Définissez le réglage DHCP.  
Lorsque vous réglez sur On, l’adresse 
IP est automatiquement assignée à 
l’appareil.  
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Pour assigner manuellement l’adresse 
IP à l’appareil, réglez sur Off.

•• IP Address 
Permet de saisir l’adresse IP de l’unité.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.

•• Subnet Mask 
Permet de saisir le masque de sous-
réseau de l’unité.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.

•• Gateway 
Permet de saisir la passerelle pour le 
point d’accès.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.

•• DNS Auto 
Permet de régler s’il faut acquérir 
automatiquement ou non le DNS.  
Avec ce réglage sur On, l’adresse 
du serveur DNS est acquise 
automatiquement. Ce réglage n’est 
disponible que si DHCP est réglé sur On.

•• Primary DNS Server 
Saisissez le serveur DNS principal du 
point d’accès.  
Ce réglage n’est disponible que si DNS 
Auto est réglé sur Off.

•• Secondary DNS Server 
Saisissez le serveur DNS secondaire du 
point d’accès.  
Ce réglage n’est disponible que si DNS 
Auto est réglé sur Off.

6	 Lorsque vous avez terminé, sélectionnez 
Connect pour vous connecter au point 
d’accès.

7	 Connectez le dispositif au point d’accès.
Pour plus de détails sur la connexion, 
consultez le mode d’emploi du dispositif.

8	 Lancez l’application Monitor & Control sur 
un dispositif et sélectionnez l’appareil.

	 [Conseil]
Vous pouvez vérifier les informations requises pour 
la connexion à l’appareil à l’aide de Network Setup 
>Show Authentication (page 61) dans le menu 
Network du menu complet.

Connexion manuelle en saisissant les 
informations du point d’accès

1	 Effectuez les étapes 1 à 3 dans 
« Connexion à un point d’accès à l’aide de 
la fonction WPS » (page 74).

2	 Sélectionnez ST Mode Settings >Manual 
Register (page 62) >Execute dans le 
menu Network du menu complet.
L’écran des détails du réseau (point 
d’accès) apparaît momentanément.

3	 Configurez les réglages de connexion 
suivants.
•• SSID 

Saisissez le SSID pour le point d’accès 
de connexion.

•• Security 
Sélectionnez la méthode de cryptage.

•• Password 
Saisissez le mot de passe du point 
d’accès de connexion.

•• DHCP 
Définissez le réglage DHCP.  
Lorsque vous réglez sur On, l’adresse 
IP est automatiquement assignée à 
l’appareil.  
Pour assigner manuellement l’adresse 
IP à l’appareil, réglez sur Off.

•• IP Address 
Permet de saisir l’adresse IP de l’unité.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.

•• Subnet Mask 
Permet de saisir le masque de sous-
réseau de l’unité.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.

•• Gateway 
Permet de saisir l’adresse de passerelle.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.

•• DNS Auto 
Permet de régler s’il faut acquérir 
automatiquement ou non le DNS.  
Avec ce réglage sur On, l’adresse 
du serveur DNS est acquise 
automatiquement. Ce réglage n’est 
disponible que si DHCP est réglé sur On.

•• Primary DNS Server 
Saisissez l’adresse du serveur DNS 
principal.  
Ce réglage n’est disponible que si DNS 
Auto est réglé sur Off.

•• Secondary DNS Server 
Saisissez l’adresse du serveur DNS 
secondaire.  
Ce réglage n’est disponible que si DNS 
Auto est réglé sur Off.

4	 Lorsque vous avez terminé, sélectionnez 
Connect pour vous connecter au point 
d’accès.

5	 Connectez le dispositif au point d’accès.
Pour plus de détails sur la connexion, 
consultez le mode d’emploi du dispositif.

6	 Lancez l’application Monitor & Control sur 
un dispositif et sélectionnez l’appareil.

	 [Conseil]
Vous pouvez vérifier les informations requises pour 
la connexion à l’appareil à l’aide de Network Setup 
>Show Authentication (page 61) dans le menu 
Network du menu complet.
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Connexion à Internet
Vous pouvez connecter l’appareil à Internet à 
l’aide d’un raccordement modem USB, d’un 
LAN filaire ou d’un LAN sans fil.
Réglez le nom d’utilisateur et le mot de passe 
de l’appareil au préalable (page 73).

Connexion à l’aide d’un 
raccordement modem USB

Vous pouvez connecter l’unité à un 
smartphone via un câble USB, puis connecter 
à Internet à l’aide du smartphone.

Configuration de la communication 
smartphone

Activez la communication par raccordement 
modem sur le smartphone.
Pour plus de détails, reportez-vous au manuel 
d’utilisation du smartphone.

Fixation d’un smartphone à l’appareil

Connectez un câble USB au connecteur USB-C 
(page 5) de l’appareil, puis connectez le 
smartphone.

[Remarques]
•• Fixez/retirez le smartphone quand l’appareil est hors 

tension.
•• Le raccordement modem USB ne peut pas être utilisé 

si le smartphone est connecté via un concentrateur 
USB.

Connexion à un réseau

1	 Allumez l’appareil.

2	 Réglez USB Tethering >Setting 
(page 63) dans le menu Network du 
menu complet sur On.

Activation d’opération depuis un 
smartphone

Vous pouvez contrôler l’appareil à distance à 
l’aide de l’application Monitor & Control sur un 
smartphone connecté à l’aide d’un câble USB.

1	 Réglez USB Tethering >Camera Remote 
Control (page 63) dans le menu 
Network du menu complet sur Enable.

2	 Lancez l’application Monitor & Control sur 
un smartphone et sélectionnez l’appareil.

	 [Conseil]
Vous pouvez vérifier les informations requises 
pour la connexion à l’appareil depuis l’application 
Monitor & Control à l’aide de Network Setup >Show 
Authentication (page 61) dans le menu Network 
du menu complet.

Connexion à l’aide mode de 
station de LAN sans fil (mode 
Wi-Fi Station)

Vous pouvez connecter l’appareil à Internet 
en mode de station Wi-Fi à l’aide d’un routeur 
Wi-Fi en option ou par raccordement modem 
au Wi-Fi avec un smartphone.
Connectez-vous au routeur Wi-Fi ou au 
dispositif comme indiqué dans « Connexion 
à l’aide du mode de station de LAN sans fil » 
(page 74).

Smartphone/
Tablette

Routeur Wi-Fi

Ordinateur

Internet

Smartphone/
Tablette

Internet

Connexion à l’aide d’un câble LAN

Vous pouvez vous connecter à Internet en 
raccordant le connecteur réseau de l’appareil à 
un routeur Wi-Fi (en option) via un câble LAN.

Smartphone/
Tablette

Ordinateur

Routeur Wi-Fi

Internet



4. Réseau : Connexion à Internet77

Connexions à l’aide d’un câble LAN et 
réglages du LAN filaire

1	 Raccordez le connecteur réseau de 
l’appareil au routeur Wi-Fi à l’aide d’un 
câble LAN.

2	 Allumez l’appareil.

3	 Réglez Network Setup >LAN Type Select 
sur Wired LAN dans le menu Network du 
menu complet.

4	 Configurez les réglages de connexion à 
l’aide de Wired LAN >Detail Settings 
(page 63) dans le menu Network.
•• DHCP 

Définissez le réglage DHCP.  
Lorsque vous réglez sur On, l’adresse 
IP est automatiquement assignée à 
l’appareil.  
Pour assigner manuellement l’adresse 
IP à l’appareil, réglez sur Off.

•• IP Address 
Permet de saisir l’adresse IP de l’unité.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.

•• Subnet Mask 
Permet de saisir le masque de sous-
réseau de l’unité.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.

•• Gateway 
Permet de saisir l’adresse de passerelle.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.

•• DNS Auto 
Permet de régler s’il faut acquérir 
automatiquement ou non le DNS.  
Avec ce réglage sur On, l’adresse 
du serveur DNS est acquise 
automatiquement. Ce réglage n’est 
disponible que si DHCP est réglé sur On.

•• Primary DNS Server 
Saisissez l’adresse du serveur DNS 
principal.  
Ce réglage n’est disponible que si DNS 
Auto est réglé sur Off.

•• Secondary DNS Server 
Saisissez l’adresse du serveur DNS 
secondaire.  
Ce réglage n’est disponible que si DNS 
Auto est réglé sur Off.

5	 Lorsque vous avez terminé, sélectionnez 
Set pour appliquer les réglages.

[Remarque]
Sélectionnez toujours Set après avoir modifié les 
réglages de connexion. Les réglages ne sont pas 
appliqués si Set n’est pas sélectionné.

Activation du fonctionnement à partir 
d’un smartphone via un LAN filaire

Pour utiliser l’appareil à distance à l’aide 
de l’application Monitor & Control sur un 
smartphone via Wi-Fi en utilisant un routeur 
Wi-Fi connecté par LAN filaire, réglez Wired 
LAN >Camera Remote Control (page 63) 
dans le menu Network du menu complet sur 
Enable.
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Téléchargement de fichiers
Vous pouvez télécharger un plan proxy ou 
un plan original enregistré sur l’appareil vers 
un serveur sur Internet ou un serveur sur un 
réseau local via un smartphone ou un point 
d’accès.

Préparatifs

Connexion à un réseau

Connectez l’appareil à Internet ou au réseau 
local comme indiqué dans « Connexion à 
Internet » (page 76) ou « Connexion à 
d’autres dispositifs via le LAN » (page 73).

Enregistrement d’une destination de 
transfert de fichier

Enregistrez au préalable le serveur pour le 
téléchargement.

1	 Sélectionnez File Transfer >Server 
Settings1 (ou Server Settings2, Server 
Settings3) dans le menu Network du 
menu complet.
L’écran de configuration de la destination 
de transfert s’affiche.

2	 Réglez chaque élément sur l’écran de 
configuration de la destination de 
transfert.
Display Name
Saisissez le nom du serveur à afficher 
dans la liste de destinations de transfert.
Service
Affiche le type de serveur.
« FTP » : serveur FTP
Host Name
Saisissez l’adresse du serveur.

Port
Saisissez le numéro de port du serveur 
pour effectuer la connexion.
User Name
Saisissez le nom d’utilisateur.
Password
Saisissez le mot de passe.
Passive Mode
Activez/désactivez le mode passivité.
Destination Directory
Saisissez le nom de répertoire sur le 
serveur de destination.

	 [Remarques]
•• Les plans originaux sont téléchargés dans le 

dossier « Main » dans le répertoire spécifié 
comme destination de transfert.

•• Lors de la modification, «  » indique des 
caractères ne pouvant pas être modifiés. Le 
fonctionnement correct n’est pas garanti lors 
de la modification d’un nom de répertoire 
contenant ces caractères.  
Si la modification est nécessaire, supprimez tous 
les caractères et saisissez à nouveau une valeur.

•• Si des caractères non valides sur le serveur 
de destination sont saisis dans Destination 
Directory, les fichiers seront transférés dans le 
répertoire original de l’utilisateur. Les caractères 
non valides varient en fonction du serveur.

Using Secure Protocol
Indiquez si vous exécutez ou non le 
téléchargement sur FTP sécurisé.
Root Certificate
Chargez/effacez un certificat.
•• Load 

Sélectionnez Set à l’étape 3 pour 
importer un certificat CA.
*	 Le certificat à charger doit être au format PEM 

et doit être écrit dans le répertoire racine de 
la carte SD insérée dans le logement de carte 
Utility SD avec « certification.pem » comme 
nom de fichier.

[Conseil]
La méthode de vérification de la validation du 
certificat est OCSP. La structure du certificat est 
présentée ci-dessous.  
-----BEGIN CERTIFICATE----- 
(Votre certificat racine) 
-----END CERTIFICATE-----

•• Clear 
Sélectionnez Set à l’étape 3 pour effacer 
un certificat CA.

•• None 
Vous ne pouvez ni charger ni effacer un 
certificat.

	 [Remarques]
•• Réglez l’horloge de l’appareil sur l’heure correcte 

avant d’importer un certificat CA.
•• Lors de l’enregistrement en XAVC-I 

4096×2160P/3840×2160P, XAVC H-I HQ/SQ ou 
X-OCN, Load ne peut pas être sélectionné.

•• En état de tension faible, Load/Clear ne peut pas 
être sélectionné pour un certificat CA.

Root Certificate Status
Affiche l’état de chargement du certificat.
Reset
Réinitialisez les réglages de Server 
Settings aux réglages par défaut.

3	 Lorsque vous avez terminé, sélectionnez 
Set pour appliquer les réglages.
Sélectionnez toujours Set après avoir 
modifié les réglages. Les réglages ne sont 
pas appliqués si Set n’est pas sélectionné.

Sélection et téléchargement des 
plans

Vous pouvez télécharger des plans proxy et 
des plans originaux sur des cartes mémoire 
vers un serveur.

Téléchargement d’un plan proxy sur une 
carte mémoire à partir d’un écran des 
plans

1	 Connectez l’appareil et le dispositif à l’aide 
d’une connexion LAN (page 73).

2	 Sélectionnez Transfer Clip (Proxy) >Select 
Clip dans le menu Clip Operations du 
menu complet.
L’affichage passe du menu complet à 
l’écran des plans.
Les plans peuvent être transférés de 
l’écran des plans ou de l’écran des plans 
filtrés.

3	 Sélectionnez le plan à transférer et 
appuyez sur la touche MENU.
Un écran de confirmation de transfert 
apparaît.

4	 Sélectionnez Execute.
Le groupe de fichiers correspondant aux 
plans proxy sélectionnés est enregistré 
comme tâche de transfert et le 
téléchargement commence.
Si l’enregistrement de la tâche de transfert 
réussit, l’écran des résultats du transfert 
s’affiche.

5	 Sélectionnez OK.
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Pour transférer tous les plans
Sélectionnez All Clips au lieu de Select Clip à 
l’étape 2 pour transférer le groupe de fichiers 
correspondant à tous les plans proxy.

[Remarque]
Un maximum de 200 tâches de transfert peuvent être 
enregistrées.

Téléchargement d’un plan original sur 
une carte mémoire à partir d’un écran 
des plans

[Remarque]
Les plans originaux sont téléchargés dans le dossier 
« Main » dans le répertoire spécifié comme destination 
de transfert.

1	 Connectez l’appareil et le dispositif à l’aide 
d’une connexion LAN (page 73).

2	 Sélectionnez Transfer Clip >Select Clip 
dans le menu Clip Operations du menu 
complet.
L’affichage passe du menu complet à 
l’écran des plans.
Les plans peuvent être transférés de 
l’écran des plans ou de l’écran des plans 
filtrés.

3	 Sélectionnez le plan à transférer et 
appuyez sur la touche MENU.
Un écran de confirmation de transfert 
apparaît.

4	 Sélectionnez Execute.
Le groupe de fichiers correspondant aux 
plans sélectionnés est enregistré comme 
tâche de transfert et le téléchargement 
commence.
Si l’enregistrement de la tâche de transfert 
réussit, l’écran des résultats du transfert 
s’affiche.

5	 Sélectionnez OK.

Pour transférer tous les plans
Sélectionnez All Clips au lieu de Select Clip à 
l’étape 2 pour transférer tous les fichiers.

[Remarque]
Un maximum de 200 tâches de transfert peuvent être 
enregistrées.

Vérification du transfert de fichiers

Vous pouvez vérifier l’état du transfert de 
fichier en sélectionnant File Transfer >View Job 
List (page 63) dans le menu Network du 
menu complet.
Vous pouvez aussi vérifier l’état du transfert de 
fichier depuis l’écran de l’application Monitor 
& Control.

[Conseil]
Si File Transfer >Auto Upload (page 63) ou Auto 
Upload (Proxy) (page 63) dans le menu Network du 
menu complet est réglé sur On et qu’une connexion 
réseau existe, les plans originaux et les plans proxy sont 
automatiquement téléchargés sur le serveur spécifié 
à l’aide de Default Upload Server (page 63) à la fin 
de l’enregistrement. Si les plans originaux et les plans 
proxy sont tous deux configurés pour le téléchargement 
automatique, le téléchargement automatique des plans 
proxy est prioritaire.

[Remarques]
•• Un maximum de 200 tâches de transfert peuvent être 

enregistrées.
•• La liste des tâches est conservée lorsque l’appareil 

est mis hors tension, mais vous pouvez perdre jusqu’à 
10 minutes d’informations de progression récente si 
le pack batterie est retiré ou si l’appareil est mis hors 
tension sans avoir placé au préalable l’interrupteur 
d’alimentation sur STANDBY.

•• Les tâches ajoutées après l’état de tension faible de 
la batterie ne sont pas enregistrées dans la liste des 
tâches.

•• Si une erreur se produit lors du transfert de fichiers, 
le transfert d’un plan ayant le même nom qu’un plan 
transféré peut ne pas se poursuivre en fonction des 
paramètres et de l’état du serveur de destination du 
transfert. Si cela se produit, vérifiez les paramètres et 
l’état du serveur de destination du transfert.

Téléchargement automatique des 
plans

Téléchargement automatique des plans 
originaux

Les plans originaux peuvent être 
téléchargés sur le serveur spécifié à la fin de 
l’enregistrement. Pour activer cette fonction, 
réglez File Transfer >Auto Upload (page 63) 
dans le menu Network du menu complet sur 
On.

Téléchargement automatique des plans 
proxy

Les plans proxy peuvent être téléchargés sur 
le serveur spécifié à la fin de l’enregistrement. 
Pour activer cette fonction, réglez File Transfer 
>Auto Upload (Proxy) (page 63) dans le 
menu Network du menu complet sur On.

Téléchargement à l’aide d’un FTP 
sécurisé

Vous pouvez télécharger des fichiers cryptés 
à l’aide de FTPS en mode Explicit (FTPES) pour 
la connexion avec le serveur de fichiers de 
destination.

Réglage d’un transfert FTP sécurisé

Pour un transfert FTP sécurisé, réglez Using 
Secure Protocol dans les réglages du serveur 
du fichier de destination sur ON et importez 
un certificat.

Pour plus de détails sur la configuration, 
consultez « Enregistrement d’une destination 
de transfert de fichier » (page 78).
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Utilisation de Creators' App for enterprise
Vous pouvez facilement transférer des fichiers 
sur le service cloud C3 Portal en reliant 
l’appareil à l’application pour smartphone 
« Creators' App for enterprise ».
D’abord, créez un compte C3 Portal et 
installez Creators' App for enterprise sur un 
smartphone.
Pour plus de détails sur la création d’un 
compte de service Cloud C3 Portal, contactez 
l’administrateur de votre organisation.

[Remarques]
•• Le service peut ne pas être disponible, en fonction de 

la région où vous vivez.
•• Pour plus de détails sur l’utilisation de Creators' App 

for enterprise, consultez le Manuel d’aide de Creators' 
App for enterprise.

Téléchargement des fichiers sur C3 
Portal

1	 Sélectionnez Network Setup >Setup for 
Mobile App (page 61) dans le menu 
Network du menu complet.
Un écran de confirmation apparaît pour 
les éléments qui seront automatiquement 
mis à jour.
Les réglages suivants dans le menu 
Network sont sélectionnés 
automatiquement.
•• USB Tethering >Setting : On
•• USB Tethering >Camera Remote 

Control : Enable
•• Network Setup >Input Password : 

(généré automatiquement si non 
spécifié)

2	 Vérifiez les réglages et sélectionnez OK.
La configuration démarre. Un message 
« Now changing » apparaît pendant la 
configuration.
Lorsque la configuration est terminée, 

l’écran suivant apparaît dans le viseur.

Les informations suivantes pour 
l’authentification d’accès sont affichées.
Nom d’utilisateur, mot de passe, 
empreinte digitale, nom du modèle de 
caméra, numéro de série

	 [Conseil]
Cet écran n’est pas émis dans la sortie vidéo.

	 [Remarque]
Veillez à ce que le mot de passe ne puisse pas 
être visualisé et que l’image du code QR ne 
puisse pas être copiée par d’autres personnes. 
Spécifiquement, pendant l’enregistrement X-OCN, 
notez que la page du menu s’affiche sur un 
moniteur SDI ainsi que sur un moniteur HDMI si 
vous affichez le code QR et le mot de passe dans 
le menu complet alors que l’écran des plans est 
ouvert.

3	 Lancez Creators' App for enterprise sur le 
smartphone et connectez-vous au service 
Cloud.

4	 Connectez le smartphone via un câble 
USB au connecteur USB-C de l’appareil.

5	 Activez le raccordement modem USB sur 
l’écran du smartphone.
Pour plus de détails sur la configuration, 
consultez « Connexion à l’aide d’un 
raccordement modem USB » (page 76).
L’opération diffère en fonction de votre 
smartphone. Reportez-vous au manuel 
d’utilisation du smartphone.

6	 Scannez le code QR dans le viseur 
conformément aux instructions sur l’écran 
de Creators' App for enterprise.
Les informations de configuration du 
transfert de fichiers sont envoyées du 
smartphone à l’appareil et le message 
suivant apparaît.

7	 Sélectionnez OK.
Les informations de configuration 
commencent à charger.
Lorsque la configuration est chargée avec 
succès, un message « Network File 
loaded. » apparaît.

[Remarques]
•• Creators' App for enterprise écrase le réglage File 

Transfer (page 63) dans le menu Network de 
l’appareil.

•• Root Certificate ne peut pas être réglé 
automatiquement. Configurez-le manuellement.

Téléchargement des plans originaux

Réglez File Transfer >Auto Upload (page 63) 
dans le menu Network sur On pour activer le 
téléchargement des plans originaux sur C3 
Portal.
Chaque fois qu’un enregistrement se termine, 
le fichier est téléchargé sur l’emplacement 
associé à votre compte C3 Portal.

Téléchargement des plans proxy

Réglez File Transfer >Auto Upload (Proxy) 
(page 63) dans le menu Network sur On 
pour activer le téléchargement des plans 
proxy sur C3 Portal.
Chaque fois qu’un enregistrement se termine, 
le fichier est téléchargé sur l’emplacement 
associé à votre compte C3 Portal.

Téléchargement des plans sélectionnés

Consultez « Sélection et téléchargement des 
plans » (page 78).

[Conseils]
•• Les fichiers envoyés par l’appareil sont mis en cache 

dans Creators' App for enterprise et transférés dans 
C3 Portal. L’affichage d’état du transfert de fichiers sur 
l’appareil indique l’état de transfert de Creators' App 
for enterprise.

•• Lorsque le transfert de fichiers de l’appareil sur 
Creators' App for enterprise sur le smartphone est 
terminé, vous pouvez mettre l’appareil hors tension, 
mais notez que le transfert de fichiers depuis le 
smartphone peut encore continuer. Soyez attentif à la 
charge restante de la batterie sur le smartphone.

Autres fonctions qui utilisent C3 
Portal

Gestion des fichiers 3D LUT

Vous pouvez importer des fichiers 3D LUT 
stockés dans C3 Portal vers l’appareil. 
Consultez « Importation depuis un service 
Cloud » (page 85).

Gestion de fichiers ALL

Vous pouvez enregistrer un fichier ALL créé 
par l’appareil dans C3 Portal et charger 
un fichier ALL depuis C3 Portal. Consultez 
« Enregistrement d’un fichier ALL sur un 
service Cloud » (page 67) et « Chargement 
d’un fichier ALL depuis un service Cloud » 
(page 67).
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Configuration des opérations de base
Avant la prise de vue, configurez les 
opérations de base de l’appareil dans l’écran 
d’état Project pour les adapter à l’application.

Mode de prise de vue

Vous pouvez commuter le mode de prise de 
vue entre « Cine EI », où l’appareil fonctionne 
comme une caméra de film, avec des images 
qui seront développées en post-production, et 
« Custom » pour créer librement des images 
sur place.
Configurez le mode de prise de vue à l’aide de 
Shooting Mode (page 28) sur l’écran d’état 
Project.

[Conseil]
Vous pouvez également configurer le mode de prise 
de vue à l’aide de Base Setting >Shooting Mode 
(page 43) dans le menu Project du menu complet.

Cine EI

Lorsque vous réglez le mode de prise de vue 
sur Cine EI, sélectionnez la gamme de couleurs 
de base pour le signal d’enregistrement et 
le signal de sortie. La gamme de couleurs 
sélectionnée ici représente la gamme de 
couleurs de la vidéo enregistrée et de la sortie 
vidéo lorsque le LUT du moniteur est réglé sur 
Off.
Vous pouvez configurer la gamme de couleurs 
à l’aide de Cine EI Setting >Color Gamut 
(page 44) dans le menu Project du menu 
complet.
•• S-Gamut3.Cine/SLog3 : gamme de couleurs 

facile à ajuster pour le mode de cinéma 
numérique (DCI-P3).

•• S-Gamut3/SLog3 : large gamme de couleurs 
Sony qui couvre la gamme de couleurs 
ITU-R BT.2020.

Pour plus de détails, consultez page 85.

[Remarques]
•• Le mode de prise de vue Cine EI comporte les limites 

suivantes.
•• Fonctions ne pouvant pas être ajustées 

automatiquement (suivi)
–– Balance des blancs
–– Gain
–– Obturateur

•• Fonctions ne pouvant pas être configurées
–– Sensibilité ISO/gain (réglé sur la sensibilité ISO 

de base (fixe))
–– Réglages du menu Paint/Look (à l’exclusion de 

Base Look)
–– Scene File (désactivé)

•• Les fonctions suivantes sont uniquement disponibles 
en mode de prise de vue Cine EI (page 85).

•• Exposure Index
•• Monitor LUT

•• Lors de l’enregistrement en mode Cine EI, il est 
recommandé de maintenir le réglage Exposure Index 
constant. Si vous modifiez le réglage Exposure Index, 
la correction de la luminosité peut être très difficile 
à réaliser en post-production, ce qui peut rendre 
impossible la reproduction de l’état dans lequel 
l’image a été filmée à l’origine.

Custom

Lorsque le mode de prise de vue est réglé sur 
Custom, vous pouvez sélectionner la norme 
vidéo.
Vous pouvez configurer la norme vidéo à l’aide 
de Base Setting >Target Display (page 43) 
dans le menu Project du menu complet.
•• SDR(BT.709) : prise de vue conforme à la 

norme de diffusion HD
•• HDR(HLG) : prise de vue conforme à la 

norme de diffusion 4K nouvelle génération
Pour plus de détails, consultez page 87.

Fréquence du système

Configurez la fréquence du système à l’aide 
de Frequency/Scan (page 28) sur l’écran 
d’état Project. L’appareil peut redémarrer 
automatiquement après avoir commuté, selon 
la valeur sélectionnée.

[Conseil]
Vous pouvez également configurer la fréquence du 
système à l’aide de Rec Format >Frequency (page 43) 
dans le menu Project du menu complet.

[Remarque]
Vous ne pouvez pas commuter la fréquence du système 
pendant l’enregistrement ou la lecture.

Mode de numérisation par 
imageur

Vous pouvez régler la taille d’image effective 
et la résolution du capteur d’image.
Configurez le mode de numérisation à l’aide 
de Imager Scan (page 28) sur l’écran d’état 
Project.
•• FF 8.6K 16:9, FF 8.6K 17:9, FFc 6K 16:9, FFc 6K 

17:9 : à utiliser pour le plein format.
•• S35 5.8K 16:9, S35 5.8K 17:9, S35c 4K 17:9 : à 

utiliser pour le format Super 35mm.

[Conseil]
Vous pouvez également configurer le mode de 
numérisation à l’aide de Rec Format >Imager Scan Mode 
(page 43) dans le menu Project du menu complet.

[Remarque]
Vous ne pouvez pas commuter le mode Imager Scan 
pendant l’enregistrement ou la lecture.
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Taille d’image effective

L’appareil prend en charge la prise de vue dans les tailles d’image effective suivantes. (Unité : 
mm)

FF 8.6K 16:9
(35.9x20.2)

FF 8.6K 17:9
(35.9x18.9)

FFc 6K 16:9
(33.6x18.9) 

FFc 6K 17:9
(33.6x17.7) 

S35 5.8K 16:9
(24.0x13.5)

S35 5.8K 17:9
(24.0x12.6)

S35c 4K 17:9
(17.0x9.0)

Codec

Configurez le codec à l’aide de Codec 
(page 28) sur l’écran d’état Project. 
L’appareil peut redémarrer automatiquement 
après avoir commuté, selon la valeur 
sélectionnée.

[Conseil]
Vous pouvez également configurer le codec à l’aide de 
Rec Format >Codec (page 43) dans le menu Project 
du menu complet.

[Remarques]
•• Vous ne pouvez pas commuter le codec pendant 

l’enregistrement ou la lecture.
•• 	L’appareil redémarre lorsque vous commutez sur ou 

depuis X-OCN ou XAVC.
•• 	Le format X-OCN inclut des limitations pour le signal 

de sortie vidéo. Pour plus de détails, consultez 
page 112.

•• Pour basculer sur X-OCN, vous devez d’abord régler le 
mode de prise de vue sur Cine EI.

Format vidéo

Vous pouvez régler le format vidéo pour 
l’enregistrement. Configurez le format vidéo à 
l’aide de Video Format (page 28) sur l’écran 
d’état Project.

[Conseil]
Vous pouvez également configurer le format vidéo à 
l’aide de Rec Format >Video Format (page 43) dans le 
menu Project du menu complet.

[Remarques]
•• 	Impossible à configurer avec le format X-OCN.
•• Vous ne pouvez pas commuter le format vidéo 

pendant l’enregistrement ou la lecture.
•• Des restrictions peuvent s’appliquer au signal des 

connecteurs SDI OUT et HDMI OUT, selon le réglage 
du format vidéo.
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Procédure d’opération de base
La prise de vue de base s’effectue à l’aide de 
la procédure suivante.

1	 Connectez les dispositifs nécessaires et 
vérifiez que l’alimentation est branchée.

2	 Insérez la/les carte(s) mémoire.

	 [Remarque]
Avant la prise de vue, effectuez une sauvegarde 
des plans puis formatez complètement le support 
à l’aide de Format Media (page 51) dans le 
menu TC/Media du menu complet.

3	 Allumez l’appareil.
Le témoin d’alimentation s’allume et 
l’image de la caméra apparaît sur le 
moniteur LCD.

4	 Appuyez sur la touche REC (démarrer/
arrêter l’enregistrement) (page 4).
Le témoin REC s’allume et 
l’enregistrement commence.

5	 Pour arrêter l’enregistrement, appuyez à 
nouveau sur la touche REC (démarrer/
arrêter l’enregistrement).
L’enregistrement s’arrête et l’appareil 
passe en mode STBY (veille 
d’enregistrement).

[Remarque]
Si la touche REC (démarrer/arrêter l’enregistrement) est 
actionné dans les quelques secondes suivant la mise 
sous tension de l’appareil, le témoin REC s’allume pour 
indiquer que l’appareil est en état d’enregistrement, 
mais l’enregistrement sur le support peut ne pas se 
déclencher pour les premières secondes, en fonction du 
format d’enregistrement sélectionné.

Sélection alternative des cartes 
mémoire

Lorsque deux cartes mémoire sont chargées, 
appuyez sur la touche SLOT SELECT 
(page 4) pour passer d’une carte à l’autre.
L’enregistrement passe automatiquement 
à la seconde carte mémoire juste avant que 
la capacité restante sur la première carte 
atteigne zéro (enregistrement relais). Lorsque 
vous basculez d’une carte mémoire à l’autre, 
vous pouvez poursuivre l’enregistrement 
continu en remplaçant la carte mémoire pleine 
par une nouvelle.

[Remarque]
Vous ne pouvez pas passer d’une carte mémoire à 
l’autre en mode de lecture. En outre, la lecture continue 
d’un plan situé sur plusieurs supports dans le logement 
A et le logement B n’est pas prise en charge.

Plans (données enregistrées)
Quand vous cessez l’enregistrement, la vidéo, 
l’audio et les données correspondantes 
du début à la fin de l’enregistrement sont 
sauvegardés sous forme de « plan » unique 
sur une carte mémoire.

Noms de plans
Le nom de chaque plan enregistré avec 
l’appareil est attribué automatiquement à 
l’aide du format réglé sous Clip Name Format 
(page 51) du menu TC/Media du menu 
complet.

Durée maximum d’un plan
Jusqu’à 6 heures par plan.
La durée maximum d’un enregistrement 
continu est identique à la durée maximum 
d’un plan. Si la durée d’enregistrement 
dépasse la durée maximum d’un plan, un 
nouveau plan est créé automatiquement et 
l’enregistrement se poursuit. Le nouveau plan 
apparaît comme un plan séparé sur l’écran des 
plans.

Les plans multiples sont enregistrés 
successivement pendant l’enregistrement 
relais, mais l’enregistrement s’arrête 
automatiquement après environ 24 heures.

[Remarques]
•• N’éjectez pas une carte mémoire pendant que des 

données y sont en cours d’enregistrement. Lors de 
l’enregistrement, remplacez uniquement les cartes 
mémoire des logements pour lesquels l’indicateur 
d’accès de logement est éteint.

•• Quand la capacité restante sur la carte mémoire en 
cours d’enregistrement descend au-dessous d’une 
minute et qu’une carte mémoire enregistrable est 
insérée dans l’autre logement, un message « Will 
Switch Slots Soon » s’affiche. Le message disparaît 
après l’échange de logement de carte mémoire.

•• L’enregistrement relais peut ne pas fonctionner 
si l’enregistrement est lancé alors que la capacité 
restante de la carte mémoire est inférieure à une 
minute. Pour un enregistrement relais correct, 
vérifiez que la capacité restante de la carte mémoire 
est supérieure à une minute avant de commencer 
l’enregistrement.

•• Une vidéo créée à l’aide de la fonction 
d’enregistrement relais de l’appareil ne peut pas être 
lue sans interruption sur l’appareil.

•• Pour combiner la vidéo créée en utilisant la fonction 
d’enregistrement relais de l’appareil, utilisez le logiciel 
« Catalyst Browse ».

Surveillance de l’audio

Vous pouvez surveiller l’audio en cours 
d’enregistrement grâce au casque.
En connectant un casque sur la prise 
casque (page 4), vous pourrez surveiller 
l’audio qui est en cours d’enregistrement. 
Vous pouvez également surveiller l’audio 
lu (page 72) en utilisant le haut-parleur 
intégré (page 4) ou le casque.
Vous pouvez régler le volume de l’audio à 
surveiller à l’aide de Volume (page 28) 
sur l’écran d’état Audio ou de Audio Output 
>Volume (page 56) dans le menu Audio du 
menu complet.
Vous pouvez sélectionner le canal à surveiller 
à l’aide de Monitor CH (page 28) sur l’écran 
d’état Audio ou de Audio Output >Monitor CH 
(page 56) dans le menu Audio du menu 
complet.

Spécification des données 
temporelles

Réglage du code temporel

Réglez le code temporel pour enregistrer en 
utilisant Timecode (page 51) dans le menu 
TC/Media du menu complet.

Réglage des bits utilisateur

Vous pouvez ajouter un nombre hexadécimal 
à 8 chiffres à l’image enregistrée en tant que 
bits utilisateur. Vous pouvez également régler 
les bits utilisateur sur l’heure actuelle. Réglez 
à l’aide de Users Bit (page 51) dans le menu 
TC/Media.
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Affichage des données temporelles

Réglez le code temporel à afficher à l’aide de 
TC Display (page 51) >Display Select dans le 
menu TC/Media.
L’activation d’une touche personnalisable 
(page 101) à laquelle DURATION/TC/U-BIT 
est assigné commute l’affichage entre le code 
temporel, les bits d’utilisateur et la durée, dans 
l’ordre.

Commutation de l’entrée/sortie de code 
temporel

Vous pouvez commuter l’entrée/la sortie de 
code temporel en utilisant le commutateur de 
sélection TC/REF IN/OUT (page 5).
Pour plus de détails, consultez page 108.

Passage en revue de 
l’enregistrement (Rec Review)

Vous pouvez revoir le dernier plan enregistré 
sur l’écran (révision d’enregistrement).

[Remarque]
Rec Review n’est pas pris en charge si le format vidéo 
est modifié après l’enregistrement d’un plan.

Méthode de révision d’enregistrement

Attribuez au préalable Rec Review à l’une des 
touches personnalisables.
Quand l’enregistrement est arrêté, appuyez 
sur la touche personnalisable (page 101) à 
laquelle Rec Review est assigné. La lecture du 
dernier plan enregistré commence.
Le plan est lu jusqu’à la fin, Rec Review prend 
fin et l’appareil revient en mode STBY (veille).

Pour arrêter Rec Review

Appuyez sur la touche personnalisable à 
laquelle Rec Review est attribué ou appuyez 
sur la touche BACK.

Réglages de la révision 
d’enregistrement

Vous pouvez configurer la position de départ 
de la lecture sur l’un des paramètres suivants 
à l’aide du réglage Rec Review (page 58) du 
menu Technical.
•• Les 3 dernières secondes du plan
•• Les 10 dernières secondes du plan
•• Début du plan

[Conseil]
Si vous souhaitez examiner un plan spécifique après 
avoir enregistré plusieurs plans, appuyez sur la touche 
CLIPS pour afficher l’écran des plans et sélectionnez le 
plan pour lancer la lecture.
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Prise de vue avec réglage d’apparence en post-production
Lorsque vous utilisez l’appareil en mode Cine 
EI et enregistrez uniformément les gradations 
des zones sombres aux zones lumineuses, 
vous pouvez effectuer des réglages précis, par 
exemple restaurer localement les gradations 
des zones sombres et des zones lumineuses, 
en post-production.
Toutefois, lorsque vous visionnez les images 
enregistrées sur un moniteur classique, 
le contraste d’ensemble est faible, ce qui 
complique les réglages de mise au point et 
d’exposition.
Vous pouvez appliquer un LUT à la cible de 
moniteur sur l’appareil pour faciliter divers 
réglages lors de la prise de vue. Vous pouvez 
aussi appliquer un LUT à la vidéo de lecture 
pour vérifier le résultat final.
Les LUT sont appliqués par les systèmes 
suivants. Cependant, vous ne pouvez 
appliquer qu’un seul LUT.
•• Pendant l’enregistrement X-OCN :

–– Sortie SDI ou sortie HDMI (une seule 
sortie)

–– Moniteur LCD, proxy, streaming
•• Autre que l’enregistrement X-OCN :

–– Sortie SDI
–– Sortie HDMI, moniteur LCD, proxy et 
streaming

Application d’un LUT à l’image du 
moniteur LCD

1	 Appuyez sur la touche MENU pour afficher 
l’écran d’état Monitoring.

2	 Sélectionnez la colonne Gamut/Gamma 
dans la rangée LCD/Stream.

3	 Sélectionnez On ou Off.

[Remarques]
•• Le réglage LUT On/Off du moniteur LCD est 

également appliqué aux fichiers proxy et à la vidéo 
en continu pendant l’enregistrement X-OCN. Pour 
tout format autre que l’enregistrement X-OCN, cela 
s’applique aussi à la sortie HDMI, aux fichiers proxy et 
à la vidéo en continu.

•• L’assistance à l’affichage gamma est disponible lors 
de l’utilisation de la loupe de mise au point.

[Conseils]
•• Vous pouvez aussi régler LUT à l’aide de LUT On/

Off (page 41) dans le menu Shooting du menu 
complet.

•• Vous pouvez configurer SDI/HDMI de la même 
manière que le moniteur LCD.

Modification d’un LUT

1	 Appuyez sur la touche MENU pour afficher 
l’écran d’état Monitoring.

2	 Sélectionnez le champ Base Look/LUT.

3	 Sélectionnez le LUT à appliquer dans la 
liste des apparences de base.

[Conseils]
•• L’appareil fournit s709, 709(800%), S-Log3, Warm, 

Cool, Vintage, Teal and Orange, ACESproxy, ACEScct et 
ACES 1.0 Output-Rec.709 comme LUT prédéfinis.

•• Vous pouvez aussi importer et appliquer un fichier 
3D LUT. Pour plus de détails, consultez « Importation 
d’une apparence de base souhaitée » (page 85) 
et « Suppression d’une apparence de base » 
(page 86).

•• L’apparence de base peut également être réglée à 
l’aide de Base Look >Select (page 49) dans le menu 
Paint/Look du menu complet.

Importation d’une apparence de 
base souhaitée

Vous pouvez importer un fichier 3D LUT, créé 
sur un ordinateur ou un autre appareil, comme 
apparence de base depuis une carte mémoire 
ou un service Cloud. Jusqu’à 16 fichiers 
peuvent être importés.
•• Format de fichier : fichier CUBE (*.cube) pour 

un LUT 17 grid ou 33 grid 3D créé via Catalyst 
Browse ou RAW Viewer

•• Gamme de couleurs d’entrée/gamma : 
S-Gamut3.Cine/S-Log3 ou S-Gamut3/S-
Log3

Importation depuis une carte mémoire

Vous pouvez importer un fichier 3D LUT depuis 
une carte mémoire.

1	 Sur l’ordinateur ou l’autre appareil, 
enregistrez le fichier 3D LUT dans le 
dossier spécifié ou sur le support 
d’enregistrement.

Support 
d’enregistrement

Chemin d’accès

Carte SD /PRIVATE/SONY/PRO/LUT/

2	 Insérez le support d’enregistrement sur 
lequel les fichiers 3D LUT sont enregistrés 
dans le logement de carte SD Utility.

3	 Sélectionnez Base Look >Import from 
Utility SD (page 49) dans le menu 
Paint/Look du menu complet.

4	 Sélectionnez une destination 
d’importation.

5	 Sélectionnez un fichier 3D LUT à importer.
Suivez les instructions qui s’affichent à 
l’écran. L’appareil gère un fichier 3D LUT 
comme une apparence de base.

6	 Sélectionnez le fichier 3D LUT importé à 
l’aide de Base Look >Select (page 49) 
dans le menu Paint/Look du menu 
complet.

7	 Configurez Base Look >Input et Output 
(page 49) dans le menu Paint/Look du 
menu complet pour qu’il corresponde aux 
attributs du fichier 3D LUT importé.

Importation depuis un service Cloud

Vous pouvez importer un fichier 3D LUT depuis 
un service Cloud.

1	 Connectez-vous à l’appareil depuis 
l’application pour smartphone « Creators' 
App for enterprise » (page 80).

2	 Sélectionnez Base Look >Import from 
Cloud(Private) ou Import from 
Cloud(Share) (page 49) dans le menu 
Paint/Look du menu complet.

3	 Sélectionnez une destination 
d’importation.
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4	 Sélectionnez un fichier 3D LUT à importer.
Suivez les instructions qui s’affichent à 
l’écran. L’appareil gère un fichier 3D LUT 
comme une apparence de base.

5	 Sélectionnez le fichier 3D LUT importé à 
l’aide de Base Look >Select (page 49) 
dans le menu Paint/Look du menu 
complet.

6	 Configurez Base Look >Input et Output 
(page 49) dans le menu Paint/Look du 
menu complet pour qu’il corresponde aux 
attributs du fichier 3D LUT importé.

Réglage pour la sous-exposition

Si vous constatez une tendance à la sous-
exposition lorsque l’exposition automatique 
est sélectionnée alors que vous utilisez 
l’apparence de base importée, réglez Base 
Look >AE Level Offset (page 49) dans le 
menu Paint/Look.

[Remarques]
•• L’importation d’un fichier 3D LUT n’affecte pas 

l’image. Chargez le fichier 3D LUT importé à l’aide de 
Base Look >Select (page 49) dans le menu Paint/
Look du menu complet.

•• Si vous ne réglez pas correctement Input, vous 
n’obtiendrez pas l’apparence appropriée.

•• Les réglages des éléments de menu Input, Output 
et AE Level Offset sont appliqués à l’apparence de 
base sélectionnée à l’aide de Select. Si vous importez 
plusieurs fichiers 3D LUT, sélectionnez Select pour 
chaque fichier 3D LUT, puis configurez Input, Output 
et AE Level Offset individuellement pour chaque 
fichier.

•• Les réglages Input, Output et AE Level Offset 
configurés sont enregistrés pour chaque fichier 3D 
LUT.

•• Les options de sélection d’apparence de base/LUT 
pour les fichiers 3D LUT importés sont communes aux 
modes Custom/Cine EI, mais la conversion de gamme 
de couleurs et gamma n’est pas effectuée en fonction 
de ces modes.

•• Les fichiers 3D LUT ne sont pas supprimés lorsque All 
Reset >Reset est exécuté dans le menu Maintenance 
du menu complet.

Suppression d’une apparence de 
base

Vous pouvez supprimer un fichier 3D LUT 
importé à l’aide de Base Look >Delete 
(page 49) dans le menu Paint/Look du 
menu complet.
Vous pouvez supprimer tous les fichiers 3D 
LUT importés à l’aide de Base Look >Delete 
All (page 49) dans le menu Paint/Look du 
menu complet.

[Remarques]
•• Avant de supprimer, vérifiez que l’apparence de 

base n’est pas utilisée par un fichier de scène. Si 
vous supprimez une apparence de base en cours 
d’utilisation, l’apparence des fichiers de scène 
correspondants sera incorrecte.

•• Une apparence de base supprimée ne peut plus être 
utilisée en mode Custom (page 85).

•• Les fichiers 3D LUT importés ne sont pas supprimés 
lorsque vous sélectionnez All Reset >Reset 
(page 65) dans le menu Maintenance du menu 
complet.

Enregistrement d’un fichier 3D 
LUT en tant que métadonnées

Vous pouvez enregistrer un fichier 3D LUT 
(fichier CUBE) qui est appliqué à l’image du 
moniteur lors de la prise de vue en tant que 
métadonnées pour le plan.
Pour activer cette fonction, réglez Cine EI 
Setting >Embed LUT File (page 44) dans le 
menu Project du menu complet sur On.
Le fichier 3D LUT (fichier CUBE) sélectionné au 
début de l’enregistrement est enregistré en 
tant que métadonnées.
Cependant, l’enregistrement en tant que 
métadonnées n’est pas possible dans les 
circonstances suivantes.
•• Lorsque vous ne pouvez pas enregistrer un 

fichier 3D LUT (fichier CUBE) sur la caméra, 
par exemple parce que la taille du fichier 3D 
LUT importé dépasse 1,25 Mo (« ! » s’affiche 
devant le nom du fichier lorsque Base Look 
est sélectionné)

•• Lorsqu’un fichier 3D LUT pouvant être 
enregistré est sélectionné, mais que les 
données LUT à utiliser sont modifiées et que 
l’enregistrement démarre immédiatement

[Remarques]
•• Un seul élément de métadonnées peut être enregistré 

par plan.
•• Pendant l’enregistrement X-OCN, l’enregistrement 

d’un fichier 3D LUT en tant que métadonnées n’est 
pas pris en charge.
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Prise de vue avec l’apparence souhaitée (Look)
Lorsque l’appareil est en mode Custom, 
vous pouvez ajouter des réglages de noir, de 
matrice et d’autres paramètres pour créer une 
« apparence » basée sur l’apparence de base.

Apparence 
de base

Apparence Noir

:

Matrice

De plus, vous pouvez sélectionner rapidement 
une autre apparence en enregistrant 
différentes combinaisons de réglages dans 
des fichiers de scène.
L’appareil est fourni avec six apparences 
prédéfinies au total.

Sélection d’une apparence

1	 Lorsque l’écran de prise de vue s’affiche, 
appuyez sur la molette multifonction.

2	 Sélectionnez l’icône  (fichier de scène).
Le numéro indiqué dans l’icône est le 
numéro de fichier.

3	 Appuyez sur la molette multifonction.

4	 Sélectionnez l’apparence souhaitée dans 
le menu et appuyez sur la molette 
multifonction.

[Conseils]
•• Les préréglages suivants sont configurés par défaut.

Shooting Mode Custom

Target Display SDR(BT.709) HDR(HLG)

Fichier de scène 1 S-Cinetone HLG Live

Shooting Mode Custom

Target Display SDR(BT.709) HDR(HLG)

Fichier de scène 2 Standard HLG Natural

Fichier de scène 3 Still (Non 

enregistré)

Fichier de scène 4 ITU709 (Non 

enregistré)

Fichiers de scène 5 à 

16

(Non 

enregistré)

(Non 

enregistré)

•• Vous pouvez aussi sélectionner une apparence à 
l’aide de Scene File >Recall (page 49) dans le 
menu Paint/Look du menu complet. Vous pouvez 
également rappeler une apparence prédéfinie à l’aide 
de Scene File >Preset Recall.

Personnalisation d’une apparence

Si vous souhaitez effectuer une prise de 
vue avec une autre apparence que celles 
prédéfinies, vous pouvez personnaliser 
une apparence d’après n’importe quelle 
apparence de base à l’aide des éléments 
Black, Knee, Detail, Matrix et Multi Matrix du 
menu Paint/Look dans le menu complet. Pour 
plus d’informations sur chaque élément de 
configuration, consultez page 49.
Raccordez l’appareil à un téléviseur ou à un 
moniteur, puis réglez la qualité d’image tout 
en observant l’image sur le téléviseur ou le 
moniteur.

[Remarque]
Lorsque vous importez un fichier 3D LUT et l’appliquez à 
l’image, l’apparence souhaitée définie dans le fichier 3D 
LUT n’est pas obtenue si Matrix et des réglages autres 
que les réglages d’apparence de base sont modifiés 
dans le menu Paint/Look. Vous pouvez réinitialiser 
tous les réglages personnalisés à l’aide de Reset Paint 
Settings >Reset without Base Look (page 49) dans le 
menu Paint/Look du menu complet.

Enregistrement d’une apparence

Vous pouvez enregistrer l’apparence 
actuelle en tant que fichier de scène dans la 
mémoire interne à l’aide de Scene File >Store 
(page 49) dans le menu Paint/Look du 
menu complet.
Vous pouvez enregistrer rapidement à l’aide 
d’opérations dans le menu direct depuis 
l’écran de prise de vue.

[Remarques]
•• Si vous sélectionnez une autre apparence sans 

enregistrer l’apparence actuelle, l’apparence actuelle 
est supprimée.

•• Les fichiers de scène ne sont pas supprimés lorsque 
All Reset >Reset (page 65) est exécuté dans le 
menu Maintenance du menu complet.

[Conseil]
Vous pouvez écraser les fichiers de scène prédéfinis.
Pour restaurer un fichier de scène prédéfini, chargez 
l’apparence à restaurer à l’aide de Scene File >Preset 
Recall (page 49) dans le menu Paint/Look du menu 
complet, puis enregistrez le fichier de scène à l’aide de 
Scene File >Store.

Suppression d’une apparence 
enregistrée

Vous pouvez supprimer un fichier de scène 
enregistré dans la mémoire interne à l’aide de 
Scene File >Delete (page 49) dans le menu 
Paint/Look du menu complet.

[Conseil]
Lorsque vous supprimez une apparence, elle n’apparaît 
plus dans le menu direct.
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Réglage du zoom
Vous pouvez régler le zoom selon les 
conditions de prise de vue.

Lorsqu’un objectif zoom motorisé à monture 
E est fixé, vous pouvez régler le zoom à l’aide 
du levier de zoom sur la télécommande de 
poignée ou sur une poignée (en option) 
équipée d’une griffe MI. La vitesse du zoom 
varie selon la pression appliquée au levier.
Le caméscope est équipé d’une fonction 
de zoom qui utilise un traitement de signal 
d’image appelé Clear Image Zoom. Lorsque 
Clear Image Zoom est activé, le zoom est pris 
en charge même pour des objectifs à distance 
focale fixe (c’est-à-dire à focale fixe). Vous 
pouvez l’utiliser pour étendre la plage au-
delà de la plage optique sur un objectif zoom 
motorisé.
Le rapport de zoom maximal avec Clear 
Image Zoom varie selon la résolution 
d’enregistrement.
•• Pour la résolution d’enregistrement 

QFHD/4K : 1.5×
•• Pour la résolution d’enregistrement HD : 2×

[Remarques]
•• Vous ne pouvez utiliser Clear Image Zoom que 

lorsque le mode de numérisation par imageur 
(page 81) est réglé sur S35.

•• Lorsqu’un objectif à monture PL est fixé, l’utilisation 
du zoom optique à l’aide du levier de zoom n’est pas 
prise en charge. Clear Image Zoom est pris en charge.

Sélection du type de zoom

Configurez le type de zoom à l’aide de Zoom 
>Zoom Type (page 58) dans le menu 
Technical du menu complet.
Le type de zoom peut varier selon le type de 
l’objectif utilisé.

Objectif 
utilisé

Réglage du Zoom Type

Optical Zoom 
Only

On(Clear Image 
Zoom)

Objectif à 
longueur 
focale 
fixe/
Objectif à 
zoom 
manuel

L’utilisation du 
zoom à l’aide du 
levier n’est pas 
prise en charge.

Clear Image 
Zoom est pris en 
charge.

Objectif 
zoom 
motorisé

Zoom optique 
seulement

Zoom optique et 
Clear Image 
Zoom sont pris 
en charge.

[Remarques]
•• Clear Image Zoom n’est pas disponible lorsque S&Q 

Motion >Frame Rate (page 41) dépasse 60fps dans 
le menu Shooting du menu complet.

•• L’utilisation du commutateur de sélection SERVO/
MANUAL sur un objectif réinitialise l’agrandissement 
de Clear Image Zoom sur 1×.

Réglage du zoom de la poignée

Définissez le réglage du levier de zoom d’une 
poignée (en option) équipée d’une griffe MI 
à l’aide de Handle Zoom (page 58) dans le 
menu Technical du menu complet.

Réglage du sens de la bague de 
zoom

Sur certains objectifs à monture E, le sens 
de rotation de la bague de zoom peut être 
inversé.
Configurez le sens de rotation à l’aide de Lens 
>Zoom Ring Direction (page 59) dans le 
menu Technical du menu complet.
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Réglage de la mise au point
Vous pouvez régler automatiquement ou 
manuellement la mise au point, selon les 
conditions de prise de vue.

[Remarques]
•• Lorsqu’un objectif à monture PL est fixé, l’utilisation 

de la mise au point depuis l’appareil et la 
télécommande de poignée n’est pas prise en charge.

•• Lorsque le moniteur LCD est en mode d’affichage 
d’informations, vous ne pouvez pas utiliser l’écran 
affiché sur un moniteur externe en utilisant le 
sélecteur multiple sur le moniteur LCD.

Réglage manuel de la mise au 
point (Manual Focus)

Pour ajuster manuellement la mise au point, 
réglez le commutateur FOCUS (page 4) sur 
la position « MF ».
Ceci vous permet d’ajuster manuellement la 
mise au point en fonction des conditions de 
prise de vue.
La mise au point manuelle est utile pour les 
types suivants de sujets.
•• Sujets de l’autre côté d’une fenêtre couverte 

de gouttelettes d’eau
•• Sujets avec un contraste faible par rapport à 

l’arrière-plan
•• Sujets plus éloignés que les sujets proches

[Conseils]
•• Une mise au point stable peut être maintenue en 

attendant au moins 10 minutes après la mise sous 
tension de l’appareil avant d’ajuster la mise au point. 
De plus, si la température ambiante change de 
manière significative, vous pouvez maintenir des 
conditions de prise de vue optimales en refaisant la 
mise au point.

•• Vous pouvez aussi utiliser la mise au point 
automatique dans les cas suivants lorsque le réglage 
manuel est la méthode principale d’utilisation.
–– Lorsque la sensibilité de changement de sujet AF 

est réglée sur 1(Locked)
–– Lorsque le commutateur FOCUS est réglé sur la 

position « AF »
–– Lorsque vous utilisez la bague de mise au point (AF 

Assist, page 92)

Mise au point à l’aide d’une opération 
tactile (Spot Focus)
En mode de mise au point manuelle, vous 
pouvez spécifier la position où vous voulez 
régler la mise au point par une opération 
tactile.
Pour utiliser la mise au point sur un point, 
réglez Focus >Touch Function in MF 
(page 41) dans le menu Shooting sur Spot 
Focus.
Un repère de mise au point sur un point 
s’affiche lorsque vous appuyez sur la position 
où vous voulez régler la mise au point.

[Conseils]
•• En mode de mise au point sur un point, vous 

pouvez appuyer sur une touche personnalisable 
(page 101) attribuée avec Push AF/Push MF pour 
arrêter temporairement la mise au point sur un point 
et activer la mise au point automatique pendant que 
la touche est enfoncée. La mise au point repasse en 
mode manuel quand vous relâchez la touche.

•• La fonction Spot Focus ne fonctionne pas si l’objectif 
est réglé pour la mise au point manuelle.

•• La position de mise au point sur un point ne peut pas 
être spécifiée pendant que la loupe de mise au point 
est utilisée ou lorsque Touch Operation (page 58) 
dans le menu Technical est réglé sur Off.

Utilisation temporaire de la mise au 
point automatique (Push Auto Focus 
(AF))
En mode de mise au point manuelle, 
vous pouvez appuyer sur une touche 
personnalisable (page 101) à laquelle 
Push AF/Push MF a été attribué pour activer 
temporairement la mise au point automatique 
pendant que la touche est enfoncée.

La mise au point s’effectue dans la zone de 
mise au point définie à l’aide de Focus >Focus 
Area (page 41) dans le menu Shooting du 
menu complet.
La mise au point repasse en mode manuel 
quand vous relâchez la touche.
Ceci est utile lorsque vous voulez régler 
lentement la mise au point d’un sujet à un 
autre lors de la mise au point manuelle.

[Remarque]
La fonction Push Auto Focus ne fonctionne pas si 
l’objectif est réglé pour la mise au point manuelle.

Mise au point à l’aide de 
l’agrandissement de la mise au point 
(Focus Magnifier)

Vous pouvez sélectionnez la cible de sortie 
pour l’agrandissement de la mise au point en 
utilisant Focus Magnifier (page 54) dans 
le menu Monitoring du menu complet. Le 
nom de la fonction attribuée à une touche 
personnalisable utilisée pour l’agrandissement 
de la mise au point changera en fonction de 
ce réglage.
Vous pouvez commuter l’agrandissement de 
la loupe de mise au point du moniteur LCD 
en appuyant sur une touche personnalisable 
(page 101) à laquelle LCD Focus Magnifier 
a été attribué. L’agrandissement au centre de 
l’écran change comme suit à chaque pression 
sur la touche.

Réglage de 
codec

Taille de 
l’image 
enregistrée

Grossissement

X-OCN 8K 3×, 6×

Autre que 8K

Autre que 
X-OCN

8K 4×

Autre que 8K 3×, 6×

Cette fonction est utile pour vérifier la mise au 
point.

Après avoir atteint l’agrandissement maximal, 
appuyez à nouveau sur la touche pour revenir 
à la vue d’origine.
Vous pouvez déplacer la position à élargir 
pendant l’agrandissement de la mise au point 
à l’aide du sélecteur multiple (page 4). 
Appuyez sur le sélecteur multiple pour revenir 
au centre de l’image.
Vous pouvez aussi commuter 
l’agrandissement de la loupe de mise au point 
de la sortie SDI et de la sortie HDMI comme 
indiqué ci-dessous en appuyant sur une 
touche personnalisable (page 101) à laquelle 
Output Focus Magnifier a été attribué.

Réglage 
de codec

Taille de 
l’image 
enregistrée

Grossissement

SDI (FHD) HDMI 
(FHD)

X-OCN – 2×, 4× 2×, 4×

Autre que 
X-OCN

8K – 4×

Autre que 
8K

– 2×, 4×

[Remarques]
•• L’image n’est pas agrandie sur les sorties SDI, sauf 

pendant l’enregistrement X-OCN, ni sur les sorties 
SDI/HDMI autres que FHD.

•• Vous ne pouvez pas appliquer un LUT à l’image 
de sortie si l’agrandissement de mise au point est 
utilisé sur l’image de sortie HDMI, sauf pendant 
l’enregistrement X-OCN.

•• La position agrandie revient au centre de l’écran 
lorsque l’appareil est mis hors tension.

•• 	Vous pouvez appliquer un LUT à l’image du moniteur 
LCD si l’agrandissement de mise au point est utilisé 
sur l’image lorsque LUT Off est sélectionné pendant 
l’enregistrement X-OCN.

•• Une vidéo au format logarithmique est émise si 
l’agrandissement de mise au point est utilisé sur 
l’image de sortie HDMI pendant l’enregistrement 
X-OCN.
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Réglage automatique de la mise 
au point (Auto Focus)

L’appareil utilise l’AF à détection de phase 
pour une mise au point ultra rapide et l’AF de 
contraste pour une mise au point ultra précise.
La combinaison de ces deux méthodes AF 
permet une mise au point automatique à 
vitesse rapide et haute précision.
Pour ajuster automatiquement la mise 
au point, réglez le commutateur FOCUS 
(page 4) de l’appareil sur « AF ». Si 
l’objectif est pourvu d’un commutateur 
de sélection de mise au point, réglez le 
commutateur sur la position « AF/MF » ou 
« AF ». Si le commutateur est réglé sur la 
position « Full MF » ou « MF », la mise au point 
de l’objectif ne peut pas être réalisée depuis 
l’appareil.

[Conseil]
Lorsque vous réglez Focus >AF Assist (page 41) sur 
On dans le menu Shooting du menu complet, vous 
pouvez encore utiliser la bague de mise au point de 
l’objectif pendant la mise au point automatique pour 
régler la mise au point.

[Remarques]
•• Un objectif prenant en charge la mise au point 

automatique est requis.
•• Vous risquez de ne pas obtenir une bonne précision 

selon les conditions de prise de vue.
•• La mise au point ne peut pas être ajustée 

automatiquement sur un objectif à monture PL.
•• La mise au point automatique ne peut pas être 

utilisée lorsque De-Squeeze >Ratio (page 52) est 
réglé sur une valeur autre que Off(1.0×) dans le menu 
Monitoring du menu complet.

Réglage de la zone/position de mise au 
point automatique (Focus Area)

Vous pouvez régler la zone cible pour la 
mise au point automatique en utilisant Focus 
>Focus Area (page 41) dans le menu 
Shooting du menu complet.

Flexible Spot :
Effectue la mise au point sur une position 
spécifique dans l’image.
Lorsque vous sélectionnez ce réglage, 
spécifiez la position à l’aide du sélecteur 
multiple (page 4).
Vous pouvez revenir à la position centrale en 
maintenant enfoncé le sélecteur multiple.

Zone :
Recherche automatiquement une position de 
mise au point dans la zone spécifiée.
Lorsque vous sélectionnez ce réglage, 
spécifiez la position à l’aide du sélecteur 
multiple (page 4).
Vous pouvez revenir à la position centrale en 
maintenant enfoncé le sélecteur multiple.

Wide :
Recherche un sujet dans un grand angle 
de l’image lors de la mise au point. Aucune 
image ne s’affiche.

[Conseil]
Vous pouvez afficher/masquer le cadre de la zone de 
mise au point à l’aide de Display On/Off >Focus Area 
Indicator (page 52) dans le menu Monitoring du 
menu complet.

[Remarque]
Le cadre de la zone de mise au point n’est pas masqué 
lorsque vous utilisez la touche DISPLAY.

Modification rapide de la zone de mise 
au point (Focus Setting)

Vous pouvez changer rapidement la 
position et la taille de la zone de mise au 
point automatique lors de la prise de vue 
en attribuant Focus Setting à une touche 
personnalisable (page 101).
L’opération varie selon le réglage de la zone 
de mise au point.

Lorsque Focus >Focus Area (page 41) du 
menu Shooting du menu complet est réglé 
sur Flexible Spot ou Zone
Vous pouvez modifier la position de la zone 
de mise au point en appuyant sur la touche 
personnalisable à laquelle vous avez attribué 
Focus Setting et en réglant à l’aide du 
sélecteur multiple (page 4).
Vous pouvez restaurer la position de la zone 
de mise au point au centre lorsque vous 
réglez la position en appuyant sur le sélecteur 
multiple.
Vous pouvez modifier la taille de la zone de 
mise au point en maintenant enfoncée la 
touche personnalisable à laquelle vous avez 
attribué Focus Setting.

Après avoir modifié la taille, définissez la 
position de la zone de mise au point en 
appuyant sur le sélecteur multiple.
Lorsque vous avez terminé, appuyez sur la 
touche personnalisable à laquelle vous avez 
attribué Focus Setting pour revenir à l’écran 
d’origine.

Lorsque Focus >Focus Area (page 41) du 
menu Shooting du menu complet est réglé 
sur Wide
Vous pouvez uniquement modifier la taille 
de la zone de mise au point en maintenant 
enfoncée la touche personnalisable à laquelle 
vous avez attribué Focus Setting. Vous pouvez 
aussi changer la position en modifiant d’abord 
le type sur Flexible Spot ou Zone.

[Conseil]
Le cadre de la zone de mise au point est affiché en 
orange lorsque la position de la zone de mise au point 
peut être modifiée.

Déplacement du cadre de la zone de 
mise au point à l’aide des opérations 
tactiles (zone de mise au point tactile)

Vous pouvez modifier la position de la zone 
de mise au point en appuyant sur une touche 
personnalisable (page 101) à laquelle vous 
avez attribué Focus Setting pour faire passer 
l’affichage de la zone de mise au point en 
orange, puis la déplacer par opération tactile.
Touchez l’écran pour déplacer la zone de 
mise au point, avec la zone de mise au point 
centrée sur la position touchée. Faites glisser 
sur l’écran pour déplacer la zone de mise 
au point à la position tracée par votre doigt 
(page 9).

[Conseil]
Vous pouvez activer/désactiver l’opération de mise au 
point tactile sur l’écran de prise de vue à l’aide de la 
touche personnalisable à laquelle vous avez attribué 
Focus Setting.
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Toucher n’importe quelle position

La zone de mise au point se déplace, avec 
la zone de mise au point centrée sur la 
position touchée.

Faire glisser pour déplacer la zone de mise 
au point, en suivant la position de votre 
doigt

[Remarques]
•• 	Si vous touchez une position ou faites glisser la zone 

de mise au point vers une position qui dépasse la 
plage de réglage, la zone de mise au point est réglée 
sur le bord supérieur/inférieur/gauche/droit de la 
plage de réglage.

•• 	Cette fonction n’est pas disponible dans les 
circonstances suivantes.
–– Lorsque Touch Operation (page 58) dans le 

menu Technical du menu complet est réglé sur Off
–– Lorsque la zone de mise au point est affichée en 

gris ou n’est pas affichée du tout

Ajustement de l’action de mise au point 
automatique (vitesse de transition AF, 
sensibilité de changement de sujet AF)

Vitesse de transition AF
Vous pouvez régler la vitesse d’entraînement 
de la mise au point pour les cas où le sujet 
change à l’aide de Focus >AF Transition Speed 
(page 40) dans le menu Shooting du menu 
complet.
Lors d’un réglage sur une vitesse basse, la 
mise au point se déplace en douceur lorsque 
le sujet à mettre au point change, ce qui 
permet de prendre de magnifiques images.
Lors d’un réglage sur une vitesse élevée, la 
mise au point change rapidement de sujet. 
La mise au point passe immédiatement sur le 
sujet entrant dans le cadre, rendant ce réglage 
idéal pour la prise de vue documentaire 
nécessitant une mise au point rapide.

Pendant la modification :
1(Slow) : la mise au point est 
lente
.
.
.
7(Fast) : la mise au point est 
rapide

Mise au point sur un sujet éloigné

Mise au point sur un sujet proche

Sensibilité de changement de sujet AF
Vous pouvez régler la sensibilité de 
changement de sujet à l’aide de Focus >AF 
Subj. Shift Sens. (page 41) dans le menu 
Shooting du menu complet.
Lors d’un réglage sur une faible sensibilité, la 
mise au point ne change pas immédiatement 
même si un autre sujet passe devant le 
sujet de la mise au point. Lors d’un réglage 
sur une sensibilité élevée, la mise au point 
change pour donner la priorité au sujet en 
mouvement au premier plan.

[Conseil]
Si AF Speed/Sens. est attribué à une touche 
personnalisable, les barres de niveau pour l’ajustement 
des valeurs s’affichent dans l’ordre suivant à chaque fois 
que vous appuyez sur la touche, ce qui vous permet de 
modifier la vitesse de transition AF et les réglages de 
sensibilité de changement de sujet AF.
Vitesse de transition AF  Sensibilité de changement 
de sujet AF  Pas d’affichage …
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AF Subj. Shift Sens. : 1(Locked On) AF Subj. Shift Sens. : 5(Responsive)

Mise au point lente sur un autre sujet Mise au point rapide sur un autre sujet

Modification manuelle de la cible de 
mise au point (AF Assist)

Lorsque vous réglez Focus >AF Assist 
(page 41) sur On dans le menu Shooting du 
menu complet, vous pouvez encore utiliser la 
bague de mise au point de l’objectif pendant 
la mise au point automatique pour régler la 
mise au point sur un sujet.
Lorsque vous arrêtez d’utiliser la bague de 
mise au point, la mise au point automatique 
continue de se faire sur le sujet mis au point 
à l’aide de la bague de mise au point (état 
d’assistance AF).
Après avoir utilisé la bague de mise au point, 
il est légèrement plus difficile de déplacer 
la mise au point sur un autre sujet, quel que 
soit le réglage Focus >AF Subj. Shift Sens. 
(page 41) dans le menu Shooting du menu 
complet.
L’état d’assistance AF est annulé par ce qui 
suit.
•• Lorsque le sujet mis au point à l’aide de la 

bague de mise au point n’est plus visible
•• Lors du passage à la mise au point manuelle
•• Lorsque l’AF de suivi en temps réel est 

démarré

[Conseils]
•• L’état d’assistance AF peut être annulé rapidement 

en utilisant une touche personnalisable (page 101) 
attribuée avec Push AF/Push MF.

•• L’AF de suivi en temps réel s’arrête lorsque la bague 
de mise au point est actionnée.

•• En mode Human Only AF, la mise au point 
automatique se fait sur le visage le plus proche de 
la position de mise au point de la bague de mise au 
point.

Utilisation temporaire de la mise au 
point manuelle (Push Manual Focus)

En mode de mise au point automatique, 
vous pouvez appuyer sur une touche 
personnalisable (page 101) à laquelle 
Push AF/Push MF a été attribué pour activer 
temporairement la mise au point manuelle 
pendant que la touche est enfoncée.
La mise au point repasse en mode 
automatique quand vous relâchez la touche.
Ceci vous permet d’arrêter temporairement la 
mise au point automatique et de l’effectuer 
manuellement lorsqu’un élément n’étant pas 
le sujet de la prise de vue passe devant le 
sujet.
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Suivi à l’aide de la détection des 
humains (Subject Recognition AF)

L’appareil peut détecter les personnes en tant 
que cible à suivre et ensuite ajuster la mise au 
point sur les yeux, le visage et le corps dans la 
zone de mise au point.
Cette fonction est uniquement disponible 
lorsque le mode de mise au point est le mode 
AF ou pendant la mise au point automatique 
par pression.
Lorsqu’une personne est détectée, un 
cadre gris de reconnaissance du sujet 
s’affiche. Lorsqu’une cible de mise au point 
automatique est identifiée, le cadre devient 
blanc et le suivi démarre.
Si une caractéristique d’identification plus 
précise (les yeux, par exemple) est reconnue, 
cette partie est automatiquement privilégiée 
et un cadre de reconnaissance s’affiche.
Lorsque plusieurs personnes sont détectées, 
le sujet principal est déterminé de manière 
automatique.

[Conseil]
Lorsque la zone de mise au point est réglée sur Zone ou 
Flexible Spot, des cadres de reconnaissance s’affichent 
autour des parties reconnues du sujet (visage, yeux, tête, 
corps) lorsqu’une personne entre dans la plage de la 
zone de mise au point configurée.

Réglez l’action d’AF de reconnaissance du 
sujet à l’aide de Focus >Subject Recognition AF 
(page 41) dans le menu Shooting.

Human Only AF :
La caméra détecte les sujets (personnes), 
puis met au point et suit leur visage/leurs 
yeux, leur tête et leur corps. Tant qu’aucun 
visage/œil, tête ou corps n’est détecté, l’AF 
est temporairement arrêté et l’icône  (pause 
AF) (page 22) s’affiche. Ce mode est utile 
lorsque souhaitez réaliser une mise au point 
automatique et un suivi du visage/des yeux, 
de la tête et du corps uniquement.

Human Priority AF :
La caméra détecte le visage/les yeux, la tête et 
le corps des sujets (personnes), et la mise au 
point/le suivi se fait en priorité sur le visage/
les yeux, la tête et le corps des personnes. Si 
aucun visage/œil, tête ou corps n’est détecté, 
la mise au point repasse en mode AF (réglage 
par défaut).

Off :
La fonction d’AF de reconnaissance du sujet 
est désactivée.

[Remarques]
•• Durant la mise au point automatique par pression, 

Human Priority AF est activé même si Human Only AF 
est actuellement sélectionné.

•• Lorsque le commutateur FOCUS est réglé sur MF, 
l’AF de reconnaissance du sujet est désactivé (sauf 
pendant l’opération de mise au point automatique 
par pression).

•• Si vous mettez l’appareil hors tension alors que 
Human Only AF est sélectionné, le mode passe 
automatiquement à Human Priority AF lorsque 
l’appareil est ensuite remis sous tension.

Masquer les cadres de reconnaissance 
du sujet

Vous pouvez afficher/masquer les cadres 
de reconnaissance du sujet à l’aide de 
Display On/Off >Subject Recognition Frame 
(page 52) dans le menu Monitoring du 
menu complet.

Commutation de l’opération d’AF de 
reconnaissance du sujet à l’aide d’une 
touche personnalisable

Attribuez Subject Recognition AF à une 
touche personnalisable (page 101). Vous 
pouvez alors commuter l’opération d’AF de 
reconnaissance du sujet dans l’ordre Human 
Priority AF, Human Only AF et Off à chaque 
pression sur la touche.

Réglage à l’aide du menu direct

Vous pouvez également régler l’opération de 
l’AF de reconnaissance du sujet à l’aide du 
menu direct (page 101).

Suivi d’un sujet spécifié (Realtime 
Tracking AF)

Vous pouvez maintenir la mise au point sur un 
sujet en spécifiant le sujet par une opération 
tactile ou en sélectionnant un cadre de 
reconnaissance du sujet.
Lorsqu’un sujet est sélectionné, un cadre de 
suivi blanc s’affiche et le suivi démarre.

[Conseils]
•• Le suivi se produit dans la zone d’image entière, 

indépendamment du réglage de la zone de mise au 
point.

•• Lorsque Focus >Touch Function in MF (page 41) 
dans le menu Shooting est réglé sur Tracking AF, 
l’AF de suivi en temps réel est pris en charge même 
lorsque le mode de mise au point est le mode MF.

Les actions suivantes se produisent 
pour la cible de suivi, selon le mode de 
fonctionnement de l’AF de reconnaissance du 
sujet.

Human Only AF / Human Priority AF :
Met au point et suit un sujet spécifié.
Si la cible de suivi est une personne et un 
visage/des yeux/une tête/un corps sont 
détectés, la caméra effectue la mise au point 
sur ce visage/ces yeux/cette tête/ce corps.

Off :
Met au point et suit un sujet spécifié.
La détection des visages/yeux/tête/corps ne 
se produit pas, même si la cible de suivi est 
une personne.

[Remarque]
La fonction Realtime Tracking AF ne fonctionne pas si 
l’objectif est réglé pour la mise au point manuelle.

Démarrage de l’AF de suivi en temps 
réel

Lorsqu’un sujet spécifique est spécifié comme 
cible de suivi, le suivi de cette cible démarre.

Spécification par une opération tactile
Appuyez sur le sujet ciblé à suivre dans l’un 
des états suivants :
•• Lorsque le mode de mise au point est 

le mode MF ou lors de la mise au point 
manuelle par pression, et lorsque Focus 
>Touch Function in MF (page 41) dans le 
menu Shooting est réglé sur Tracking AF

•• Lorsque le mode de mise au point est le 
mode AF ou pendant la mise au point 
automatique (AF) par pression

[Remarque]
La spécification d’une cible par une opération 
tactile n’est pas disponible lorsque Touch Operation 
(page 58) dans le menu Technical est réglé sur Off.

Spécification par la sélection d’un cadre de 
reconnaissance du sujet
Déplacez le curseur de sélection du sujet 
(soulignement orange) sur le sujet cible 
à suivre à l’aide du sélecteur multiple 
(page 4) et appuyez sur le sélecteur 
multiple.

Autres cadres de reconnaissance 
du sujet (gris) Cadre de suivi

Curseur de sélection du sujet (orange)
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[Conseils]
•• Vous pouvez également changer de cible à suivre lors 

de l’AF de suivi en temps réel.
•• Si une touche personnalisable (page 101) attribuée 

avec la fonction LCD Focus Magnifier est enfoncée 
lors de l’AF de suivi en temps réel, l’état de suivi est 
conservé et la mise au point est agrandie. Cependant, 
vous ne pouvez pas spécifier de cible à suivre lors de 
l’agrandissement de la mise au point.

[Remarque]
Lors de la mise au point manuelle, le suivi ne peut 
pas être démarré par la sélection du cadre de 
reconnaissance du sujet.

Arrêt de l’AF de suivi en temps réel

Arrêt par une opération tactile
Appuyez sur la touche  (arrêt de l’AF de 
suivi en temps réel) affichée en haut à gauche 
du panneau tactile.

[Conseil]
L’AF de suivi en temps réel s’arrêtera dans les cas 
suivants :

–– Lorsque le commutateur FOCUS ou la commande 
AUTO/MAN sur l’objectif est commuté

–– Lorsque le mode de mise au point est modifié
–– Lorsque l’aide pour la mise au point automatique 

est exécutée
–– Lorsque le réglage de la zone de mise au point 

ou l’action de l’AF de reconnaissance du sujet est 
modifié

–– Lorsqu’une touche personnalisable attribuée avec 
Push AF/Push MF est enfoncée

–– Lorsque la cible de suivi n’est pas comprise dans 
l’écran de prise de vue ou que le sujet est flou 
pendant quelques secondes

Remarques à propos de la prise 
de vue

•• Vous pourriez rencontrer des difficultés pour 
effectuer la mise au point sur le sujet dans 
les situations suivantes :

•• En cas de lumière faible ou de rétro-
éclairage

•• Lorsque le sujet est dans l’ombre
•• Lorsque le sujet est très flou

Il peut s’avérer difficile d’effectuer la mise 
au point sur les yeux dans les situations 
suivantes, même si la caméra reconnaît les 
yeux :

•• Lorsque les yeux sont fermés
•• Lorsque les cheveux couvrent les yeux, 

etc.
•• Lorsque la personne porte des lunettes 

(lunettes de soleil)
Il existe d’autres situations où l’exécution de 
la mise au point sur le sujet peut se révéler 
impossible.

•• Lorsque la caméra ne parvient pas à 
effectuer la mise au point sur la partie que 
vous souhaitez privilégier, par exemple 
les yeux du sujet, la caméra peut effectuer 
automatiquement la mise au point sur 
d’autres parties reconnues, comme la tête 
ou le corps du sujet.

•• Même si un cadre blanc de reconnaissance 
du sujet s’affiche autour du visage de 
ce dernier, etc., la caméra peut effectuer 
automatiquement la mise au point sur la 
partie que vous souhaitez privilégier, par 
exemple les yeux du sujet.

•• Il se peut que le sujet ne soit pas reconnu 
lorsque seule une partie de celui-ci se 
trouve dans l’angle de vue.
–– Lorsque seuls les mains et les pieds d’une 
personne ou d’un animal sont visibles

–– Lorsqu’une partie du sujet est masquée et 
invisible, etc.

•• Dans certaines conditions, il se peut que 
la caméra reconnaisse accidentellement 
d’autres objets en tant que sujet désigné.
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Réglage de la luminosité
Vous pouvez régler la luminosité en réglant le 
diaphragme, le gain, la vitesse d’obturateur, 
ainsi qu’en réglant le niveau de luminosité à 
l’aide des filtres ND. Vous pouvez également 
procéder à des réglages automatiques.
Le niveau cible pour le réglage automatique 
de la luminosité se règle à l’aide de Auto 
Exposure >Level (page 39) dans le menu 
Shooting du menu complet. Vous pouvez 
également attribuer Auto Exposure Level à 
une touche personnalisable ou à une molette 
personnalisable (page 101).

[Remarque]
Le gain ne peut pas être réglé en mode Cine EI. La 
sensibilité de base est fixée. De même, la luminosité ne 
peut pas être ajustée automatiquement en utilisant la 
vitesse d’obturation. L’ajustement automatique de la 
luminosité à l’aide du diaphragme et du filtre ND est pris 
en charge.

Sélection de la sensibilité de base

Vous avez le choix entre deux types de 
sensibilité de base sur l’appareil.
En mode Cine EI, vous pouvez régler l’ISO de 
base sur ISO 3200 ou ISO 800 à l’aide de ISO/
Gain/EI >Base ISO (page 37) dans le menu 
Shooting du menu complet.
Sélectionnez ISO 800 dans des conditions 
d’éclairage normales et sélectionnez ISO 3200 
dans des conditions d’éclairage faibles.
En mode Custom, vous pouvez régler la 
sensibilité de base sur High ou Low à l’aide 
de ISO/Gain/EI >Base Sensitivity (page 37) 
dans le menu Shooting du menu complet.
Sélectionnez Low dans des conditions 
d’éclairage normales et sélectionnez High 
dans des conditions d’éclairage faibles.

[Conseil]
Vous pouvez également attribuer Base ISO/Sensitivity à 
une touche personnalisable (page 101).

Réglage du diaphragme

Vous pouvez régler le diaphragme pour régler 
la luminosité.

[Remarque]
Lorsqu’un objectif à monture PL est fixé, le contrôle du 
diaphragme depuis l’appareil et la télécommande n’est 
pas pris en charge.

Réglage automatique du diaphragme

Cette fonction règle la luminosité en fonction 
du sujet. Un objectif prenant en charge le 
diaphragme automatique est requis.

1	 Si un objectif avec commutateur Auto Iris 
est fixé, placez le commutateur sur AUTO.

2	 Affichez le menu direct Auto Iris 
(page 101) et sélectionnez Auto.

	 [Remarque]
Lorsqu’un objectif à monture PL est utilisé, Auto Iris 
est réglé sur Off.

	 [Conseil]
Vous pouvez également attribuer Auto Iris à une 
touche personnalisable (page 101).

Réglage manuel du diaphragme

1	 Affichez le menu direct Auto Iris 
(page 101) et sélectionnez Manual.

2	 Affichez le menu direct Iris (page 101) 
pour afficher la valeur du diaphragme sur 
un arrière-plan blanc.

3	 Tournez la molette multifonction pour 
régler la valeur.

	 [Conseils]
•• Vous pouvez aussi utiliser la molette 

multifonction comme molette IRIS (page 101) 
en affectant la fonction IRIS à la molette 
multifonction.

•• Vous pouvez également attribuer la fonction 
IRIS à une molette personnalisable de la 
télécommande (page 101).

•• Pour un objectif équipé d’une bague de 
diaphragme, vous pouvez effectuer des 
ajustements manuels à l’aide de celle-ci.

Réglage automatique temporaire

Appuyez sur la touche personnalisable 
(page 101) à laquelle la fonction Push Auto 
Iris est affectée pour régler automatiquement 
le diaphragme de façon temporaire lorsque la 
touche est enfoncée.
Le diaphragme revient au réglage précédent 
quand vous relâchez la touche.

[Remarques]
•• Quand le commutateur Auto Iris de l’objectif est réglé 

sur MANUAL, les fonctions Auto Iris et Push Auto Iris 
de l’appareil n’ont aucun effet. Les réglages manuels 
du diaphragme sur l’appareil n’ont aucun effet.

•• Push Auto Iris ne peut pas être exécuté lorsque Iris 
>Bokeh Control (page 39) dans le menu Shooting 
est réglé sur On.

Réglage d’Exposure Index

En mode Cine EI, il est considéré que la sortie 
vidéo avec le LUT de moniteur réglé sur Off est 
enregistrée comme signal principal. Lorsque 
vous changez la luminosité de l’image avec le 
LUT de moniteur réglé sur On pour adapter à 
une valeur EI, vous pouvez vérifier le résultat 
du réglage de la sensibilité d’exposition post-
production pendant la prise de vue.
Vous pouvez modifier la valeur EI à l’aide de 
ISO/Gain/EI >Exposure Index (page 37) 
dans le menu Shooting du menu complet.

[Remarque]
Lors de l’enregistrement en mode Cine EI, il est 
recommandé de maintenir le réglage Exposure Index 
constant. Si vous modifiez le réglage Exposure Index, 
la correction de la luminosité peut être très difficile 
à réaliser en post-production, ce qui peut rendre 
impossible la reproduction de l’état dans lequel l’image 
a été filmée à l’origine.

Réglage du gain

En mode Custom, vous pouvez régler le gain 
pour régler la luminosité.

Réglage automatique du gain

Affichez le menu direct AGC (page 101) et 
sélectionnez Auto.

[Conseils]
•• Vous pouvez aussi effectuer le même réglage en 

définissant Auto Exposure >AGC (page 39) sur On 
dans le menu Shooting.

•• Vous pouvez également attribuer AGC à une touche 
personnalisable (page 101).

Réglage manuel du gain

Vous pouvez surveiller le gain lorsque vous 
souhaitez ajuster l’exposition tout en utilisant 
un réglage de diaphragme fixe ou lorsque 
vous souhaitez éviter que le gain n’augmente 
à cause de l’AGC.

1	 Affichez le menu direct AGC (page 101) 
et sélectionnez Manual.

2	 Affichez le menu direct Gain Value 
(page 101) et réglez le gain.

[Conseils]
•• Vous pouvez modifier la valeur de gain prédéfinie à 

l’aide de ISO/Gain/EI >ISO/Gain (page 37) dans le 
menu Shooting du menu complet.

•• Vous pouvez également attribuer Push AGC à une 
touche personnalisable et régler AGC sur On de 
manière temporaire en appuyant sur la touche et en 
la maintenant enfoncée.

[Remarque]
Push AGC ne peut pas être exécuté lorsque Iris >Bokeh 
Control (page 39) dans le menu Shooting du menu 
complet est réglé sur On.
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Réglage de l’obturateur

Vous pouvez régler l’obturateur pour régler la 
luminosité.

Réglage automatique de l’obturateur

Affichez le menu direct Auto Shutter 
(page 101) et sélectionnez Auto pour régler 
automatiquement la vitesse d’obturation 
ou l’angle d’obturation en fonction de la 
luminosité de l’image.

[Conseil]
Vous pouvez aussi effectuer le même réglage en 
définissant Auto Exposure >Auto Shutter (page 39) 
sur On dans le menu Shooting du menu complet.

Réglage manuel de l’obturateur

1	 Affichez le menu direct Shutter Speed 
Value ou Shutter Angle Value (page 101) 
pour afficher la valeur de l’obturateur sur 
un arrière-plan blanc.

2	 Tournez la molette multifonction pour 
régler la valeur de l’obturateur.

[Conseils]
•• Pour régler la durée d’exposition afin qu’elle 

corresponde à l’intervalle d’image, sélectionnez Off 
à l’étape 1.

•• Vous pouvez également définir l’angle et régler la 
fréquence (page 38).

Réglage du niveau de luminosité 
(ND Filter)

Lorsque l’éclairage est trop fort, vous pouvez 
régler la luminosité appropriée en changeant 
le filtre ND.

L’appareil comporte deux modes de filtre 
ND. Vous pouvez commuter entre les deux 
modes en utilisant le commutateur ND STEP/
VARIABLE.

LOCK

MFAF

ND STEP ND VARIABLE

FULL MENU

ND ON

1 2

3

CLEAR

DISP

MENU

BACK

REC

B

C

A

Réglage en mode Step

Réglez le commutateur ND STEP/VARIABLE (A) 
sur la position STEP et configurez le filtre sur 
l’un des réglages suivants à l’aide des touches 
haut/bas ND FILTER POSITION (B).
Vous pouvez régler le mode d’affichage utilisé 
pour exprimer la transmittance de la lumière 
via le filtre ND à l’aide de ND Filter >Display 
Mode (page 38) dans le menu Shooting du 
menu complet.  
•• 	Avec un réglage sur Optical Density : 

Clear (pas de filtre ND), 0.6, 0.9, 1.2, 1.5, 1.8 
ou 2.1.

•• Avec un réglage sur Transmittance : 
Clear (pas de filtre ND), 1/4, 1/8, 1/16, 1/32, 
1/64 ou 1/128.

Réglage en mode variable

Réglez le commutateur ND STEP/VARIABLE (A) 
en position VARIABLE. Commutez le filtre entre 
CLEAR et On à l’aide des touches haut/bas ND 
FILTER POSITION (B).

Réglage automatique du niveau de luminosité
Vous pouvez régler Auto ND Filter sur On pour 
activer l’ajustement d’exposition automatique 
à l’aide du filtre ND.

1	 Appuyez sur la touche [+] des touches 
haut/bas ND FILTER POSITION (B) pour 
activer le fonctionnement du filtre ND.

2	 Affichez le menu direct Auto ND Filter 
(page 101) et sélectionnez Auto.

Réglage manuel du niveau de luminosité

1	 Appuyez sur la touche [+] des touches 
haut/bas ND FILTER POSITION (B) pour 
activer le fonctionnement du filtre ND.

2	 Affichez le menu direct Auto ND Filter 
(page 101) et sélectionnez Manual.

3	 Tournez la molette ND VARIABLE (C) pour 
régler la transmittance du filtre.

[Conseil]
Vous pouvez également affecter la fonction ND Filter à 
une molette personnalisable (page 101).

Réglage automatique temporaire
Vous pouvez attribuer Push Auto ND à une 
touche personnalisable (page 101), et 
régler de manière temporaire Auto ND Filter 
sur On en appuyant sur cette touche et en 
la maintenant enfoncée. Auto ND Filter sera 
de nouveau réglé sur Off si vous relâchez la 
touche.

Appuyez sur la touche [+] des touches haut/
bas ND FILTER POSITION (B) pour activer le 
fonctionnement du filtre ND.

[Remarques]
•• La modification du réglage Display Mode peut 

changer la densité actuelle du filtre ND.
•• Lorsque le filtre ND est basculé via CLEAR lors de la 

prise de vue, le cadre de filtre ND s’affiche, un reflet 
de la lumière violette du capteur de détection peut 
apparaître sur l’image et le son de fonctionnement 
peut être inclus dans l’audio. La lumière du capteur et 
les sons de fonctionnement ne se reflètent pas dans 
la vidéo lorsque la commutation est terminée.

•• 	Push Auto ND ne peut pas être exécuté lorsque Iris 
>Bokeh Control (page 39) dans le menu Shooting 
est réglé sur On.

[Conseils]
•• Vous pouvez régler le filtre sur CLEAR en tournant 

la molette ND VARIABLE (C) vers le bas depuis ND 
0.6. Si depuis CLEAR vous tournez la molette vers le 
haut, vous configurez ND 0.6. Vous pouvez désactiver 
cette action à l’aide de ND Dial >CLEAR with Dial 
(page 58) dans le menu Technical du menu 
complet.

•• Vous pouvez également attribuer ND Filter Position à 
une touche personnalisable (page 101) et appuyer 
sur la touche au lieu d’utiliser les touches haut/bas 
ND FILTER POSITION pour changer le réglage.  
Mode Step : Clear  0.6  0.9  …  Clear … 
Mode Variable : Clear  On  Clear …

•• Vous pouvez également attribuer Auto ND Filter à une 
touche personnalisable (page 101) et appuyer sur la 
touche pour commuter Auto ND filter entre On et Off.

•• Lorsque vous filmez un sujet lumineux, une fermeture 
trop importante du diaphragme peut provoquer un 
flou de diffraction, qui crée une image commençant à 
perdre sa netteté (phénomène typique des caméras 
vidéo). Vous pouvez supprimer cet effet pour obtenir 
de meilleurs résultats de prise de vue en utilisant le 
filtre ND.
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Réglage pour des couleurs naturelles (balance des blancs)
Vous pouvez sélectionner le mode de réglage 
pour vous adapter aux conditions de prise de 
vue.

ATW (balance des blancs à suivi 
automatique)

Cette fonction ajuste la balance des blancs 
automatiquement à un niveau approprié.
La balance des blancs est automatiquement 
ajusté quand la température de couleur de la 
source de lumière change.
Affichez le menu direct de balance des blancs 
(page 101) et réglez ATW sur On.
Vous pouvez sélectionner la vitesse de réglage 
(cinq incréments) à l’aide de White Setting 
>ATW Speed (page 40) dans le menu 
Shooting du menu complet.

[Conseils]
•• 	Vous pouvez également régler White >ATW 

(page 40) sur On dans le menu Shooting du menu 
complet ou en utilisant une touche personnalisable 
(page 101) attribuée à la fonction ATW.

•• Vous pouvez geler le réglage de balance des 
blancs actuel en assignant la fonction ATW Hold 
à une touche personnalisable (page 101) et en 
appuyant sur la touche personnalisable pour mettre 
temporairement le mode ATW en pause.

[Remarques]
•• ATW ne peut pas être utilisé en mode Cine EI.
•• Il peut ne pas être possible de s’ajuster sur la couleur 

appropriée à l’aide d’ATW, en fonction des conditions 
d’éclairage et de sujet.  
Exemples :
–– Quand une couleur unique domine le sujet, comme 

par exemple le ciel, la mer, la terre ou des fleurs.
–– Lorsque le sujet est éclairé par une source 

lumineuse avec une température chromatique 
extrêmement élevée ou faible.

	 Si l’effet approprié ne peut pas être obtenu parce que 
la vitesse de suivi automatique d’ATW est lente ou 
pour d’autres raisons, utilisez la balance des blancs 
automatique.

Réglage manuel de la balance des 
blancs

Lorsque ATW On est sélectionné : 
Sélectionnez l’icône  dans le menu 
direct (page 101) et sélectionnez W:A, 
W:B ou W:C.

Lorsque ATW Off est sélectionné : 
Sélectionnez W:A, W:B ou W:C dans le 
menu direct.

•• W:A : position de mémoire A
•• W:B : position de mémoire B
•• W:C : position de mémoire C

Sélectionnez la position de mémoire A/B/C 
sur l’écran d’accueil (page 25).

[Conseil]
Vous pouvez également sélectionner la mémoire à 
l’aide de White >White Select (page 40) dans le menu 
Shooting du menu complet.

Vous pouvez régler chaque position de 
mémoire à l’aide des méthodes suivantes.
•• Modification de la valeur prédéfinie par 

défaut
•• Modification de la température de couleur 

et de la teinte
•• Utilisation de la balance des blancs 

automatique

Modification de la valeur prédéfinie par 
défaut

Lorsque vous sélectionnez W:A, W:B ou W:C 
dans le menu direct (page 101), ce qui suit 
s’affiche.
Cine EI :
5500K±00
4300K±00
3200K±00
Personnalisé :
6300K±00
5600K±00
4300K±00

3200K±00
Sélectionner une valeur met à jour le réglage 
de la position de mémoire actuelle.

Modification de la température de 
couleur

1	 Affichez le menu direct Color Temp. ou 
Tint (page 101) pour afficher le réglage 
sur un arrière-plan blanc.

2	 Tournez la molette multifonction pour 
régler la valeur.

[Conseil]
Vous pouvez aussi régler la température chromatique 
sur l’écran d’accueil (page 25) ou à l’aide de White 
>Color Temp, Tint, R-Gain et B-Gain (page 40) dans le 
menu Shooting du menu complet.

Utilisation de la balance des blancs 
automatique

La balance des blancs à enregistrer dans la 
position de mémoire A/mémoire B/mémoire 
C est configurée automatiquement.

1	 Sélectionnez la position de mémoire A, B 
ou C.

2	 Placez une feuille de papier blanc (ou tout 
autre objet) dans un lieu présentant la 
même source et les mêmes conditions de 
lumière que le sujet, puis effectuez un 
zoom avant sur le papier pour montrer la 
zone blanche sur l’écran.

3	 Réglez la luminosité.
Ajustez le diaphragme à l’aide de la 
procédure dans « Réglage manuel du 
diaphragme » (page 95).

4	 Sélectionnez W:A, W:B ou W:C dans le 
menu direct, puis sélectionnez AWB.

•• Le résultat de l’ajustement automatique 
de la balance des blancs est enregistré 
dans la position de mémoire (A, B ou C) 
sélectionnée à l’étape 1.

•• Si la balance des blancs automatique 
est exécutée en mode ATW, le résultat 
est hérité et le mode ATW reprend 
lorsque l’ajustement automatique est 
terminé. Ceci est utile lorsque vous 
souhaitez ajuster la balance des blancs 
très rapidement, quel que soit le 
réglage de la vitesse ATW.

[Conseil]
Vous pouvez également exécuter la balance des 
blancs automatiquement à partir de l’écran d’accueil 
(page 25), à l’aide de White >Auto White Balance 
(page 40) dans le menu Shooting du menu complet 
ou en utilisant une touche personnalisable (page 101) 
attribuée à la fonction Auto White Balance.

[Remarque]
Si l’ajustement échoue, un message d’erreur s’affiche sur 
l’écran pendant environ trois secondes. Si le message 
d’erreur persiste après plusieurs tentatives de réglage 
de la balance des blancs, contactez votre technicien 
Sony.
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Utilisation d’Image Stabilization
Vous pouvez activer la stabilisation d’image 
pour supprimer un flou de l’image causé par 
un mouvement infime de la main pendant la 
prise de vue.
Vous pouvez aussi exécuter la stabilisation 
d’image automatiquement ou manuellement, 
selon l’objectif utilisé.

[Remarque]
La stabilisation d’image ne peut pas être utilisée lorsque 
De-Squeeze >Ratio (page 52) est réglé sur 1.3× ou 
2.0× dans le menu Monitoring.

Activation d’Image Stabilization

Les éléments de configuration varient si 
l’adaptateur de monture fixé est un adaptateur 
de la monture PL.

Lorsqu’un adaptateur de la monture PL 
est fixé

Réglez Image Stabilization >PL Stabilization 
(page 42) sur High ou Low dans le menu 
Shooting du menu complet.
•• Low : exécute la stabilisation d’image lors 

de la prise de vue d’une vidéo dans des 
conditions relativement stables.

•• High : exécute une stabilisation d’image 
améliorée par rapport à Low.

Pour une prise de vue sans utiliser la 
fonction de stabilisation d’image, réglez PL 
Stabilization sur Off. Dans ce cas, l’utilisation 
d’un trépied est recommandée.

Lorsque aucun adaptateur de la 
monture PL n’est fixé

Réglez Image Stabilization >SteadyShot 
(page 42) sur Active ou Standard dans le 
menu Shooting du menu complet.

•• Standard : exécute la stabilisation d’image 
lors de la prise de vue d’une vidéo dans des 
conditions relativement stables.

•• Active : exécute une stabilisation d’image 
améliorée par rapport à Standard.

Pour une prise de vue sans utiliser la fonction 
de stabilisation d’image, réglez SteadyShot sur 
Off. Dans ce cas, l’utilisation d’un trépied est 
recommandée.

[Remarques]
•• Vous pouvez régler la stabilisation d’image sur Active 

(ou High) lorsque Rec Format >Imager Scan Mode 
(page 43) dans le menu Project du menu complet 
est réglé sur S35 5.8K 17:9 ou S35 5.8K 16:9.

•• Vous ne pouvez pas régler Active (ou High) dans les 
cas suivants.
–– Lorsque Rec Format >Codec (page 43) est réglé 

sur X-OCN dans le menu Project
–– Lorsque S&Q Motion >Setting (page 41) est 

réglé sur On dans le menu Shooting

Réglage automatique de la 
longueur focale

La longueur focale de la stabilisation de 
l’image est réglée automatiquement d’après 
les informations fournies par l’objectif.
Pour régler automatiquement la longueur 
focale de la stabilisation de l’image, réglez 
Image Stabilization >Stabilization Adjustment 
(page 42) dans le menu Shooting du menu 
complet sur Auto.

Réglage manuel de la longueur 
focale

Vous pouvez régler manuellement la longueur 
focale de la stabilisation de l’image.
Pour régler manuellement la longueur focale 
de la stabilisation de l’image, réglez Image 
Stabilization >Stabilization Adjustment 
(page 42) dans le menu Shooting du menu 
complet sur Manual et réglez la longueur 
focale.
Réglez la longueur focale à l’aide de Image 
Stabilization >Focal Length (page 42) dans 
le menu Shooting du menu complet. Vous 
pouvez régler une longueur focale dans une 
plage comprise entre 8 mm et 1000 mm.
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Réglage de l’audio à enregistrer
Vous pouvez spécifier l’audio à enregistrer à 
l’aide des connecteurs, des commutateurs et 
des molettes d’entrée de l’appareil.

Connecteurs et commutateurs d’entrée 
audio externe

Connecteur INPUT 1 (page 5)
Connecteur INPUT 2 (page 5)
Griffe à interfaces multiples (lorsqu’une 
poignée en option équipée d’une griffe MI est 
installée)
Commutateur INPUT 1 (LINE/MIC/MIC+48V) 
(page 5)
Commutateur INPUT 2 (LINE/MIC/MIC+48V) 
(page 5)

Commutateurs permettant de régler le 
niveau audio

Commutateur CH1 (AUTO/MAN) (page 4)
Commutateur CH2 (AUTO/MAN) (page 4)
Molette AUDIO LEVEL (CH1) (page 4)
Molette AUDIO LEVEL (CH2) (page 4)

Écran d’état Audio

Sélection du dispositif d’entrée 
audio

1	 Configurez l’entrée audio à l’aide de CH1/
CH2/CH3/CH4 >Source (page 28) dans 
l’écran d’état Audio ou de Audio Input 
>CH1 Input Select à CH4 Input Select 
(page 55) dans le menu Audio du 
menu complet.

	 [Remarques]
•• L’audio n’est pas enregistré en mode Interval 

Rec ou en mode Slow & Quick Motion.
•• L’appareil comporte un microphone de 

narration intégré pour l’enregistrement du 
son d’ambiance. Il peut être utilisé pour la 
synchronisation avec d’autres appareils. Dans ce 
cas, spécifiez MIC interne.

•• Lorsque CH1 Input Select et CH2 Input 
Select sont réglés sur Internal MIC, le niveau 
d’enregistrement audio de CH1 et CH2 est 
réglé à l’aide de la molette AUDIO LEVEL 
(CH1) (page 4). Lorsque CH3 Input Select 
et CH4 Input Select sont réglés sur Internal 
MIC, le niveau d’enregistrement audio de CH3 
et CH4 est réglé à l’aide de CH3 Input Level 
(page 55).

2	 Sélectionnez la source audio d’entrée.
Réglez les commutateurs INPUT 1/INPUT 2 
(LINE/MIC/MIC+48V) selon les dispositifs 
raccordés aux connecteurs INPUT 1/INPUT 
2, respectivement.

Dispositif raccordé Position de 
commutateur

Source audio externe (p. 
ex., table de mixage)

LINE

Microphone dynamique, 
microphone à piles

MIC

Microphone à alimentation 
fantôme de +48 V

MIC+48V

•• Le fait de sélectionner MIC+48V et de 
connecter un microphone qui n’est 
pas compatible avec une source de 
+48V peut endommager le dispositif 
connecté. Vérifiez le réglage avant de 
connecter le dispositif.

•• Si le bruit est un problème sur des 
connecteurs sur lesquels aucun 
dispositif n’est connecté, réglez les 
commutateurs INPUT1/INPUT2 (LINE/
MIC/MIC+48V) correspondants sur LINE.

Réglage automatique du niveau 
d’enregistrement audio

Réglez les commutateurs CH1/CH2 (AUTO/
MAN) des canaux sur AUTO pour qu’ils 
s’ajustent automatiquement.
Pour CH3/CH4, réglez la commande de niveau 
audio de l’écran d’état Audio (page 28) ou 
Audio Input >CH3 Level Control et CH4 Level 
Control sur Auto (page 55) dans le menu 
Audio du menu complet.

Réglage manuel du niveau 
d’enregistrement audio

Utilisez la procédure suivante pour régler le 
niveau d’enregistrement audio pour CH1/CH2.

1	 Réglez les commutateurs CH1/CH2 
(AUTO/MAN) des canaux sur MAN pour 
pouvoir les ajuster manuellement.

2	 Pendant la prise de vue ou la veille, 
tournez les molettes AUDIO LEVEL (CH1)/
(CH2) des canaux correspondants pour 
régler le niveau audio.

•• Pour CH3/CH4, réglez la commande 
de niveau audio à l’aide de CH3/CH4 
(page 28) dans l’écran d’état Audio 
ou de Audio Input >CH3 Level Control 
ou CH4 Level Control dans le menu 
Audio du menu complet sur Manual. 
Puis, réglez le niveau d’enregistrement 
audio à l’aide de CH3 Input Level ou 
CH4 Input Level.

•• Vous pouvez régler les niveaux de CH1 
à CH4 en tant que groupe. Vous pouvez 
ajuster le niveau d’enregistrement en 
utilisant la molette personnalisable 
(page 101) à laquelle la fonction Audio 
Input Level est attribuée, l’écran d’état 
Audio ou Audio Input >Audio Input 
Level dans le menu Audio du menu 
complet.

[Conseil]
L’écran d’état Audio est utile pour vérifier le niveau de 
l’entrée audio (page 28).

[Remarques]
•• Les réglages du niveau d’entrée audio peuvent être 

désactivés, en fonction de la combinaison de réglages 
dans le menu Audio. Pour en savoir plus, reportez-
vous au diagramme dans 131.

•• L’appareil prend en charge des combinaisons de 
plusieurs réglages. Pour en savoir plus, reportez-vous 
au diagramme dans 131.

Ajout de connecteurs d’entrée 
audio

Vous pouvez connecter simultanément jusqu’à 
quatre canaux de dispositifs audio XLR à 
l’appareil en installant une poignée (en option) 
équipée d’une griffe MI et un adaptateur XLR-
K3M XLR (en option).
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Fixez l’adaptateur XLR à la griffe à interfaces 
multiples d’une poignée (en option) équipée 
d’une griffe MI et réglez CH3 >Source sur Shoe 
CH1 et CH4 >Source sur Shoe CH2 dans l’écran 
d’état Audio (page 28). Ou réglez Audio 
Input >CH3 Input Select sur Shoe CH1 et CH4 
Input Select sur Shoe CH2 dans le menu Audio 
du menu complet.
Les fonctions de l’appareil qui se superposent 
seront désactivées pour les canaux sur 
lesquels l’adaptateur XLR est sélectionné 
comme entrée. Utilisez les commutateurs 
et les molettes sur l’adaptateur XLR pour 
effectuer les réglages.

[Remarques]
•• L’appareil prend en charge l’interface audio 

numérique 2 canaux du XLR-K3M.
•• Si Audio Input >CH3 Level et CH4 Level dans le menu 

Audio sont réglés sur Audio Input Level, Audio Input 
Level sur l’appareil sera alors multiplié par le niveau 
réglé sur l’adaptateur XLR.  
Audio Input Level est également activé lorsque le 
commutateur de l’adaptateur XLR est réglé sur AUTO.  
Lorsque « Through » est spécifié, l’audio sera 
enregistré au niveau réglé avec l’adaptateur XLR 
(page 132).
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Fonctions utiles

Utilisation du menu Direct

Lorsque l’écran de prise de vue s’affiche sur 
le moniteur LCD, vous pouvez vérifier l’état 
de l’appareil, et directement sélectionner et 
modifier les réglages affichés sur l’écran.
Les éléments suivants peuvent être 
configurés.
•• Auto Focus Mode
•• Steady Shot
•• Auto Exposure Mode
•• Auto Exposure Level
•• ND Filter Position
•• Auto ND Filter
•• ND Filter Value
•• Auto Iris
•• Iris Value
•• AGC
•• Gain Value
•• ISO Value
•• EI Gain
•• Base ISO/Sensitivity
•• ECS
•• Auto Shutter
•• Shutter Speed Value
•• Shutter Angle Value
•• ATW
•• Auto White Balance
•• Color Temp.
•• Tint
•• Preset White Select
•• Scene File
•• S&Q Motion Frame Rate

1	 Appuyez sur la molette multifonction ou 
sur une touche personnalisable à laquelle 
la fonction Direct Menu est attribuée.
Sur l’écran, vous pouvez uniquement 
sélectionner avec le curseur orange les 
éléments pouvant être configurés à l’aide 
du menu direct.

2	 Tournez la molette multifonction pour 
déplacer le curseur vers l’élément de 
menu à régler, puis appuyez sur la 
molette multifonction.
Un menu s’affiche ou l’élément s’affiche 
sur un arrière-plan blanc.

3	 Tournez la molette multifonction pour 
sélectionner un réglage, puis appuyez sur 
la molette multifonction.
Le menu ou l’arrière-plan blanc disparaît 
et le nouveau réglage s’affiche avec un 
curseur orange.
Appuyez à nouveau sur la touche 
personnalisable à laquelle la fonction 
Direct Menu est affectée ou attendez 
3 secondes sans réaliser d’action pour 
fermer Direct Menu.

	 [Conseils]
•• Vous pouvez aussi configurer les réglages 

directs en maintenant enfoncée chacune des 
touches de fonction.

•• Lorsque des éléments s’affichent sur un arrière-
plan blanc, vous pouvez utiliser la molette 
multifonction comme molette personnalisable.

•• Vous pouvez aussi utiliser le sélecteur multiple 
(page 4) pour les opérations de sélection.

Touches/molettes 
personnalisables

L’appareil dispose de touches 
personnalisables ASSIGN 1 à 3 et ASSIGN 7 à 
11 (page 5, 5, 6, 8) auxquelles 
vous pouvez attribuer des fonctions.
Vous pouvez également attribuer des 
fonctions à la molette multifonction 
(page 4) sur l’appareil et à la molette 
personnalisable sur la télécommande de 
poignée (en option). Les touches ASSIGN 4 à 6 
se trouvent sur la télécommande de poignée 
(en option) RM-30BP (en option).

Changement de la fonction d’une 
touche

Utilisez Assignable Button (page 46) dans le 
menu Project du menu complet.
Vous pouvez visionner les fonctions 
attribuées sur l’écran d’état Assignable Button 
(page 29).

Fonctions attribuées à chaque touche 
personnalisable par défaut
Touche 1	 Off
Touche 2	 Off
Touche 3	 Off
Touche 4	 LCD Focus Magnifier
Touche 5	 Direct Menu
Touche 6	 Off
Touche 7	 Off
Touche 8	 Off
Touche 9	 Off
Touche 10	 Off
Touche 11	 Off
Touche Focus Hold	 Focus Hold

Fonctions attribuables aux touches
•• Off
•• Base ISO/Sensitivity
•• AGC
•• Push AGC
•• ND Filter Position
•• Auto ND Filter
•• Push Auto ND
•• Iris (touche de fonction)
•• Auto Iris
•• Push Auto Iris
•• Bokeh Control
•• Auto Shutter
•• Auto Exposure Level
•• Backlight
•• Spotlight
•• Auto White Balance
•• ATW
•• ATW Hold

•• AF Speed/Sens.
•• Focus Setting
•• Subject Recognition AF
•• Push AF/Push MF
•• Focus Hold
•• LCD Focus Magnifier
•• Output Focus Magnifier
•• S&Q Motion
•• LUT On/Off
•• LUT On/Off
•• Image Stabilization
•• Crop Select
•• Rec
•• Picture Cache Rec
•• Rec Review
•• Clip Flag OK
•• Clip Flag NG
•• Clip Flag Keep
•• Color Bars
•• DURATION/TC/U-BIT
•• Display
•• Lens Info
•• Video Signal Monitor
•• Marker
•• LCD Monitor Adjust
•• LCD Monitor Mode
•• Gamma Display Assist
•• Peaking
•• Zebra
•• Volume
•• Clips
•• Touch Operation
•• Handle Zoom
•• Auto Upload (Proxy)
•• Direct Menu
•• User Menu
•• Menu
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Changement de la fonction d’une 
molette

Vous pouvez modifier la fonction de la molette 
multifonction sur l’appareil et de la molette 
personnalisable sur la télécommande de 
poignée (en option).

Pour la molette multifonction, réglez à l’aide 
de Multi Function Dial (page 48) >Default 
Function dans le menu Project.
Iris est assigné par défaut.

Fonctions attribuables à la molette 
multifonction
•• Off
•• ISO/Gain/EI
•• IRIS
•• Auto Exposure Level
•• Audio Input Level

[Remarque]
Le réglage est désactivé lorsque le menu est affiché.

Pour la molette personnalisable, réglez avec 
Assignable Dial (page 48) dans le menu 
Project du menu complet.
IRIS est attribué partout par défaut.

[Conseil]
La molette personnalisable du RM-30BP (option) 
applique le réglage Grip/Remote Dial.

Fonctions attribuables à la molette 
personnalisable
•• Off
•• ISO/Gain/EI
•• ND Filter
•• IRIS
•• Auto Exposure Level
•• Audio Input Level
•• Multi Function Dial

Vous pouvez visionner les fonctions 
attribuées sur l’écran d’état Assignable Button 
(page 29).

Slow & Quick Motion

Quand Rec Format >Imager Scan Mode 
(page 43) dans le menu Project du menu 
complet est réglé sur les valeurs suivantes, 
vous pouvez spécifier différentes valeurs pour 
la fréquence d’images de prise de vue et la 
fréquence d’images de lecture.

Mode Imager Scan Fréquence d’images

FF 8.6K 17:9 1–30

FF 8.6K 16:9

FFc 6K 17:9 1–60

FFc 6K 16:9

S35 5.8K 17:9

S35 5.8K 16:9

S35c 4K 17:9 1–60, 100, 120

Vous pouvez activer/désactiver le mode Slow 
& Quick Motion en appuyant sur une touche 
personnalisable (page 101) à laquelle la 
fonction S&Q Motion est attribuée.
Vous pouvez régler la fréquence d’images 
pour la prise de vue en maintenant la touche 
enfoncée.

[Conseil]
Vous pouvez également régler le mode à l’aide de Rec 
Function sur l’écran d’état Project et de S&Q Motion 
dans le menu Shooting du menu complet.

[Remarques]
•• Le mode Slow & Quick Motion ne peut pas être réglé 

pendant l’enregistrement, la lecture ou pendant 
l’affichage de l’écran des plans.

•• L’enregistrement audio n’est pas pris en charge en 
mode ralenti et accéléré.

•• La fonction de diaphragme automatique et la fonction 
d’obturation automatique sont désactivées en mode 
Slow & Quick Motion.

•• Certains objectifs peuvent inclure une limite 
supérieure pour la fréquence d’images, selon la 
combinaison du format d’enregistrement.

•• La mise au point automatique présente les limites 
suivantes en mode Slow & Quick Motion.
–– Limites dues au modèle d’objectif, à la fréquence 

du système et à la fréquence d’images de prise 
de vue

Objectif 
Sony

Fréquence du 
système

AF disponible

SEL16F28 59.94/29.97/ 
23.98

30, 60, 120, 
240 fps pris en 
charge

50.00/25.00 25, 50, 100, 
200 fps pris en 
charge

24.00 Non pris en 
charge

Enregistrement de la vidéo par 
intermittence (Interval Rec)

La fonction Interval Rec de l’appareil vous 
permet de capturer de la vidéo à intervalles 
dans la mémoire interne de l’appareil. Cette 
fonction est un moyen efficace pour la prise 
de vue de sujets en mouvement lent.
Lorsque vous commencez l’enregistrement, 
l’appareil enregistre automatiquement un 
nombre spécifié d’images à un intervalle de 
temps spécifié.

Intervalle de prise de vue (Interval Time)

Nombre d’images en une prise
(Number of Frames)

Lorsque Interval Rec est activé, la lampe 
de la vidéo HVL-LBPC (en option) s’allume 
automatiquement avant le début de 
l’enregistrement, ce qui vous permet 
d’enregistrer des images sous des conditions 
de lumière stable et de température de 
couleur (fonction de pré-éclairage).

[Remarques]
•• Il est possible d’utiliser une seule fonction 

d’enregistrement spéciale, tel que l’enregistrement en 
mode Interval Rec.

•• Si un autre mode d’enregistrement spécial est activé 
alors que Interval Rec est en cours d’utilisation, ce 
dernier est automatiquement annulé.

•• Le mode Interval Rec est automatiquement activé 
après avoir modifié les réglages système tel que le 
format vidéo.

•• Les réglages Interval Rec ne peuvent pas être 
modifiés pendant l’enregistrement ou la lecture ou 
lorsque l’écran des plans s’affiche.

Pour régler Interval Rec

Sélectionnez Rec Function >Interval Rec sur 
l’écran d’état Project et configurez les réglages 
Number of Frames et Interval Time.
Si vous utilisez la lampe vidéo HVL-LBPC 
(en option), réglez la durée d’intervalle pour 
allumer la lampe vidéo avant le démarrage de 
l’enregistrement à l’aide de Interval Rec >Pre-
Lighting dans le menu Project, tel que requis.

[Conseil]
Vous pouvez également configurer le mode à l’aide de 
Interval Rec (page 45) dans le menu Project du menu 
complet.

[Remarques]
•• Une poignée (en option) équipée d’une griffe MI est 

requise pour utiliser une lampe HVL-LBPC.
•• Si vous voulez allumer la lampe vidéo avant le début 

de l’enregistrement, mettez l’interrupteur de lampe 
vidéo sur AUTO. La lampe vidéo s’allume et s’éteint 
automatiquement en fonction du réglage de Video 
Light Set (page 60) dans le menu Technical.

•• Si vous allumez la lampe vidéo, la lampe reste 
toujours allumée (la lampe vidéo ne s’allume pas et 
ne s’éteint pas automatiquement).

•• Si la lampe vidéo est configurée pour s’éteindre 
pendant 5 secondes ou moins, la lampe vidéo ne 
s’éteint pas.
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L’appareil quitte le mode Interval Rec lorsqu’il 
est mis hors tension, mais les réglages 
Number of Frames, Interval Time et Pre-
Lighting sont maintenus. Vous n’aurez pas 
besoin de les régler de nouveau la fois 
suivante lorsque vous effectuez une prise de 
vue en mode Interval Rec.

Prise de vue en mode Interval Rec

Appuyez sur la touche REC (démarrer/
arrêter l’enregistrement) pour démarrer 
l’enregistrement. « Int Rec » et « Int Stby » 
s’affichent alternativement sur le moniteur 
LCD.
Si vous utilisez la fonction de pré-éclairage, la 
lampe de la vidéo s’allume avant le démarrage 
de l’enregistrement.

Pour arrêter la prise de vue

Arrêtez l’enregistrement.
A la fin de la prise de vue, les données vidéo 
enregistrées dans la mémoire à ce point sont 
enregistrées sur le support.

Pour quitter le mode Interval Rec

Effectuez l’une des actions suivantes.
•• Mettez l’appareil hors tension.
•• En mode de veille d’enregistrement, réglez 

Rec Function sur un réglage autre que 
Interval Rec sur l’écran d’état Project.

De même, le mode Interval Rec est 
automatiquement activé lorsque l’appareil est 
redémarré.

Limitations pendant l’enregistrement

•• L’audio n’est pas enregistré.
•• Le passage en revue de l’enregistrement 

(Rec Review) n’est pas possible.

Si l’appareil est mis hors tension 
pendant l’enregistrement

•• Si l’interrupteur d’alimentation de 
l’appareil est réglé sur la position Off, 
l’accès au support s’effectue pendant 
plusieurs secondes pour enregistrer les 
images sauvegardées dans la mémoire 
jusqu’à ce moment, puis l’appareil se met 
automatiquement hors tension.

•• Si l’alimentation est coupée car la batterie 
est retirée, le cordon d’alimentation CD 
débranché ou l’alimentation coupée à partir 
de l’adaptateur CA, les données vidéo et 
audio prises jusqu’à ce point peuvent être 
perdues (maximum 10 secondes). Faites 
attention en remplaçant la batterie.

Enregistrement d’images en cache 
(Picture Cache Rec)

La fonction Picture Cache Rec vous permet de 
tourner des vidéos à posteriori lorsque vous 
démarrez l’enregistrement en maintenant 
une mémoire cache interne d’une durée 
déterminée lors de la prise de vue.
Réglez Picture Cache Rec sur On dans l’écran 
d’état Project, puis réglez la taille du cache.

Réglage de la taille 
du cache

Durée de cache 
(approximative)

Short 5 secondes

Medium 10 secondes

Long 20 secondes

Max Valeur maximale ou 
chaque format 
d’enregistrement

[Conseils]
•• La durée du cache peut être plus courte, selon la 

fréquence d’images de prise de vue et le format 
d’enregistrement. Vérifiez l’affichage en bas à droite 
de l’écran de configuration de la taille du cache.

•• Vous pouvez également configurer le mode à l’aide 
de Picture Cache Rec (page 45) dans le menu 
Project du menu complet.

•• Vous pouvez également commuter Picture Cache Rec 
entre On et Off à l’aide d’une touche personnalisable 
(page 101).

[Remarques]
•• La fonction Picture Cache Rec ne peut pas être 

utilisée en combinaison avec la fonction Interval 
Rec, l’enregistrement simultané sur 2 logements ou 
l’enregistrement proxy. Lorsque Picture Cache Rec est 
réglé sur On, ces autres fonctions d’enregistrement 
sont réglées sur Off de force.

•• Le mode Picture Cache Rec ne peut pas être 
sélectionné lorsqu’un enregistrement ou Rec Review 
est en cours.

•• Lorsque Picture Cache Rec est réglé sur On, le code 
temporel est enregistré en mode Free Run, même s’il 
est réglé sur Regen ou Rec Run (page 51).

•• Le réglage Output Format ne peut pas être configuré 
en mode Picture Cache Rec. Si celà se produit, 
désactivez temporairement Picture Cache Rec, puis 
modifiez le réglage.

Démarrage de Picture Cache Rec

Lorsque Picture Cache Rec est sur On, 
« Cache » apparaît sur le moniteur LCD.
Lorsque vous appuyez sur la touche 
REC (démarrer/arrêter l’enregistrement), 
l’enregistrement démarre et la vidéo 
est inscrite sur les cartes mémoire, en 
commençant par la vidéo stockée dans la 
mémoire cache.

Pour quitter Picture Cache Rec

Réglez Picture Cache Rec sur Off sur l’écran 
d’état Project, ou appuyez sur une touche 
personnalisable à laquelle est attribuée la 
fonction Picture Cache Rec.

[Remarques]
•• Si vous modifiez le format d’enregistrement ou le 

look de base, la vidéo dans la mémoire cache stockée 
jusqu’à présent est effacée, et la mise en cache 
d’une nouvelle vidéo démarre. Ainsi, il est impossible 
d’enregistrer des images en mode d’enregistrement 
de cache d’image avant le changement de format, 
même si vous commencez immédiatement à 
enregistrer après avoir changé le format.

•• Si Picture Cache Rec est réglé sur On ou Off 
immédiatement après avoir inséré une carte 
mémoire, les données de cache peuvent ne pas être 
enregistrées sur la carte.

•• La vidéo est stockée dans la mémoire cache lorsque 
la fonction Picture Cache Rec est réglée sur On. La 
vidéo précédant le réglage de la fonction sur On n’est 
pas mise en cache.

•• La vidéo n’est pas stockée dans la mémoire cache 
tant qu’une carte mémoire est en cours d’accès, 
comme lors de la lecture, de la fonction Rec Review 
ou de l’affichage de l’écran des plans. Il est impossible 
d’enregistrer des vidéos en mode d’enregistrement 
de cache d’image pendant cet intervalle.
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Enregistrement simultané sur les 
cartes mémoire A et B (2-slot 
Simul Rec)

Vous pouvez enregistrer simultanément 
sur la carte mémoire A et la carte mémoire 
B en réglant Simul Rec (page 28) dans 
l’écran d’état Project ou Simul Rec >Setting 
(page 44) dans le menu Project du menu 
complet sur On.

Moniteur de signal vidéo

Vous pouvez régler le type de signal vidéo 
à afficher sur le moniteur LCD sur forme 
d’onde, vecteurscope ou histogramme en 
utilisant Display On/Off >Video Signal Monitor 
(page 53) dans le menu Monitoring.
La ligne orange indique la valeur définie du 
niveau zébré.
Vous pouvez également affecter la 
fonction Video Signal Monitor à une touche 
personnalisable (page 101).

Affichage de la cible du moniteur

En mode Cine EI, les informations du réglage 
de la gamme de couleur (page 81) ou du 
réglage du LUT de moniteur (page 41) 
s’affichent en haut à droite du moniteur 
de signal vidéo pour indiquer la cible du 
moniteur.

Look

Fonction d’aide pour l’affichage 
gamma

En mode Custom (page 81) lorsque Target 
Display est réglé sur HDR(HLG), vous pouvez 
régler Gamma Display Assist* sur l’écran d’état 
Monitoring sur On pour voir un affichage 
d’assistance dans le viseur qui facilite la prise 
de vue en HDR.
*	 Vous pouvez également configurer le fonction à l’aide 

de Gamma Display Assist >Setting (page 54) dans 
le menu Monitoring du menu complet.

Breathing Compensation

Vous pouvez définir si vous souhaitez 
effectuer une compensation de respiration 
pour l’objectif à monture E à l’aide de Lens 
>Breathing Compensation (page 59) dans le 
menu Technical du menu complet.
Cette fonction corrige le phénomène qui 
modifie l’angle de vue lorsque la position de 
mise au point varie.
Lorsque la compensation de la respiration est 
exécutée, une partie de l’image est recadrée 
électroniquement pour maintenir un angle 
de vue constant afin que le phénomène de 
respiration n’apparaisse pas.

[Remarques]
•• Lorsque la compensation de la respiration est activée, 

l’angle de vue et la qualité d’image peuvent être 
légèrement modifiés.

•• Selon l’objectif, il peut être impossible de corriger 
la modification de l’angle de vue lorsque la 
compensation de la respiration est activée.

•• La compensation n’est pas possible lorsqu’un objectif 
qui ne prend pas en charge la compensation de la 
respiration est fixé.

•• Cette fonction est réglée sur Off (fixe) dans les cas 
suivants.
–– Lorsque Lens >Distortion Comp. dans le menu 

Technical réglé sur Off
–– Lorsque S&Q Motion >Setting dans le menu 

Shooting est réglé sur On

–– Lorsque Rec Format >Imager Scan Mode 
(page 43) dans le menu Project n’est pas réglé 
sur S35 5.8K 17:9/S35 5.8K 16:9.

–– Lorsque Rec Format >Codec (page 43) dans le 
menu Project est réglé sur X-OCN(LT)

Ajustement du bokeh (Fonction de 
contrôle du bokeh)

Vous pouvez facilement ajuster le degré 
de bokeh en liant le filtre ND et le gain à 
l’opération du diaphragme.

Activation/désactivation de la fonction 
de contrôle du bokeh

Cette fonction ne peut être activée que lors de 
l’ajustement manuel de l’exposition. Réglez le 
filtre ND sur le mode Variable, puis réglez le 
diaphragme, le gain, l’obturateur et le filtre ND 
sur l’ajustement manuel.
Vous pouvez activer/désactiver la fonction 
de contrôle du bokeh à l’aide de Iris >Bokeh 
Control (page 39) dans le menu Shooting 
du menu complet.
Lorsque la fonction de contrôle du bokeh est 
réglée sur On, une icône  s’affiche sur les 
indicateurs de filtre ND et de gain. 

[Conseil]
Vous pouvez également attribuer la fonction Bokeh 
Control à une touche personnalisable (page 101) et 
commuter la fonction de contrôle du bokeh entre On et 
Off en utilisant la touche.

Ajustement du degré de bokeh

1	 Réglez la fonction de contrôle du bokeh 
sur On.

2	 Ouvrez entièrement le diaphragme.

3	 Réglez le filtre ND sur 1/128.

4	 Réglez le gain sur 0 dB et utilisez 
l’éclairage pour ajuster l’exposition.

5	 Ajustez la mise au point.

6	 Ajustez le diaphragme.
Le degré de bokeh change.

[Conseils]
•• Lorsque la fonction de contrôle du bokeh est réglée 

sur On, le filtre ND et le gain fonctionnent ensemble 
pour compenser les changements d’exposition dus à 
l’ajustement du diaphragme, ce qui vous permet de 
changer le degré de bokeh.

•• Le contrôle du bokeh est d’abord lié au filtre ND en 
réponse à l’opération du diaphragme. Lorsque le filtre 
ND ne peut plus être changé, le gain est lié.

•• En mode MF, il est recommandé d’ouvrir d’abord le 
diaphragme, puis d’ajuster la mise au point.

•• Si vous utilisez le filtre ND automatique au lieu 
de la fonction de contrôle du bokeh, le filtre ND 
automatique suit le changement de luminosité du 
sujet.

Affichage pendant l’opération de liaison 
du gain

Lorsque la fonction de contrôle du bokeh est 
réglée sur On, le gain peut changer lorsque le 
diaphragme est ajusté.
Lorsque la liaison du gain est active et que le 
gain change, un message s’affiche en haut 
de l’écran et une icône  sur l’indicateur de 
gain clignote. 

[Remarques]
•• Cette fonction est activée uniquement sur les 

objectifs à monture E qui peuvent communiquer avec 
l’appareil.

•• L’effet maximal de cette fonction peut être obtenu 
en utilisant la bague de diaphragme d’un objectif à 
monture E de Sony.

•• L’apparence peut varier en fonction de la vitesse de 
fonctionnement, de l’objectif, des réglages de prise 
de vue et du sujet, et la luminosité peut également 
changer. Il est fortement recommandé d’effectuer un 
test de la caméra avant la prise de vue.
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•• La luminosité peut changer lorsque le sens de 
fonctionnement du diaphragme change, comme par 
exemple lors de l’ouverture du diaphragme après 
sa fermeture ou lors de la fermeture du diaphragme 
après son ouverture. Dans ce cas, ajustez un peu plus 
que nécessaire au préalable, puis revenez un peu en 
arrière, vérifiez la luminosité, puis commencez la prise 
de vue.  
Par exemple, si vous voulez ouvrir le diaphragme à 
une ouverture F8 et rendre l’arrière-plan flou, fermez 
d’abord le diaphragme au-delà de F8, puis revenez 
à F8, vérifiez la luminosité et commencez la prise de 
vue.

•• Effectuez les opérations de contrôle du bokeh 
lentement. Si vous devez accélérer l’opération, 
essayez d’ajuster progressivement tout en vérifiant les 
changements apportés à l’image.

•• La qualité d’image avec contrôle du bokeh n’est pas 
garantie dans toutes les conditions de prise de vue.

•• La fonction de contrôle du bokeh est réglée sur Off 
lorsque l’une des opérations suivantes se produit.
–– Lorsque l’appareil est mis hors tension
–– Lorsque le diaphragme, le gain, l’obturateur ou le 

filtre ND est réglé sur Auto
–– Lorsque le mode de prise de vue est commuté
–– Lorsque le filtre ND est réglé sur le mode Clear ou 

Step
–– Lorsque l’objectif est retiré
–– Lorsque l’appareil redémarre, par exemple, après 

une commutation de la fréquence

Réglage de l’affichage dé-squeeze

Vous pouvez filmer avec un objectif 
anamorphique pour créer des images au 
format cinémascope.
Régler l’affichage de décompression pour 
qu’il corresponde au grossissement de 
votre objectif anamorphique vous permet 
de produire des images sur la sortie SDI, la 
sortie HDMI et sur l’écran du moniteur LCD qui 
sont ajustées au même rapport d’aspect que 
lorsque vous regardez le sujet directement.
Vous pouvez régler l’affichage de 
décompression à l’aide de De-Squeeze 
(page 52) dans le menu Monitoring du 
menu complet.

[Remarque]
Lorsque le rapport de décompression est réglé sur 2.0×, 
le moniteur de forme d’onde (VSM) détecte aussi les 
parties latérales gauche/droite non affichées.
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Enregistrement du proxy
Vous pouvez enregistrer un plan proxy sur une 
carte SD simultanément à l’enregistrement sur 
une carte CFexpress.

Pour plus de détails sur les cartes mémoire compatibles, 
le formatage des cartes mémoire et la vérification de 
la capacité restante, consultez « Vérification de la durée 
d’enregistrement restante » (page 19).

Configuration avant la prise de 
vue

1	 Réglez Proxy Rec (page 28) dans l’écran 
d’état Project ou Proxy Rec >Setting 
(page 44) dans le menu Project du 
menu complet sur On.

2	 Insérez la carte SD dans le logement de 
carte SD Utility (page 4) avec 
l’étiquette orientée vers le haut.

[Remarque]
Proxy Rec ne peut pas être réglé sur On en même temps 
que S&Q Motion ou Interval Rec. Lorsque Proxy Rec est 
réglé sur On, ces autres modes d’enregistrement sont 
obligatoirement réglés sur Off.

Enregistrement d’un proxy

Appuyez sur la touche REC (démarrer/arrêter 
l’enregistrement) pour lancer l’enregistrement 
lorsque vous avez terminé les réglages 
nécessaires pour la prise de vue.

[Remarques]
•• Si l’appareil est arrêté ou la carte mémoire enlevée 

pendant que le système accède à la carte mémoire, 
l’intégrité des données sur la carte ne peut pas être 
garantie. Toutes les données enregistrées sur la carte 
mémoire peuvent être supprimées. Assurez-vous 
toujours que l’indicateur d’accès de la carte mémoire 
est éteint avant d’arrêter l’appareil ou d’enlever la 
carte mémoire.

•• Assurez-vous que la carte mémoire ne s’éjecte pas 
quand vous l’insérez ou la retirez.

Pour quitter, arrêtez l’enregistrement.

Réglage de Audio Channel pour 
Proxy Recording

Sélectionnez Proxy Rec >Audio Channel 
(page 44) dans le menu Project du 
menu complet et réglez le canal audio pour 
l’enregistrement de données proxy.

À propos du fichier enregistré

L’extension du nom de fichier est « .mp4 ».
Le code temporel est enregistré 
simultanément aussi.

Destination de stockage du fichier 
enregistré

Le fichier enregistré est stocké dans le 
répertoire suivant.

Support 
d’enregistrement

Chemin d’accès

Carte SD /PRIVATE/PXROOT/Clip

À propos du nom de fichier

Le nom de fichier comprend le nom de plan 
enregistré sur la carte mémoire + un suffixe 
« S03 ».
Pour plus de détails sur les noms de plans, 
consultez Clip Name Format (page 51) dans 
le menu TC/Media du menu complet.

[Remarque]
Lorsque le lien entre un plan original et un plan proxy 
est rompu, un plan proxy est créé avec le code temporel 
du début de l’enregistrement comme nom de plan.
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Connexion des moniteurs externes et des dispositifs d’enregistrement
Pour afficher les images enregistrées/lues sur 
un moniteur externe, sélectionnez le signal 
de sortie de l’appareil et utilisez un câble 
approprié pour le moniteur à raccorder.
Vous pouvez également raccorder des 
dispositifs d’enregistrement, tels qu’un 
magnétoscope, et enregistrer le signal de 
sortie depuis l’appareil.
Vous pouvez afficher diverses informations 
d’état et le menu sur un moniteur HDMI 
externe. Set Info. Disp. (page 28) dans 
l’écran d’état Monitoring ou Output Display 
(page 52) dans le menu Monitoring du 
menu complet sur On en fonction du signal à 
transmettre au moniteur. Lorsque le codec est 
réglé sur X-OCN, vous pouvez aussi afficher 
les diverses informations sur un moniteur SDI 
plutôt qu’un moniteur HDMI.

[Remarque]
Veillez aux points suivants lors de la connexion d’un 
moniteur externe ou d’un dispositif d’enregistrement 
à l’appareil. Sinon, des courants importants peuvent 
circuler dans les circuits internes de l’appareil et 
endommager les composants électroniques.
1.	 À propos des câbles CC 

Utilisez des câbles CC avec une faible impédance 
de ligne GND pour connecter un moniteur externe 
d’enregistrement et des dispositifs d’enregistrement.

2.	 Vérification de la différence de potentiel 
Avant l’utilisation, assurez-vous qu’il n’y a pas de 
différence de potentiel entre tous les dispositifs 
connectés et l’appareil.
(1)	 Déconnectez de l’appareil tous les dispositifs 

connectés, tels qu’un moniteur externe et des 
dispositifs d’enregistrement.  
Vérifiez que le câble coaxial 75 Ω, le câble HDMI et 
les autres câbles ne sont pas connectés.

(2)	 Connectez les câbles CC de tous les dispositifs 
connectés et de l’appareil, puis mettez sous 
tension chaque dispositif connecté et l’appareil.

(3)	 Utilisez un testeur ou un autre dispositif pour 
confirmer qu’il n’y a pas de différence de potentiel 
entre l’appareil et chaque dispositif connecté.

S’il y a une différence de potentiel, il est possible 
que l’impédance de la ligne GND de l’un des câbles 
CC soit élevée. Remplacez ces câbles par des 
câbles ayant une faible impédance de ligne GND, 
si nécessaire, afin d’éliminer toute différence de 
potentiel.

3.	 Connexion et séquence de mise sous tension 
Connectez chaque câble et mettez l’appareil sous 
tension dans l’ordre suivant.
(1)	 Mettez hors tension l’appareil, le moniteur 

externe, les dispositifs d’enregistrement et tous 
les autres dispositifs.

(2)	 Connectez les câbles CC de tous les dispositifs.
(3)	 Connectez le câble coaxial 75 Ω, HDMI et les autres 

câbles.
(4)	 Mettez sous tension tous les dispositifs connectés 

et ensuite l’appareil.
Pour plus de détails, contactez un technicien Sony.

Connecteurs SDI OUT 1/2 (de type 
BNC)

Le connecteur SDI OUT 1 peut émettre des 
signaux SDI atteignant 12G.
Le connecteur SDI OUT 2 peut émettre des 
signaux SDI atteignant 3G.
Réglez le format de sortie à l’aide du menu 
Monitoring (page 52).
Utilisez un câble coaxial de 75 Ω disponible 
dans le commerce pour le branchement.

[Remarques]
•• 	Pendant l’enregistrement X-OCN, la sortie SDI n’est 

pas prise en charge si la sortie HDMI est active.
•• 	Vérifiez que le raccordement à la terre entre l’appareil 

et le périphérique externe est correctement effectué 
avant de mettre sous tension. (Nous recommandons 
de mettre sous tension l’appareil et le périphérique 
externe après le branchement d’un câble coaxial de 
75 Ω.)  
Si l’appareil est sous tension, procédez au 
raccordement à l’appareil après avoir branché un 
câble coaxial de 75 Ω au périphérique externe.

•• Pendant l’enregistrement X-OCN, les métadonnées ne 
sont pas enregistrées en temps réel.

Pour commencer l’enregistrement sur 
l’appareil et sur le dispositif externe de 
manière simultanée

Lorsque la sortie de signal SDI est activée, 
réglez SDI/HDMI Rec Control (page 45) 
>Setting dans le menu Project du menu 
complet sur SDI/HDMI Remote I/F ou Parallel 
Rec pour activer la sortie d’un signal de 
déclenchement REC vers le dispositif externe 
raccordé au connecteur SDI OUT. Cela 
permettra de synchroniser l’enregistrement 
sur le dispositif externe avec l’appareil.

[Remarques]
•• Si un dispositif externe raccordé ne prend pas en 

charge le signal de déclenchement REC, le dispositif 
ne peut pas être utilisé.

•• Seul le signal de déclenchement REC est émis 
lorsqu’aucun support n’est inséré.

•• Vous ne pouvez pas sélectionner Parallel Rec pendant 
l’enregistrement X-OCN.

Connecteur HDMI OUT (connecteur 
de type A)

Réglez le format de sortie à l’aide du menu 
Monitoring (page 52) du menu complet.

Pour commencer l’enregistrement sur 
l’appareil et sur le dispositif externe de 
manière simultanée

Lorsque la sortie de signal HDMI est activée, 
réglez HDMI TC Out >Setting (page 51) 
dans le menu TC/Media du menu complet sur 
On, et réglez SDI/HDMI Rec Control >Setting 
(page 45) dans le menu Project sur SDI/
HDMI Remote I/F ou Parallel Rec pour activer 
la sortie d’un signal de déclenchement 
REC vers le dispositif externe raccordé au 
connecteur HDMI OUT. Cela permettra de 
synchroniser l’enregistrement sur le dispositif 
externe avec l’appareil.

[Remarques]
•• Si un dispositif externe raccordé ne prend pas en 

charge le signal de déclenchement REC, le dispositif 
ne peut pas être utilisé.

•• Lorsqu’il est réglé sur SDI/HDMI Remote I/F, seul le 
signal de déclenchement REC est émis lorsqu’aucun 
support d’enregistrement n’est inséré.

•• Vous ne pouvez pas sélectionner Parallel Rec pendant 
l’enregistrement X-OCN.

6. Raccordement de périphériques externes
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Pendant une prise de vue avec plusieurs 
appareils, ces derniers peuvent être 
synchronisés sur un signal de référence 
spécifique ou un code temporel via le 
connecteur REF IN/REF OUT des appareils.

Synchronisation de la phase des 
signaux vidéo (synchronisation)

Configurez le commutateur de sélection 
TC/REF IN/OUT (page 5) de l’appareil 
sur la position IN et envoyez un signal de 
référence au connecteur REF IN/REF OUT 
(page 6) afin d’activer le verrouillage de 
synchronisation.
Les signaux de référence pouvant être 
utilisés varient en fonction de la fréquence 
du système du format d’enregistrement 
sélectionné.

Fréquence du 
système du format 
d’enregistrement

Signaux de référence 
d’entrée pris en charge

59.94P 1920×1080 59.94i 
720×486 59.94i

50P 1920×1080 50i 
720×576 50i

29.97P 1920×1080 59.94i 
720×486 59.94i

25P 1920×1080 50i 
720×576 50i

24P 1920×1080 48i (24PsF)
1920×1080 24P

23.98P 1920×1080 47.95i (23.98PsF)
1920×1080 23.98P

[Remarques]
•• Si le signal de référence est instable, le genlock ne 

peut pas être obtenu.
•• La sous-porteuse n’est pas synchronisée.

Verrouillage du code temporel sur 
d’autres dispositifs

Réglez l’appareil fournissant le code temporel 
sur un mode dans lequel la sortie de code 
temporel continue à défiler (comme Free Run 
ou Clock).

1	 Réglez Timecode (page 51) dans le 
menu TC/Media de la manière suivante.
Mode : prédéfini
Défilement : défilement libre

2	 Appuyez sur la touche personnalisable 
(page 101) à laquelle la fonction 
DURATION/TC/U-BIT consistant à afficher 
le code temporel sur l’écran est attribuée.

3	 Vérifiez que le commutateur de sélection 
TC/REF IN/OUT (page 5) est réglé sur 
la position IN, puis envoyez un signal 
vidéo de référence HD ou SD au 
connecteur REF IN/REF OUT et le code 
temporel de référence au connecteur TC 
IN/TC OUT.

Le générateur de code temporel de l’appareil 
acquiert le verrou avec le code temporel de 
référence et « EXT-LK » apparaît à l’écran.
Une fois que 10 secondes environ se sont 
écoulées après le verrouillage du code 
temporel, l’état de verrouillage externe 
est maintenu, même si la source de 
code temporel de référence externe est 
déconnectée.

[Remarques]
•• Vérifiez que le code temporel de référence et le signal 

vidéo de référence fournis sont en relation de phase 
conforme à la norme de code temporel SMPTE.

•• Lors de l’utilisation d’un verrou externe, le code 
temporel acquiert instantanément le verrou avec 
le code temporel externe et la valeur de code 
temporel externe apparaît dans la zone d’affichage 
des données. Cependant, ne commencez pas 
immédiatement l’enregistrement. Patientez quelques 
secondes le temps que le générateur de code 
temporel se stabilise avant l’enregistrement.

•• Si la fréquence du signal vidéo de référence et 
la fréquence d’images sur l’appareil ne sont pas 
les mêmes, un verrou ne peut pas être acquis et 
l’appareil ne fonctionnera pas correctement. Si cela se 
produit, le code temporel ne pourra pas acquérir de 
verrouillage correct avec le code temporel externe.

•• Si la source de code temporel externe est 
déconnectée, le code temporel peut changer d’une 
image par heure, par rapport au code temporel de 
référence.

Pour déverrouiller le verrou externe

Changez le réglage Timecode dans le menu 
TC/Media.
La synchronisation externe se déclenche 
également en cas de modification de la 
fréquence du système et lorsque vous 
démarrez un enregistrement en mode 
d’enregistrement spécial (Slow & Quick Motion 
ou Interval Rec).

Synchronisation du code temporel 
d’un autre dispositif avec le code 
temporel de l’appareil

Définissez le réglage du code temporel de 
l’appareil sur un mode dans lequel la sortie 
de code temporel continue à être mis à jour 
(comme Free Run ou Clock).

1	 Réglez le code temporel de l’appareil en 
utilisant Timecode (page 51) dans le 
menu TC/Media.

2	 Vérifiez que le commutateur de sélection 
TC/REF IN/OUT (page 5) est réglé sur 
la position OUT, et connectez le 
connecteur TC IN/TC OUT et le connecteur 
REF IN/REF OUT sur le connecteur 
d’entrée de code temporel et le 
connecteur d’entrée de signal de 
référence, respectivement, du dispositif 
que vous souhaitez synchroniser.

Synchronisation externe
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Gestion/Edition de plans grâce à un ordinateur

Connexion à l’aide d’un câble USB

Utilisation d’un lecteur de carte (en 
option)

Connectez un lecteur de carte CFexpress Type 
B ou un lecteur de carte SD à un ordinateur à 
l’aide d’un câble USB, puis insérez une carte 
mémoire dans le logement du lecteur de 
carte. La carte mémoire est reconnue comme 
un lecteur d’extension de l’ordinateur. Sur 
les ordinateurs compatibles, vous pouvez 
importer des plans à haute vitesse à l’aide du 
mode de stockage de masse de l’appareil.

Utilisation du mode de stockage de 
masse

[Remarque]
Le mode de stockage de masse ne peut pas être utilisé 
lorsque USB Tethering >Setting du menu Network dans 
le menu complet est réglé sur On. Réglez sur Off.

Raccordez l’appareil à l’aide d’un câble 
USB et insérez une carte mémoire dans le 
logement de carte A ou B. La carte mémoire 
est reconnue comme un lecteur d’extension 
de l’ordinateur.

1	 Raccordez le connecteur USB-C 
(page 5) à l’ordinateur à l’aide d’un 
câble USB.

2	 Allumez l’appareil.
Un message apparaît sur le moniteur LCD, 
vous demandant si vous souhaitez activer 
les connexions USB.

	 [Remarques]
•• 	N’effectuez pas les opérations suivantes si 

l’indicateur d’accès est allumé en rouge.
–– Mise hors tension ou débranchement du 

cordon d’alimentation.
–– Retrait de la carte mémoire

–– Déconnexion du câble USB
•• Le message de confirmation de connexion USB 

n’est pas affiché tant qu’un autre message de 
confirmation ou de progression est affiché, par 
exemple, lors du formatage ou de la restauration 
d’une carte mémoire.  
Le message de confirmation est affiché lorsque 
l’exécution du formatage ou de la restauration 
est terminée. Le message de confirmation USB 
n’est pas non plus affiché lorsque l’écran des 
propriétés du plan est affiché. Le message est 
affiché lorsque le traitement se termine ou 
lorsque vous revenez à l’écran des plans.

3	 Tournez la molette multifonction pour 
sélectionner Execute.

4	 Sous Windows, vérifiez que la carte est 
ajoutée en tant que disque amovible dans 
la fenêtre « Poste de travail ».
Sous Mac, vérifiez que le dossier appelé 
« NO NAME » ou « Untitled » (éditable) est 
créé sur le bureau.

[Remarques]
•• N’effectuez pas les opérations suivantes si l’indicateur 

d’accès est allumé en rouge.
–– Mise hors tension ou débranchement du cordon 

d’alimentation
–– Retrait de la carte mémoire
–– Déconnexion du câble USB

•• Le fonctionnement n’est pas garanti avec tous les 
ordinateurs.

Utilisation d’un système de 
montage non linéaire

Dans un système de montage non linéaire, un 
logiciel de montage (en option) qui prend en 
charge les formats enregistrés par l’appareil 
est nécessaire.
Utilisez un logiciel d’application dédié pour 
enregistrer au préalable les plans que vous 
souhaitez éditer sur le disque dur de votre 
ordinateur.
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Précautions d’utilisation
Lisez cette section en vous référant également 
aux informations fournies dans le document 
« Avant d’utiliser cet appareil » fourni.

Utilisation et stockage

Ne soumettez pas l’appareil à des chocs 
violents

Ils pourraient endommager les mécanismes 
internes ou déformer le boîtier.

Ne couvrez pas l’appareil pendant son 
fonctionnement

Le fait de couvrir l’appareil d’un tissu, par 
exemple, peut provoquer une surchauffe 
interne.

Après utilisation

Mettez l’appareil hors tension.

Avant un stockage prolongé de 
l’appareil

Retirez le pack de batteries.

Ne laissez pas l’appareil avec l’objectif 
face au soleil

La lumière directe du soleil peut entrer dans 
l’objectif, se concentrer dans l’appareil et 
provoquer un incendie.

Transport

•• Retirez les cartes mémoire avant de 
transporter l’appareil.

•• En cas de transport par camion, bateau, 
avion ou par d’autres services de transport, 
emballez l’appareil dans son emballage 
d’expédition.

Entretien de l’appareil

Si le boîtier de l’appareil est sale, nettoyez-le 
au moyen d’un chiffon sec et doux. Dans les 
cas extrêmes, utilisez un chiffon humidifié 
avec un peu de détergent neutre, puis 
essuyez.
N’utilisez pas de produits organiques tels 
que de l’alcool ou des solvants qui peuvent 
provoquer une décoloration ou d’autres 
dommages de la finition de l’appareil.
Évitez de nettoyer l’appareil avec un 
équipement à haute pression, tel qu’un 
aspirateur à air comprimé, car cela pourrait 
endommager les composants optiques.

En cas de problèmes de fonctionnement

Si vous rencontrez des problèmes avec 
l’appareil, contactez votre revendeur Sony.

Ventilateur

Le ventilateur est une pièce consommable qui 
nécessitera un remplacement périodique.
Lorsque vous utilisez l’appareil à température 
ambiante, le cycle de remplacement 
est d’environ 5 ans. Mais, ce cycle de 
remplacement ne représente qu’une 
indication et ne garantit pas la durée de vie 
de ce consommable. Pour plus de détails 
sur le remplacement de ces pièces, veuillez 
contacter votre revendeur.

Condensateur électrolytique

La durée de vie du condensateur 
électrolytique est de 5 ans environ, sous des 
températures de fonctionnement normales et 
pour un usage normal (8 heures par jour, 25 
jours par mois).
Si l’utilisation dépasse la fréquence 
d’utilisation normale, la durée de vie peut être 
réduite en conséquence.

Remarque à propos de la borne 
de batterie

La borne de batterie de cet appareil (le 
connecteur pour les packs batterie et les 
adaptateurs CA) est une pièce consommable.
L’appareil risque de ne pas être alimenté 
correctement si les broches de la borne de 
batterie sont cintrées ou déformées par 
les chocs ou les vibrations, ou si elles sont 
touchées par la corrosion en raison d’une 
utilisation prolongée en extérieur.
Des inspections périodiques sont 
recommandées pour que l’appareil continue 
à fonctionner correctement et pour prolonger 
la durée de son utilisation. Contactez un 
vendeur ou un technicien Sony pour plus 
d’informations sur les inspections.

Emplacements d’utilisation et de 
stockage

Rangez le caméscope dans un endroit aéré plat.
Évitez d’utiliser ou de stocker l’unité dans les 
endroits suivants.

•• Les endroits excessivement chauds ou froids 
(plage de température de fonctionnement : 
0 °C à 40 °C (32 °F à 104 °F))  
N’oubliez pas qu’en été, dans les climats 
chauds, la température à l’intérieur d’un 
véhicule aux vitres fermées peut facilement 
dépasser 50 °C (122 °F).

•• Les endroits humides ou poussiéreux.
•• Lieux où l’appareil pourrait recevoir la pluie
•• Lieux soumis à de violentes vibrations
•• À proximité de puissants champs 

magnétiques
•• À proximité d’émetteurs radio ou de 

télévision générant de puissants champs 
magnétiques

•• Sous la lumière directe du soleil ou à 
proximité de chauffages pendant de 
longues périodes

Pour empêcher les interférences 
électromagnétiques dues aux dispositifs 
de communication portables

L’utilisation des téléphones portables et 
d’autres dispositifs de communication à 
proximité de cet appareil peut provoquer des 
dysfonctionnements et des interférences avec 
les signaux audio et vidéo.
Il est recommandé de désactiver les dispositifs 
de communication portables à proximité de 
cet appareil.

Remarque sur les faisceaux laser

Les faisceaux laser peuvent endommager le 
capteur d’image CMOS. Si vous filmez une 
scène comprenant un faisceau laser, veillez à 
ce que celui-ci ne soit pas dirigé directement 
vers l’objectif de l’appareil. En particulier, les 
faisceaux laser haute puissance provenant de 
dispositifs médicaux ou d’autres dispositifs 
peuvent causer des dommages dus à la 
lumière réfléchie et à la lumière diffuse.
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À propos des écrans

•• Ne laissez pas les écrans face aux rayons 
directs du soleil, car cela risque de les 
endommager.

•• Lorsque vous appuyez/balayez les écrans, 
ne forcez pas et ne laissez pas d’objets 
sur les écrans, car cela pourrait entraîner 
un dysfonctionnement, notamment une 
irrégularité de l’image, etc.

•• Les écrans peuvent chauffer pendant leur 
utilisation. Il ne s’agit pas d’une anomalie.

Écrans LCD

L’écran LCD intégré à cet appareil est fabriqué 
avec une technologie de haute précision, 
ce qui permet d’obtenir un taux d’au moins 
99,99% de pixels qui fonctionnent. Ainsi, 
un infime pourcentage de pixels peut être 
« bloqué », c’est-à-dire toujours éteint (noir), 
toujours éclairé (rouge, vert ou bleu), ou 
clignotant. En outre, après une longue période 
d’utilisation, en raison des caractéristiques 
physiques de l’afficheur à cristaux liquides, 
de tels pixels « bloqués » peuvent apparaître 
spontanément.
Ces problèmes ne sont pas graves.
Notez que ces problèmes n’ont aucun effet sur 
les données enregistrées.

Condensation

Si l’appareil est soudainement déplacé 
d’un endroit froid à un endroit chaud, ou 
si la température ambiante augmente 
brusquement, de l’humidité peut se former 
sur la surface externe de l’appareil et/ou à 
l’intérieur de l’appareil. Ce phénomène est 

connu sous le nom de condensation. Si de 
la condensation se produit, mettez l’appareil 
hors tension et patientez le temps que la 
condensation disparaisse avant d’utiliser 
l’appareil. L’utilisation de l’appareil avec de la 
condensation pourrait endommager l’appareil.

Phénomènes spécifiques aux 
capteurs d’images CMOS de 
caméra

[Remarque]
Les phénomènes suivants, qui peuvent se produire 
sur les images, sont propres aux capteurs d’images. Ils 
n’indiquent en aucun cas un dysfonctionnement.

Taches blanches

Bien que les capteurs soient fabriqués à 
l’aide de technologies de haute précision, 
il peut arriver (dans de rares cas) que des 
petites taches blanches apparaissent sur 
l’écran, celles-ci sont causées par les rayons 
cosmiques, etc.
Ce phénomène est inhérent à la technologie 
des capteurs d’images et ne signale en aucun 
cas un dysfonctionnement.
Les taches blanches sont surtout visibles dans 
les cas suivants :
•• Lors du fonctionnement à haute 

température ambiante
•• Lorsque vous avez augmenté le gain (la 

sensibilité)

Scintillement

Si l’enregistrement est effectué sous un 
éclairage fluorescent, des lampes au sodium, 
à vapeur de mercure ou LED, l’écran peut 
scintiller ou les couleurs peuvent varier.

Remarques concernant l’affichage

Il se peut que les opérations suivantes 
déforment les sorties et les images sur l’écran 
du viseur.

–– Modification du format vidéo
–– Changer la fréquence d’images FPS
–– Lorsque le genlock est appliqué

Fragmentation de fichiers

S’il est impossible d’enregistrer/reproduire 
correctement des images, essayez de formater 
le support d’enregistrement. Lors de la 
lecture/enregistrement répétés d’une image 
à l’aide d’un certain support d’enregistrement 
pendant une période prolongée, les fichiers 
du support risquent d’être fragmentés, 
empêchant le stockage/enregistrement 
corrects. Dans de tels cas, effectuez une 
sauvegarde des plans sur les supports puis 
formatez le support à l’aide de Format Media 
(page 51) dans menu TC/Media du menu 
complet.

Ne placez pas ce produit près 
d’appareils médicaux 

Ce produit (y compris les accessoires) 
comporte un ou des aimants qui peuvent 
perturber les stimulateurs cardiaques, les 
valves de dérivation programmables pour 
le traitement de l’hydrocéphalie ou d’autres 
appareils médicaux. Ne placez pas ce produit 
près de personnes utilisant ce type d’appareil 
médical. Consultez votre médecin avant 
d’utiliser ce produit si vous utilisez ce type 
d’appareil médical.

Précautions de sécurité

•• SONY NE PEUT ÊTRE TENUE RESPONSABLE 
DE TOUT DOMMAGE, DE QUELQUE NATURE 
QUE CE SOIT, RÉSULTANT D’UNE INCAPACITÉ 
À METTRE EN PLACE DES MESURES DE 
SÉCURITÉ ADAPTÉES POUR LES DISPOSITIFS 
DE TRANSMISSION, DE FUITES DE DONNÉES 
INÉVITABLES DUES AUX SPÉCIFICATIONS 
DE TRANSMISSION OU DE TOUT AUTRE 
PROBLÈME DE SÉCURITÉ.

•• Selon l’environnement d’exploitation, il est 
possible que des tiers non autorisés sur le 
réseau puissent accéder à l’appareil. Avant 
de connecter l’appareil au réseau, vérifiez 
que le réseau est bien protégé.

•• Le contenu des communications peut être 
intercepté à votre insu par des tiers non 
autorisés à proximité des signaux. Lors de 
communications LAN sans fil, appliquez des 
mesures de sécurité adaptées pour protéger 
le contenu des communications.

•• Lorsque vous connectez ce produit à 
un réseau, connectez-le via un système 
fournissant une fonction de protection, 
tel qu’un routeur ou un pare-feu. Si vous 
vous connectez sans cette protection, des 
problèmes de sécurité pourraient survenir.

•• Pour des raisons de sécurité, lors de 
l’utilisation de cet appareil connecté au 
réseau, il est fortement recommandé 
d’accéder à la fenêtre de commande via un 
navigateur Web et de modifier la limitation 
d’accès des valeurs d’usine préréglées 
(page 61).  
Il est par ailleurs recommandé de modifier 
régulièrement le mot de passe.

•• Ne consultez aucun autre site Web dans 
le navigateur Web pendant ou après la 
configuration. Étant donné que l’état de 
connexion est conservé dans le navigateur 
Web, fermez ce dernier lorsque la 
configuration est terminée pour empêcher 
tout tiers non autorisé d’utiliser l’appareil ou 
d’exécuter des programmes malveillants.
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Les réglages par défaut sont affichés en gras (par exemple, 1920×1080P (Level A)).

[Remarques]
•• La résolution du format de sortie est limitée par les réglages Rec Format >Frequency, Codec et Video Format dans le menu Project du menu complet (page 43).
•• L’image n’est pas émise si une résolution supérieure à celle de l’image de lecture est configurée.

Formats de sortie du connecteur SDI OUT/HDMI OUT

Réglage de la fréquence de système
(Rec Format >Frequency dans le menu 
Project)

Réglage de codec
(Rec Format >Codec dans le menu Project)

Résolution d’enregistrement Format de sortie (Output Format dans le menu Monitoring)

SDI1 SDI2 HDMI

50/59.94Hz X-OCN LT (6K 17:9)
(5K 17:9)
(4.3K 17:9)
(4K 17:9)

1920×1080P(A) 1920×1080P(A) –

– – 4096×2160P

– – 1920×1080P

– – 1920×1080i

(6K 16.9)
(5K 16:9)
(4.3K 16:9)
(4K 16:9)

1920×1080P(A) 1920×1080P(A) –

– – 3840×2160P

– – 1920×1080P

– – 1920×1080i

XAVC Intra 4096×2160
(17:9)

4096×2160P1) 2048×1080P(A)1) 4096×2160P1)

4096×2160P1) 2048×1080P(A)1) 1920×1080P1)

4096×2160P1) 2048×1080P(A)1) 1920×1080i1)

1920×1080P(A) 1920×1080P(A) 1920×1080P

1920×1080P(A) 1920×1080P(A) 1920×1080i

1920×1080P(B) 1920×1080P(B) 1920×1080P

1920×1080P(B) 1920×1080P(B) 1920×1080i

1920×1080i 1920×1080i 1920×1080i

Formats de sortie et limites
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Réglage de la fréquence de système
(Rec Format >Frequency dans le menu 
Project)

Réglage de codec
(Rec Format >Codec dans le menu Project)

Résolution d’enregistrement Format de sortie (Output Format dans le menu Monitoring)

SDI1 SDI2 HDMI

50/59.94Hz XAVC Intra
XAVC Long

3840×2160
(16:9)

3840×2160P 1920×1080P(A) 3840×2160P

3840×2160P 1920×1080P(A) 1920×1080P

3840×2160P 1920×1080P(A) 1920×1080i

1920×1080P(A) 1920×1080P(A) 1920×1080P

1920×1080P(A) 1920×1080P(A) 1920×1080i

1920×1080P(B) 1920×1080P(B) 1920×1080P

1920×1080P(B) 1920×1080P(B) 1920×1080i

1920×1080i 1920×1080i 1920×1080i

XAVC Intra
XAVC Long

1920×1080
(16:9)

1920×1080P(A) 1920×1080P(A) 1920×1080P

1920×1080P(A) 1920×1080P(A) 1920×1080i

1920×1080P(B) 1920×1080P(B) 1920×1080P

1920×1080P(B) 1920×1080P(B) 1920×1080i

1920×1080i 1920×1080i 1920×1080i

– – 720×480P, 720×576P

25/29.97Hz X-OCN LT (8K 17:9)
(6K 17:9)
(5K 17:9)
(4.3K 17:9)
(4K 17:9)

1920×1080P 1920×1080P –

– – 4096×2160P

– – 1920×1080P

(8K 16:9)
(6K 16:9)
(5K 16:9)
(4.3K 16:9)
(4K 16:9)

1920×1080P 1920×1080P –

– – 3840×2160P

– – 1920×1080P

XAVC H-I HQ
XAVC H-I SQ

8192×4320
(17:9)

1920×1080P 1920×1080P 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080i

XAVC H-I HQ
XAVC H-I SQ
XAVC H-L

7680×4320
(16:9)

1920×1080P 1920×1080P 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080i
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Réglage de la fréquence de système
(Rec Format >Frequency dans le menu 
Project)

Réglage de codec
(Rec Format >Codec dans le menu Project)

Résolution d’enregistrement Format de sortie (Output Format dans le menu Monitoring)

SDI1 SDI2 HDMI

25/29.97Hz XAVC Intra 4096×2160
(17:9)

4096×2160P1) 2048×1080P1) 4096×2160P1)

4096×2160P1) 2048×1080P1) 1920×1080P1)

1920×1080P 1920×1080P 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080i

XAVC Intra
XAVC Long

3840×2160
(16:9)

3840×2160P 1920×1080P 3840×2160P

3840×2160P 1920×1080P 1920×1080P

1920×1080P 1920×1080P 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080i

XAVC Intra
XAVC Long

1920×1080
(16:9)

1920×1080P 1920×1080P 1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080i

23.98Hz X-OCN LT (8K 17:9)
(6K 17:9)
(5K 17:9)
(4.3K 17:9)
(4K 17:9)

1920×1080P 1920×1080P –

– – 4096×2160P

– – 1920×1080P

(8K 16:9)
(6K 16:9)
(5K 16:9)
(4.3K 16:9)
(4K 16:9)

1920×1080P 1920×1080P –

– – 3840×2160P

– – 1920×1080P

XAVC H-I HQ
XAVC H-I SQ

8192×4320
(17:9)

1920×1080P 1920×1080P 1920×1080P

XAVC H-I HQ
XAVC H-I SQ
XAVC H-L

7680×4320
(16:9)

1920×1080P 1920×1080P 1920×1080P

XAVC Intra 4096×2160
(17:9)

4096×2160P1) 2048×1080P1) 4096×2160P1)

4096×2160P1) 2048×1080P1) 1920×1080P1)

1920×1080P 1920×1080P 1920×1080P

23.98Hz XAVC Intra
XAVC Long

3840×2160
(16:9)

3840×2160P 1920×1080P 3840×2160P

3840×2160P 1920×1080P 1920×1080P

1920×1080P 1920×1080P 1920×1080P

XAVC Intra
XAVC Long

1920×1080
(16:9)

1920×1080P 1920×1080P 1920×1080P
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Réglage de la fréquence de système
(Rec Format >Frequency dans le menu 
Project)

Réglage de codec
(Rec Format >Codec dans le menu Project)

Résolution d’enregistrement Format de sortie (Output Format dans le menu Monitoring)

SDI1 SDI2 HDMI

24Hz X-OCN LT (8K 17:9)
(6K 17:9)
(5K 17:9)
(4.3K 17:9)
(4K 17:9)

1920×1080P 1920×1080P –

– – 4096×2160P

– – 1920×1080P

XAVC H-I HQ
XAVC H-I SQ

8192×4320
(17:9)

1920×1080P 1920×1080P 1920×1080P

XAVC Intra 4096×2160
(17:9)

4096×2160P1) 2048×1080P1) 4096×2160P1)

1920×1080P 1920×1080P 1920×1080P

1)	 Impossible à sélectionner si la taille d’imageur (Imager Scan Mode) est S35c 4K 17:9 et si la fréquence d’images est de 100 fps ou plus lors d’une prise de vue en mode Slow & Quick Motion.
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Durée d’enregistrement/de lecture de plans
Les tableaux suivants indiquent la durée de lecture/enregistrement lors de l’utilisation de cartes mémoire Sony CFexpress Type B VPG400 960 Go (Unité : minutes).

[Remarque]
Les durées d’enregistrement et de lecture sont pour l’enregistrement continu sous forme de plan unique. Les durées réelles peuvent être plus courtes, selon le nombre de plans enregistrés. La durée d’enregistrement/de lecture peut varier 
selon les conditions d’utilisation et les caractéristiques de mémoire.

Imager Scan 
Mode

Frequency Codec

X-OCN (LT) XAVC H-I HQ 
8192×4320

XAVC H-I HQ 
7680×4320

XAVC H-I SQ 
8192×4320

XAVC H-I SQ 
7680×4320

XAVC H-L 
7680×4320

XAVC-I 
4096×2160

XAVC-I 
3840×2160

XAVC-I 
1920×1080

XAVC-L 
3840×2160

XAVC-L 
1920×1080

FF 8.6K 17:9 23 74 130 – 194 – – – – – – –

24 74 130 – 193 – – – – – – –

25 71 125 – 186 – – – – – – –

29 59 104 – 155 – – – – – – –

50 – – – – – – – – – – –

59 – – – – – – – – – – –

FF 8.6K 16:9 23 69 – 130 – 194 239 – – – – –

24 – – – – – – – – – – –

25 66 – 125 – 186 239 – – – – –

29 55 – 104 – 155 238 – – – – –

50 – – – – – – – – – – –

59 – – – – – – – – – – –

FFc 6K 17:9 23 150 – – – – – 494 – – – –

24 150 – – – – – 493 – – – –

25 144 – – – – – 473 – – – –

29 120 – – – – – 397 – – – –

50 72 – – – – – 241 – – – –

59 60 – – – – – 201 – – – –

FFc 6K 16:9 23 140 – – – – – – 494 1207 1145 2121

24 – – – – – – – – – – –

25 135 – – – – – – 473 985 1140 2106

29 112 – – – – – – 397 981 1127 2070

50 67 – – – – – – 241 512 756 1939

59 56 – – – – – – 201 510 745 1878

S35 5.8K 17:9 23 165 – – – – – 494 – – – –

24 164 – – – – – 493 – – – –

25 158 – – – – – 473 – – – –

29 132 – – – – – 397 – – – –

50 79 – – – – – 241 – – – –

59 66 – – – – – 201 – – – –
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Imager Scan 
Mode

Frequency Codec

X-OCN (LT) XAVC H-I HQ 
8192×4320

XAVC H-I HQ 
7680×4320

XAVC H-I SQ 
8192×4320

XAVC H-I SQ 
7680×4320

XAVC H-L 
7680×4320

XAVC-I 
4096×2160

XAVC-I 
3840×2160

XAVC-I 
1920×1080

XAVC-L 
3840×2160

XAVC-L 
1920×1080

S35 5.8K 16:9 23 154 – – – – – – 494 1207 1145 2121

24 – – – – – – – – – – –

25 148 – – – – – – 473 985 1140 2106

29 124 – – – – – – 397 981 1127 2070

50 74 – – – – – – 241 512 756 1939

59 62 – – – – – – 201 510 745 1878

S35c 4K 17:9 23 323 – – – – – 494 – – – –

24 323 – – – – – 493 – – – –

25 310 – – – – – 473 – – – –

29 259 – – – – – 397 – – – –

50 156 – – – – – 241 – – – –

59 130 – – – – – 201 – – – –
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Dépannage

Alimentation

Symptôme Cause Solution

L’appareil ne se met pas sous 
tension.

Le pack batterie n’est pas 
mis en place et aucune 
alimentation n’est fournie au 
connecteur DC IN.

Mettez en place un pack batterie 
(page 13) ou connectez-vous à une 
source d’alimentation CA à l’aide d’un 
adaptateur CA (page 13).

Le pack batterie est 
totalement déchargé.

Remplacez-le par un pack batterie 
totalement chargé (page 13).

L’alimentation est 
interrompue pendant le 
fonctionnement.

Le pack batterie se décharge. Remplacez-le par un pack batterie 
totalement chargé (page 13).

Le pack batterie se décharge 
très rapidement.

La température ambiante est 
très basse.

Cela est dû aux caractéristiques de la 
batterie et ne constitue pas une 
anomalie.

La charge du pack batterie 
est inadéquate.

Rechargez le pack batterie (page 13).
Si le pack batterie se décharge 
rapidement même après avoir été 
totalement chargé, il se peut que sa 
durée de vie en service touche à sa fin. 
Remplacez-le par un neuf.

Enregistrement/lecture

Symptôme Cause Solution

L’enregistrement ne démarre 
pas lorsque vous appuyez 
sur la touche REC (démarrer/
arrêter l’enregistrement).

La carte mémoire est pleine. Remplacez la carte mémoire par une 
autre possédant suffisamment 
d’espace.

La carte mémoire nécessite 
une restauration.

Restaurez la carte mémoire 
(page 19).

L’enregistrement audio est 
impossible.

Les molettes AUDIO LEVEL 
(CH1/CH2) sont réglées sur le 
niveau minimal.

Ajustez les niveaux d’enregistrement 
audio avec les molettes AUDIO LEVEL 
(CH1/CH2) (page 99).

Le son enregistré est 
déformé.

Le niveau sonore est trop 
élevé.

Ajustez les niveaux d’enregistrement 
audio avec les molettes AUDIO LEVEL 
(CH1/CH2) (page 99).

Symptôme Cause Solution

L’enregistrement audio 
présente un niveau sonore 
élevé.

Le niveau sonore est trop 
bas.

Ajustez les niveaux d’enregistrement 
audio avec les molettes AUDIO LEVEL 
(CH1/CH2) (page 99).
Ajustez également le réglage Audio 
Input >INPUT MIC Reference 
(page 55) dans le menu Audio du 
menu complet lorsqu’un microphone 
externe est sélectionné.

Impossible de lire les plans. Le plan est en cours de 
modification.

La lecture des plans est impossible si 
vous avez modifié les noms de fichiers 
ou les dossiers ou si le plan est en cours 
d’utilisation sur un ordinateur. Il ne 
s’agit pas d’un dysfonctionnement.

Le plan est en cours 
d’enregistrement sur un 
autre appareil.

Il se peut que les plans enregistrés sur 
d’autres appareils soient illisibles ou 
s’affichent dans une taille incorrecte. Il 
ne s’agit pas d’un dysfonctionnement.

Dispositifs externes

Symptôme Solution

L’ordinateur ne reconnaît pas 
l’appareil.

Débranchez le câble USB de l’ordinateur, puis rebranchez-le 
correctement.

Débranchez le câble USB de l’ordinateur, redémarrez votre 
ordinateur, et suivez de nouveau les étapes dans le bon ordre.

Raccordez l’ordinateur et l’appareil en insérant un câble USB dans 
le connecteur USB-C ou dans le connecteur USB/Multi.

Le chargement de plans sur 
l’ordinateur est impossible.

Débranchez le câble USB de l’ordinateur, redémarrez l’appareil, 
puis rebranchez-le.

Il faut installer un logiciel d’application pour charger des plans sur 
votre ordinateur (page 109).
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Connexion LAN sans fil

[Remarque]
Les obstructions et les interférences électromagnétiques entre l’appareil et le point d’accès au réseau local sans fil ou 
le périphérique terminal, ou l’environnement ambiant (comme les matériaux muraux) pourraient raccourcir la plage 
de communication ou empêcher complètement les connexions. Si vous rencontrez ces problèmes, vérifiez l’état de la 
connexion/communication après avoir déplacé l’appareil vers un nouvel emplacement ou avoir rapproché l’appareil 
et le point d’accès/terminal.

Symptôme Solution

Un terminal ne peut pas accéder 
à l’appareil.

•• Vérifiez la connexion LAN sans fil (adresse IP, etc.).
•• Il se peut que le réglage de la communication entre le point 

d’accès et le client soit invalide. Pour plus de détails, consultez le 
mode d’emploi du point d’accès.

Vous ne pouvez pas vous 
connecter à l’appareil.

Vérifiez le nom d’utilisateur et le mot de passe que vous avez 
définis.

Connexion Internet

Symptôme Solution

Échec de téléchargement du 
fichier.

Il se peut que le nom d’utilisateur et le mot de passe du serveur ne 
soient pas corrects.
Saisissez le nom d’utilisateur et le mot de passe corrects.

Le téléchargement du fichier 
n’est pas disponible.

Il se peut que l’état du signal soit mauvais.
Déplacez-vous vers un autre emplacement, et réessayez.

Lors de l’utilisation du filtre ND

Symptôme Solution

Le filtre ND ne se déplace pas. Vous pouvez positionner manuellement le filtre sur la position 
Clear à l’aide de la procédure suivante.

1	 Réglez le commutateur ND STEP/VARIABLE (page 5) sur la position STEP et appuyez sur 
la touche bas de la touche haut/bas ND FILTER POSITION (page 5) de manière à ce que 
le témoin ND CLEAR s’allume.

2	 Mettez l’appareil hors tension.

3	 Retirez le capuchon rond situé sur le côté inférieur (2 emplacements).

4	 Insérez un tournevis dans l’orifice (2 emplacements) et tournez-le dans le sens contraire des 
aiguilles d’une montre.
•• Le filtre ND se place en position Clear lorsque vous tournez dans le sens contraire des 

aiguilles d’une montre. Continuez à tourner jusqu’à atteindre la position Clear.
•• Utilisez un tournevis de ø2,4 mm ou moins de diamètre. La profondeur d’insertion du 

tournevis est d’environ 3,0 cm (1 3/16 po.).

Trou pour tournevis 
(avec le capuchon retiré)

[Remarques]
•• N’utilisez pas la procédure ci-dessus pendant le fonctionnement normal. Utilisez uniquement cette procédure 

si le filtre ND ne se déplace pas. Le filtre ND peut être endommagé si cette procédure est utilisée pendant le 
fonctionnement normal.

•• Après avoir utilisé la procédure ci-dessus, consultez un centre de service Sony pour faire réparer l’appareil.
•• Si un message d’erreur apparaît toujours après avoir utilisé la procédure ci-dessus, la prise de vue est toujours 

possible.
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Avertissements de fonctionnement
Si l’appareil détecte un avertissement, une précaution ou une opération qui nécessite une 
confirmation, un message s’affiche dans le moniteur LCD, le témoin d’enregistrement/de 
signalisation commence à clignoter et un avertissement sonore est émis.
Le son d’avertissement est émis depuis les écouteurs connectés au connecteur pour casque.

Messages d’erreur

L’appareil arrêtera l’opération si l’un des écrans suivants s’affiche.

Affichage d’erreur du 
moniteur LCD

Avertissement 
sonore

Témoin 
d’enregistre-
ment/de 
signalisation

Cause et solution

E + code d’erreur Continu Clignotement 
très rapide

L’appareil peut être défectueux.
Mettez l’appareil hors tension, et vérifiez si vous 
détectez un problème au niveau des dispositifs, 
des câbles ou du support raccordés. Si l’erreur 
persiste après avoir remis l’appareil sous tension, 
contactez votre représentant du service après-
vente Sony.
(Si l’alimentation ne peut pas être coupée en 
mettant l’interrupteur d’alimentation sur la 
position  (veille), retirez le pack de batteries ou 
la source DC IN.)
Il se peut qu’aucun affichage d’erreur ni aucune 
alerte sonore d’avertissement ne survienne selon 
l’état de l’appareil.

Messages d’avertissement

Suivez les instructions fournies si l’écran suivant s’affiche.

Affichage 
d’avertissement du 
moniteur LCD

Avertissement 
sonore

Témoin 
d’enregistre-
ment/de 
signalisation

Cause et solution

Battery Near End Intermittent Clignotant La capacité restante du pack batterie est faible.
Rechargez-le dès que possible.

Affichage 
d’avertissement du 
moniteur LCD

Avertissement 
sonore

Témoin 
d’enregistre-
ment/de 
signalisation

Cause et solution

Battery End Continu Clignotement 
très rapide

Le pack de batteries est épuisé. L’enregistrement 
est désactivé.
Arrêtez les opérations et remplacez le pack 
batterie.

Temperature High Intermittent Clignotant La température interne est élevée.
Mettez l’appareil hors tension et laissez-le refroidir 
avant de le faire fonctionner à nouveau.

Media Temperature 
High

Intermittent Clignotant La température de la carte CFexpress est élevée.
Remplacez la carte ou et laissez-la refroidir avant 
de l’utiliser à nouveau.

Voltage Low Intermittent Clignotant La tension DC IN est faible (niveau 1). Vérifiez la 
source d’alimentation.

Insufficient Voltage Continu Clignotement 
très rapide

La tension DC IN est trop faible (niveau 2). 
L’enregistrement est désactivé.
Raccordez une source d’alimentation différente.

Media Near Full Intermittent Clignotant La capacité restante de la carte mémoire est 
faible.
Remplacez-la dès que possible.

Media Full Continu Clignotement 
très rapide

Les plans n’ont pas pu être enregistrés ni copiés 
car la capacité restante de la carte mémoire n’est 
pas suffisante.
Remplacez-la immédiatement.

Clips Near Full Intermittent Clignotant Le nombre de plans supplémentaires pouvant 
être enregistrés sur la carte mémoire diminue.
Remplacez-la dès que possible.

Clips Full Continu Clignotement 
très rapide

Le nombre maximal de plans pouvant être 
enregistrés sur la carte mémoire a été atteint.
L’enregistrement ou la copie de plus de plans est 
impossible. Remplacez-la immédiatement.

Last Clip Recording Intermittent Clignotant Le plan en cours d’enregistrement est le dernier 
plan qui peut être enregistré, étant donné que le 
nombre maximum de plans a été atteint.
Préparez une nouvelle carte mémoire.

Media(A)1) Life Near 
End

Intermittent Clignotant La carte mémoire approche de la fin de sa durée 
de vie. Remplacez-la dès que possible.

Media(A)1) Life End Continu Clignotement 
très rapide

La carte mémoire a atteint la fin de sa durée de 
vie. Remplacez-la immédiatement.

Media(A)1) Near Full Intermittent Clignotant Lorsque vous utilisez la fonction Simul Rec



7. Annexe : Avertissements de fonctionnement121

Affichage 
d’avertissement du 
moniteur LCD

Avertissement 
sonore

Témoin 
d’enregistre-
ment/de 
signalisation

Cause et solution

Media(A)1) Full Continu Clignotement 
très rapide

Lorsque vous utilisez la fonction Simul Rec

Media(A)1) Clips Near 
Full

Intermittent Clignotant Lorsque vous utilisez la fonction Simul Rec

Media(A)1) Clips Full Continu Clignotement 
très rapide

Lorsque vous utilisez la fonction Simul Rec

Media(A) 1) Last Clip 
Rec

Intermittent Clignotant Lorsque vous utilisez la fonction Simul Rec

Transfer Jobs Near 
Full

– – Le nombre de tâches de transfert de fichiers FTP 
pouvant être enregistrées diminue.

Transfer Jobs Full – – Le nombre de tâches de transfert de fichiers FTP 
pouvant être enregistrées a atteint la limite 
supérieure. Pour ajouter une autre tâche, 
supprimez d’abord toute tâche non désirée. 2)

1)	 « (B) » s’affiche pour la carte située dans le logement B.
2)	Vous pouvez sélectionner et supprimer des tâches à l’aide de File Transfer >View Job List (page 63) dans le menu 

Network du menu complet. Vous pouvez également supprimer des tâches de la liste des tâches dans l’application 
Monitor & Control.

Messages de précaution concernant l’opération

Les messages de précaution et d’opération suivants peuvent apparaître au centre de 
l’écran. Suivez les instructions fournies pour résoudre le problème.

Message du viseur Cause et solution

Battery Error
Please Change Battery

Une erreur a été détectée au niveau du pack batterie.
Remplacez-le par un pack batterie normal.

Backup Battery End
Please Change

La capacité restante de la batterie de secours est insuffisante.
Rechargez la batterie de secours.

Unknown Media (A) 1)

Please Change
Une carte mémoire qui a été partitionnée ou une carte 
mémoire contenant plus de plans que ceux pouvant être 
gérés par l’appareil a été insérée.
La carte ne peut pas être utilisée dans l’appareil et doit être 
remplacée.

Cannot Use Media (A) 1)

Unsupported File System
Une carte utilisant un système de fichiers différent ou une 
carte non formatée a été insérée.
La carte ne peut pas être utilisée dans l’appareil et doit être 
remplacée ou formatée à l’aide de l’appareil.

Media Error
Media (A) 1) Needs to be Restored

Une erreur s’est produite avec la carte mémoire et la carte doit 
être restaurée.
Restaurez la carte mémoire.

Media Error
Cannot Record to Media(A) 1)

La carte mémoire peut être endommagée et ne peut plus être 
utilisée pour l’enregistrement.
La lecture est possible, il est donc recommandé d’effectuer 
une copie et de remplacer la carte mémoire.

Media Error
Cannot Use Media (A) 1)

La carte mémoire peut être endommagée et ne peut plus être 
utilisée pour l’enregistrement ou la lecture.
La carte ne peut pas être utilisée dans l’appareil et doit être 
remplacée.

Media (A) 1) Error
Recording Halted
Playback Halted

La lecture ou l’enregistrement s’est arrêté parce qu’une erreur 
s’est produite sur la carte mémoire.
Si le problème persiste, remplacez la carte mémoire.

Media Reached Rewriting Limit
Change Media (A) 1)

La carte mémoire a atteint la fin de sa durée de vie.
Effectuez une copie de sauvegarde et remplacez la carte 
immédiatement. Si vous continuez à utiliser la carte, la carte 
risque de ne plus pouvoir enregistrer ou lire.
Pour plus de détails, reportez-vous au mode d’emploi de la 
carte mémoire.

The specified address is invalid. L’adresse spécifiée est invalide.
Vérifiez que le réglage est correct.

Cannot Use Specified Port Number Le numéro de port spécifié est invalide.
Vérifiez que le réglage est correct.
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Message du viseur Cause et solution

Fan Stopped Le ventilateur intégré s’est arrêté.
Evitez l’utilisation à des températures élevées, débranchez 
l’alimentation et prenez contact avec votre technicien Sony.

LENS Error Défaillance de communication I/F de l’objectif détectée 
lorsqu’un objectif à monture E est fixé.
Vérifiez l’état du raccordement à l’objectif à monture E.

This Multi Term. acc is not supported 
by the device and cannot be used.
Please verify the compatibility.

Un accessoire incompatible a été détecté.
Le seul accessoire à terminaux multiples compatible avec 
l’unité est la télécommande de poignée fournie.

Failed. Cette erreur peut apparaître si une adresse ne peut pas être 
obtenue avec DHCP réglé sur On.
Vérifiez les réglages du serveur DHCP.

Addition of auto upload job failed. Le nombre maximum de tâches de transfert a été atteint.
Effacez toute tâche non désirée. Il est possible que le réglage 
de destination de téléchargement automatique pour les plans 
originaux ou les plans proxy soit également incorrect. Vérifiez 
que le réglage est correct.

<SSID>Not found. Le réseau (point d’accès) avec le <SSID> spécifié est 
introuvable.
Vérifiez que le réglage est correct.

<SSID>Authentication Failed L’authentification de connexion sur le réseau (point d’accès) 
avec le <SSID> spécifié a échoué.
Vérifiez que le mot de passe et les autres réglages sont 
corrects.

An IP address conflict has occurred. 
Please check the network settings.

Il y a un conflit entre les adresses réseau du LAN sans fil, du 
LAN filaire ou du raccordement modem USB.
Changez l’adresse manuellement ou changez les réglages du 
routeur réseau.

The IP address of the Wireless LAN 
Access Point Mode has been 
changed due to an IP address 
conflict.

L’adresse IP du mode de point d’accès de LAN sans fil a été 
modifiée en raison d’un conflit entre les adresses réseau du 
mode de point d’accès de LAN sans fil, du LAN filaire ou du 
raccordement modem USB.
Vérifiez le réglage de l’adresse IP.

1)	 « (B) » s’affiche pour la carte située dans le logement B.
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Eléments enregistrés dans les fichiers

Éléments configurés dans Full Menu

Oui : l’élément est enregistré.
Non : l’élément n’est pas enregistré.
– : non enregistré (réglage temporaire)

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting ISO/Gain/EI Mode Oui Non

ISO/Gain Oui Non

Exposure Index Oui Non

Shockless Gain Oui Non

Base Sensitivity Oui Non

Base ISO Oui Non

ND Filter Display Mode Oui Non

Shutter Mode Oui Non

Shutter Speed On/Off Oui Non

Shutter Speed Oui Non

Shutter Angle Oui Non

ECS On/Off Oui Non

ECS Frequency Oui Non

Iris Bokeh Control Non –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Auto Exposure Level Oui Non

Mode Oui Non

Speed Oui Non

Auto ND Filter Oui Non

AGC Oui Non

AGC Limit Oui Non

AGC Point Oui Non

Auto Shutter Oui Non

A.SHT Limit Oui Non

A.SHT Point Oui Non

Auto Iris Oui Non

Clip High light Oui Non

Detect Window Oui Non

Detect Window Indication Oui Non

Custom Width Oui Non

Custom Height Oui Non

Custom H Position Oui Non

Custom V Position Oui Non

White White Select Oui Non

Auto White Balance – –

ATW Oui Non

Color Temp Oui Non

Tint Oui Non

R Gain Oui Non

B Gain Oui Non

Preset White Select – –

White Setting Shockless White Oui Non

ATW Speed Oui Non
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Focus AF Transition Speed Oui Non

AF Subj. Shift Sens. Oui Non

Focus Area Oui Non

Subject Recognition AF Oui Non

Touch Function in MF Oui Non

AF Assist Oui Non

S&Q Motion Setting Oui Non

Frame Rate Oui Non

LUT On/Off SDI/HDMI Oui Non

SDI Oui Non

LCD/Proxy/Stream Oui Non

LCD/HDMI/Px/Stream Oui Non

Noise Suppression Setting(Custom) Oui Non

Level(Custom) Oui Non

Setting(Cine EI) Oui –

Level(Cine EI) Oui –

Flicker Reduce Mode Oui Non

Frequency Oui Non

Image Stabilization SteadyShot Oui Non

PL Stabilization Oui Non

Stabilization Adjustment Oui Non

Focal Length Oui Non

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project Base Setting Shooting Mode Oui –

Target Display Oui –

Rec Format Frequency Oui Non

Imager Scan Mode Oui Non

Codec Oui Non

Video Format Oui Non

Cine EI Setting Color Gamut Oui –

Embed LUT File Oui Non

Simul Rec Setting Oui Non

Proxy Rec Setting Oui Non

Audio Channel Oui Non

Interval Rec Setting Non Non

Interval Time Oui Non

Number of Frames Oui Non

Pre-Lighting Oui Non

Picture Cache Rec Setting Oui Non

Cache Size Oui Non

Cache Rec Time – –

SDI/HDMI Rec Control Setting Oui Non

Assignable Button <1> Oui Non

<2> Oui Non

<3> Oui Non

<4> Oui Non

<5> Oui Non

<6> Oui Non

<7> Oui Non

<8> Oui Non

<9> Oui Non

<10> Oui Non

<11> Oui Non

Focus Hold Button Oui Non
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project Assignable Dial Grip/Remote Dial Oui Non

Grip Dial Direction Oui Non

Multi Function Dial Default Function Oui Non

User File Load from UTILITY SD – –

Save to UTILITY SD – –

File ID Non Non

Load Customize Data Oui Non

Load White Data Oui Non

All File Load from UTILITY SD – –

Load from Cloud(Private) – –

Load from Cloud(Share) – –

Save to UTILITY SD – –

Save to Cloud(Private) – –

Save to Cloud(Share) – –

File ID Oui Non

Load Network Data Non Non

Paint/Look Scene File Recall – –

Store – –

Delete – –

Preset Recall – –

Base Look Select Oui Oui

Delete – –

Delete All – –

Import from Utility SD – –

Import from Cloud(Private) – –

Import from Cloud(Share) – –

Input Oui –

Output Oui –

AE Level Offset Oui –

Reset Paint Settings Reset without Base Look – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Paint/Look Black Master Black Oui Oui

R Black Oui Oui

B Black Oui Oui

Knee Setting Oui Oui

Auto Knee Oui Oui

Point Oui Oui

Slope Oui Oui

Detail Setting Oui Oui

Level Oui Oui

H/V Ratio Oui Oui

B/W Balance Oui Oui

Limit Oui Oui

Crispening Oui Oui

High Light Detail Oui Oui

Matrix User Matrix Oui Oui

User Matrix Level Oui Oui

User Matrix Phase Oui Oui

User Matrix R-G Oui Oui

User Matrix R-B Oui Oui

User Matrix G-R Oui Oui

User Matrix G-B Oui Oui

User Matrix B-R Oui Oui

User Matrix B-G Oui Oui

Multi Matrix Setting Oui Oui

Reset – –

Axis Non Non

Hue Oui Oui

Saturation Oui Oui
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

TC/Media Timecode Mode Oui Non

Run Oui Non

Setting Non Non

Reset – –

TC Format Oui Non

TC Display Display Select Oui Non

Users Bit Mode Oui Non

Setting Non Non

HDMI TC Out Setting Oui Non

Clip Name Format Camera ID Non Non

Reel Number Non Non

Camera Position Non Non

XAVC Root Folder Name Oui Non

Update Media Media(A) – –

Media(B) – –

Format Media Media(A) – –

Media(B) – –

Utility SD – –

Monitoring Output Format SDI1 Oui Non

SDI2 Oui Non

HDMI Oui Non

REF Non Non

De-Squeeze Ratio Oui Non

SDI (X-OCN) Oui Non

HDMI (FHD Output) Oui Non

Moniteur LCD Oui Non

Output Display SDI Oui Non

HDMI Oui Non

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Display On/Off Focus Mode Oui Non

Focus Position Oui Non

Network Status Oui Non

File Transfer Status Oui Non

Rec/Play Status Oui Non

SDI/HDMI Rec Control Oui Non

Tally Oui Non

Battery Remain Oui Non

Zoom Position Oui Non

Image Stabilization Oui Non

Media Status Oui Non

Lens Info Oui Non

Look Name Oui Non

UWP RF Level Oui Non

Focus Area Indicator Oui Non

Subject Recognition Frame Oui Non

Clip Name Oui Non

Video Level Warning Oui Non

Timecode Oui Non

Gamma Display Assist Oui Non

Video Signal Monitor Oui Non

Imager Scan Mode Oui Non

Frame Rate Oui Non

Rec Format Oui Non

Rec Look Oui Non

Level Gauge Oui Non

Audio Level Meter Oui Non

Auto Exposure Mode Oui Non

Auto Exposure Level Oui Non

ND Filter Oui Non

Iris Oui Non

ISO/Gain/EI Oui Non

Base ISO/Sensitivity Oui Non

Shutter Oui Non
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Display On/Off White Balance Oui Non

Clip Number Oui Non

Notice Message Oui Non

Marker Setting Oui Non

Color Oui Non

Center Marker Oui Non

Safety Zone Oui Non

Safety Area Oui Non

Aspect Marker Oui Non

Aspect Mask Oui Non

Aspect Safety Zone Oui Non

Aspect Safety Area Oui Non

Aspect Select Oui Non

Custom Aspect Ratio Oui Non

Guide Frame Oui Non

100% Marker Oui Non

User Box Oui Non

User Box Width Oui Non

User Box Height Oui Non

User Box H Position Oui Non

User Box V Position Oui Non

LCD Monitor Setting Brightness Oui Non

Color Mode Oui Non

Gamma Display Assist Setting Oui Non

Peaking Setting Oui Non

Peaking Level Oui Non

Color Oui Non

Monitoring Zebra Setting Oui Non

Zebra1 Level Oui Non

Zebra1 Aperture Level Oui Non

Zebra2 Level Oui Non

Focus Magnifier Focus Mag Button Target Oui Non

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Audio Audio Input CH1 Input Select Oui Non

CH2 Input Select Oui Non

CH3 Input Select Oui Non

CH4 Input Select Oui Non

INPUT1 MIC Reference Oui Non

INPUT2 MIC Reference Oui Non

Line Input Reference Oui Non

Reference Level Oui Non

CH1 Wind Filter Oui Non

CH2 Wind Filter Oui Non

CH3 Wind Filter Oui Non

CH4 Wind Filter Oui Non

CH3 Level Control Oui Non

CH4 Level Control Oui Non

CH3 Input Level Oui Non

CH4 Input Level Oui Non

Audio Input Level Oui Non

Limiter Mode Oui Non

CH1&2 AGC Mode Oui Non

CH3&4 AGC Mode Oui Non

AGC Spec Oui Non

1kHz Tone on Color Bars Oui Non

CH1 Level Oui Non

CH2 Level Oui Non

CH3 Level Oui Non

CH4 Level Oui Non

Audio Audio Output Monitor CH Oui Non

Volume Non Non

Headphone Out Oui Non

Alarm Level Oui Non

HDMI Output CH Oui Non

SDI Output CH (X-OCN) Oui Non
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Clip 
Operations

Display Clip Properties – –

Set Clip Flag Add OK – –

Add NG – –

Add KEEP – –

Delete Clip Flag – –

Lock/Unlock Clip Select Clip – –

Lock All Clips – –

Unlock All Clips – –

Transfer Clip Select Clip – –

All Clips – –

Transfer Clip (Proxy) Select Clip – –

All Clips – –

Filter Clips OK – –

NG – –

KEEP – –

None – –

All – –

Customize View Clips Caption Oui –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Technical Color Bars Setting Non Non

Type Oui Non

ND Dial CLEAR with Dial Oui Non

Rec/Tally Rec/Tally Oui Non

Rec Start/Stop Beep Oui Non

LOCK Switch Settings with Rec Button Oui Non

with Hand Grip Remote Oui Non

with LCD Monitor Oui Non

Touch Operation Setting Oui Non

Rec Review Setting Oui Non

Zoom Zoom Type Oui Non

Handle Zoom Setting Oui Non

High Oui Non

Low Oui Non

Menu Settings User Menu Only Oui Non

User Menu with Lock Non Non

Menu Page On/Off Project Oui Non

Audio Oui Non

Monitoring Oui Non

Assignable Button Oui Non

Battery Oui Non

Media Oui Non

Network Oui Non

File Transfer Oui Non

Fan Control Setting Oui Non

Lens PL-Mt Interface Position Oui Non

Zoom Ring Direction Oui Non

Shading Compensation Oui Non

Chroma Aberration Comp. Oui Non

Distortion Comp. Oui Non

Breathing Compensation Oui Non

Distance Display Oui Non

Zoom Position Display Oui Non
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Technical Video Light Set Video Light Set Oui Non

APR APR – –

Camera Battery Alarm Near End:Info Battery Oui Non

End:Info Battery Oui Non

Near End:Sony Battery Oui Non

End:Sony Battery Oui Non

Near End:Other Battery Oui Non

End:Other Battery Oui Non

Detected Battery Non Non

Camera DC IN Alarm DC Low Voltage1 Oui Non

DC Low Voltage2 Oui Non

Network Network Setup Setup for Mobile App – –

User Name Non Non

Input Password Non Non

Generate Password Non Non

Show Authentication – –

LAN Type Select Oui Non

Wireless LAN WPS – –

MAC Address – –

AP Mode Settings Channel Oui Non

Camera SSID & Password – –

Regenerate Password – –

IP Address – –

Subnet Mask – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network ST Mode Settings Camera Remote Control Oui Non

Connected Network

SSID – –

Security – –

Password – –

DHCP – –

IP Address – –

Subnet Mask – –

Gateway – –

DNS Auto – –

Primary DNS Server – –

Secondary DNS Server – –

Scan Networks

SSID – –

Security – –

Password Non Non

DHCP Oui Non

IP Address Oui Non

Subnet Mask Oui Non

Gateway Oui Non

DNS Auto Oui Non

Primary DNS Server Oui Non

Secondary DNS Server Oui Non

Manual Register

SSID Oui Non

Security Oui Non

Password Non Non

DHCP Oui Non

IP Address Oui Non

Subnet Mask Oui Non

Gateway Oui Non

DNS Auto Oui Non

Primary DNS Server Oui Non

Secondary DNS Server Oui Non
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network Wired LAN Camera Remote Control Oui Non

Detail Settings

DHCP Oui Non

IP Address Oui Non

Subnet Mask Oui Non

Gateway Oui Non

DNS Auto Oui Non

Primary DNS Server Oui Non

Secondary DNS Server Oui Non

MAC Address – –

USB Tethering Setting Oui Non

Camera Remote Control Oui Non

Device Name – –

IP Address – –

Subnet Mask – –

File Transfer Auto Upload Oui Non

Auto Upload (Proxy) Oui Non

Default Upload Server Oui Non

Clear Completed Jobs – –

Clear All Jobs – –

View Job List – –

Server Settings1/Server Settings2/Server Settings3

Display Name Oui Non

Service Oui Non

Host Name Oui Non

Port Oui Non

User Name Non Non

Password Non Non

Passive Mode Oui Non

Destination Directory Oui Non

Using Secure Protocol Oui Non

Root Certificate – –

Root Certificate Status – –

Reset – –

Network Network Reset Reset – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Maintenance Language Select Oui Non

Clock Set Time Zone Oui Non

Date Mode Oui Non

12h/24h Oui Non

Date Non Non

Time Non Non

All Reset Reset – –

Reset without Network – –

Hours Meter Hours(System) – –

Hours(Reset) – –

Reset – –

Version Version Number – –

Version Up – –

Lens Version Number – –
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Diagrammes bloc
Consultez les éléments associés dans « Réglage de l’audio à enregistrer » (page 99) et « Menu User » (page 35).

Audio Input (CH1&CH2)

INPUT1

L

R

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

CH1

[CH1 Input Select]
INPUT1
Internal MIC
Shoe CH1

[CH2 Input Select]
INPUT1
INPUT2
Internal MIC
Shoe CH2

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

<CH1 LEVEL
   CONTROL>*
AUTO
MAN

<CH1 INPUT LEVEL>
0 − 10

[CH1 Wind Filter]
On
O�

[CH2 Wind Filter]
On
O�

CH2

<CH2 LEVEL
   CONTROL>*
AUTO
MAN

<CH2 INPUT LEVEL>
0 − 10

[CH1&2 AGC Mode]
Mono
Stereo [Color Bars]

[1kHz Tone on Color
Bars]
On
O�

[Audio Input Level]
0 − 99

[Limiter Mode]
O�, -6dB,

-9dB, -12dB,
-15dB, -17dB SG

[CH1 Level]
Audio Input Level
Side
Level + Side
Through

[CH2 Level]
Audio Input Level
Side
Level + Side
Through

*	 Réglez sur Manual lorsque l’audio est entré par l’adaptateur XLR.
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Audio Input (CH3&CH4)

L

R

CH3

[CH3 Level
 Control]*
Auto
Manual

[CH4 Level
 Control]*
Auto
Manual

[CH3 Input Level]
0 − 99

CH4

[CH4 Input Level]
0 − 99

[CH3&4 AGC Mode]
Mono
Stereo

[Audio Input Level]
0 − 99

[Limiter Mode]
O�, -6dB,
-9dB, -12dB,
-15dB, -17dB SG

OFF

[CH3 Input Select]
O�
INPUT1
Internal MIC
Shoe CH1

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

[CH3 Wind Filter]
On
O�

[CH4 Wind Filter]
On
O�

[CH4 Input Select]
O�
INPUT1
INPUT2
Internal MIC
Shoe CH2

INPUT1

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

[CH3 Level]
Audio Input Level
CH3 Input Level
Level+CH3 Input Level
Through

[CH4 Level]
Audio Input Level
CH4 Input Level
Level+CH4 Input Level
Through

[Color Bars]
[1kHz Tone on Color
Bars]
On
O�

 
*	 Réglez sur Manual lorsque l’audio est entré par l’adaptateur XLR.



7. Annexe : Diagrammes bloc133

Audio Output (X-OCN)

L

R

Alarm
Beep

[HDMI Output CH]
CH1/CH2, CH3/CH4

[SDI Output CH (X-OCN)]
CH1/CH2, CH3/CH4

[Output Format]
SDI1, SDI2, HDMI

[Monitor CH]
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

[Headphone Out]
Mono, Stereo

[VOLUME]
0 − 50

[Alarm Level]
0 − 7

Ch
MIX

CH1

SDI OUT

Headphone

Internal Speaker

HDMI OUT

QoS
Streaming

CH2

CH3

CH4
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Audio Output (XAVC)

L

R

Alarm
Beep

[HDMI Output CH]
CH1/CH2, CH3/CH4

[Monitor CH]
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

[Headphone Out]
Mono, Stereo

[VOLUME]
0 − 50

[Alarm Level]
0 − 7

Ch
MIX

CH1

SDI OUT

Headphone

Internal Speaker

HDMI OUT

QoS
Streaming

CH2

CH3

CH4
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Mise à jour du logiciel de l’objectif à monture E
Vous pouvez mettre à jour le logiciel d’un 
objectif à monture E en utilisant l’appareil.
Consultez le site Web pour connaître les 
objectifs qui peuvent être mis à jour, ainsi que 
le logiciel correspondant.

Vérification de la version

1	 Fixez un objectif à monture E sur l’appareil 
(page 17).

2	 Sélectionnez Version dans le menu 
Maintenance du menu complet pour 
afficher Lens Version Number 
(page 65).
Le numéro de version du logiciel de 
l’objectif à monture E est affiché sur le 
côté.

Mise à jour du logiciel

Réglez l’appareil sur le mode de stockage de 
masse (page 109).
Actualisez le logiciel en appliquant la 
procédure fournie avec le logiciel de l’objectif.
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Licences

Licence MPEG-4 AVC Patent 
Portfolio

CE PRODUIT EST SOUS LICENCE AVC 
PATENT PORTFOLIO POUR L’UTILISATION 
PERSONNELLE DU CONSOMMATEUR OU TOUT 
AUTRE UTILISATION N’IMPLIQUANT PAS DE 
REMUNERATION
(i)	 ENCODAGE VIDEO EN CONFORMITÉ AVEC LE 

STANDARD AVC (« AVC VIDEO ») ET/OU
(ii)	DÉCODAGE VIDEO AVC ENCODÉ PAR UN 

CONSOMMATEUR ENGAGÉ DANS UNE 
ACTIVITÉ PERSONNELLE ET/OU OBTENU 
D’UN FOURNISSEUR VIDEO AYANT LA 
LICENCE DE DISTRIBUTION AVC VIDEO.

AUCUNE LICENCE N’EST ATTRIBUEE OU 
NE DOIT ETRE DESTINEE POUR TOUT 
AUTRE USAGE. DES INFORMATIONS 
SUPPLEMENTAIRES PEUVENT ETRE OBTENUES 
DE MPEG LA, L.L.C. VOIR  
HTTP://WWW.MPEGLA.COM

Obtention d’un logiciel sous 
licence GPL/LGPL

Ce produit utilise le logiciel auquel s’applique 
la licence GPL/LGPL. Ceci vous informe 
que vous disposez d’un droit d’accès, de 
modification et de redistribution du code 
source de ces logiciels dans les conditions de 
la GPL/LGPL.
Le code source est disponible sur Internet. 
Reportez-vous à l’adresse URL suivante et 
suivez les instructions de téléchargement.
https://oss.sony.net/Products/Linux/

Nous préférerions que vous ne nous 
contactiez pas au sujet du contenu du code 
source.

Les licences (en anglais) sont enregistrées 
dans la mémoire interne de votre produit.
Établissez une connexion de stockage de 
masse entre le produit et un ordinateur pour 
lire les licences du dossier « PMHOME » - 
« LICENSE ».

CONTRAT DE LICENCE 
D’UTILISATEUR FINAL

Last Updated: 2022-9

IMPORTANT:
BEFORE USING THE SOFTWARE, PLEASE READ 
THIS END USER LICENSE AGREEMENT (“EULA”) 
CAREFULLY. BY USING THE SOFTWARE YOU 
ARE AGREEING TO BE BOUND BY THE TERMS 
OF THIS EULA. IF YOU DO NOT AGREE TO THE 
TERMS OF THIS EULA, YOU MAY NOT USE THE 
SOFTWARE.

This EULA is a legal agreement between (i) 
you and any entity you represent (collectively 
“you”) and (ii) Sony Corporation (“SONY”). 
This EULA governs your rights and obligations 
regarding the product software of SONY 
and/or its third party licensors (including 
SONY’s affiliates) and their respective 
affiliates (collectively, the “THIRD-PARTY 
SUPPLIERS”), together with any updates/
upgrades, any printed, on-line or other 
electronic documentation for such software 
and any data files, each provided by SONY or 
the THIRD-PARTY SUPPLIERS, or created by 
operation of such software (collectively, the 
“SOFTWARE”). 

Notwithstanding the foregoing, any software 
in the SOFTWARE having a separate end 
user license agreement (including, but not 
limited to, GNU General Public license and 
Lesser/Library General Public License) shall be 
covered by such applicable separate end user 

license agreement in lieu of the terms of this 
EULA to the extent required by such separate 
end user license agreement (“EXCLUDED 
SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The 
SOFTWARE is protected by copyright and other 
intellectual property laws and international 
treaties. 

COPYRIGHT
All right and title in and to the SOFTWARE 
(including, but not limited to, any images, 
photographs, animation, video, audio, 
music, text and “applets” and other content 
incorporated into the SOFTWARE) is owned 
by SONY or one or more of the THIRD-PARTY 
SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited, non-exclusive, 
personal, non-transferable license to use the 
SOFTWARE solely in connection with your 
compatible device (including, but not limited 
to, SONY’s products which the SOFTWARE 
is embedded in or bundled with) (“DEVICE”) 
solely in accordance with this EULA and 
the usage instructions as may be made 
available to you by SONY or the THIRD-PARTY 
SUPPLIERS. SONY and the THIRD-PARTY 
SUPPLIERS expressly reserve all rights, title 
and interest (including, but not limited to, 
all intellectual property rights) in and to the 
SOFTWARE that this EULA does not specifically 
grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, 
attempt to derive source code, modify, reverse 
engineer, decompile, or disassemble any of 
the SOFTWARE, whether in whole or in part, 
or create any derivative works from or of the 
SOFTWARE unless such derivative works are 

intentionally facilitated by the SOFTWARE. 
You may not modify or tamper with any 
digital rights management functionality 
of the SOFTWARE. You may not bypass, 
modify, defeat or circumvent any of the 
functions or protections of the SOFTWARE 
or any mechanisms operatively linked to 
the SOFTWARE. You may not separate any 
individual component of the SOFTWARE 
for use on more than one DEVICE unless 
expressly authorized to do so by SONY. You 
may not remove, alter, cover or deface any 
trademarks or notices on the SOFTWARE. 
You may not share, distribute, rent, lease, 
sublicense, assign, transfer or sell the 
SOFTWARE. You may not use the SOFTWARE 
in connection with violation of laws, 
regulations, court decisions or other legally 
binding dispositions by a public authority or 
public policy, or infringement of the rights 
or legally protected interests (including, but 
not limited to, intellectual and other property 
rights, rights to trade secrets, honors, privacy 
and publicity) of SONY, each of the THIRD-
PARTY SUPPLIERS or any third parties. The 
software, network services or other products 
other than the SOFTWARE upon which the 
SOFTWARE’S performance depends might be 
modified, interrupted or discontinued at the 
discretion of the suppliers (software suppliers, 
service suppliers, or SONY). SONY and such 
suppliers do not warrant that the SOFTWARE, 
network services, contents or other products 
will continue to be available, or will operate 
without interruption or modification. You shall 
not, nor shall you instruct or permit, procure, 
enable or request any third party (including 
your users, third party personnel or other 
personnel, staff or contractors) to, take any 
action designed or intended to: (i) use the 
SOFTWARE (or any part thereof) in any manner 
or for any purpose that is inconsistent with 
this EULA; (ii) introduce to the SOFTWARE 
any “back door,” “drop dead device,” “time 
bomb,” “Trojan horse,” “virus,” or “worm” (as 

https://oss.sony.net/Products/Linux/
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such terms are commonly understood in the 
software industry) or any other equivalent 
code, files, scripts, agents, programs, software 
routine or instructions designed or intended to 
disrupt, disable, harm or otherwise impede in 
any manner the operation of the SOFTWARE or 
any device or system owned or controlled by 
you or any third party, or which otherwise may 
damage or destroy any data or file (“Malicious 
Code”); (iii) interfere with the proper working 
of the SOFTWARE; (iv) circumvent, disable, 
or interfere with security-related features 
of the SOFTWARE or features that prevent 
or restrict use, access to, or copying the 
SOFTWARE, or that enforce limitations on use 
of the SOFTWARE; or (v) impose (or which 
may impose, in your sole discretion) an 
unreasonable or disproportionately large load 
on the SOFTWARE.

EXCLUDED SOFTWARE AND OPEN SOURCE 
COMPONENTS
Notwithstanding the foregoing limited license 
grant, you acknowledge that the SOFTWARE 
may include EXCLUDED SOFTWARE. Certain 
EXCLUDED SOFTWARE may be covered by 
open source software licenses (“Open Source 
Components”), which means any software 
licenses approved as open source licenses by 
the Open Source Initiative or any substantially 
similar licenses, including but not limited to 
any license that, as a condition of distribution 
of the software licensed under such license, 
requires that the distributor make the software 
available in source code format. If and to 
the extent disclosure is required, please visit 
oss.sony.net/Products/Linux or other SONY-
designated web site for a list of applicable 
OPEN SOURCE COMPONENTS included in 
the SOFTWARE from time to time, and the 
applicable terms and conditions governing 
its use. Such terms and conditions may be 
changed by the applicable third party at any 
time without liability to you. To the extent 

required by the licenses covering EXCLUDED 
SOFTWARE, the terms of such licenses will 
apply in lieu of the terms of this EULA. To the 
extent the terms of the licenses applicable 
to EXCLUDED SOFTWARE prohibit any of the 
restrictions in this EULA with respect to such 
EXCLUDED SOFTWARE, such restrictions will 
not apply to such EXCLUDED SOFTWARE. To 
the extent the terms of the licenses applicable 
to Open Source Components require SONY 
to make an offer to provide source code in 
connection with the SOFTWARE, such offer is 
hereby made.

USE OF SOFTWARE WITH COPYRIGHTED 
MATERIALS
The SOFTWARE may be capable of being used 
by you to view, store, process and/or use 
content created by you and/or third parties. 
Such content may be protected by copyright, 
other intellectual property laws, and/or 
agreements. You agree to use the SOFTWARE 
only in compliance with all such laws and 
agreements that apply to such content. You 
acknowledge and agree that SONY may take 
appropriate measures to protect content 
stored, processed or used by the SOFTWARE. 
Such measures include, but are not limited 
to, refusal to accept your request to enable 
backup and restoration of content through 
certain SOFTWARE features, and termination 
of this EULA in the event of your illegitimate 
use of the SOFTWARE.

CONTENT SERVICE
PLEASE ALSO NOTE THAT THE SOFTWARE MAY 
BE DESIGNED TO BE USED WITH CONTENT 
AVAILABLE THROUGH ONE OR MORE CONTENT 
SERVICES (“CONTENT SERVICE”). USE OF THE 
SERVICE AND THAT CONTENT IS SUBJECT TO 
THE TERMS OF SERVICE OF THAT CONTENT 
SERVICE. IF YOU DECLINE TO ACCEPT THOSE 
TERMS, YOUR USE OF THE SOFTWARE WILL 
BE LIMITED. You acknowledge and agree 

that certain content and services available 
through the SOFTWARE may be provided 
by third parties over which SONY has no 
control. WHERE CONTENT SERVICE IS NOT 
UNDER SONY’S CONTROL, SONY SHALL NOT 
BE LIABLE IN RESPECT OF ANY DAMAGES (OR 
OTHER LIABILITY) RELATED TO SUCH CONTENT 
SERVICE. USE OF THE CONTENT SERVICE 
REQUIRES AN INTERNET CONNECTION. THE 
CONTENT SERVICE MAY BE MODIFIED OR 
DISCONTINUED AT ANY TIME.

INTERNET CONNECTIVITY AND THIRD PARTY 
SERVICES
You acknowledge and agree that access to 
certain SOFTWARE features may require an 
Internet connection for which you are solely 
responsible. Further, you are solely responsible 
for payment of any fees associated with 
your Internet connection, including but not 
limited to Internet service provider or airtime 
charges. Operation of the SOFTWARE may 
be limited or restricted depending on the 
capabilities, bandwidth or technical limitations 
of your Internet connection and service. The 
provision, quality and security of such Internet 
connectivity are your responsibility or that of 
the third party providing such service. You are 
solely responsible in the event any Malicious 
Code introduced in the SOFTWARE because of 
or through, your internet connections.

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export 
and re-export restrictions and regulations of 
the area or country in which you reside or 
use the SOFTWARE, and not to transfer, or 
authorize the transfer, of the SOFTWARE to a 
prohibited country or otherwise in violation of 
any such restrictions or regulations. 

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is 
not designed, manufactured or intended for 

use or resale as on-line control equipment 
in hazardous environments requiring fail-
safe performance, such as in the operation 
of nuclear facilities, aircraft navigation or 
communication systems, air traffic control, 
direct life support machines, or weapons 
systems, in which the failure of the SOFTWARE 
could lead to death, personal injury, or severe 
physical or environmental damage (“HIGH 
RISK ACTIVITIES”). SONY, each of the THIRD-
PARTY SUPPLIERS, and each of their respective 
affiliates specifically disclaim any express or 
implied warranty, duty or condition of fitness 
for HIGH RISK ACTIVITIES. 

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the 
SOFTWARE is at your sole risk and that you 
are responsible for use of the SOFTWARE. 
The SOFTWARE is provided “AS IS,” without 
warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY 
SUPPLIERS (for purposes of this Section, SONY 
and each of the THIRD-PARTY SUPPLIERS 
shall be collectively referred to as “SONY”) 
EXPRESSLY DISCLAIM ALL WARRANTIES, 
DUTIES OR CONDITIONS, EXPRESS OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY, QUALITY, 
FITNESS FOR A PARTICULAR PURPOSE, 
ACCURACY, TITLE AND NONINFRINGEMENT. 
WITHOUT LIMITING THE GENERALITY OF THE 
FOREGOING, SONY DOES NOT WARRANT OR 
MAKE ANY CONDITIONS OR REPRESENTATIONS 
(A) THAT THE FUNCTIONS CONTAINED IN 
ANY OF THE SOFTWARE WILL MEET YOUR 
REQUIREMENTS OR THAT THEY WILL BE 
UPDATED, (B) THAT THE OPERATION OF ANY 
OF THE SOFTWARE WILL BE CORRECT OR 
ERROR-FREE OR THAT ANY DEFECTS WILL 
BE CORRECTED, (C) THAT THE SOFTWARE 
WILL NOT DAMAGE ANY OTHER SOFTWARE, 
HARDWARE OR DATA, (D) THAT ANY 



7. Annexe : Licences138

SOFTWARE, NETWORK SERVICES (INCLUDING 
THE INTERNET) OR PRODUCTS (OTHER 
THAN THE SOFTWARE) UPON WHICH THE 
SOFTWARE’S PERFORMANCE DEPENDS WILL 
CONTINUE TO BE AVAILABLE, UNINTERRUPTED, 
TIMELY, SECURE OR UNMODIFIED, (E) THAT 
THE SOFTWARE OR ANY EQUIPMENT, SYSTEM 
OR NETWORK ON WHICH THE SOFTWARE IS 
USED (INCLUDING THE DEVICE) WILL BE FREE 
OF VULNERABILITY TO INTRUSION OR ATTACK 
AND (F) REGARDING THE USE OR THE RESULTS 
OF THE USE OF THE SOFTWARE IN TERMS OF 
ITS CORRECTNESS, ACCURACY, RELIABILITY, OR 
OTHERWISE.

NO ORAL OR WRITTEN INFORMATION OR 
ADVICE GIVEN BY SONY OR AN AUTHORIZED 
REPRESENTATIVE OF SONY SHALL CREATE 
A WARRANTY, DUTY OR CONDITION OR IN 
ANY WAY INCREASE THE SCOPE OF THIS 
WARRANTY. SHOULD THE SOFTWARE PROVE 
DEFECTIVE YOU ASSUME THE ENTIRE COST 
OF ALL NECESSARY SERVICING, REPAIR OR 
CORRECTION. SOME JURISDICTIONS DO 
NOT ALLOW THE EXCLUSION OF IMPLIED 
WARRANTIES, SO THESE EXCLUSIONS MAY 
NOT APPLY TO YOU TO THE EXTENT THEY ARE 
CONTRARY TO APPLICABLE LAW OF YOUR 
JURISDICTION.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY 
SUPPLIERS (for purposes of this Section, 
SONY and each of the THIRD-PARTY 
SUPPLIERS shall be collectively referred to 
as “SONY”) SHALL NOT BE LIABLE FOR ANY 
INCIDENTAL, INDIRECT, SPECIAL, EXEMPLARY 
OR CONSEQUENTIAL LOSS OR DAMAGES 
FOR BREACH OF ANY EXPRESS OR IMPLIED 
WARRANTY, BREACH OF CONTRACT, 
NEGLIGENCE, STRICT LIABILITY OR UNDER 
ANY OTHER LEGAL THEORY RELATED TO THE 
SOFTWARE, INCLUDING, BUT NOT LIMITED 
TO, ANY DAMAGES ARISING OUT OF LOSS OF 

PROFITS, LOSS OF REVENUE, LOSS OF DATA, 
LOSS OF USE OF THE SOFTWARE OR ANY 
ASSOCIATED HARDWARE, DOWN TIME AND 
USER’S TIME, EVEN IF ANY OF THEM HAVE 
BEEN ADVISED OF THE POSSIBILITY OF SUCH 
LOSSES OR DAMAGES. IN ANY CASE, EACH 
AND ALL OF THEIR AGGREGATE LIABILITY 
UNDER ANY PROVISION OF THIS EULA SHALL 
BE LIMITED TO THE GREATER OF (i) THE 
AMOUNT ACTUALLY PAID FOR THE SOFTWARE, 
SONY’S PRODUCT WHICH THE SOFTWARE IS 
EMBEDDED IN OR BUNDLED WITH AND/OR 
SONY’S SERVICE TO WHICH THE SOFTWARE 
IS DEDICATED OR (ii) THE FIXED AMOUNT 
AGREED IN WRITING BETWEEN SONY AND 
YOU. SOME JURISDICTIONS DO NOT ALLOW 
SUCH EXCLUSIONS OR LIMITATIONS OF 
LIABILITY, SO THE ABOVE EXCLUSIONS OR 
LIMITATIONS MAY NOT APPLY TO YOU TO THE 
EXTENT THEY ARE CONTRARY TO APPLICABLE 
LAW OF YOUR JURISDICTION.

INDEMNITY
Except as prohibited by applicable law, you 
agree to indemnify and hold harmless SONY 
and the THIRD-PARTY SUPPLIERS and their 
respective affiliates, officers and employees, 
from any loss, claim or demand, including 
reasonable attorneys' fees, made by any third 
party due to or arising out of your use of the 
SOFTWARE and/or the DEVICE (including, 
without limitation, any software vulnerability 
caused by such use), your violation of this 
EULA or your failure to fulfill your responsibility 
under this EULA.

AUTOMATIC UPDATE FEATURE 
From time to time, SONY or the THIRD-
PARTY SUPPLIERS may automatically 
update or otherwise modify the SOFTWARE, 
including, but not limited to, for purposes 
of enhancement of security functions, error 
correction and improvement of functions, 
at such time as you interact with SONY’s 

or third parties’ servers, or otherwise. Such 
updates or modifications may delete or 
change the nature of features or other 
aspects of the SOFTWARE, including, but not 
limited to, functions you may rely upon. You 
acknowledge and agree that such activities 
may occur at SONY’s sole discretion and that 
SONY may condition continued use of the 
SOFTWARE upon your complete installation or 
acceptance of such update or modifications. 
Any updates/modifications shall be deemed 
to be, and shall constitute part of, the 
SOFTWARE for purposes of this EULA. By 
acceptance of this EULA, you consent to such 
update/modification. 

FORCE MAJEURE
SONY shall not be liable for any delay or failure 
to perform resulting from causes outside 
its reasonable control, including, but not 
limited to, fire, floods, storms, earthquakes, 
epidemics, acts of God, war, terrorism, riots, 
insurrection, embargos, acts of civil, military 
or governmental authorities, nuclear or other 
accidents, explosions, strikes or shortages of 
transportation facilities, fuel, energy, labor or 
materials.

ENTIRE AGREEMENT, WAIVER, SEVERABILITY 
This EULA (and SONY’s applicable privacy 
policy separately presented to you, if any), as 
amended and modified from time to time, 
constitute the entire agreement(s) between 
you and SONY with respect to the SOFTWARE. 
The failure of SONY to exercise or enforce 
any right or provision of this EULA shall not 
constitute a waiver of such right or provision. 
If any part of this EULA is held invalid, illegal, 
or unenforceable, that provision shall be 
enforced to the maximum extent permissible 
so as to maintain the intent of this EULA, and 
the other parts will remain in full force and 
effect. 

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts 
for the International Sale of Goods shall 
not apply to this EULA. This EULA shall be 
governed by the laws of Japan, without 
regards to conflict of laws provisions. Any 
dispute arising out of this EULA shall be 
subject to the exclusive venue of the Tokyo 
District Court in Japan, and the parties hereby 
consent to the venue and jurisdiction of such 
courts. The foregoing does not apply to you to 
the extent applicable law of your jurisdiction 
restricts or prohibits such agreements.

EQUITABLE REMEDIES
Notwithstanding anything contained in this 
EULA to the contrary, you acknowledge and 
agree that any violation of or non-compliance 
with this EULA by you will cause irreparable 
harm to SONY, for which monetary damages 
would be inadequate, and you consent to 
SONY obtaining any injunctive or equitable 
relief that SONY deems necessary or 
appropriate in such circumstances. SONY may 
also take any legal and technical remedies 
to prevent violation of and/or to enforce this 
EULA, including, but not limited to, immediate 
termination of your use of the SOFTWARE, if 
SONY believes in its sole discretion that you 
are violating or intend to violate this EULA. 
These remedies are in addition to any other 
remedies SONY may have at law, in equity or 
under contract.

TERMINATION
Without prejudice to any of its other rights, 
SONY may suspend your access or use of the 
SOFTWARE and/or terminate this EULA if you 
fail to comply with any of its terms. In case of 
such termination, you must: (i) cease all use, 
and destroy any copies, of the SOFTWARE; (ii) 
comply with the requirements in the section 
below entitled “Your Account Responsibilities”.
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AMENDMENT
SONY RESERVES THE RIGHT TO AMEND 
ANY OF THE TERMS OF THIS EULA AT ITS 
SOLE DISCRETION BY POSTING NOTICE ON 
A SONY DESIGNATED WEB SITE, BY EMAIL 
NOTIFICATION TO AN EMAIL ADDRESS 
PROVIDED BY YOU, BY PROVIDING NOTICE AS 
PART OF THE PROCESS IN WHICH YOU OBTAIN 
UPGRADES/UPDATES OR BY ANY OTHER 
LEGALLY RECOGNIZABLE FORM OF NOTICE. 
If you do not agree to the amendment, you 
should promptly contact SONY for instructions. 
Your continued use of the SOFTWARE after 
the effective date of any such notice shall be 
deemed your agreement to be bound by such 
amendment. 

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express 
intended third-party beneficiary of, and shall 
have the right to enforce, each provision of 
this EULA with respect to the software of such 
party.

YOUR ACCOUNT RESPONSIBILITIES
Should you return your DEVICE to its place 
of purchase, sell or otherwise transfer your 
DEVICE, or if this EULA is terminated, you 
are responsible for and must, if reasonably 
possible, uninstall the SOFTWARE from the 
DEVICE and delete any and all accounts 
you may have established on DEVICE or 
are accessible through the SOFTWARE. You 
are solely responsible for maintaining the 
confidentiality of any accounts you have with 
SONY or third parties and any usernames and 
passwords associated with your use of the 
DEVICE.

Should you have any questions concerning 
this EULA, you may contact SONY by writing 
to SONY at the applicable contact address for 
each area or country.

Licences de logiciels libres

Sur la base des contrats de licence entre Sony 
et les détenteurs de copyright des logiciels, ce 
produit utilise des logiciels libres.
Pour répondre aux exigences des détenteurs 
de copyright des logiciels, Sony est dans 
l’obligation de vous informer sur le contenu de 
ces licences.
Les licences (en anglais) sont enregistrées 
dans la mémoire interne de votre produit.
Établissez une connexion de stockage de 
masse entre le produit et un ordinateur pour 
lire les licences du dossier « PMHOME » - 
« LICENSE ».

Si vous utilisez un Mac, le dossier « PMHOME » 
- « LICENCE » peut ne pas être accessible.
Pour visualiser les fichiers, utilisez un 
ordinateur autre qu’un Mac ou visitez l’URL 
suivante.
https://oss.sony.net/License/MPC-2610/

https://oss.sony.net/License/MPC-2610/
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Caractéristiques techniques

Généralités

Poids

	 Environ 2,9 kg (6 lb 6,3 oz) (boîtier, adaptateur 

de la monture PL)

	 Environ 2,4 kg (5 lb 4,7 oz) (boîtier 

uniquement, adaptateur de la 

monture PL exclu)

Dimensions

	 Consultez page 142.

Besoins en alimentation

	 12 V CC (11 V à 17 V)

Consommation électrique

	 Consommation électrique nominale de 

l’appareil : environ 50,0 W 

(objectif, 6K 17:9, 59.94P, 

enregistrement X-OCN LT, 

ventilation automatique, en 

excluant la télécommande de 

poignée et les périphériques)

	 Consommation électrique maximale de 

l’appareil : environ 66,0 W 

(objectif, 6K 17:9, 59.94P, 

enregistrement X-OCN LT, 

température 40 °C (104 °F), filtre 

ND (1/4), enregistrement proxy 

activé, Wi-Fi activé, ventilation 

automatique, en incluant la 

télécommande de poignée et les 

périphériques)

Température de fonctionnement

	 0 °C à 40 °C (32 °F à 104 °F)

Température de stockage

	 –20 °C à +60 °C (–4 °F à +140 °F)

Durée d’utilisation continue

	 Environ 100 minutes (lors de l’utilisation du 

BP-GL95B)

Format d’enregistrement (vidéo)

	 X-OCN(LT)

	 XAVC H Intra HQ

	 XAVC H Intra SQ

	 XAVC H Long

	 XAVC Intra

	 XAVC Long

Format d’enregistrement (audio)

	 LPCM 24 bits, 48 kHz, 4 canaux

Fréquence d’enregistrement élevée

	 X-OCN(LT)

		  FF 8.6K 17:9 

29.97P, 25P, 24P, 23.98P

		  FF 8.6K 16:9

			   29.97P, 25P, 23.98P

		  FFc 6K 17:9/S35 5.8K 17:9/S35c 4K 17:9

			   59.94P, 50P, 29.97P, 25P, 24P, 

23.98P

		  FFc 6K 16:9/S35 5.8K 16:9

			   59.94P, 50P, 29.97P, 25P, 23.98P

	 XAVC H Intra HQ

		  8192×4320/29.97P, 25P, 24P, 23.98P

		  7680×4320/29.97P, 25P, 23.98P

	 XAVC H Intra SQ

		  8192×4320/29.97P, 25P, 24P, 23.98P

		  7680×4320/29.97P, 25P, 23.98P

	 XAVC H Long

		  7680×4320/29.97P, 25P, 23.98P

	 XAVC Intra

		  4096×2160/59.94P, 50P, 29.97P, 25P, 

24P, 23.98P

		  3840×2160/1920×1080/59.94P, 50P, 

29.97P, 25P, 23.98P

	 XAVC Long

		  3840×2160/1920×1080/59.94P, 50P, 

29.97P, 25P, 23.98P

Durée d’enregistrement/lecture

	 Consultez page 116.

Section de caméra

Élément d’imagerie

	 Capteur d’image CMOS à puce unique, 

équivalent à plein format 35 mm

Nombre de pixels

	 57,0M (total)

Mise au point automatique

	 Méthode de détection : détection de phase/

détection de contraste

Filtres ND internes

	 CLEAR : OFF

	 ND variable linéairement : 0.6 (1/4) à 2.1 

(1/128)

Sensibilité ISO

	 ISO 800/3200 (mode Cine EI, source 

lumineuse D55)

Monture d’objectif

	 Monture PL (avec adaptateur de la monture 

PL)

	 Monture E (sans adaptateur de la monture 

PL)

Longueur focale de collerette

	 Monture PL : 52 mm

	 Monture E : 18 mm

Latitude

	 16 stops

Vitesse d’obturateur

	 1/8000 sec à 64F (23.98P)

Angle d’obturateur

	 5,6° à 360°, 2 à 64 images

Balance des blancs

	 2000 K à 15000 K

Gain

	 –3 dB à +18 dB (incréments de 1 dB)

Section audio

Fréquence d’échantillonnage

	 48 kHz

Quantification

	 24 bits

Réponse de fréquence

	 Mode MIC entrée XLR : 20 Hz à 20 kHz (±3 dB 

ou moins)

	 Mode LINE entrée XLR : 20 Hz à 20 kHz (±3 dB 

ou moins)

Plage dynamique

	 Mode MIC entrée XLR : 80 dB (typique)

	 Mode LINE entrée XLR : 90 dB (typique)

Distorsion

	 Mode MIC entrée XLR : 0,08% ou moins 

(niveau d’entrée –40 dBu)

	 Mode LINE entrée XLR : 0,08% ou moins 

(niveau d’entrée +14 dBu)

Haut-parleur intégré

	 Monaural

Microphone interne

	 Monaural

Section entrée/sortie

Entrées
INPUT 1/2 :

	 Type XLR, 3 broches, femelle

	 Commutable LINE / MIC / MIC+48V

	 MIC : référence –30 dBu à –80 dBu

TC IN :

	 Type BNC

REF IN :

	 Type BNC
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Sorties
SDI OUT 1 :

	 Type BNC, 12G-SDI, 6G-SDI, 3G-SDI (niveau 

A/B), HD-SDI 

SDI OUT 2 :

	 Type BNC, 3G-SDI (niveau A/B), HD-SDI

Casque (mini-prise stéréo) :

	 –16 dBu (sortie du niveau de référence, 

volume maximal du moniteur, 

charge de 16 Ω)

HDMI :

	 Type A, 19 broches

TC OUT :

	 Type BNC

REF OUT :

	 Type BNC

Autre
DC IN :

	 Type XLR, mâle à 4 broches (1), 11 V à 17 V

REMOTE :

	 Type mini-sub à 3 pôles, 2,5 mm

Connecteur de la télécommande de poignée :

	 3,5 mm, prise mini-jack à 4 pôles

USB-C :

	 USB 3.2 Gen 1

VF :

	 Dédié 40 broches

Connecteur réseau :

	 Type RJ45

Connecteur de poignée :

	 Dédié 40 broches

Section d’affichage

Viseur (LCD)
Taille d’écran

	 8,8 cm (3,5 pouces) de diagonale

Rapport d’aspect

	 16:9

Nombre de pixels

	 1280 (H) × 720 (V)

Section de logement de support

Logement de carte CFexpress Type B (2)

Logement de carte SD Utility (1) 

LAN sans fil

Normes prises en charge*

	 IEEE 802.11a/b/g/n/ac (modèle WW279317)

	 IEEE 802.11b/g/n (modèle WW057783)

Bande de fréquences*

	 2,4 GHz/5 GHz (modèle WW279317)

	 2,4 GHz (modèle WW057783)
*	 Reportez-vous à la plaque signalétique apposée 

sur le dessous de l’appareil.

Protocoles de sécurité pris en charge

	 WEP/WPA-PSK/WPA2-PSK

Méthode de connexion

	 Wi-Fi Protected Setup™ (WPS)/Manuel

Méthode d’accès

	 Mode Infrastructure

Accessoires fournis

Poignée (avec bras de viseur) (1)

Vis de montage de poignée (4)

Moniteur LCD (1)

Loupe de viseur (1)

Adaptateur de fixation du viseur (1)

Cale (circulaire) (1)

Cale (tiers de cercle) (15)

Capuchon de la monture E (1) 

Capuchon de la monture PL (1)

Avant d’utiliser cet appareil (1)

Livret de garantie (1)

La conception et les caractéristiques 
techniques sont sujettes à modification sans 
préavis.

Remarques
•• Effectuez toujours un essai 

d’enregistrement pour vérifier que 
l’enregistrement s’est fait correctement. 
SONY N’ASSUMERA PAS DE 
RESPONSABILITÉ POUR LES DOMMAGES 
DE QUELQUE SORTE QU’ILS SOIENT, 
INCLUANT MAIS NE SE LIMITANT PAS À LA 
COMPENSATION OU AU REMBOURSEMENT, 
SUITE AU MANQUEMENT DE CET APPAREIL 
OU DE SON SUPPORT D’ENREGISTREMENT, 
OU DE TOUT AUTRE SUPPORT OU SYSTÈME 
DE MÉMOIRE À ENREGISTRER UN CONTENU 
DE TOUT TYPE.

•• Vérifiez toujours que l’appareil fonctionne 
correctement avant l’utilisation. SONY 
NE PEUT ÊTRE TENUE RESPONSABLE DE 
TOUT DOMMAGE, DE QUELQUE NATURE 
QUE CE SOIT, Y COMPRIS MAIS SANS 
LIMITATION, LA COMPENSATION OU LE 
REMBOURSEMENT SUITE À LA PERTE 
DES BÉNÉFICES PRÉSENTS ET À VENIR 
RÉSULTANT D’UN DYSFONCTIONNEMENT 
DE CET APPAREIL NI PENDANT LA PÉRIODE 
DE GARANTIE OU UNE FOIS LE DÉLAI DE 
GARANTIE EXPIRÉ OU POUR TOUTE AUTRE 
RAISON QUE CE SOIT.

•• SONY N’ASSUMERA PAS DE 
RESPONSABILITÉ POUR LES 
RÉCLAMATIONS, QUELLE QU’ELLES SOIENT, 
EFFECTUÉES PAR LES UTILISATEURS DE CET 
APPAREIL OU PAR DES TIERCES PARTIES.

•• SONY N’ASSUMERA PAS DE 
RESPONSABILITÉ POUR LA PERTE, LA 
RÉPARATION OU LA REPRODUCTION DE 
TOUTES DONNÉES ENREGISTRÉES SUR 
LE SYSTÈME DE MÉMOIRE INTÉRIEUR, 
LE SUPPORT D’ENREGISTREMENT OU 
TOUT AUTRE SUPPORT OU SYSTÈME DE 
MÉMOIRE.

•• SONY N’ASSUMERA PAS DE 
RESPONSABILITÉ POUR LA CESSATION OU 
L’INTERRUPTION DE TOUT SERVICE LIÉ À 
CET APPAREIL, RÉSULTANT DE QUELQUE 
CIRCONSTANCE QUE CE SOIT.
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Dimensions externes

Haut/avant/côté des commutateurs d’opérateur/arrière

14 (9/16)

2,3 (3/32)

73 
(2 7/8)

3×UNC 3/8-16, 
Profondeur : 14

M2, Profondeur : 3,9 
(Contre-alésage ø5,3, 

Profondeur : 1,9)

6×UNC 3/8-16, Profondeur : 10

8×UNC 1/4-20, 
Profondeur : 103×UNC 1/4-20, 

Profondeur : 9

6×M3, Profondeur : 6

6×UNC 1/4-20, 
Profondeur : 9

UNC 3/8-16, 
Profondeur : 7

142,5 
(5 5/8)

27 
(1 1/8)12 (1/2)

70 
(2 7/8)

144 (5 3/4)
64,6 

(2 5/8)

66,85 
(2 3/4)

41,85 (1 11/16) 50 (2) 50 (2)

50 (2) 50 (2)

9 (3/8)

18 (23/32)
30,75 (1 1/4) 20 (13/16) 20 (13/16)

30 (1 3/16) 30 (1 3/16)

84 (3 3/8)

50,6 (2)

33,4 (1 3/8)

2×M3, Profondeur : 5

2×M3, 
Profondeur : 5

Unité : mm (po.)

218,1 (8 5/8) 184,25 (7 3/8)

212,5 
(8 3/8)

13,5 
(9/16)

UNC 1/4-20, 
Profondeur : 9

2×M3, 
Profondeur : 5

62  
(2 1/2) 

29  
(1 3/16)

25 (1) 20 (13/16)

20 (13/16)

6,05 (1/4)

59,1 
(2 3/8)

145,7 
(5 3/4)

25 (1)

7,4 (5/16)

12,5 (1/2)

12,5 (1/2)

7,4 (5/16)

25 (1)
50 (2)
25 (1)

184 (7 1/4)
50 
(2)

50 
(2) 75 (3)

50 (2) 50 (2)41,85 (1 11/16)

66,85 
(2 3/4)
65,4 

(2 5/8)

73 
(2 7/8)

69 (2 3/4)

58,6 
(2 3/8)

58,6 
(2 3/8)

86,5 (3 1/2)

69,5 
(2 3/4)
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Côté des connecteurs/dessous

Unité : mm (po.)25 (1)
25 (1)
25 (1)

1,5 (1/16)

34,6 (1 3/8)

4×UNC 3/8-16, 
Profondeur : 9

4×UNC 1/4-20, 
Profondeur : 9

2×M3, 
Profondeur : 5

25 (1)
25 (1)
25 (1)

14 (9/16)
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Marques commerciales

•• Les termes HDMI et High-Definition 
Multimedia Interface ainsi que le logo 
HDMI sont des marques commerciales ou 
des marques déposées de HDMI Licensing 
Administrator, Inc. aux États-Unis et dans 
d’autres pays.

•• USB-C est une marque déposée d’USB 
Implementers Forum.

•• Tous les noms de système et les noms de 
produit sont des marques déposées ou des 
marques commerciales de leur propriétaire 
respectif. Les éléments de marques 
commerciales ne sont pas indiqués par les 
symboles ® ou ™ dans ce document.
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